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ABSTRACT 

The MELCOR Accident Consequence Code System (MACCS) is used by Nuclear Regulatory 
Commission (NRC) and various national and international organizations for probabilistic 
consequence analysis of nuclear power accidents.  This User Guide is intended to assist analysts 
in understanding the MACCS/WinMACCS model and to provide information regarding the code.  
This user guide version describes MACCS Version 3.10.0.  Features that have been added to 
MACCS in subsequent versions are described in separate documentation.  This User Guide 
provides a brief description of the model history, explains how to set up and execute a problem, 
and informs the user of the definition of various input parameters and any constraints placed on 
those parameters.  This report is part of a series of reports documenting MACCS. Other reports 
include the MACCS Theory Manual, MACCS Verification Report, Technical Bases for 
Consequence Analyses Using MACCS, as well as documentation for preprocessor codes 
including SecPop, MelMACCS, and COMIDA2.   
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EXECUTIVE SUMMARY 

The purpose of this document is to provide a user guide and reference document for MACCS, 
which is used for calculating health and economic consequences from a release of radioactive 
materials into the atmosphere.  The MACCS code suite has a diverse user base including the 
U.S. Nuclear Regulatory Commission (NRC), the U.S. Department of Energy (DOE), various 
research organizations, nuclear power plant applicants and licensees, as well as international 
regulators and technical support organizations.  

In 2001, the NRC initiated an effort to create a Windows-based interface and framework for 
performing consequence analysis.  This user guide describes the functions of both WinMACCS 
and MACCS together.  For simplicity, the combined functions of MACCS and WinMACCS are 
often referred to as MACCS.  However, WinMACCS and MACCS are separate codes and it is 
often useful to distinguish the functions of the two codes.  This User Guide applies to version 
3.10.0 of both MACCS and WinMACCS but is largely applicable to more recent updates.  
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1. INTRODUCTION  

The historical reference to the consequence code has been MACCS or MACCS2, which was 
related to the version number.  In 2001, the NRC initiated an effort to create a Windows-based 
interface and framework for performing consequence analyses.  This user guide describes the 
functions of both WinMACCS and MACCS together.  For simplicity, the combined functions of 
MACCS and WinMACCS are often referred to as MACCS.  However, WinMACCS and MACCS 
are separate codes and it is often useful to distinguish the functions of the two codes.  

MACCS is the NRC code used to estimate the offsite consequences of potential severe accidents 
at nuclear power plants.  The code is used to perform probabilistic health and economic 
consequence assessment of hypothetical releases of radioactive material.  Atmospheric 
dispersion and transport, wet and dry deposition, probabilistic treatment of meteorology, 
environmental transfer, countermeasure strategies, dosimetry, health effects, and economic 
impacts are addressed in the code.  

The lineage of development of accident consequence codes for the NRC is described as follows: 

• CRAC was used in the landmark Reactor Safety Study (WASH-1400) to estimate 
consequences of a set of hypothetical accidents. WASH-1400 was published in 1975 but 
a CRAC user manual does not appear to have been published.  

• CRAC2 was published in 1983 (Ritchie et al., 1984) and was most notably used to 
support Technical Guidance for Siting Criteria Development (Aldrich et al., 1982) 

• MACCS was published in 1990 (H-N Jow, et al., 1990) and was used to perform the 
consequence analyses for the landmark probabilistic risk assessment (PRA) study 
documented in NUREG-1150 (NRC, 1989) 

• MACCS2 was published in 1997 (Chanin and Young, 1997).  The work to develop 
MACCS2 was sponsored by the DOE and was focused largely on generalizing MACCS 
to be used for nonreactor applications. 

• WinMACCS was first released to the public in March of 2008 as Version 3.4.0.  
Version 3.10.0 is the sixth release version to be published. WinMACCS has been used 
for a large number of important studies, including the State-of-the-Art Reactor 
Consequence Analyses (SOARCA) (Chang et al., 2012; Bixler et al., 2013, and Sandia 
National Laboratories, 2013), the SOARCA uncertainty analyses for Peach Bottom, 
Sequoyah, and Surry (Mattie et al., 2016; Sandia National Laboratories, 2019; Ross et 
al., 2015), and Consequence Study of a Beyond-Design-Basis Earthquake Affecting the 
Spent Fuel Pool for a U.S. Mark I Boiling Water Reactor (Barto et al., 2014).  

1.1 MACCS History  

MACCS2.1.12 was released in April of 1997 as a batch-process code.  In September 2001 
version 1.13 was released to allow execution under newer operating systems and to fix several 
bugs in the previous version.  Since 2001, a new version of MACCS has been released 
approximately every two years.  New versions offered enhancements in addition to addressing 
bugs.  The current version of MACCS is 4.0; however, this report applies to version 3.10.0.  A 
detailed chronicle of changes made to MACCS is distributed along with MACCS in a document 
titled, “History of MACCS.”  Parallel revisions to WinMACCS are similarly documented in “History 
of WinMACCS.” 
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1.2 Software Quality Assurance 

Development of MACCS, WinMACCS, and other supporting codes in the suite of MACCS 
software is controlled by a set of software quality assurance (SQA) requirements in compliance 
with NRC requirements.  The elements of the SQA requirements include QA training for the 
software developers, testers, and administrators; documentation of software requirements; 
documentation of software implementation; test plans; management of revision history and 
configuration control; test reports; bug tracking; and client tracking.  Further documentation, such 
as a user manual, a verification report, theory manual, and other supporting documentation, are 
either currently available or in the process of being written at the time of this writing.  Bug tracking 
for MACCS version 3.10 used Melzilla, an implementation based on Bugzilla.  Currently, as of 
this report’s publication, bug tracking for newer versions of MACCS use FogBugz.  All MACCS 
users can request a Melzilla account to report and view bugs for MACCS version 3.10.  All 
MACCS users can also request a FogBugz account to report and view bugs for newer code 
versions.  The details of the SQA plan are documented in MELCOR Accident Consequence Code 
System (MACCS) Software Quality Assurance Plan, Version 1.6, which is available to MACCS 
users upon request.  

At the time of this writing, the MACCS SQA plan is being revised and updated.  It is the intent that 
this update will facilitate future versions of MACCS being included in the DOE’s toolbox codes 
listed in the Safety Software Quality Assurance Central Registry.  

1.3 WinMACCS Overview 

In 2001, the NRC initiated an effort to create a Windows-based interface and framework for 
performing consequence analyses.  WinMACCS is developed for Windows operating systems. 
This effort was intended to address the following needs: 

• Simplify the effort required to create or modify input files and make it more intuitive; 

• Reduce the likelihood of user errors in performing consequence analyses;  

• Enable the user to simply and conveniently account for uncertainties in input data; and  

• Displace the original batch framework with a Windows-based framework. 

The result of this development effort was the WinMACCS code. WinMACCS is currently 
integrated with versions of MACCS, COMIDA2, and LHS (Latin Hypercube Sampling) to perform 
all the required functionality.  The original MACCS2 batch framework is preserved; MACCS can 
still be run in stand-alone fashion apart from the WinMACCS interface.  However, there are 
significant advantages for migrating to the WinMACCS framework for running consequence 
calculations.  

1.4 MACCS Framework 

 Software used to Develop WinMACCS 

Components used to develop the WinMACCS software are described in Chapter 4. 

 WinMACCS Components 

The components of WinMACCS are shown in Figure 1-1.  WinMACCS allows one or more 
calculations to be run on a computer.  The user can modify model input parameters and model 
settings and save them in the project database.  The user can initiate a WinMACCS deterministic 
simulation or a set of simulations to evaluate uncertainty from input parameters represented by 
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probability distributions to reflect degree of belief.  To do the latter, WinMACCS uses a code called 
LHS to generate vectors of sampled input parameters to create a set of equally probable 
realizations.  LHS can use either of two sampling algorithms:  simple random sampling (SRS) or 
LHS, which is a type of stratified sampling.  WinMACCS can also run three other codes: COMIDA2 
to evaluate parameters affecting the food ingestion pathway, PopMod to change the number of 
sectors in a site file, and CombineSource to combine source terms for multiple units and/or spent 
fuel pools.  These codes act as preprocessors for MACCS.  

WinMACCS can run LHS to generate values for the uncertain parameters and to build the MACCS 
input files for each simulation.  It runs MACCS multiple times, once for each realization.  Multiple 
simulations can also be created using the cyclical file option.  In this case, MACCS input can be 
modified using a set of input files that effectively act as change cards.  One application of this 
feature is to run successive MACCS simulations using multiple source terms from MELCOR 
accident progression simulations.  The interface utility, MelMACCS, can be used to create the 
input files containing the source-term data.  This feature is called cyclical because it can be 
combined with sampling of uncertain input data and the input files are cycled if there are more 
simulations than input files.  The user may view, export, and aggregate results of MACCS 
simulations in various formats, such as text, Microsoft Excel, JPEG, BMP, XML, and HTML.  

WinMACCS
COMIDA2

LHS

PopMod

MACCSInput

CombineSourceMACCS

Results

 

Figure 1-1 WinMACCS components 

PopMod can be used with site files generated with versions of SecPop prior to 4.0 to support 
MACCS grids with more than 16 compass sectors.  The work of PopMod is primarily interpolation 
and reformatting.  No new information is added to the site data file that is created. With SecPop 
4.0 or newer, PopMod is not needed because SecPop creates population distributions for grids 
with more than 16 compass sectors.  

Data files managed by WinMACCS include a set of auxiliary files, such as a site file, a 
meteorological file, one or more COMIDA2 binary file(s), and one or more DCF file(s).  Input files 
are created by WinMACCS using the model and input settings stored in an underlying database.  
These input files can include Atmosn.inp, Earlyn.inp, Chroncn.inp, Comidan.inp, and Lhs.inp. 
Here, n is 1 or more and denotes the simulation number.  Multiple simulations are performed 
when evaluating uncertainty and/or using the cyclical file option discussed in this document. 
Output files are created by MACCS and its preprocessors (e.g., LHS and COMIDA2).  A set of 
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MACCS output files, Modeln.out and Modeln.bin, are normally created for each simulation. Other 
files may or may not be created, depending on settings chosen by the user. 

An Access database file is created from a database template file, Initialize2000.mdb, when a new 
project is created.  The project database is modified using the Microsoft DAO 3.6 library.  The 
database contains the following information: 

• Default input values and model settings, 

• Input values and model settings specified by user, 

• Input parameter descriptions and limits, 

• Information to construct input forms,  

• Information to construct input files, 

• LHS results, and 

• MACCS results read from binary files. 

 WinMACCS Project File Structure 

A project folder contains the following files and subfolders: 

• A database file (e.g., myProject\myProject.mxd).  This file is an Access 2010 database 
file.  In addition to its settings, this file contains the parameter values used to build the 
MACCS input files when a simulation is run. 

This folder contains three subfolders as follows:  

• myProject\Data\ contains user specified data files, such as the site file, the 
meteorological file, and the dose conversion factor (DCF) file.  

• myProject\Input\ contains input files created by WinMACCS each time the user requests 
a MACCS simulation. 

• myProject\Output\ contains output files from MACCS and other executables run by 
WinMACCS.  

To move the location of the project, the user can simply move (or drag and drop) the folder 
myProject\, including its files and subdirectories, to a new location.  

 Parameters Tab 

The parameters are organized in a tree structure to facilitate access.  The highest level of the tree 
structure is called a main category, the second level is called a category, the third level is called 
a subcategory, fourth level is called a form and under a form are one or more parameters.  The 
example in Figure 1-2, shows the main categories: GENERAL, ATMOS, EARLY, CHRONC, 
DOSE COEFFICIENTS, and COMIDA2. GENERAL contains categories named Properties, File 
Specifications, and Output Options.  More information under each of the categories can be viewed 
if the + is clicked to display more detail.  The convention used in this document is that italicized 
words are names or labels that appear in the WinMACCS interface.  

Within the ATMOS main category, the Radionuclides category has been completed, as indicated 
by the solid orange diamond next to the category name.  The orange color of the symbol indicates 
that there is at least one form in this category that is optional. 
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Within the ATMOS main category, the Deposition category detail is shown.  The X-ed red octagon 
indicates that there is missing or inconsistent information in this category.  The Wet/Dry Depos 
Flags and Wet Deposition forms have been completed consistently, as indicated by the solid 
green octagons.  The Dry Deposition form needs attention, as indicated by the X-ed red octagon 
next to the form name.  This form contains two variables: NPSGRP and VDEPOS.  If the form 
name or the parameters are double-clicked, the corresponding parameter modification form is 
opened. 

It is important to note that the symbols do not indicate whether input values are correct or 
incorrect; they only indicate whether they are consistent and within acceptable bounds imposed 
by WinMACCS.  The user is responsible for entering and performing adequate quality 
assurance/control to verify that reasonable values of input parameters are entered in the interface.  

 

Figure 1-2 Parameters Tab Under the Project Window 

Each entry in the tree shown in Figure 1-2 has a related icon.  This icon reflects the state of the 
object. The objects and icons are as follows: 

 Input associated with a main category is represented by a lightning bolt icon.  

GENERAL, ATMOS, EARLY, CHRONC, DOSE COEFFICIENTS, and COMIDA2 are the 
main categories.  The GENERAL category contains the links to the model settings 
(e.g., the weather sampling method) and the links to the auxiliary files to be used in a 
simulation.  There are several categories within each module.  These categories contain 
forms that are used to specify input parameters.  An example of a category is Plume 
Specifications. 
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Icons next to category names define the underlying form states as follows: 

 An X-ed red octagon indicates that the user needs to complete or correct this form before 
running MACCS. 

 A solid green octagon indicates that the user has completed this form and that the data 
defined on this form are needed to perform a calculation. 

  A solid orange diamond indicates that the user has completed this optional form.  The 
values defined on all forms with a solid orange diamond are used to perform a calculation.  
A solid orange diamond may appear on categories and subcategories when some forms 
are optional, and others are required. 

  An empty orange diamond indicates that the user has not completed this optional form.  

 A solid X-ed orange diamond indicates that this optional form needs attention before 
running MACCS. This can be done by opening, clearing the form, and clicking OK or by 
correcting it, in which case the values on this form are conveyed to the appropriate 
MACCS input file.  

 A solid gray octagon with a diagonal line indicates that the user has completed this form, 
but the values are not needed under the current model choices. 

 An empty gray octagon with a diagonal line indicates that the user has not completed this 
form, but it is not required and can be ignored. 

 A black circle indicates a parameter that is contained on a form. The parameter names 
are listed to facilitate navigation within WinMACCS and are given the same names as the 
MACCS input variables. Double-clicking on a parameter object causes the related form to 
open with the focus at the selected parameter value. 

Double-clicking on a form or on a parameter name associated with a form causes that form to 
open for review and editing. 

The Properties form found under the GENERAL main category and under the Properties category 
allows the user to modify model choices to be used in a subsequent MACCS calculation(s).  Data 
entry on this form can modify the status of the categories and forms as indicated by the icons 
listed above.  The user should generally start a new project or modify an existing project by making 
appropriate model choices under the Properties form.  This defines the status of the categories 
and forms shown under the Project Parameters tab.  

 Files Tab 

There are three file categories on the Files tab: Data, Input, and Output.  The Data file category 
contains several file-type variables.  Beneath the file-type parameters are links to the files 
currently used or defined in the project.  Each of the file categories corresponds to folders stored 
in the project folder.  

The structure emulates the folder structure displayed when the project is viewed in Windows  
Explorer as shown in Figure 1-3 with differences noted below in the detailed description of each 
of the three file categories. 
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Figure 1-3 Data folder as seen from Windows Explorer 

 Data Files 

This file category called Data contains data files specified by the user under the General/File 
Specifications category on the Parameters tab of the Project window.  Double-clicking on a file 
link opens the selected file in Notepad for editing.  This allows the user to modify the file and save 
it. The modified file is used when MACCS is run.  Files in the Data folder, as shown in Figure 1-3, 
other than those in File Specifications, are not shown in the Data files category.  

 

Figure 1-4 Project data folder 

Not all the files shown in Figure 1-4 are necessarily used when MACCS is run.  Which files are 
used depends on the models that have been selected on the Properties form.  For example, if 
Early Consequences is not selected under the Scope tab on the Properties form, the DCF file is 
not needed for the simulation.  This is indicated by the icon displayed next to DCF File under the 
File Specifications category.  
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The file links displayed in Figure 1-4 can be modified by double-clicking on the form or parameter 
name under the GENERAL/File Specifications category, as shown in Figure 1-5. 

 

Figure 1-5 File specifications 

Model settings that determine which data files are needed for a calculation are controlled with the 
Project Properties form shown in Figure 1-6. 

If a user desires to include map files in order to use the network evacuation model, the map files 
also need to be placed in the Data folder.  Map files stored in the Data folder are not shown in the 
Files tab in the Project form.  These files need to be in Graphics Interchange Format (.gif).  A 
utility to facilitate creating .gif files uses a stand-alone executable called MapGen (see 
Section 4.4.7.3).  MapGen reads an interface file containing information about the spatial grid 
written by WinMACCS and creates a set of map files using Microsoft MapPoint. MapPoint is no 
longer supported by Microsoft and this capability is now largely obsolete, although Sandia retains 
the capability to generate these maps. Some forms use these maps as a background layer to 
facilitate defining evacuation model settings.  These forms are located in each of the 
EARLY/Emergency Cohort categories (e.g., EARLY/Emergency Cohort One).  
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Figure 1-6 Project Properties form 

 Input Files 

This category contains input files as shown in Figure 1-7 that are normally created by WinMACCS 
before running a MACCS simulation.  If the main menu option, Execute→Refresh Template Input 
Files before Running is not checked, the template files atmosTemplate.txt, earlyTemplate.txt, 
chroncTemplate.txt, and comidaTemplate.txt are not recreated from the settings within 
WinMACCS before running a simulation.  This feature allows the user to edit these files and run 
a simulation using the edited files.  This feature was created to allow users to modify the template 
files manually during the implementation of new features not yet supported by WinMACCS.  It is 
unusual to uncheck this menu option, but it could be useful in exceptional situations when the 
WinMACCS template file does not satisfy the user’s needs.  When any project is opened, 
regardless of the previous state of this menu option, this option is checked.  
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Figure 1-7 Input files 

All files in Project\Input\ are shown in the Project window.  Selecting main menu option 
File→Refresh File View causes the hard drive to be queried and refreshes the set of files shown 
in the Project window.  

WARNING: The Input folder is not a good place to store any files that the user wants to 
keep! WinMACCS deletes all files in this folder when it runs MACCS. The 
Data (Project\Data\) and root directories (Project\) are safe places to store 
files because they are never deleted by WinMACCS. The user can also create 
additional directories for archiving files under the Project\ folder. 

The following example reflects a run with a scope of Atmospheric Dispersion, Early 
Consequences, Late Consequences, and COMIDA2.  In this example, some parameters are 
sampled, the template files are created, and two simulations are requested.  
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Table 1-1 Files created in the input folder by WinMACCS during execution. 

Name of file 
Conditions when file 

Is created 
Description 

atmosTemplate.txt Always created when 
MACCS is run. 

File atmosTemplate.txt is used to create input files 
Atmos1.inp and Atmos2.inp. This file is used by 
WinMACCS 

earlyTemplate.txt EARLY module is 
selected under the 
Scope tab in the 
Properties form. 

File earlyTemplate.txt is used to create input files 
Early1.inp and Early2.inp. This file is used by 
WinMACCS. 

chroncTemplate.txt CHRONC module is 
selected under the 
Scope tab in the 
Properties form. 

File chroncTemplate.txt file is used to create input 
files Chronc1.inp and Chronc2.inp. This file is used 
by WinMACCS.  

Atmos1.inp 

Early1.inp 

Chronc1.inp 

Atmos2.inp 

Early2.inp 

Chronc2.inp 

Input files are created 
consistently with the 
model scope. For 
example, when the user 
has only specified 
Atmospheric Dispersion 
and Early 
Consequences on the 
Scope tab in the 
Properties form, 
Atmos1.inp, Atmos2.inp, 
Early1.inp, and 
Early2.inp are created 
using 
atmosTemplate.txt and 
earlyTemplate.txt. 
Chroncn.inp is not 
created. This example is 
for Late Consequences 
selected so that the 
Chronc files are 
created. 

Files are created using the template files in 
conjunction with data from LHS.out relevant to each 
simulation. If any of the parameters are uncertain, 
this information is encoded in the relevant template 
file. The actual values used in simulation n 
correspond to realization n in the LHS.out file. 
These files are used by MACCS.  

LHS.inp Created whenever 
uncertain parameters 
are defined. 

This file contains input to LHS that indicates the 
number of observations, probability distributions, 
parameter names, and correlations between 
sampled parameters. 

Sipra.ini Created whenever 
uncertain parameters 
are defined. 

This file contains LHS settings and is copied from 
Program Files\WinMACCS folder into the 
\Project\Input\ folder. It is read by LHS.  

LHS.out 

LHS.msg 

Created whenever 
uncertain parameters 
are defined. 

These files are created by LHS. LHS.msg is a 
detailed output file describing the run. LHS.out is 
used to create the input files by WinMACCS for 
MACCS. 
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Name of file 
Conditions when file 

Is created 
Description 

comidaTemplate.txt Created when the Late 
Consequences option is 
selected on the Scope 
tab in the Properties 
form and the Create 
COMIDA2 File option is 
selected on the Food 
tab in the Properties 
form. 

This file is like the other template files. It is used 
with LHS.out to create the three sets of input files 
required by COMIDA2, namely Comidan.inp, 
Comidan.par, and Comidan.var, where n is the 
simulation number. 

Comida1.inp 

Comida2.inp 

Created when the Late 
Consequences option is 
selected on the Scope 
tab in the Properties 
form and the Create 
COMIDA2 File option is 
selected on the Food 
tab in the Properties 
form. 

This is a set of one of three input files required by 
COMIDA2. 

Comida1.var 

Comida2.var 

Created when the Late 
Consequences option is 
selected on the Scope 
tab in the Properties 
form and the Create 
COMIDA2 File option is 
selected on the Food 
tab in the Properties 
form. 

This is a set of one of three input files required by 
COMDIA2. The files contain radionuclide data. 

Comida1.par 

Comida2.par 

Created when the Late 
Consequences option is 
selected on the Scope 
tab in the Properties 
form and the Create 
COMIDA2 File option is 
selected on the Food 
tab in the Properties 
form. 

This is a set of one of three input files required by 
COMDIA2. The files contain food-pathway data. 

 

When the Execute→Refresh Template Input Files before Running from the main menu is checked 
(the default setting): 

• All the files in the Project\Input folder are deleted when Run is clicked on the Run form. 

When the Execute→Refresh Template Input Files before Running from the main menu is 
unchecked: 

• All the files in the Project\Input folder are deleted except for the files atmosTemplate.txt, 
earlyTemplate.txt, chroncTemplate.txt, and comidaInpTemplate.txt when Run is clicked 
on the Run form.  
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• The option allows the template files to be manually edited before running MACCS.  
While this option would not normally be selected by a user, it could be helpful if there 
were new features in MACCS that are not yet supported by WinMACCS. 

When the user has checked the box labeled Delete Atmos, Early, Chronc and COMIDA2 Input 
Files on the Advanced Execution Parameters form, the input files that aren’t used as templates 
are deleted when the calculation is finished.  In the example above, this means that Atmos1.inp, 
Atmos2.inp, Early1.inp, Early2.inp, Chronc1.inp, Chronc2.inp, LHS.inp, Comida1.inp, 
Comida2.inp, Comida1.par, Comida2.par, Comida1.var and Comida2.var are deleted.  Normally, 
this box is checked.  The user might uncheck this box when MACCS input files are needed for 
some other process and so need to be retained.  Otherwise, the input parameters are preserved 
for QA purposes in the output file that is generated.  

 Output Files 

This category contains output files created by MACCS and COMIDA2. 

The entries under the file category Output are file names found in the user’s project folder 
Project\Output\ excluding the binary MACCS result files, which end with a .bin extension.  They 
are created when Run is selected. Select main menu option File→Refresh File View to query the 
hard drive and refresh the file list.  

The Output folder is a convenient place to store files because they are listed in the file view of the 
project as shown in Figure 1-8.  

 

Figure 1-8 Output files 

WARNING: Do not name any files in the output folder Modeln.out, Modeln.bin, 
Comidan.cnc, Comidan.dmp, or Comidan.lst. These files are deleted from the 
Ouput folder each time a simulation is run. Likewise, never put any files in 
the Project\Input\ folder. These are all deleted each time a simulation is run. 

Double-clicking on a file causes it to open in Notepad.  The following example shows a simulation 
with a scope including Atmospheric Dispersion, Early Consequences, and Late Consequences. 
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Comida2 is run to create the .bin files used for Late Consequences.  In the example shown in 
Table 1-2, two simulations are requested.  

Table 1-2 Output files created by MACCS and COMIDA2. 

Name of file Description 

Model1.out 

Model2.out  

These are the text output files created by 
MACCS corresponding to each of the LHS 
samples. 

Model1.bin 

Model2.bin 

These are the binary result files created by 
MACCS corresponding to each of the LHS 
samples. These files are not shown on the 
Project\Output\ screen.  

Comida1.lst 

Comida2.lst 

Comida1.cnc 

Comida2.cnc 

Comida1.dmp 

Comida2.dmp 

These are output created by COMIDA2 for each 
of the LHS samples. 

 

When the user has checked the box labeled Delete MACCS and COMIDA2 Output Files on the 
Advanced Execution Parameters form, the text output files are deleted after each simulation.  
Normally, this box is unchecked as shown in Figure 1-9.  The user would have this box checked 
if it was not necessary to directly view the output results.  Results that are written to the binary file 
are still available in the form of plots, summary.out and custom available reporting options.  These 
options may be convenient when there are many simulations and it is important to conserve space 
on the hard drive. 

Similarly, if the user has checked the box labeled Delete MACCS and COMIDA2 Binary Result 
Files the binary result files are deleted after the reports have been created.  See Section 4.5.2 for 
more information.  Normally, this box is unchecked as shown in Figure 1-9.  WinMACCS imports 
the binary results into the project file (the .mxd file) after the simulations are complete.  Having 
this box checked causes these files to be deleted after the data are imported into WinMACCS.  
This option may be useful for conserving space on the hard drive.  
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Figure 1-9 Advanced Execution Parameters 

 Results Window 

The Results window is found at the bottom of the application window.  The Results window 
communicates progress, e.g., during MACCS execution.  

Results text, as shown in Figure 1-10, can be selected and copied to the Windows clipboard by 
using the copy and paste functions available when right clicking the mouse.  Alternatively, the 
user can use the control-C option to copy text from this window.  Error messages may be included 
in the text to describe an execution problem in need of resolution.  For any questions regarding 
error messages, users are encouraged to contact wg-maccs-entity@sandia.gov for user support. 

 

Figure 1-10 Sample results window 

mailto:wg-maccs-entity@sandia.gov
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1.5 Main Menu Options 

Figure 1-11 shows the main menu options shown at the top of the MACCS application. 

 

Figure 1-11 Main menu 

The main menu contains the following drop-down menus: 

• File allows projects to be managed and MACCS files to be imported, along with several 
other functions. 

• Edit manages some screens, enables distributions for uncertain input parameters to be 
correlated, enables editing of some parameters, and allows the user to open all windows 
containing a specified parameter.  

• Execute allows the user to run calculations and to control choices related to those 
calculations.  

• PostProcessing controls the post-processing options, both graphical and tabular. 

• Window manages screens within WinMACCS. 

• Help provides information on the version of WinMACCS that is installed on the user’s 
computer.  

Section 4.2 describes each of these menu items in more detail. 
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2. GETTING STARTED  

2.1 Overview of User Interface 

Instructions for WinMACCS installation are located within the ReadMe file in the installation 
download folder.  These instructions walk the user through running the installation executable and 
obtaining a license key.  For WinMACCS version 3.10, a password is required and may be 
obtained from Sandia National Laboratories.  For versions of WinMACCS after and including 
WinMACCS v4.0, the ReadMe file contains instructions to generate a license key request file to 
be emailed to Sandia National Laboratories.  Upon receiving the license key request file, Sandia 
National Laboratories will reply with a license key file to be linked to the user’s specific computer 
which will allow the use of WinMACCS for one year.  Users may renew this license when needed 
by following the same procedure.   

When a project is opened using the File→Open Project command or a new project is created 
using the File→New Project command, Project and Results screens are also opened, as 
illustrated in Figure 2-1.  The Project window is used to modify parameter values and view related 
project files.  

 

Figure 2-1 Project and results windows 

The caption at the top of the window indicates the name and location of the project.  In the example 
shown in Figure 2-1, the project C:\WinMACCS Projects\SampleProblems\WinMACCS 
Samples\NRC Sample Problems\Sampled Values Linear No Threshold (LNT) is displayed. 

The main menu options are File, Edit, Execute, PostProcessing, Window, and Help. 

The Project window contains two tabs, Parameters and Files.  

• The Parameters tab contains a list of forms that are used to select model options, modify 
input parameters, and create file links.  

• The Files tab contains links to active files in the project folder displayed at the top of the 
window.  
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The Results window displays the progress of a user-initiated action, such as importing a file or 
running a simulation.  

A legend automatically opens with a project, as shown in Figure 2-2.  The legend defines the 
meaning of the icons shown next to the form names and categories in the Parameters tab of the 
Project window. 

 

Figure 2-2 Legend 

The information displayed under the Parameters tab is organized as follows: 

• The top display level is called a main category, which includes GENERAL, ATMOS, 
EARLY, CHRONC, DOSE COEFFIENTS, and COMIDA2.  The icon used for main 
categories looks like a lightning bolt and a main category can contain categories, 
subcategories, and forms, as defined below.  

• The next level of organization below a main category is a category.  For example, 
Radionuclides is a category under ATMOS.  Several types of icons are used to 
represent categories, depending on whether they are required, not required, optional, 
defined, undefined, or have an error state.  The icons corresponding to each possibility 
are displayed in the Legend window shown in Figure 2-2. 

• The next level below a category is a subcategory.  For example, Emergency Cohort Two 
is a subcategory under Additional Emergency Cohorts, which is a category under 
EARLY. 

• The next level of organization below a subcategory is a form.  The icons for forms are 
identical to those for categories and subcategories.  For example, Basic Parameters is a 
form under Additional Emergency Cohorts.  

• Each form contains one or more parameters.  Parameters are denoted by black dots. 

In some cases, forms are directly under categories or even main categories because the 
intermediate levels are not required.  

2.2 Modifying a Parameter Value 

A parameter can be modified by opening the form containing the parameter.  This is illustrated in 
Figure 2-3 for the parameters associated with wet deposition. 
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Figure 2-3 Modifying a parameter on a form 

Parameter values are changed by replacing the value on the form and clicking the OK button. 
The Make Uncertain button allows a probability distribution to be assigned to an uncertain input 
parameter for sampling in an uncertainty analysis (see Section 4.4.1.3).  Clicking OK saves all 
changes and closes the form; Clicking Cancel retains the previous values and closes the form. 
Clicking the pencil eraser button on the top right clears the form of all values and comments.  

The user is not allowed to save values by clicking OK unless all values have been defined and 
are within the bounds specified on the form.  For example, the limits on CWASH1 in Figure 2-3 
are from 0.0 to 1.0, inclusive of the end points.  Resetting a form to the default state is 
accomplished by closing the form, right clicking on the form name, and selecting Reset to Default. 
The default state may or may not be the same as clearing the form. 

2.3 Specifying and Viewing Files 

MACCS may require auxiliary files depending on the selections made in Project Properties.  For 
example, if one of the file-sampling options was selected on the Weather tab of Project Properties, 
the user must provide a meteorological data file. 

Under the GENERAL/File Specifications category, icons displayed next to the names indicate 
which files are required.  Figure 2-4 shows an example in which the Meteorological File and DCF 
File are required.  The DCF file was defined previously, as is indicated by the solid green octagon, 
but the user has not yet defined a meteorological data file, as is indicated by the red, X-ed 
octagon.  The undefined status for this file is addressed by opening this form, clicking the Browse 
button, and selecting the desired file.  The selected file is copied to the project’s data folder, 
ProjectName/Data, where ProjectName is the name of the project.  This copy is used for 
subsequent MACCS calculations. 



 

2-4 

 

Figure 2-4 File specifications 

Selecting a site file works the same way as selecting a meteorological data file.  The Site File 
form contains extra functionality to allow the creation of a more finely gridded site file from an 
existing, more coarsely gridded one.  This function is described in Section 4.4.8.  

The Annual Differential DCF Files, Annual Differential COMIDA2 Files, and Cyclical File Set are 
organized to allow selection of a set of files.  Copies of the files are used for a calculation, and 
these copies are placed in the ProjectName/Data folder. 

Once a file has been selected, it can be viewed and edited via the Files tab.  The Data, Input, and 
Output categories on the File tab correspond to files stored in the project folders named Data\, 
Input\, and Output\.  Any of these files can be viewed and edited in Notepad by double clicking 
on the file name.  The files in the Input\ and Output\ folders are automatically generated when a 
simulation is run.  

2.4 Filling out a Map Form 

Some forms in the interface display a polar grid.  These are used to specify evacuation directions 
when the network evacuation model is enabled and speed multipliers when the speed multiplier 
option is enabled on the Project Properties form, Evac/Rotation tab, or to specify what population 
group is designated to that grid element.  

Detailed instructions are provided in Chapter 4.  The following notes, however, can help the user 
get started with these forms: 

• Evacuation directions are initially set to be radially outward and the speed multiplier is 
set to one.  The evacuation direction in each grid element is shown as an arrow.  The 
speed multiplier is identified by an integer.  
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• Speed multipliers are modified on the forms named Radial Evacuation Speed and 
Network Evacuation Speed, depending on which model is selected on the Properties 
form.  Evacuation directions are modified on the form named Network Evacuation 
Direction.  There is one of these forms for each cohort.  Both speeds and directions are 
shown on all these forms, but only one of them can be changed from that form.  

• Speed multipliers are activated by clicking on the button Modify Multipliers. 

• There are several ways to change evacuation directions on this screen.  The simplest is 
to click on one of the grid elements, which causes the arrow to rotate clockwise to the 
next direction.  Directions can also be changed on the Network Evacuation Direction 
form by selecting multiple radii and/or sectors and applying a direction to the selected 
portion of the map.  The direction is selected by clicking on an entry in the table labeled 
Direction; the multiple radii and sectors are selected from the lists labeled Radius and 
Sector.  Clicking the Assign button applies the direction to the selected area(s).  Multiple 
radii and sectors can be selected by holding down either the shift or the control key for 
contiguous or noncontiguous selections, respectively.  Similar options are available on 
the Radial Evacuation Speed and Network Evacuation Speed forms. 

• The SaveMap button saves a copy of the evacuation map with the grid background as 
either a jpeg or Windows bit map file.  This allows maps to be imported into other 
applications and documents. 

• The sliders labeled Inner Ring Shown and Outer Ring Shown allow the user to zoom in 
and out and to eliminate detail at the center of the map. 

• In WinMACCS versions 3.9.0 and newer, the maps forms can be resized by grabbing 
the corner/edge of the map and dragging it to the desired size.  

2.5 Running a Simulation 

Running a simulation starts by selecting Execute→Run Models from the main menu.  

Clicking the Run Simulation button initiates a simulation.  If there are any input inconsistencies 
detected by WinMACCS, forms open automatically to allow values to be corrected.  However, not 
all input inconsistencies are caught at this stage.  Some input problems are detected when 
MACCS is run.  Errors generated at this step are described in the Results window. 

The simulation progress can be observed in the command-prompt window (Results Window) from 
which MACCS is initiated.  The window is minimized by default but can be opened by the user. 

When the simulation has completed, the command window closes and a message conveying 
successful completion is written to the Results window.  At this point, results can be viewed using 
the following options: 

• Double-clicking on Output/Model1.out found under the Files tab of the Project window to 
open the results file in Notepad. 

• Select Post Processing/Graphical Result/Results Over All Weather Trials to view a 
complimentary cumulative distribution function (CCDF) over weather trials. 
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• When sampling is used (parameters were set to be uncertain and multiple realizations 
were run), the option Post Processing/Create Custom Report can be used to combine 
results. The quantiles reported can be modified on the form GENERAL/Reporting 
Options. 

• If sampling was used, the option Post Processing/Graphical Result/Statistical Summary 
Results can be used to display the distributions of the results. 

2.6 Running MACCS from a command line 

A MACCS run can be generated by using command line parameters.  The following parameters 
can be specified on the MACCS.exe command line in any order. 

-a ATMOS input file and path  

-e EARLY input file and path 

-c CHRONC input file and path 

-m meteorological data file and path 

-s site file and path 

-o output file and path. The prefix portion of the output file name is also used to name the 
binary output file. For example, if the output file is named model1.out, the binary file 
created by MACCS is named model1.bin.  

-i file containing names of MACCS input files. This is the path and name of a file 
containing the ATMOS, EARLY, CHRONC, meteorological, site, and output file names 
and paths. The file must have one file name per line, and they must be listed in the 
order above. If one of these files is not needed for a calculation, the line must contain a 
dummy name or blank field defined by two consecutive double quotes. If any of these 
files have been specified on the command line using the -a, -e, -c, -m, -s, or -o 
parameter, this file is not used for any of the file names. If this -i option is not used and 
the files are not specified on the command line, the file names are expected to be in a 
file named MACCS.tmp located in the same folder as MACCS.exe.  

The following example shows the contents of a sample MACCS.tmp file.  Only the Atmos model 
is to be executed in this example.  The EARLY, CHRONC, and site files are not needed, and file 
names do not need to be specified.  A meteorological data file, Metsur.inp, is to be used.  MACCS 
creates the output files Model1.out and Model1.bin.  

C:\WinMACCSSamp\inb\Input\Atmos1.inp 
"" 
"" 
C:\WinMACCSSamp\inb\Data\Metsur.inp 
"" 
C:\WinMACCSSamp\inb\Output\Model1.out 

-p is a prefix used in naming the status files.  If this isn’t specified, the status files are 
named MaxStat.log and FortErr.log by default.  If it is specified, the names of the two 
status files are prefixed with the string following this flag.  For example, “MACCS.exe -
p MyRun” would create status files MyRunMaxStat.log and MyRunFortErr.log.  These 
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files are placed in the same folder as the output file specified with the -o parameter.  If 
the -i option was used to specify the file names (instead of the -a, -e, -c, -m, -s and -o 
parameters), the status files are placed in the same folder as the output file specified 
using the -i option.  If neither of these options were used, the status files are placed in 
the same folder as the MACCS executable file, MACCS.exe.  

The status file, MaxStat.log, contains a single line with the string ‘OK’ if the MACCS execution 
was successful.  If the execution is not successful, this file contains a line with the string ‘NO’.  If 
MACCS detects an error and exits, the line containing the string ‘NO’ is followed by a MACCS 
generated error message. 

The FORTRAN error file, FortErr.log, is created only when MACCS aborts abnormally.  It contains 
trace-back information and system level error messages.  If this file exists before MACCS crashes, 
the error messages are appended to the end of the file rather than overwriting the previous 
contents. 

When at least one of the command line parameters, -a, -e, -c, -m, -s, or -o, is present, the 
MACCS.tmp file is not used to define the names and paths of the required files.  In this case, all 
the files used by MACCS must be specified on the command line.  

The following example shows a case in which all files are specified on the command line. 

C:\Program Files\WinMACCS> MACCS.exe -a C:\inb\Input\Atmos1.inp -m 
C:\inb\Data\Metsur.inp -o C:\inb\Output\Model1.out 

The following example shows a case in which a file is used to specify the names of MACCS files. 
The file specifying the names is Maccs.tmp. Error files are named inbMaxStat.log and 
inbFortErr.log.  These files are placed in the folder C:\inb\. 

 C:\ Program Files\WinMACCS> MACCS.exe -i C:\inb\Maccs.tmp –p inb 
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3. WINMACCS USER GUIDE  

All WinMACCS model choices and parameters are specified through the Parameters tab on the 
Project window. The main categories are GENERAL, ATMOS, EARLY, CHRONC, DOSE 
COEFFICIENTS, and COMIDA2.  

This chapter is not intended to be a theory manual that describes the theoretical and mathematical 
foundations for the MACCS models; however, some equations are provided for context to help 
define some of the input parameters. 

3.1 GENERAL Main Categories  

The GENERAL main category consists of Properties, File Specifications, and Reporting Options.  

The hierarchical structure in WinMACCS can be expanded or contracted by clicking on the + or – 
next to items on the parameters tab, respectively.  For example, clicking on the + to the right of 
the GENERAL main category reveals three categories that belong to this main category.  Clicking 
on the + to the left of the Properties category expands it, revealing the two forms that it contains. 
Finally, clicking on the + to the left of the Properties form reveals the set of parameters that it 
contains. 

 Properties 

The Properties form is opened by double-clicking on General/Properties/Properties from the 
Parameters tab in the Project window, as illustrated in Figure 3-1.  

 

Figure 3-1 Accessing Properties form 

A window opens that shows the scope of the calculation and related model settings, as shown in 
Figure 3-2.  Depending on the selections made, input parameters may be or may not be required. 
Details describing the available models are included in this chapter of this document. 
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Figure 3-2 Project Properties Form 

The following describes how modifying the scope of the calculation affects the forms that are 
required. 

(1). Creating a new project by selecting File→New from the main menu causes Project 
Properties to open after the new project is created with default settings. Notice that 
Atmospheric Dispersion (corresponding to the ATMOS Main Category in the 
Parameters tab) is always selected and cannot be modified, as indicated by the light 
gray color of this item. Early Consequences (corresponding to the EARLY Main 
Category) and Late Consequences (corresponding to the CHRONC Main Category) 
are not checked by default. 

(2). Clicking on the plus sign next to the ATMOS, EARLY, and CHRONC main categories 
on the Parameters tab causes categories to become visible, as illustrated in Figure 
3-3.  All the categories under EARLY and CHRONC are empty grey circles with a 
single slash.  This means that the parameters on these forms are not defined but are 
not required in order to run a simulation given the model choices on the Properties 
form.  

(3). Clicking the check box next to the Early Consequences label and clicking the button 
labeled Show Required Forms shows that some categories in the EARLY main 
category now require attention.  These categories have icons consisting of an X-ed red 
octagon.  If the OK button is clicked in Properties, the scope of the calculation changes 
to include early consequences. 
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(4). Repeating the process by adding Late Consequences to the scope causes an 
additional group of categories to require attention. 

(5). Each of the selected main categories (ATMOS, EARLY, CHRONC) contains a form 
called Property Form Parameters.  Opening these by double-clicking on the word 
Property Form Parameters under each of the main categories allows a user to see the 
parameter values that are defined on the Project Properties form.  Note that forms 
titled Property Form Parameters cannot be updated while open.  The user must close 
and re-open them after changing parameters on the Properties form.  

 

Figure 3-3 Form icons 
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Figure 3-4 shows the form for EARLY.  The values on these forms correspond to model settings 
in Project Properties.  These values can be modified by changing settings in Project Properties 
(under the GENERAL main category) but cannot be changed from the Property Form Parameters 
form, as indicated by the light gray backgrounds.  

The settings on the other Project Properties tabs function in a similar way.  

When the Show Required Forms is clicked on the Project Properties form, WinMACCS modifies 
the icons next to each category to indicate the ones that would be required if the change is made 
by clicking OK.  

 

Figure 3-4 Read-only parameters on Property form under the EARLY main category 

Scope Tab 

MACCS uses parameters ENDAT1 and ENDAT2 to determine whether the simulation should run 
ATMOS; ATMOS and EARLY; or ATMOS, EARLY, and CHRONC.  The Scope tab in Figure 3-5 
determines the value of these variables. ENDAT1 is set to False if the EARLY model is to be run. 
ENDAT2 is set to False if the CHRONC model is to be run.  The option to invoke the MACCS 
Cyclical File Set does not correspond to any MACCS parameters; this option is handled within 
the WinMACCS interface. 
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Figure 3-5 Scope Tab on the Project Properties Form 

The Atmospheric Dispersion (ATMOS) box is always checked.  

Checking the Early Consequences Module (EARLY) box means: 

• A DCF file needs to be assigned under the File Specifications category on the 
Parameters tab of the Project window.  

• Entries on other tabs, namely Site Data, Dose, Evac/Rotation, Wind Rose, and Early 
Effects, determine which other EARLY input parameters are required. 

Checking the Late Consequences module (CHRONC) means: 

• Early Consequences are automatically checked. The CHRONC module cannot be run 
without the EARLY module. 

• Entries on the Food tab determine which additional CHRONC input parameters are 
required. 

Checking the MACCS Cyclical File Set means: 

• A cyclical file set needs to be assigned under the File Specifications category on the 
Parameters tab of the Project window.  The function of this model choice is described in 
Section 4.4.6.  
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• OK saves changes made under any tab and closes the form.  Show Required Forms 
shows how changes affect the form states on the Parameters tab window and the tab 
states in Project Properties without saving the changes.  

• Cancel closes the form without saving any changes. 

Dispersion Tab 

The contents of the Dispersion tab are shown in Figure 3-6.  The user must either select power 
law functions or lookup tables to define the dispersion parameters.  

Selecting the Power Law Functions means: 

• Power law function parameters are required.  They must be defined in the Dispersion 
Function form found in the ATMOS/Dispersion category in the Parameters tab.  

• WinMACCS sets NUM_DIST to be zero when building input images for MACCS. 

Selecting Lookup Tables means: 

• Lookup table parameters are required.  These must be defined in the Dispersion Table 
form found in the ATMOS/Dispersion category in the Parameters tab.  

• WinMACCS sets NUM_DIST to be the value defined on the Dispersion Table form when 
building input images for MACCS. 

 

Figure 3-6 Dispersion tab on the Project Properties form 
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Switch to Time-Based Dispersion Model at User-Specified Distance: 

• If checked, WinMACCS sets the parameter DISPMD to the value LRTIME.  Parameters 
on the Long-Range Time-Based Parameters form found in the ATMOS/Dispersion 
category in the Parameters tab are required.  Dispersion parameters are functions of 
time rather than distance beyond a user-specified distance. 

• If not checked, DISPMD is set to the value LRDIST.  The value LRDIST causes MACCS 
to use the original model in which dispersion parameters are functions of distance. 

There are three choices for plume meander model.  MACCS uses a variable, MNDMOD, to 
determine which plume meander model to use.  The corresponding value of MNDMOD is shown 
parenthetically on the right of each entry on the Properties form. 

Selecting Original MACCS means: 

• The plume meander model is the original one in MACCS Version 1.12.  This model 
accounts for the effect of the duration of release. 

• The ATMOS/Plume Specifications/Original Meander form is required. 

Selecting U.S. NRC Regulatory Guide 1.145 means: 

• The Regulatory Guide 1.145 plume meander model is used.  This model assumes one-
hour duration plume segments.  It accounts for the effects of stability class and wind 
speed on plume meander.  It should not be used when plume segment durations are 
substantially different than one hour, especially when they are less than one hour, 
because this violates the assumptions of the model.  

• Parameters on the form ATMOS/Plume Specifications/US NRC Reg. Guide 1.145 
Meander are required.  

Selecting None means:  

• There are no required parameters.  

• The plume meander model is turned off.  
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Weather Tab 

The contents of the Weather tab are shown in Figure 3-7. 

 

Figure 3-7 Weather tab on the Project Properties form 

MACCS uses a variable, METCOD, to specify which weather sampling option to use.  The 
corresponding value of METCOD is shown on the right of each entry.  

Constant Weather means that a single weather trial is evaluated and that inputs on the following 
ATMOS/Weather category forms on the Parameters tab are required: 

• Constant or Boundary Conditions  

• Fixed Start Time Data 

User Supplies 120 Weather Points means that a single weather trial is evaluated and that the 
following inputs found on the ATMOS/Weather category on the Parameters tab are required: 

• Constant or Boundary Conditions 

• Fixed Start Time Data 

• User-Supplied Weather 

• Boundary Limit  

The fixed start time is required for these options to determine the time of year the accident occurs, 
which is needed for food ingestion modeling.  These inputs are required even if food ingestion is 
not being treated but they can be set to dummy values. 
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The other weather options require specifying a meteorological data file.  The meteorological data 
file allows 15-minute, 30-minute, and one-hour intervals.  Only the traditional hourly weather data 
are supported with the User Supplies 120 Weather Points (METCOD=3) option described above. 

When Weather File Specified is selected, a meteorological data file is required and needs to be 
assigned under the File Specifications category.  The input data requirements for the weather 
options are described in the subsequent paragraphs. 

Fixed Start Time means that the following ATMOS/Weather category forms under the Parameters 
tab inputs are required: 

• Constant or Boundary Conditions 

• Fixed Start Time Data 

• Boundary Limit 

Uniform Bin Sampling means the following ATMOS/Weather category forms under the 
Parameters tab are required: 

• Constant or Boundary Conditions 

• Samples per Bin 

• Seed 

• Boundary Limit 

• Rain Distances 

• Rain Intensities 

Nonuniform Bin Sampling means the following ATMOS/Weather category forms under the 
Parameters tab are required: 

• Constant or Boundary Conditions 

• Seed 

• Boundary Limit 

• Bins 

• Rain Distances 

• Rain Intensities 

Stratified Random Sampling means the following ATMOS/Weather category forms under the 
Parameters tab are required: 

• Constant or Boundary Conditions 

• Samples per Day 

• Seed 

• Boundary Limit 

When the Weather File Specified is selected, an optional, mixing-height model can be chosen. 
MACCS uses a variable, MAXHGT, to determine which mixing height model to use. 

Adjust Mixing Height Based on Time of Day means: 

• WinMACCS sets the parameter MAXHGT to the value DAY_AND_NIGHT.  
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• Parameters in Site Location found on the ATMOS/Weather category are required.  

• Both daytime and nighttime values of the mixing heights in the meteorological data file 
are used.  

• When not checked, MAXHGT is set to the value DAY_ONLY. This causes MACCS to 
use the model in MACCS Version 1.12, which uses only the maximum seasonal values 
that normally correspond to daytime values. 

Plume/Source Tab 

The contents of the Plume/Source tab are shown in Figure 3-8. 

 

Figure 3-8 Plume/Source Tab on the Project Properties form 

Choosing Power Model means:  

• The original MACCS model is used.  

• Values for rate of release of sensible heat for each plume segment must be specified in 
ATMOS/Release Description/Heat. 

Choosing Density and Flow Model means:  

• Mass flow rate and mass density are required for each plume segment. These are 
defined in ATMOS/Release Description/Density and Flow. 

Choosing Original MACCS 1.12 Briggs Model means: 
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• WinMACCS sets the parameter BRGSMD to the value ORIGINAL.  The original Briggs 
model is used to simulate plume rise.  The default and recommended model is the 
improved one (see Bixler et al., 2020, for more information).  

• When not checked, BRGSMD is set to the value IMPROVED.  This causes MACCS to 
use the improved plume rise model. 

Choosing Multi Source Term means: 

• MACCS allows the user to use multiple source term definitions, possibly created from 
different MELCOR plot files, to define the overall source term for an accident.  

• The user specifies these files under File Specifications and needs to fill out additional 
forms in the ATMOS main category.  

Site Data Tab 

The contents of the Site Data tab are shown in Figure 3-9.  This tab is required when Early 
Consequences are selected on the Scope tab.  MACCS uses a variable, POPFLG, to define the 
source of the site data.  

 

Figure 3-9 Site Data tab on the Project Properties form 

Choosing Import from File means:  

• WinMACCS sets the parameter POPFLG to the value FILE. 

• A site file is required and needs to be chosen under the File Specifications category 
under the Parameters tab.  This file can be created by a preprocessor (e.g., SecPop, to 
generate a file containing census and economic data for the chosen site).  A sample site 
file, FicticiousSite.inp, is included in the WinMACCS installation.  WinMACCS allows the 
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user to increase the number of compass sectors in a site file, and this feature has been 
integrated into the site file specification form.  

• The SUMPOP option is available under Results Weighting Factor. 

• Results Weighting Factor determines the way multiple-cohort results are combined. 
Except when SUMPOP is selected, the weighting factor used for each of the cohorts is 
assigned by the parameter WTFRAC found under the EARLY/Emergency Cohort 
n/Basic Parameters forms, where n is the cohort number. 

• When SUMPOP is selected, the site file must include a separate population distribution 
for each evacuation scenario.  This option enables cohorts to be defined in a very 
general fashion.  

• If TIME is selected, the weighting factor under each Basic Parameters form refers to 
fraction of time.  

• If PEOPLE is selected, the weighting factor under each Basic Parameters form refers to 
fraction of people.  

Choosing Uniform means:  

• MACCS sets the parameter POPFLG to the value UNIFORM. 

• Population density data are required and are specified in the Population Data form found 
under the EARLY/Model Basis category.  

• The SUMPOP option is unavailable under Results Weighting Factor. 

MACCS uses a variable, WTNAME, to determine the cohort weighting method.  This is set to 
SUMPOP, TIME, or PEOPLE, depending on the choice on this form. 

When Import from File is chosen and the Results Weighting Factor is set to be equal to SUMPOP, 
the user must specify the source of the site file by choosing one of two options as follows: 

Choosing Predefined Site File means: 

• The user is required to link an existing site file to the project using the Site File form in 
the GENERAL/File Specifications category on the Parameters tab.  This site file should 
have a POPULATIONn section defined for each evacuation cohort or MACCS will fail.  
The n in POPULATIONn is a number corresponding to the cohort number. 

Choosing Create from Existing Site File means: 

• The user is required to link an existing site file to the project using the Site File form in 
the GENERAL/File Specifications category on the Parameters tab.  The number of 
POPULATION sections in this file is not relevant.  In other words, a site file previously 
created with or without the SUMPOP option is acceptable.  Most commonly, the site file 
is created using SecPop. 

• Additional forms in the EARLY category Population by Cohort are required.  
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After a site file is linked, the total population can be viewed on the Population from Site File form 
found in the EARLY/Model Basis category within the Parameters tab. 

Dose Tab 

Choices under the Dose tab must be made when the Early Consequences option is selected 
under the Scope tab.  The contents of the Dose tab are shown in Figure 3-10. 

MACCS supports Federal Guidance Report (FGR-11 and -12) dose coefficient files created by a 
preprocessor program, FGRDCF, files created from Federal Guidance Report 13, and files 
created by DOSFAC2.  DOSFAC2 bases its DCFs on DOE/EH-0070 (1988).  Changing the type 
of DCF file has the effect of changing the allowed organ types on several forms and the user is 
required to modify these forms to be consistent with the select type of dose coefficient file.  The 
sets of organs allowed with each dose coefficient file is hardwired in WinMACCS/MACCS version 
3.10.  However a feature was added in MACCS version 3.11.2 which enables the user more 
flexibility in assigning organs.  

 

Figure 3-10 Dose tab on the Project Properties form 

Choosing Federal Guidance Report (FGR-11 and -12) Dose Conversion Factor File (FGRDCF) 
means: 

• Early injury and early fatality results are not available. These selections, Early Fatality 
Effects and Early Injury Effects, are grayed out on the Early Effects tab of the Project 
Properties form. 

• Data on the related forms, Early Fatality Parameters and Early Injury Parameters, are 
not used. 
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• Outputs requested on the Early Fatality Radius form in the Early/Output Control category 
are not available. 

• The Annual Threshold and Piecewise Linear dose-response models are not available on 
the Dose tab.  Only the LNT dose-response model is available. 

Choosing File Created by DOSFAC2 means: 

• When the Late Consequences option is selected on the Scope tab, the Annual 
Threshold and Piecewise Linear dose-response models are available. 

• The form Organs of Risk DOSFAC2 is required.  

Choosing File Created from FGR-13 means: 

• When the Late Consequences option is selected on the Scope tab, the Annual 
Threshold and Piecewise Linear dose-response models are available. 

• The form Organs of Risk FGR-13 is required.  

The user has three dose-response models to choose from. MACCS uses a variable, DOSMOD, 
to specify which dose-response model is to be used. 

Choosing LNT means:  

• The linear no-threshold dose-response model (the only option in early versions of 
MACCS) is used to calculate latent health effects. (MACCS continues to support a 
linear-quadratic dose response model under this option, although it has fallen into 
disuse.)  

• DOSMOD is set to LNT 

• MACCS Food Model on the Food tab is available. 

Choosing Annual Threshold means: 

• The EARLY/Dose Model/Annual Threshold form is required. 

• The EARLY/Dose Model/Lifetime Threshold form is optional. 

• DOSMOD is set to Annual Threshold. 

Choosing Piecewise Linear means: 

• The EARLY/Dose Model/Piecewise Linear (PL) form is required.  

• DOSMOD is set to PL. 

Choosing either Annual Threshold or Piecewise Linear means: 

• When the Activate KI Model box is checked, the EARLY/Emergency Cohort n/KI 
Ingestion Threshold or Piecewise form must be filled out instead of the 
EARLY/Emergency Cohort n/KI Ingestion LNT form.  

• Only the values 0 or 1 are valid for POPFRAC on the KI Ingestion form.  



 

3-15 

• On the Food tab the options User supplies COMIDA2 file or No Food Model must be 
chosen. 

• Files must be specified under the GENERAL/File Specifications/Annual Differential DCF 
Files and, when the COMIDA2 Food Model under the Food tab is selected, files must be 
specified under the GENERAL/File Specifications/Annual Differential COMIDA2 Files 
form.  

MACCS uses a parameter named KIMODL to determine whether the KI model is to be used. 
When the check box Activate KI Model is checked, this parameter is set to KI.  Otherwise, this 
parameter is set to NOKI. 

Choosing Predefined DCF File means: 

• The user is required to link an existing DCF file to the project using the DCF File in the 
GENERAL/File Specifications category on the Parameters tab. 

• If the user has chosen Predefined COMIDA2 File on the Food tab, the COMIDA2 file 
chosen must have been created using the same DCF file that is specified.  

Choosing Create DCF File means: 

• The user is required to link an existing DCF file to the project using the DCF File in the 
GENERAL/File Specifications category on the Parameters tab.  This file is used to 
extract the list of available radionuclides.  The default DCF values are the values defined 
in this file but can be modified by the user.  

• The COMIDA2 Food Model is unavailable, even though it appears to be enabled in the 
WinMACCS interface.  The reason is that MACCS requires each COMIDA2 file to be 
consistent with the DCF file and WinMACCS does not have the capability to create a 
new COMIDA2 file when the DCF file is modified.  

• After the DCF file is linked to the project, the user can select radionuclides and define 
both deterministic and uncertain DCF values using forms in the category DOSE 
COEFFICIENTS within the Parameters tab.  

Evac/Rotation Tab 

Choices under this tab are required when the Early Consequences module is selected.  The 
Evac/Rotation tab is broken up into three main areas: problem model, number of cohorts, and 
model activation, as shown in Figure 3-11.  First, the user must choose the type of evacuation to 
use.  The choices are Radial, Network, and None.  Choosing Radial causes evacuees to move 
radially outward from each grid element to the next.  Network evacuation models evacuation from 
a grid element to any of the four adjacent grid elements.  Finally, None specifies that no 
evacuation occurs.  Selecting None means all cohorts are nonevacuating.  

The next action is to specify whether the Speed Multiplier Model and/or Keyhole Evacuation 
Model is active.  Finally, the user specifies the number of cohorts represented in the problem. 
WinMACCS supports up to 20 cohorts.  All scenarios correspond to EARLY change sets in the 
MACCS input files. MACCS uses a variable, EVATYP, to determine the evacuation model for 
each cohort.  The choices for the evacuation model are automatically designated based on the 
selected option, Radial, Network or None in the Problem Model box.  The selected choice restricts 
the options for all cohorts that are defined.  
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Figure 3-11 Evac/Rotation Tab on the Project Properties form  

Choosing None under Problem Model means: 

• The only option for the evacuation type field for all evacuation cohorts is None. 

• The Activate Speed Multiplier Model check box cannot be activated on this form. 

• The Activate Keyhole Evacuation Model check box cannot be activated on this form. 

Choosing Radial means:  

• The options for the evacuation Type field for all evacuation cohorts are None and 
Circular. Keyhole is also available when the Activate Keyhole Evacuation Model check 
box is checked. 

• The options for the evacuation type for all evacuation cohorts must be entered.  The first 
Cohort must be assigned the type Circular or Keyhole to allow Circular or Keyhole to be 
assigned for subsequent cohorts.  

Choosing Network means:  

• The options for the evacuation Type field for all evacuation cohorts are None and 
Circular. Keyhole is also available when the Activate Keyhole Evacuation Model check 
box is checked. 

• The options for the evacuation type for all evacuation cohorts must be entered.  The first 
Cohort must be assigned the type Circular or Keyhole to allow Circular or Keyhole to be 
assigned for subsequent cohorts. 

• The field Wind Shift and Rotation must be set to Wind Shift without Rotation. 
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Choosing Activate Speed Multiplier Model Means:  

• When the Network evacuation option has been selected, the evacuation speed can be 
adjusted by grid element on the Network Evacuation Speed form.  

• When the Radial evacuation option has been selected, the evacuation speed can be 
adjusted by grid element on the Radial Evacuation Speed form. 

• Wind Shift Without Rotation must be selected. 

Choosing Activate Keyhole Evacuation Model Means:  

• Keyhole evacuation methods become available for all cohorts. 

• Wind Shift Without Rotation must be selected. 

The user must choose the method for plume segment modeling. MACCS uses a variable, 
IPLUME, to specify the option that is used.  The corresponding value of IPLUME is shown to the 
right of the drop-down box, as shown in Figure 3-11.  

Choosing No Wind Shift with Rotation means:  

• All subsequent plume segments travel in the same direction as the initial plume 
segment. 

• When weather bin sampling is selected, a set of results is constructed for each weather 
trial by considering that the wind might have blown toward each compass direction.  This 
is equivalent to rotating the results for the weather trial around the compass, one 
compass sector at a time.  This process creates an expanded set of results for each 
weather trial with little additional CPU time.  The total number of results generated by 
this process is the number of compass sectors times the number of weather trials.  
Probabilities for each of the rotated results are calculated by using the wind rose for the 
corresponding weather bin or using a user-defined wind rose, depending on the wind 
rose option selected by the user (see below).  The wind-rose probability is assigned 
based on the direction taken by the first plume segment.  This method may not create 
realistic results when more than one plume segment is modeled.  

Choosing Wind Shift with Rotation means:  

• Each plume segment moves in the direction that the wind is blowing at the time of its 
release.  Thus, each plume segment can travel in its own direction. 

• When weather bin sampling is selected, each weather pattern is rotated around the 
compass, creating a set of results equal to the number of compass sectors times the 
number of weather trials.  The probability of each result is calculated using the wind rose 
for the weather bin or the user defined values for the wind rose, depending on the wind 
rose option selected by the user (see below).  The wind-rose probability is assigned 
based on the direction taken by the first plume segment.  

Wind Shift with Rotation assumes that specific weather patterns (i.e., time dependence 
of wind directions relative to the initial wind direction) are independent of the initial 
direction and that the likelihood only depends on the wind rose probability of the initial 
wind direction.  For example, the conditional probability of the second plume segment 
traveling southeast given that the first segment traveled east is the same as same as the 
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conditional probability of the second plume segment traveling northwest given that the 
first segment traveled west.  This option has been used in past analyses, such as 
NUREG-1150, where only a few plume segments were used to represent the source 
term.  More recent analyses commonly use more than a few plume segments to 
represent the source term.  The more plume segments that are used in an analysis, the 
less likely this assumption is to be valid.  As a result, this option should be avoided when 
more than a few plume segments are modeled.  

Choosing Wind Shift without Rotation means:  

• Each plume segment moves in the direction that the wind is blowing at the time of its 
release.  Thus, each plume segment can travel in its own direction. 

• Only the set of wind directions indicated in the meteorological file is used; no wind 
rotation is performed.  Thus, only a single result is generated per weather trial.  

Wind Shift without Rotation produces the most realistic results and is recommended for most 
analyses when more than a single plume segment is used. The drawback is that more weather 
trials may be required to achieve adequate weather statistics than are required using Wind Shift 
with Rotation. The user can evaluate the accuracy of weather statistics by comparing results for 
weather sampling options against the case of performing the maximum number of weather trials 
(e.g., 8760 weather trials when data are averaged over hourly periods) and using the Wind Shift 
without Rotation option.  

When more than one cohort is specified, the user must enter the evacuation Type for each cohort 
by filling in the grid, as illustrated in Figure 3-12. 

 

Figure 3-12 Specifying cohort evacuation types 

Choosing a Circular evacuation type means people will evacuate from an entire circular region, 
regardless of the wind direction(s). 

Choosing a Keyhole evacuation means people evacuate if they are downwind of the source, 
accounting for wind changes and possibly weather forecasting.  In addition, people near the 
source evacuate regardless of direction. 

Wind Rose Tab 

The Wind Rose tab shown in Figure 3-13 is required when the Early Consequences module is 
selected.  
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Figure 3-13 Wind Rose tab on the Project Properties form 

The corresponding value of the MACCS parameter OVRRID is shown to the right of each entry.   

Choosing User Supplied means:  

• Wind rose probabilities are required. These are defined on the Wind Rose Probabilities 
form found on the EARLY/Model Basis on the Parameters tab.  

• User defined wind rose probabilities are used in place of values taken from the weather 
file when one of the Wind Rotation options and one of the weather binning options are 
selected.  

Choosing Default means:  

• Wind rose probabilities for each weather sampling bin constructed from the 
meteorological data file are used if one of the bin sampling options is selected.  

• Wind rose data are only used by MACCS when one of the Wind Rotation options and 
one of the weather binning options are selected.  

User Supplied wind rose values are used for all weather bins; whereas, the Default option 
constructs wind roses separately for each weather bin.  As a result, the User Supplied option 
sacrifices some accuracy and is therefore only recommended when a weather file is only available 
for a nearby site, but wind rose data are available for the site to be analyzed.  
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Early Effects Tab 

This Early Effects tab shown in Figure 3-14 is required when the Early Consequences module is 
selected.  This form allows the user to select the health effects to be calculated.  If an FGRDCF 
DCF file is specified, early fatality and injury results are not available.  

 

Figure 3-14 Early effects on the Project Properties form 

Checking the box next to Early Fatality Effects means:  

• At least one set of early fatality parameters must be defined on the Early Fatality 
Parameters form.  

• The fatalities defined can be included in the output requests on the Health-Effect Cases 
form (type 1), Early Fatality Radius form (type 2), Average Individual Risk form (type 4), 
Centerline Risk form (type 7), and Population-Weighted Risk form (type 8). Early fatality 
results are unavailable when this box is not checked.  

• The user must choose a dose coefficient file type that supports early health effects.  

Checking the box next to Early Injury Effects means:  

• At least one set of early injury parameters must be defined on the Early Injury 
Parameters form.  



 

3-21 

• The injuries defined can be included in the output requests on the Health-Effect Cases 
form (type 1), Average Individual Risk form (type 4), Centerline Risk form (type 7), and 
Population-Weighted Risk form (type 8). Early injury results are unavailable when this 
box is not checked. 

• The user must choose a DCF file type that supports early health effects.  

Checking the box next to Latent Cancer Effects from Early Exposure means:  

• Latent cancer parameters must be defined on the forms found under the Latent Cancer 
Parameters category, namely those on the Latent Cancer Parameters and Latent 
Cancer Thresholds forms. 

• The latent cancer results can be included in the output requests on the Health-Effect 
Cases form (type 1), Average Individual Risk form (type 4), Centerline Risk form (type 7) 
and Population-Weighted Risk form (type 8). Latent cancer results are unavailable when 
this box is not checked. 

Food Tab 

The Food tab shown in Figure 3-15 is required when Long-Term Consequences was selected on 
the Scope tab.  

 

Figure 3-15 Food tab on the Project Properties form 

MACCS uses a variable, FDPATH, to determine which food model to use.  
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Choosing the radio button next to No Food Model means:  

• FDPATH is set to OFF. 

• No food-chain doses are calculated. 

• Economic consequences are disabled.  

Choosing the radio button next to MACCS Food Model means:  

• The original MACCS food-chain model is used.  

• FDPATH is set to OLD. 

• MACCS uses parameter NTTRM to indicate the number of crop weathering terms used 
when the MACCS food model is used.  The value of NTTRM is chosen on this tab. 

• A set of forms under CHRONC/Food-Chain are required.  

This option is not available when the Annual Threshold or Piecewise Linear dose response 
models are chosen on the Dose tab 

Choosing the radio button next to Predefined COMIDA2 File means:  

• The COMIDA2 food chain model is used.  

• The Annual Threshold and Piecewise Linear dose-response models are available on the 
Dose tab.  When either of these models is chosen, a set of binary files created by the 
preprocessor, COMIDA2, and the corresponding DCF files used to create those binary 
COMIDA2 files must be linked to the project. 

• When the LNT dose-response model is chosen on the Dose tab, a single COMIDA2 
binary file must be linked to the project.  The DCF file must be the same one used to 
create the COMIDA2 binary file. 

• FDPATH is set to NEW. 

Create COMIDA2 File: 

• The Annual Threshold and Piecewise Linear dose-response models are not available, 
even though they appear to be available in the WinMACCS interface.  

• One or more COMIDA2 binary files are created when a simulation is run, depending on 
whether there are uncertain parameters defined in the COMIDA2 inputs.  

• Values must be specified on the forms under the COMIDA2 main category on the 
Parameters tab.  

 Problem Description Form 

WinMACCS provides several options for documenting a project by adding comments and other 
description fields.  One of the options is to enter a general project description on the 
General/Properties/Problem Description form. 

Comments entered anywhere within WinMACCS are echoed in the MACCS input files.  MACCS 
echoes the comments in the input files to the output file, so comments are traceable throughout 
the calculation process. 



 

3-23 

 File Specifications Category 

Model settings that determine the types of files required are chosen on the Project Properties 
form.  The set of files are shown as required under the File Specifications category.  In the 
example shown in Figure 3-16, the meteorological, site, dose coefficient, and COMIDA2 files are 
required, as indicated by the icons to the left of the forms.  When the required files have not been 
correctly specified, the icons appear as red octagons with an X over them.  

 

Figure 3-16 Specifying files 

Table 3-2 describes the types of files that may be required, the conditions under which they are 
required, the tab within the Properties form that controls the requirement, and some sample files 
that are included with WinMACCS to illustrate the contents and format of the file.  The interface 
uses icons just to the left of the form names to indicate which auxiliary files are required, 
depending on the project properties settings selected by the user. 

Meteorological File Form 

A meteorological data file is required when the user selects Weather File Specified on the Weather 
tab.  WinMACCS allows the user to select any file, but a file should be selected that conforms to 
the format described in Chapter 7.  The range of allowable wind directions in the meteorological 
file is determined by the value of the MACCS parameter NUMCOR, which is the number of 
compass sectors in the spatial grid.  

Table 3-1 Meteorological File Form 

Parameter 
Name 

Definable Type Dimensions Allowed Values 

Meteorological File Yes Text File None Any file. File is not validated by 
WinMACCS, but it should conform with 
the format described in Chapter 7. 
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Site File Form 

A site file is required when the user selects EARLY CONSEQUENCES on the Scope tab and 
selects the Import from File on the Site Data tab. NUMCOR is the number of compass sectors in 
the spatial grid.  Site files created by older versions of SecPop or used in earlier versions of 
MACCS have 16 sectors in the spatial grid.  Changing the value of NUMCOR in an older site file 
is accomplished by clicking the button labeled Create from Existing Site File.  The user can browse 
to an existing site file and create a new site file with a modified value of NUMCOR.  This operation 
does not add any resolution; it merely interpolates the original data onto a finer grid.  The latest 
version of SecPop supports up to 64 sectors and should be used to create site files with more 
than 16 compass sectors whenever possible.  

Table 3-2 Auxiliary files used by WinMACCS. 

Name of form 
Related Project 

Properties 
tab(s)  

Conditions when form(s) is 
(are) required 

Files from sample 
problems 

Meteorological 
File 

Weather Radio button next to Weather File 
Specified is selected.  

westernsite_04.inp 
metsurMxHt_60min.inp 

Site File Scope and Site 
Data 

EARLY Consequences is selected 
on Scope tab. Import from File is 
selected on Dose tab. 

FicticiousSite.inp 

Dose 
Conversion 
Factor File 

Scope and Dose EARLY Consequences is selected 
on Scope tab.  

LNT is selected on the Dose tab. 

DosData20Organs.inp 
DOSD825.inp 
Fgr13dcf.inp  

Pu72.inp 

Annual 
Differential DCF 
Files 

Scope, Dose, and 
Food 

Late Consequences is selected on 
Scope tab.  

Annual Threshold or Piecewise 
Linear dose-response model is 
selected on Dose tab. 

Predefined DCF File is selected on 
Dose tab. 

Either the No Food Model or the 
Predefined COMIDA2 File is 
selected on the Food tab. 

dosdata20organs.inp 

dosdata20organs01.inp 

… 

dosdata20organs50.inp 

Fgr13dcf.inp 

Fgr13dcf01.inp 

… 

Fgr13dcf50.inp 

COMIDA2 File Scope and Food Late Consequences is selected on 
Scope tab.  

LNT is selected on the Dose tab. 

Predefined COMIDA2 File is 
selected on the Food tab.  

samp_a20organs.inp 

samp_d.bin 

Fgr13samp_a.bin 

Annual 
Differential 
COMIDA2 Files  

Scope, Dose, and 
Food 

Late Consequences is selected on 
Scope tab.  

Annual Threshold or Piecewise 
Linear dose-response model is 
selected on Dose tab. 

Predefined DCF File is selected on 
Dose tab. 

Predefined COMIDA2 File is 
selected on the Food tab. 

samp_a20organs.inp 

samp_a20organs01.inp 

… 

samp_a20organs50.inp 

fgr13samp_a.bin 

fgr13samp_a01.bin 

… 

fgr13samp_a50.bin 
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Name of form 
Related Project 

Properties 
tab(s)  

Conditions when form(s) is 
(are) required 

Files from sample 
problems 

Cyclical File Set Scope MACCS Cyclical File Set is selected.  Case 2, 1MW.txt 

Case 3, 5MW.txt 

Case 4, 10MW.txt 

Case 5, 1MW, 
Entr.+Wake.txt 

Case 6, 5MW, 
Entr.+Wake.txt 

Case 7, 10MW, 
Entr.+Wake.txt 

Multi Source 
Term File Set 

Plume/Source Multi Source Term option is selected.  

 

The site file is a text file containing site specific information.  This file is commonly created using 
SecPop but may be created by a different process as long as it has the required format.  See 
Section 4.4.8 for more information. 

Table 3-3 Site File Form 

Parameter Name Definable Type Dimensions Allowed Values 

NUMCOR Yes 

Click Create from Existing 
Site File to change value 

Integer None 16, 32, 48, and 64 

Site File Yes Text File None Site data is partially 
validated by WinMACCS. 

 

Dose Coefficient or Dose Conversion Factor File Form 

The newer term used by International Commission on Radiation Protection (ICRP) is dose 
coefficient, but the older term, DCF, is generally used in WinMACCS.  A single DCF file is required 
when the user selects Early Consequences on the Scope tab and selects LNT on the Dose tab. 
A DCF File is an ASCII file containing a set of DCFs.  Three types of DCF files are provided with 
MACCS.  The most recent of these is based on FGR-13. 

Table 3-4 Dose Coefficient File Form 

Parameter Name Definable Type Dimensions Allowed Values 

DCF File Yes Text File None Files are provided. WinMACCS 
does not validate the files, but 
the format required by MACCS is 
specified in Chapter 6. 

 

Annual Differential DCF Files Form 

A set of DCF files are required when the user selects Late Consequences on the Scope tab and 
selects Annual Threshold or Piecewise Linear on the Dose tab. Annual Differential DCF Files are 
a set of fifty-one DCF files provided with the WinMACCS installation.  These consist of a parent 
DCF file and a set of 50 annual DCF files, for which the 50-year dose commitment period is broken 
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up into single years. Only the parent DCF file needs to be selected by the user; the set of annual 
files, with standardized nomenclature, are automatically included when the parent is selected. 
See Section 4.4.5 for more information. 

Table 3-5 Annual Differential DCF Files Form 

Parameter Name Definable Type Dimensions Allowed Values 

Annual Differential 
DCF File Set 

Yes Text Files 51 files File sets are provided. 
WinMACCS does not validate the 
files, but the format required by 
MACCS is specified in Chapter 6. 

 

COMIDA2 File Form 

This form is required when the user selects Late Consequences on the Scope tab, selects LNT 
on the Dose tab, and selects Predefined COMIDA2 File on the Food tab.  The COMIDA2 file is a 
binary file created by the COMIDA2 preprocessor. COMIDA2 requires a DCF file as part of its 
input.  This DCF file must be the same as the one specified in the section above.  

Table 3-6 COMIDA2 File Form 

Parameter Name Definable Type Dimensions Allowed Values 

COMIDA2 File Yes Binary File None This file is not validated by 
WinMACCS, but it is by MACCS. 

 

Annual Differential COMIDA2 Files Form 

This form is required when the user selects Late Consequences on the Scope tab, selects Annual 
Threshold or Piecewise Linear on the Dose tab, and selects User Supplies COMIDA2 File on the 
Food tab. Annual Differential COMIDA2 File Set is a set of fifty-one COMIDA2 binary files provided 
with the WinMACCS installation.  

Table 3-7 Annual Differential COMIDA2 Files Form 

Parameter Name Definable Type Dimensions Allowed Values 

Annual Differential 
COMIDA2 File Set 

Yes Binary 
Files 

51 files File set are provided. WinMACCS 
does not validate the files, but 
they are validated by MACCS. 

 

Cyclical File Set Form 

A set of cyclical files is required when the user selects MACCS Cyclical File Set on the Scope 
tab. A MACCS Cyclical File Set is a set of files in MACCS input format. The function of this file 
set is described in Section 4.4.6. 

Table 3-8 Cyclical File Set Form 

Parameter Name Definable Type Dimensions Allowed Values 

MACCS Cyclical 
File Set 

Yes Text File ≥1 file MACCS input file format. Files 
are read by WinMACCS.  
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Multi Source Term File Set Form 

Using this option requires selecting Multi Source Term option on the Properties form and selecting 
the multi-source term files created using MelMACCS (version 2.0.1 or later) or with some other 
method.  A software program, CombineSource, is integrated into WinMACCS and processes the 
set of multi-source term files specified and creates two output files.  One output file, 
CombineSource.wmc, contains information that is directly imported into WinMACCS.  The other 
file, CombineSource.out, contains information that is read by MACCS.  

Table 3-9 Multi Source Term File Set Form 

Parameter Name Definable Type Dimensions Allowed Values 

Multi Source Term File Set Yes Text Files ≥1 file MelMACCS output file format 

 

 Output Options 

Reporting Options Form 

Results are calculated by WinMACCS for each quantile level on this form.  If results have the 
Report option activated in the output request forms, results are automatically generated after 
model execution.  The reported values are interpolated from the binned CCDF tables in the 
MACCS binary file.  The quantile levels are also used when creating custom reports that combine 
results over simulations. See Section 4.6.2.3 for more information.  

Table 3-10 Reporting Options Form 

Parameter Name Definable Type Dimensions Allowed Values 

Probabilities Yes Real ≥1 file 0.0 to 1.0 

 

Output Units Form 

Each time MACCS runs, an output file and a binary file is created containing the results. The units 
reported in the text and binary output files can be modified.  

Table 3-11 Output Units Form 

Parameter Name Definable Type Dimensions Allowed Values 

Activity Units Yes Character None {Bq, Ci} 

Distance Units Yes Character None {km, mi} 

Area Units Yes Character None {ha, km**2, mi**2} 

Dose Units Yes Character None {rem, Sv} 
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3.2 ATMOS Input and Model Description 

 Overview of ATMOS 

ATMOS performs all the calculations pertaining to atmospheric transport, including dispersion 
and deposition, as well as the radioactive decay and ingrowth that occurs prior to release and 
while the material is in the atmosphere. (Following calculation of transport within the problem 
domain, radioactive decay and dose modeling are performed by the EARLY and CHRONC 
modules of MACCS.) The specification of the release characteristics designating a “source term” 
can consist of up to 500 plume segments. ATMOS models the transport of these plume segments 
considering time-varying meteorological conditions.  Treatment of variable meteorological 
conditions, referred to as weather sampling, is supported using various sampling options.  If 
weather sampling is used, results are reported as statistical summaries and optionally as a binned 
CCDF.  This is done for an individual MACCS run and only reflects weather variability, not 
uncertainty in other input parameters. 

The radioactive materials released are modeled as being dispersed while being advected by the 
prevailing wind.  During transport, deposition of particles onto the ground from dry and wet 
processes can be modeled.  In addition to the air and ground concentrations, ATMOS determines 
plume arrival time, plume departure time, and plume dimensions.  

ATMOS results are used by the EARLY and CHRONC modules.  Therefore, at a minimum, a 
MACCS calculation must include the ATMOS module.  In other words, calculations of early or 
latent health effects of a radioactive release depend on dispersion and deposition results provided 
by ATMOS. 

MACCS allows multiple individual source terms to be specified in the ATMOS input using a 
method called change records.  Change records allow the user to specify new values for 
previously defined variables.  When these are encountered, the code's calculations are rerun 
based on the new values for parameters defined in the set of change records and new output is 
generated for each specified source term and emergency response scenario.  

WinMACCS does not support this feature of ATMOS, but a similar feature in EARLY that allows 
the specification of multiple emergency response cohorts is supported.  Results for multiple 
source term can be treated by WinMACCS through multiple MACCS runs using the MACCS 
Cyclical File Set option found on the Scope tab. 

A relatively new feature of MACCS is to treat releases from multiple units and/or spent fuel pools 
that occur in a sequential or overlapping fashion.  These releases can be associated with units 
having different isotopic inventories, different reactor shutdown times, and different release 
histories.  MACCS can calculate the combined consequences of the multiple releases.  

 Basic Parameters 

Atmos Description Form 

The Atmos Description form, as shown in Figure 3-17, contains one variable, which is a short 
description of the calculation.  This description is printed in the output file.  It is required input for 
all MACCS calculations. 

Table 3-12 Atmos Description Parameter 

Parameter Name Definable Type Dimensions Allowed Values 

ATNAM1 Yes Character None 1 to 80 characters 
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A more detailed description of the calculation can be entered on the Problem Description form 
under the GENERAL/Properties category.  

 

Figure 3-17 ATMOS Site and Model Description Form 

Property Form Parameters Form 

The Property Form Parameters form, shown in Figure 3-18, illustrates how selections in the 
Properties form define some important parameters that are required in the ATMOS input to 
MACCS.  The parameters are read-only and cannot be changed from this form.  

ENDAT1 terminates the calculation after running ATMOS when set to True.  Likewise, ENDAT2 
terminates the calculation after running EARLY when set to True. ATMOS, EARLY, and CHRONC 
are run in sequence when both flags are set to False. 

DISPMD is the long-range crosswind dispersion model flag.  The value is set to LRTIME for the 
long-range, time-based option, in which case dispersion is calculated as a function of time.  The 
value is set to LRDIST for the long-range, distance-based option, in which dispersion is calculated 
as a function of downwind distance.  The distance-based model is the original MACCS2 1.12 
dispersion model.  
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Figure 3-18  Property Form Parameters Form 

MNDMOD defines the algorithm used to calculate plume meander.  If set to OLD, the plume 
meander factor is a function of release duration only.  If set to NEW, plume meander factor 
depends on wind speed and stability class, but not on the duration of release.  This model is 
consistent with NUREG/CR-2260 and US NRC Regulatory Guide 1.145.  If MNDMOD is chosen 
to be NEW, the plume segments should be approximately one hour in duration.  OFF means no 
plume meander is treated.  

METCOD determines what meteorological data are used and how weather sampling is 
performed.  When the value is set to one, two, or five, a meteorological data file is needed to 
supply the meteorological data. 

• A value of one allows the user to choose a single starting point in the file, defined by a 
day and period of the day. A single weather trial is performed using this time as a 
starting point.  

• A value of two corresponds to weather-bin sampling from the meteorological data file.  

• A value of three is used for user-supplied hourly data for 120 hours. 

• A value of four is used for user-supplied, constant weather. 

• A value of five corresponds to stratified, random sampling from the meteorological data 
file.   

MAXHGT determines whether only the daytime or both the daytime and nighttime mixing heights 
are to be used in the calculation.  When DAY_AND_NIGHT is selected, the Site Location form is 
required to estimate sunrise and sunset for each day of the year.  The required mixing heights 
are specified in the meteorological data file.  
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BRGSMD is the plume-rise model flag. IMPROVED is the recommended value.  This 
recommendation is based on comparisons of several empirical models with results from the 
National Institute of Standards and Technology (NIST) ALOFT-FT code. ALOFT-FT solves the 
fundamental equations that govern the rise of hot gases into the atmosphere. ORIGINAL is the 
original MACCS 1.12 Briggs plume rise model.  See Section 3.2.8.1 for more details. 

MSMODL is the Multi Source Term model flag.  When set to True, the forms under the Multi 
Source Term category are required, and MACCS calculates the combined effects of the multiple 
releases defined in these files.  When set to False, the source term is specified directly in the 
WinMACCS interface. 

Table 3-13 Property Form Parameter Inputs 

Parameter 
Name 

Definable Type Dimensions Allowed Values 
Tab where Defined 
on Properties Form 

ENDAT1 Read-Only Logical None True, False Scope tab  

ENDAT2 Read-Only Logical None True, False Scope tab  

DISPMD Read-Only Character None LRDIST, LRTIME Dispersion tab  

MNDMOD Read-Only Character None OLD, NEW, OFF Dispersion tab  

METCOD Read-Only Integer None 1 to 5 Weather tab  

MAXHGT Read-Only Character None DAY_ONLY, 
DAY_AND_NIGHT 

Weather tab  

BRGSMD Read-Only Character None ORIGINAL, 
IMPROVED 

Plume/Source tab  

MSMODL Read-Only Logical None True, False Plume/Source tab 

 

Spatial Grid Form 

The region potentially affected by a release is represented by polar coordinates, (𝑟, 𝜃).  The 
radius, r, represents distance from the release point, which is always at r = 0.  The angle, θ, is 
the angle measured clockwise from north.  The user must specify a set of radial endpoints (i.e., the 
outer radii for the grid elements), as shown in Figure 3-19.  Up to 35 radii may be defined, 
extending out to a maximum distance of 9999 km.  The number of angular divisions, or compass 
sectors, used to define the spatial grid can be 16, 32, 48, or 64.  If the spatial grid is divided into 
16 sectors, each sector is 22.5˚ wide.  In all cases the sectors are equally spaced.  The first sector 
is always centered on north.  

NUMCOR is the number of sectors in the spatial grid.  If a site file is used, it must be consistent 
with the number of sectors in the grid. 

NUMRAD is the number of radial spatial intervals.  The value of this parameter is automatically 
determined in WinMACCS by the number of entries in vector SPAEND.  The number of radial 
intervals and the radial locations must be consistent with the site file, if one is used. 

SPAEND defines the radial boundaries in the spatial grid.  If a site data file is being used, these 
values are optionally updated when the site file is selected.  This update ensures consistency 
between the site file and the MACCS input.  The first radius must be at least 0.05 km.  The 
minimum spacing between adjacent radii is 0.1 km. 
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Figure 3-19 Spatial Grid Form 

Table 3-14 Spatial Grid Form Parameter Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUMCOR Yes Integer None 16, 32, 48, 64 

NUMRAD Linked Integer None 2 to 35 

SPAEND Yes Real NUMRAD 0.05 to 9999.0, spacing ≥ 0.1 km 

 

 Radionuclides 

This section defines the radionuclide classes (groups) and the radionuclides that are modeled.  
The radioactive decay data (half-life and decay chains) are provided to MACCS by the file 
INDEXR.DAT, which is from the Radiation Shielding Information Center as part of the FGR-
DOSE/DLC-167 data package.  This file is part of the WinMACCS installation and is transparent 
to the user.  
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 Radionuclide Descriptions 

Radionuclide names are case sensitive.  Names of chemical elements follow the usual convention 
that the first letter is capitalized, and the second letter is lower case.  The element names are 
followed by a hyphen and the atomic mass of the radionuclide to define the radionuclide name.  

Each decay chain is limited to a maximum of six generations.  Each decay chain is independent 
of the others.  The MACCS output file lists the chains that are being used in the calculations.  

Decay chains can be terminated in two ways.  They are automatically terminated when the decay 
product is a stable isotope.  In some cases, it is desirable to terminate a decay chain with a decay 
product that is not stable.  This is commonly done when the decay product has a very long half-
life or contributes very little to the overall dose.  Terminating a decay chain in this way is done by 
adding the radionuclide to the pseudostable isotope list. 

For example, Cs-135 is formed by beta-decay of Xe-135.  It decays to Ba-135 from low-energy 
beta decay with a half-life of 2.3x106 years.  Because of the long half-life and low energy beta 
produced by its decay, it has little effect on doses and is often included as a decay-chain 
terminator in MACCS calculations by including it as a pseudo-stable isotope. 

In some older calculations, decay products were added implicitly by adding the DCFs for the 
progeny to the parent and including the progeny in the list of pseudostable radionuclides.  This 
simplification was done to reduce memory and CPU requirements.  It works when the half-life for 
the progeny is much shorter than the one for the parent so that the progeny decays almost 
immediately once the parent decays.  This practice somewhat disguises the set of radionuclides 
that are being treated in a problem and reduces flexibility.  Since computer memory is at much 
less of a premium now than when MACCS was initially developed, this practice of implicitly 
including progeny in a calculation is now discouraged.  With the latest DCF file based on FGR-13, 
all progeny must be included in a calculation if their doses are to be included.  

If an input error occurs because an unstable decay product is omitted, MACCS exits with an error 
message that lists the isotope or isotopes that are missing.  The missing decay products must 
either be added to the radionuclide list or to the pseudostable isotope list.  A radionuclide cannot 
be included on both lists.  When one or more decay chain branches exist, the decay products in 
all the active branches must be included in one of the two lists. 

 Radionuclides Forms and Parameters 

Chemical Names Form 

The Chemical Names form is required when Multi Source Term is not selected on the 
Plume/Source tab.  Each radionuclide to be modeled is assigned to a chemical class.  
Traditionally, the term chemical class has been used in MELCOR applications to identify a set of 
chemically similar elements that are assumed to behave identically within the radionuclide 
package of MELCOR.  For example, all noble gases are generally assigned to the Xe class. In 
MACCS, the dry deposition characteristics and release fractions are assigned by chemical group, 
where group is commonly used instead of class.  Thus, all isotopes assigned to a chemical group 
are assumed to act similarly in terms of release fraction and deposition behavior.  The user is 
required to assign a name for each chemical group, which is used as a label in the forms for 
RELFRC and DRYDEP. 

MAXGRP is the number of chemical groups.  The value is linked to the number of entries in the 
vector GRPNAM. 
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GRPNAM is vector of character strings used to identify each of the radionuclide classes.  This 
parameter is used for labeling within WinMACCS and appears in the ATMOS input file created by 
WinMACCS. 

 

Figure 3-20 Chemical Group Names Form 

Table 3-15 Chemical Names Form Parameter Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

MAXGRP Linked Integer None 1 to 150 

GRPNAM Yes Character MAXGRP 1 to 15 characters 

 

Radionuclides Form 

The Radionuclides form is required when Multi Source Term is not selected on the Plume/Source 
tab.  

The Radionuclides form specifies the number of radionuclides treated in the WinMACCS 
calculation, the names of the radionuclides, the core inventory of each of the radionuclides, and 
the chemical group to which each one is assigned.  The names of the radionuclides must 
correspond to those in the DCF file associated with the WinMACCS project. (In their latest 
documents, ICRP uses “dose coefficients” in place of “dose conversion factors.”  These names 
are used interchangeably in this document.)  
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Three types of DCF files are distributed with MACCS.  The oldest of these was created by the 
program DOSFAC2.  This file, named dosdata20organs.inp, contains 60 radionuclides.  It 
includes DCFs for estimating acute and latent health effects. In addition to the 60 radionuclides, 
11 decay products are implicitly included in this DCF file.  This is done by summing the DCFs for 
the parent and progeny.  This simplification was done to reduce CPU time and is appropriate 
when the progeny’s half-life is very short compared with the parent’s half-life.  All implicit decay 
products must be included on the pseudostable isotope list when using this DCF file. 

The two other types of DCF files are based on FGR-11, -12, and -13.  The DCFs for the external 
pathways are common to both and are from FGR-12.  DCFs for the internal pathways are from 
FGR-11 in one case and from FGR-13 in the other case.  Both files contain extensive lists of 
radionuclides (825); however, treatment of implicit progeny is different in the two files.  The older 
file, based on FGR-11 and -12, includes several implicit progenies (e.g., Ba-137m is included with 
Cs-137).  Thus, Ba-137m should not be treated directly using this file or it would be double 
counted.  On the other hand, the newer DCF file based on FGR-12 and -13 does not include any 
implicit progeny, so both Cs-137 and Ba-137m must be explicitly included.  This allows more 
flexibility in the treatment of decay products.  For example, with the older DCF file, a calculation 
could include either Cs-137 or Ba-137m in the inventory. Including both would lead to double 
counting most of the Ba-137m dose.  The newer DCF file allows either Cs-137, Ba-137m, or both 
to be included in the inventory.  The newer file also includes DCFs for estimating both acute and 
latent health effects; the older file only includes DCFs for latent health effects. 

NUMISO defines the number of radionuclides.  It is linked to the number of entries in the NUCNAM 
vector. 

NUCNAM is a vector of radionuclide names.  Each radionuclide name must be in the decay-chain 
definition file, INDEXR.DAT, as well as the DCF file used in the calculation.  

CORINV defines the inventory of each radionuclide in the facility at the time of reactor shutdown. 
The unit, Bq, or Becquerel, is equivalent to disintegrations/second.  This inventory can be scaled 
by modifying parameter CORSCA found on form ATMOS/Release Description/Inventory Scale 
Factor. 

IGROUP identifies the chemical group to which the radionuclide is assigned.  The radionuclides 
should be grouped according to their physical/chemical properties.  All members of a chemical 
group have the same deposition characteristics and release fractions.  The assignment into 
chemical groups or classes is often taken from MELCOR, especially when the source term was 
calculated using MELCOR.  
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Figure 3-21 Radionuclides Form 

Table 3-16 Radionuclides Form Parameter Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUMISO Linked Integer None 1 to 150 

NUCNAM Yes Character NUMISO 3 to 8 characters 

CORINV Yes Real NUMISO 0 to 1025 Bq 

IGROUP Yes Integer NUMISO 1 to MAXGRP 

 

Pseudostable Radionuclides Form 

The Pseudostable Radionuclides form is available when Multi Source Term is not selected on the 
Plume/Source tab.  The Pseudostable Radionuclides form is optional, although it is almost always 
used in practice.  This form specifies the name and number of pseudostable radionuclides, as 
described above.  

NUMSTB is the number of pseudostable radionuclides.  The value is determined by the number 
of entries in vector NAMSTB. 

NAMSTB contains a set of decay-chain terminators.  Each radionuclide must also be present in 
the decay-chain definition file, INDEXR.DAT.  These entries and their decay products are 
excluded from dose calculations.  Radionuclide names cannot appear in both NUCNAM and 
NAMSTB. 
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Figure 3-22 Pseudostable Radionuclides Form 

Table 3-17 Pseudostable Radionuclides Form Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

NUMSTB Linked Integer None 1 to 150 

NAMSTB Yes Character NUMSTB 3 to 8 characters 

 

 Deposition 

 Deposition Model Description 

The wet deposition model estimates how much material is deposited during episodes of 
precipitation.  Wet deposition is treated as a function of both precipitation duration and intensity.  
The fraction of aerosols that remains suspended after wet deposition is calculated from the 
following equation (Brink and Vogt, 1981): 

𝑄

𝑄0
= 𝐶1 ⋅ 𝑒𝑥𝑝 [−𝑡𝑟 ⋅ (

𝐼𝑟

𝐼0
)

𝐶2

]  (3-1) 

Where 

𝑄 = Quantity of suspended aerosols after rain event (Bq) 

𝑄0 = Quantity of suspended aerosols before event (Bq) 
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𝐶1 = linear washout coefficient, corresponding to MACCS input variable, CWASH1 
(dimensionless)  

tr = duration of precipitation (s) 

Ir = intensity of precipitation (mm/hr) 

I0 = unit rain intensity, 1 mm/hr 

C2 = exponential washout coefficient, corresponding to MACCS input variable, 
CWASH2 (dimensionless) 

Dry deposition is modeled using the source depletion method.  This method makes use of the 
simplifying assumption that deposition onto the ground does not significantly affect the air 
concentration near the ground.  That is, removal by deposition is assumed to be much slower 
than dispersion in the air.  This assumption allows the plume to be treated as Gaussian when 
deposition occurs.  This is generally an excellent assumption because turbulent advection is 
generally on the order of 0.5 m/s while deposition velocities are typically a few cm/s or less. 

The concentration of monodisperse aerosols at a location on the ground is the product of the 
integrated ground-level air concentration three times the deposition velocity.  In the general case, 
multiple aerosol sizes each with a different deposition velocity, the ground concentration is the 
sum over the set of aerosol sizes of the products of the time-integrated air concentrations and the 
deposition velocities.  

The material in each chemical group can be distributed among several particle-size groups (up to 
20), with each chemical group having a different distribution of activity among the particle-size 
groups.  The particle-size distribution of each chemical group is specified in the release 
description data. Because each particle size can deposit at a different rate, both the size 
distribution and the relative amounts of chemical groups can vary with downwind distance.  For 
example, consider a release containing noble gases, which do not deposit (deposition velocity is 
zero) and iodine, which does deposit.  As a result, the ratio of noble gases to iodine increases 
with downwind distance because iodine deposits while the noble gases do not.  Further, consider 
that the iodine is represented by two aerosol bins, each with its own deposition velocity.  The 
activity in the bin that deposits faster is depleted more rapidly than the other bin as the plume 
travels downwind.  Thus, both the chemical composition and size distribution of a plume can 
change with time and distance. 

 Deposition Forms and Parameters 

Wet/Dry Depos Flags 

The Wet/Dry Depos Flags form is required. DRYDEP is defined for each of the chemical groups. 
This flag indicates whether the chemical group is subject to dry deposition.  Setting the flag to 
False ensures that the deposition velocity is zero for this radionuclide class.  WETDEP is also 
defined for each of the chemical groups.  This flag indicates whether the radionuclide class is 
subject to wet deposition. 
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Figure 3-23 Wet/Dry Depos Flags Form 

Table 3-18 Wet/Dry Depos Flags Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

DRYDEP Yes Logical MAXGRP True, False 

WETDEP Yes Logical MAXGRP True, False 

 

The chemical group representing the noble gases, which do not form aerosols and are highly 
inert, is generally assigned deposition flags of False for both wet and dry deposition.  Other 
chemical groups are generally assigned deposition flags of True for both wet and dry deposition.  

Wet Deposition 

CWASH1 is the linear coefficient in the washout function shown in Equation (3-1). 

CWASH2 is the exponential coefficient in the washout function shown in Equation (3-1). 
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Figure 3-24 Wet Deposition Form 

Table 3-19 Wet Deposition Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

CWASH1 Yes Real None 0.0 to 1.0 

CWASH2 Yes Real None 0.0 to 1.0 

 

Dry Deposition 

NPSGRP is the number of particle size groups, determined by the number of entries in vector 
VDEPOS. 

VDEPOS is the set of dry deposition velocities corresponding to the set of particle size groups. 
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Figure 3-25 Dry Deposition Form 

Table 3-20 Dry Deposition Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

NPSGRP Linked Integer None 1 to 20 

VDEPOS Yes Real NPSGRP 0.0 to 10.0 m/s 

 

 Dispersion 

 Dispersion Model Description 

The Gaussian plume model of atmospheric dispersion optionally uses spatially dependent 

dispersion parameters, y and z. (A subsequent section describes an option to switch to time-
based dispersion at a user-specified distance downwind of the source.)  The dispersion 
parameters can be supplied in two different ways as functions of distance: as power-law functions 
or in the form of a lookup-table.  The choice of which of the two models to use is made on the 
Dispersion tab on the Properties form.  

Gaussian Plume Equations 

MACCS models plume dispersion during downwind transport using a Gaussian plume segment 
model.  Thus, the crosswind and vertical extent of plume segments is expressed in terms of the 
crosswind (𝜎𝑦) and vertical (𝜎𝑧) standard deviations of the normal concentration distributions that 
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characterize a Gaussian plume.  The Gaussian equations implemented in MACCS are derived 
assuming that turbulent velocities are negligible compared to the mean wind speed (Koa, 1984). 
Accordingly, MACCS assumes that the initial length of plume segments is unaffected by 
dispersion during downwind transport (i.e., plume segment lengths are constant once release of 
that plume segment is complete). Furthermore, MACCS assumes that concentration profiles have 
a sharp leading and trailing edge (i.e., the profile is a step function in x at these locations). 

During downwind transport, atmospheric turbulence causes plume segments to expand in all 
directions with the rate of expansion increasing when atmospheric turbulence increases.  Vertical 
expansion of the plume is increased by surface roughness and constrained by the ground and by 
the temperature structure of the atmosphere (location of inversion layers).  Crosswind spreading 
of the plume along the y-direction is unconstrained.  The effective crosswind dimensions of a 
plume segment are increased by lateral meander of the plume about its centerline trajectory. 
Because turbulent velocities are almost always very small compared to the mean wind speed that 
transports the bulk plume, expansion in the wind direction can be neglected (Turner, 1970). 

Because they are simple and computationally efficient, Gaussian plume models are commonly 
used to model atmospheric dispersion in reactor accident risk assessments (see for example the 
PRA Procedures Guide, NRC, 1983b).  Gaussian plume models assume that the dispersion of 
gas molecules and aerosol particles in the plume during its downwind transport can be modeled 
as a random walk that generates a normal distribution for air concentration in all directions. 
Because wind speed and temperature vary significantly with height near the ground, vertical and 
crosswind plume distributions can differ significantly and must be calculated separately. Since the 
distribution in the wind direction does not appear in the Gaussian plume equations implemented 
in MACCS, only the vertical and crosswind distributions are calculated. 

The size of a Gaussian plume in the vertical and crosswind directions is defined by the standard 
deviations (σy and σz) of the normal distributions of material concentrations in the vertical and 
crosswind directions. When not constrained by the ground or by inversion layers, the Gaussian 
plume equation has the following form (Turner, 1970): 

𝜒(𝑥, 𝑦, 𝑧) =
𝑄

2𝜋𝑢𝜎𝑦𝜎𝑧
𝑒𝑥𝑝 [−

1

2
(

𝑦

𝜎𝑦
)

2

] 𝑒𝑥𝑝 [−
1

2
(

𝑧 − ℎ

𝜎𝑧
)

2

]  (3-2) 

Where 

𝜒(𝑥, 𝑦, 𝑧) = time-integrated air concentration (Bq∙s/m3) at downwind location (x, y, z) 

𝑄 = released activity (Bq) 

u = mean wind speed (m/s) 

𝜎𝑦 = lateral dispersion parameter representing the standard deviation of a 

Gaussian distribution (m) 

𝜎𝑧 = vertical dispersion parameter representing the standard deviation of a 

Gaussian distribution (m) 

h = stabilized height of the plume centerline (m) 

Once a plume has expanded sufficiently in the vertical dimension so that further vertical expansion 
is constrained by the ground and/or the capping inversion layer, Equation (3-4) is no longer 
applicable.  To treat restricted growth in the vertical dimension, the ground and the inversion layer 
are treated as impenetrable, reflecting boundaries.  Mathematically, reflection is accomplished by 
the addition of mirror image sources above the inversion layer and below the plane of the ground. 
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This produces the following equation, which is used in MACCS to calculate both the 
time-integrated, plume-centerline, air concentration,  (x, y = 0, z = h), and time-integrated, 

ground-level, air concentration under the plume centerline,  (x, y = 0, z = 0), from the time a 

plume segment is released until the vertical distribution of the segment becomes uniform between 
the ground and capping inversion layer (becomes well mixed in the vertical dimension): 

𝜒(𝑥, 𝑦, 𝑧) =
𝑄

2𝜋𝑢𝜎𝑦𝜎𝑧
𝑒𝑥𝑝 [−

1

2
(

𝑦

𝜎𝑦
)

2

] ∑ {𝑒𝑥𝑝 [−
1

2
(

𝑧 − ℎ + 2𝑛𝐻

𝜎𝑧
)

2

]

∞

𝑛=−∞

+ 𝑒𝑥𝑝 [−
1

2
(

𝑧 + ℎ + 2𝑛𝐻

𝜎𝑧
)

2

]} 

 (3-3) 

Where 

H = height (m) of the capping inversion layer (i.e., the height of the mixing layer) 

At each spatial interval along the plume's trajectory, MACCS tests for the occurrence of a uniform 
concentration distribution in the vertical direction (well-mixed plume between the ground and the 
capping inversion layer).  Once a uniform vertical distribution is attained, Equation (3-5) 
approximately reduces to the following equation:  

𝜒(𝑥, 𝑦 = 0, 𝑧) =
𝑄

√2𝜋𝜎𝑦𝑢𝐻
𝑒𝑥𝑝 [−

1

2
(

𝑦

𝜎𝑦
)

2

] 
 (3-4) 

 

MACCS switches from Equation (3-5) to Equation (3-6) when 𝐻/𝜎𝑧 < 0.03.  This criterion 
approximately corresponds to the requirement that the results of the two equations agree within 
1%.  Because Equation (3-6) is independent of 𝜎𝑧, this value is not calculated once the transition 
from Equation (3-5) to Equation (3-6) is made. 

Dispersion Values 

The rate at which materials disperse in the atmosphere depends strongly on atmospheric 
turbulence, which varies greatly with stability class.  Therefore, the rate of expansion of a plume 
during downwind transport also varies with stability class. 

The growth of plume dimensions during downwind transport to short distances (1 km) has been 
experimentally determined (Haugen, 1959) over flat terrain covered by prairie grass (surface 
roughness length z0 = 3 cm) for short plumes (10 min release durations) released during stable, 
neutral, and unstable atmospheric conditions.  Pasquill (1961) used these data to develop curves 
that depict the increase of plume dimensions (σy and σ z values) with downwind distance for each 
of the six Pasquill-Gifford Stability Classes A through F.  Although measurements had only been 
made to 1 km, Pasquill extrapolated the curves to 100 km.  These curves, as later modified by 
Gifford (1975, 1976), are presented in Figure 3-26.  
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Figure 3-26 Dependence of σy and σz  on distance for the six Pasquill-Gifford stability 
classes, A through F 

Solid lines depict the range of the experimental data; dashed lines are extrapolations.  Tadmor 
and Gur (1969) constructed power-law fits to the Pasquill-Gifford (P-G) curves.  The coefficients 
are provided in Table 3-21.  Technical guidance for selecting a parameterization to represent 
dispersion can be found in Technical Bases for Consequence Analyses Using MACCS (Bixler et 
al., 2020).  

Table 3-21 Tadmor and Gur coefficients for σy and σz for Equation(3-2). 

Stability Class Constant* 

P-G i ai bi ci di 

A 1 0.3658 0.9031 0.00025 2.125 

B 2 0.2751 0.9031 0.0019 1.6021 

C 3 0.2089 0.9031 0.2 0.8543 

D 4 0.1474 0.9031 0.3 0.6532 

E 5 0.1046 0.9031 0.4 0.6021 

F 6 0.0722 0.9031 0.2 0.6020 

*The values of these constants reflect correction of typographical errors identified by Dobbins (1979).  

As used in MACCS, the values of the dispersion parameters, σy and σz, in Equation (3-2) must 
change in a piecewise continuous fashion.  Discontinuous changes in slope occur when stability 
class changes.  Since stability class changes discretely, the source distance x in the dispersion 
parameter equation (Equation (3-2) must be changed to some new value that causes dispersion 
parameter growth to be continuous.  The value of the source distance, when it differs from the 
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actual source distance, is called the virtual source distance and generally has a different value for 
σy and for σz. It is calculated as follows.  

Let i be the stability class before the change in atmospheric conditions, j the stability class after 
the change, and xyi and xzi be the source distances under the old conditions (the downwind 
distances to the virtual source just before the stability class changes). Let xyj and xzj be the source 
distances under the new conditions (i.e., the new virtual source distances).  To ensure continuity, 
σyi must be equal to σyj and σzi must be equal to σzj. Thus, 
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These equations can be solved explicitly for the virtual source locations to produce the following 
result: 
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This same approach can be used in conjunction with the lookup table option described above.  
This assumes that the inverse functional dependence for the lookup table can be evaluated 
(i.e., that given a dispersion value, a unique value of x can be determined).  For the lookup table, 
the requirement of monotonically increasing values in the table ensures uniqueness.  Performing 
the inverse function is done by interpolation in the same way as for the function itself. 

Although new “virtual source” distances for σy and σz are calculated every time stability class 
changes, these distances are used only to calculate growth of σy and σz.  Plume locations are 
always expressed relative to the release point that is the center point of the polar-coordinate 
computational grid. 

For a given spatial element, the average values of σy and σz are used to calculate air and ground 
concentrations for the entire spatial element.  The average values of σy and σz are the arithmetical 
means of the initial and final values of these two parameters as a plume segment traverses the 
spatial element. 

Scaling Factors 

MACCS allows the user to input a separate scaling factor for σy and σz.  These scale factors can 
be used to account for phenomena that would tend to increase or decrease the plume dimensions. 
There are two such phenomena that are commonly included in plume modeling: plume 
broadening caused by meander (wind direction fluctuations) and increase in the vertical plume 
dimension caused by surface roughness.  Separate options exist to account for plume meander, 
as described in a subsequent subsection, so the scale factor for σy is usually set to 1.0.  However, 
MACCS does not contain a separate model to account for surface roughness, so most commonly 
the vertical scale factor is set to a value other than unity. 
The Pasquill-Gifford curves depicted in Figure 3-26 are appropriate for transport over flat terrain 
covered by prairie grass (surface roughness length z0 = 3 cm).  But plume transport is usually over 



 

3-46 

areas characterized by surface roughness lengths greater than 3 cm.  Figure 3-27 presents some 
approximate surface roughness lengths for different surfaces based on the values in (Lettau, 
1969; Briggs, 1984; Randerson, 1984). 

 

Figure 3-27 Approximate surface roughness lengths (z0) for various surfaces (from 
Figure 7.3 in Whelan et al., 1987) 

Figure 3-27 suggests that a roughness length greater than 3 cm, at least 5 cm and possibly as 
much as 1000 cm, is more likely typical of populated areas.  Surface roughness principally affects 
vertical dispersion and thus 𝜎𝑧 values.  The following formula (AMS, 1977) can be used to correct 

Pasquill-Gifford values of 𝜎𝑧,𝑃−𝐺, which are appropriate for z0,P–G = 3 cm, for the effects of smoother 

or rougher surfaces: 

𝜎𝑧,𝑟 = 𝜎𝑧,𝑃−𝐺 [
𝑧0

𝑧0,𝑃−𝐺
]

0.2

  (3-7) 

Where the subscript P–G refers to the Pasquill-Gifford formulation for dispersion parameters and 
subscript r refers to the scaled dispersion accounting for the actual surface roughness, z0.  

Dispersion Function Parameters 

The MACCS power-law functions for y and z have the form: 
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Where 

𝜎𝑦𝑖 = lateral (crosswind) dispersion parameter for stability class, i.  This parameter is 

the standard deviation of a Gaussian distribution (m).  

𝜎𝑧𝑖 = vertical dispersion parameter for stability class, i.  This parameter is the standard 
deviation of a Gaussian distribution (m). 

x = downwind distance (m) 

ai,bi  = linear and exponential coefficients in the power-law expressions for crosswind 
dispersion. Subscript, i, represents stability class. Units for these coefficients are 
m and dimensionless, respectively. 

ci,di  = linear and exponential coefficients in the power-law expressions for vertical 
dispersion. Subscript, i, represents stability class. Units for these coefficients are 
m and dimensionless, respectively. 

x
0 

 = unit of length, 1 m 

The user should ensure that the categorization scheme used to define the stability classes for the 
meteorology is consistent with the values of the dispersion coefficients.  

Lookup-Table Parameters 

The lookup-table option allows the user to define a lookup table in place of power-law functions 

for y and z.  This code option uses an interpolation algorithm that avoids the numerical 
instabilities observed with cubic spline fits.  The calculational approach uses a Hermite cubic 
approach from Kahaner, Moler, and Nash (1989).  This lookup-table algorithm can be used to 
implement alternative dispersion parameterizations or to use fits to site-specific tracer data. 

This feature was implemented to allow the use of parameterizations other than simple power laws 
(e.g., the Briggs formulas).  Also, if tracer experiments are available for a site, it may be possible 

to process the data into tables of horizontal and vertical standard deviations (y and z).  A caution 
to the user is that the algorithms associated with the lookup tables do not allow for extrapolation, 
either to smaller values than the first entry or to larger values than the last entry in the table.  If, 
for example, the initial value of one of the dispersion parameters is smaller than the first value in 
the table for a specific stability class, the initial value in the table is used.  If a larger value of the 
dispersion parameter is needed than the final value in the table for a specific stability class, the 
dispersion parameter is held fixed until the stability class changes. 

Time-Based Dispersion  

A time-based dispersion model can be enabled as an option.  This is done on the Dispersion tab 
on the Properties form. 

Hanna (2002) recommends that plume dispersion beyond 30 km be based on time, not on 
distance. This model allows the user to implement Hanna’s recommendation.  The basis for the 
recommended distance, 30 km, is that nearly all measurements upon which dispersion tables are 
based have a limit of about 30 km.  The time-based dispersion model is closer to the treatment 
used in some Gaussian puff codes. In the MACCS implementation, the user must select the 
downwind distance at which the code switches from distance-based dispersion to time-based 
dispersion.  The user must also select a linear coefficient for the time-based dispersion model. 
Hanna recommends a value of 0.5 m/s, which is used as a default (see Bixler et al., 2020, for 
more information).  The virtual source concept is used to ensure that there is no discontinuity in 
switching from distance-based to time-based dispersion.  The following equation describes the 
time-based model:  
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Where  

𝜎𝑦 = Value of crosswind dispersion (m) 

a = Linear coefficient for distance-based, crosswind dispersion (m).  The subscript i 
is omitted but it is implied that the coefficient is for a specific stability class.  

x = Downwind distance from the virtual source (m) 

b = Exponential parameter for distance-based, crosswind dispersion (dimensionless). 
The subscript i is omitted but it is implied that the coefficient is for a specific 
stability class. 

xc = Distance from the source (m) at which dispersion model switches from distance- 
to time-based (CYDIST in MACCS) 

ac = Linear coefficient for time-based, crosswind dispersion (m/s) (CYCOEF in 

MACCS) 

t = Time since the plume was released from the virtual source (s) 

When the time-based dispersion model is enabled, time-based dispersion is implemented at 
distances greater than or equal to 𝑥𝑐 in Equation (3-3).  However, distance-based dispersion is 
always applied within the first ring, regardless of the value of CYDIST.  Either a power-law 
function, as illustrated in Equation (3-3), or a lookup table can be used to define the dependence 
of dispersion on downwind distance at distances less than CYDIST. 

 Dispersion Forms and Parameters 

Dispersion Function Form 

The Dispersion Function form is required when the user selects Power Law Functions on the 
Dispersion tab.  Values entered on this form correspond to the parameters used to calculate 
dispersion when using the six Pasquill–Gifford stability classes (classes A through F).  The user 
must supply six values for each parameter defined on this form, one value for each stability class 
in the order A through F.  

CYSIGA is the linear coefficient of the expression for y.  

CYSIGB is the exponential coefficient of the expression for y. 

CZSIGA is the linear coefficient of the expression for z. 

CZSIGB is the exponential coefficient of the expression for z. 
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Figure 3-28 Power Law Sigmas Form 

Table 3-22 Dispersion Function Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

CYSIGA Yes Real 6 1×10-6 to 10.0 m 

CYSIGB Yes Real 6 1×10-6 to 10.0  

CZSIGA Yes Real 6 1×10-6 to 10.0 m 

CZSIGB Yes Real 6 1×10-6 to 10.0  

 

Dispersion Table Form  

The Dispersion Table form is required when the user selects Lookup Tables on the Dispersion 
tab. NUM_DIST is the number of distances in the lookup table and its value is determined by the 
number of rows entered in the grid containing the dispersion table.  DISTANCE is the set of 
downwind distances corresponding to sigma-y and sigma-z values.  Distances must be 
monotonically increasing. SIGMA_Y and SIGMA_Z values need to be provided on this form for 
each stability class, A, B, C, D, E, and F, and these values must be monotonically increasing. 
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Figure 3-29 Dispersion Table Form 

Table 3-23 Dispersion Table Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

NUM_DIST Linked Integer None 3 to 50 

DISTANCE Yes Real NUM_DIST 1.0 to 1×108 m 

SIGMA_Y_A Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Z_A Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Y_B Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Z_B Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Y_C Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Z_C Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Y_D Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Z_D Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Y_E Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Z_E Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Y_F Yes Real NUM_DIST 1×10-6 to 1×1020 m 

SIGMA_Z_F Yes Real NUM_DIST 1×10-6 to 1×1020 m 
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Scaling Factors 

Scaling factors are required. MACCS allows linear scaling of y and z by means of the input 

parameters, YSCALE and ZSCALE.  These scaling factors are used to multiply the values of y 

and z that have been defined for each of the six stability classes.  YSCALE is the linear scaling 

factor that is applied to the formula for y.  This modifies all the calculated y values by a constant 
multiplicative factor for either the power-law or lookup-table options. YSCALE is normally set to 

1.0. ZSCALE is the linear scaling factor that is applied to the formula for z.  It is commonly used 

to account for surface roughness.  This factor modifies all the z values by a constant multiplicative 
factor for either the power-law or lookup-table options.  ZSCALE is normally set to a value greater 
than 1.0.  

 

Figure 3-30 Scaling Factors Form 

Table 3-24 Scaling Factors Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

YSCALE Yes Real None 0.01 to 100.0 

ZSCALE Yes Real None 0.01 to 100.0 

 

Long-Range Parameters 

The Long-Range Parameters form is required when the user selects the option, Switch to Time-
Based Dispersion Model at User-Specified Distance, on the Dispersion tab. CYDIST is the 
distance for switching from distance-based to time-based crosswind dispersion model.  The 
distance-based dispersion model is always used within the first radial interval.  The default value 
for this parameter is 30,000 m (see Bixler et al., 2020, for more discussion). CYCOEF is the linear 
coefficient for the time-based, crosswind dispersion model.  The default value for this parameter 
is 0.5 m/s. Both default values are based on a recommendation by Hanna (2002).  
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Figure 3-31 Long-Range Paramters Form 

Table 3-25 Long Range Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

CYDIST Yes Real None 0.0 to 1×107 m 

CYCOEF Yes Real None 1×10-6 to 2.0 m/s 

 

 Multi-Source Option 

 Multi-Source Model Description 

MelMACCS is the interface tool that allows MELCOR plot files to be post-processed to create 
MACCS source term data that can be imported directly into WinMACCS using the Import MACCS 
Input File option discussed in Chapter 4.  In the past, the process has only been able to address 
single-unit source terms. WinMACCS 3.10 now has the capability to merge several source terms 
to create a multi-unit source term.  Furthermore, MELCOR and MelMACCS have been modified 
to create multiple source terms from a single MELCOR plot file, provided this feature is activated 
in the MELCOR input. The new feature allows the user to create a source term file for each ring 
in the MELCOR analysis.  Multiple rings are generally used in MELCOR analyses to define 
annular portions of the reactor core in a polar coordinate system. Similarly, rings in the MELCOR 
analysis of a spent fuel pool are generally used to represent different regions of the fuel.  This 
feature is especially advantageous for analyses of spent fuel pools, where each spent-fuel ring 
can represent a different age of spent fuel.  This allows different ages of fuel to be assigned 
different isotopic inventories in performing the MACCS analysis. MelMACCS 2.0 (and later) is 
compatible with the multi-source model and allows the user to assign an inventory for a selected 
ring.  One source term file is created for each ring processed by the user.  
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Source term files can be merged to create a multi-unit source term, as described subsequently in 
this section. Details of how to use MelMACCS are provided in Appendix A.  Details of how to use 
the multi-source model is provided in Section 4.4.10.  

 Multi-Source Forms and Parameters 

Chemical Names Form 

The values on this form are read from the multi-source files and are not changeable. 

 

Figure 3-32 Chemical Names Form 

Table 3-26 Chemical Names Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

MAXGRP No Integer None 1 to 150 

GRPNAM No Character MAXGRP 1 to 15 characters 
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Radionuclides Form 

The values on this form are read from the multi-source files and are not changeable. 

 

Figure 3-33 Radionuclides Form 

Table 3-27 Radionuclides Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

NUMISO No Integer None 1 to 150 

NUCNAM No Character NUMISO 3 to 8 characters 

IGROUP No Integer NUMISO 1 to MAXGRP 

 

Plume Segments Form 

The values on this form are read from the multi-source files and are not changeable.  Each row 
in the grid identifies a plume segment that is defined on one of the multi-source files. 
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Figure 3-34 Plume Segements Form 

Table 3-28 Plume Segments Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

TOTREL No Integer None 2 to 500 

MS_LABELS No Character TOTREL 1 to 255 characters 

IGROUP No Integer NUMISO 1 to MAXGRP 

 

Time Offsets Form 

A time offset can be associated with each of the multi-source files to account for different accident 
initiation times for each of the sources.  Time offsets define the times associated with the 
inventories in each of the files.  This information allows MACCS to adjust its calculation of 
radioactive decay for each unit or source. 
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Figure 3-35 Time Offsets Form 

Table 3-29 Time Offsets Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

NUM_SOURCES No Integer None 2 to 500 

Source Time Offset Yes Real NUM_SOURCES 0 to 2.592×106 s (30 days) 

 

 Plume Specification 

 Plume Meander Model Descriptions 

WinMACCS allows three choices for plume meander model on the Dispersion tab shown in Figure 
3-6.  Namely, the original MACCS model, a model based on Reg Guide 1.145 (NRC, 1983a), and 
an option to turn off plume meander.  Plume meander accounts for the tendency of wind direction 
to vary over time.  The amount of plume meander depends on wind speed, stability class, and the 
observation period.  For the purposes of MACCS, observation period generally translates to the 
duration of release for a plume segment.  

Original MACCS Plume Meander Option 

The original MACCS model accounts for the effect of meander during transport of a plume 
segment by using a meander factor.  This factor, 𝑓𝑚, serves to broaden the plumes in the 

cross-wind dimension. It acts as a linear factor on y, which affects the calculation of /Q.  The 
expansion factor is defined as follows: 
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Where 

𝛥𝑡𝑟𝑒𝑙𝑒𝑎𝑠𝑒 = release duration for the plume segment (s) 

𝛥𝑡0 = release duration for the P–G data (s), which was 600 s 

𝛥𝑡1 = breakpoint in release duration (s), usually chosen to be 3600 s (the default 
value) 

F1 = exponent for time dependence below the breakpoint (dimensionless), 
usually chosen to be 0.2 (the default value)  

F2 = exponent for time dependence above the breakpoint (dimensionless), 
usually chosen to be 0.25 (the default value)  

Bixler et al. (2020) provides more discussion on dispersion modeling and related 
recommendations.  The duration of each plume segment should be limited to 10 hours when using 
this meander model because the formula is not intended to be used above that value. If a plume 
segment exceeds 10 hours, a nonfatal warning is given in the output file and the expansion factor 
is calculated as though the plume duration were 10 hours.  

Plume Meander Model Based on U.S. NRC Regulatory Guide 1.145 

MACCS now contains a plume meander model based on Regulatory Guide 1.145 (NRC, 1983a) 
and supporting document NUREG/CR-2260.  The Regulatory Guide 1.145 plume meander model 
differs from the original model in MACCS in that it accounts for the effects of wind speed and 
stability class.  The original model in MACCS accounts for the duration of the release; the new 
model is calibrated for 1-hour release durations.  The plume meander model described below 
would lead to an over prediction of peak doses for release durations significantly longer than 
1 hour; it would under predict peak doses for release durations that are significantly shorter than 
1 hour. Enforcement of this model restriction is left to the user; WinMACCS and MACCS do not 
restrict the duration of plume segments to be approximately 1 hour when this model is selected. 
The MACCS implementation of the Reg. Guide 1.145 plume meander model treats plume 
meander in a similar manner as an area source. The meander occurs in the first 800 m downwind, 
creating a broader plume at that distance.  Beyond 800 m, the plume gradually approaches the 
size that it would have had if meander had not occurred, just like the effect of an area source.  

The plume meander model in Regulatory Guide 1.145 is described as follows: 

𝜎𝑦𝑚 = 𝑓𝑚 ⋅ 𝜎𝑦(𝑥)  (3-11) 

Where 

𝜎𝑦(𝑥) = lateral dispersion not accounting for plume meander (m) 

𝑓𝑚 = meander factor (dimensionless) 

𝜎𝑦𝑚 = lateral dispersion accounting for plume meander (m) 

x  = downwind distance measured from the virtual source (m) 
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Lateral dispersion, σy, can be defined in terms of a power-law equation or as a look-up table. The 
meander factor is defined as follows: 

𝑓𝑚 = 𝑚 ⋅ 𝑓(𝑢)  (3-12) 

Where 

𝑚 = 1.0 for stability classes A through C 

  2.0 for stability class D 

  3.0 for stability class E 

  4.0 for stability class F 

f(u) = a function of wind speed and is defined in Equation (3-13) below 

u = wind speed (m/s) 
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The above equations are valid for distances within 800 m of the source. Beyond 800 m downwind, 
Equation (3-11) is modified as follows: 

𝜎𝑦𝑚 = (𝑓𝑚 − 1) ⋅ 𝜎𝑦(800) + 𝜎𝑦(𝑥)  (3-14) 

The MACCS model is like the model described above except that it is more general and uses a 
different approach at distances greater than D (D = 800 m in Equation (3-14)). The equations 
used in MACCS are as follows: 
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D is the location beyond which the plume meander factor is no longer used.  At this distance, the 

location of the virtual source is adjusted to ensure continuity in the value of ym . Beyond MNDIST 

(the MACCS name corresponding to D), the meander factor is set to unity and the effect of the 
plume meander is treated in just the same way as an area source (i.e., by using an appropriate 
value for the virtual source location).  

The MACCS plume meander model closely matches the Reg. Guide 1.145 model when 
[MNDFAC(i)] = [1, 1, 1, 2, 3, 4], WINSP1 = 2 m/s, WINSP2 = 6 m/s, and MNDIST = 800 m. These 
are the default values, as discussed in Bixler et al. (2020).  
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 Plume Forms and Parameters 

Original Meander Form 

The Original Meander form is required when the user selects Original MACCS (MNDMOD=OLD) 
in the Select Plume Meander Model group on the Dispersion tab.  TIMBAS is the release duration 
associated with the Prairie Grass tests upon which the Pasquill-Gifford dispersion curves are 
based. BRKPNT is the time breakpoint in the formula used to calculate the plume meander 
expansion factor.  When the release duration is less than or equal to this value but greater than 
TIMBAS, the second formula is used in Equation (3-10). When the release duration exceeds the 
value of BRKPNT, the third expression is used in Equation (3-10).  XPFAC1 is the exponential 
factor used to calculate the plume meander expansion factor for releases having durations that 
are less than or equal to BRKPNT.  XPFAC2 is the exponential factor used in calculating the 
plume meander expansion factor for releases having durations that are greater than BRKPNT. 

 

Figure 3-36 Plume Meander Form 

Table 3-30 Plume Meander Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

TIMBAS Yes Real None 60.0 to 86400.0 s 

BRKPNT Yes Real None 60.0 to 86400.0 s 

XPFAC1 Yes Real None 0.01 to 1.0 

XPFAC2 Yes Real None 0.01 to 1.0 
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US NRC Reg. Guide 1.145 Meander Form  

The U.S. NRC Reg. Guide Meander form is required when the user selects U.S. NRC Regulatory 
Guide 1.145 (MNDMOD=NEW) in the Select Plume Meander Model group on the Dispersion tab.  

WINSP1 is the wind speed where the meander factor changes from a constant value to a 
decreasing function of the wind speed.  Meander factor decreases log-linearly from the value 
specified by MNDFAC(n) to one at WINSP2.  The index n represents the atmospheric stability 
class. 

WINSP2 is the wind speed where the meander factor reaches one for all stability classes. 
Meander factor decreases log-linearly from the value specified by MNDFAC(n) at WINSP1 to one 
at WINSP2. The index n represents the atmospheric stability class. 

MNDIST is the downwind distance where the effect of meander begins to diminish. MNDIST is a 
breakpoint in the formula for calculating sigma-y. 

MNDFAC is the plume meander factor used to calculate sigma-y described in the NRC Regulatory 
Guide 1.145. MNDFAC(1) corresponds to atmospheric stability class A, MNDFAC(2) to stability 
class B, ..., and MNDFAC(6) to stability class F. 

 

Figure 3-37 U.S. NRC Regulatory Guide 1.145 Meander 
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Table 3-31 U.S. NRC Reguatory Guide 1.145 Meanders 

Parameter Name Definable Type Dimensions Allowed Values 

WINSP1 Yes Real None 0.0 to 20.0 m/s 

WINSP2 Yes Real None 0.0 to 20.0 m/s 

MNDIST Yes Real None 0.0 to 10,000.0 m 

MNDFAC Yes Real 6 1.0 to 10.0 

 

Plume Rise Scale Factor 

SCLCRW is a linear scaling factor on the critical wind speed used to determine whether buoyant 
plumes are trapped in the turbulent wake of the facility building complex.  Parameter values less 
than unity make plume rise less likely to occur because plume liftoff occurs only when the ambient 
wind speed at the time of release is less than the calculated critical wind speed; values greater 
than unity make plume rise more likely to occur. 

SCLADP is the linear scaling factor on the plume rise formula used to determine the amount of 
plume rise that occurs when the atmosphere is unstable or neutrally stable (stability classes A 
through D). 

SCLEFP is the linear scaling factor on the plume rise formula used to determine the amount of 
plume rise that occurs when atmospheric conditions are stable (stability classes E and F). 

 

Figure 3-38 Plume Rise Scale Factor Form 
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Table 3-32 Plume Rise Scale Factor Parameters Input 

Parameter Name Definable Type Dimensions Allowed Values 

SCLCRW Yes Real None 0.001 to 1x106  

SCLADP Yes Real None 0.01 to 100.0 

SCLEFP Yes Real None 0.01 to 100.0 

 

 Release Description 

 Release Model Description 

Release Description 

ATMOS can handle multiple plume segments to treat a source term that has a time-varying 
composition and release rate.  The plume segments that describe a release can be separated 
with a time gap, can directly follow each other, or can overlap.  Different release heights, heat 

contents, starting times, release durations, release fractions, and initial values for y and z can 
be assigned to each plume segment.  Only one initial particle-size distribution can be assigned to 
each chemical group.  Thus, the effective, initial, particle-size distribution can vary from one plume 
segment to another only as a function of the relative release fractions of the radionuclide classes. 
However, the aerosol size distribution of a plume segment changes with time (i.e., downwind 
location as the plume segment travels through the grid) when there are multiple particle sizes with 
different deposition velocities.  

Initial Plume Dimensions 

Mixing of the plume into the wake of a building from which a release occurs generally determines 
the initial dimensions of the plume. For the purpose of initializing plume dimensions, the common 
assumption is that the plume centerline is at ground level and in the middle of the downwind face 
of the building.  

If plume concentrations at the sides and roofline of the building from which the release occurs are 
assumed to be 10% of plume centerline concentrations (building edges are 2.15 sigma from the 
plume centerline), initial values of the horizontal and vertical standard deviations of the Gaussian 
plume are given by 
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 (3-16) 

 

Where 

Wb  = Width of the building from which release occurs (m) 

Hb  = Height of the building from which release occurs (m) 

Choosing the height and, especially, the width of the building from which the release occurs is not 
always straightforward. In many cases, the reactor complex is comprised of a set of buildings, 
which may be connected or disconnected.  The heights of the buildings in this complex may vary. 
Usually, the containment or reactor building is used to define the building height, but this may not 
be appropriate in all cases.  Determining the width is more problematic because the complex is 
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generally rectangular or irregular in footprint.  Thus, the apparent width depends on the direction 
of the wind. Fortunately, the effect of the initial size of the plume is quickly lost as the plume moves 
downwind of the plant.  While the initial plume dimensions can have a significant effect on the 
maximum dose at the exclusion area boundary, they usually have little effect on doses multiple 
kilometers from the plant.  

Plume Rise Models 

There are three basic components of the plume rise models in MACCS: (1) liftoff of buoyant 
plumes from a building wake, (2) plume rise under unstable and neutral atmospheric conditions 
(stability classes A to D), and (3) plume rise under stable conditions (stability classes E and F). 
Each of these components is described in this section. 

When wind speeds are sufficiently high, a buoyant plume segment that is released into a building 
wake is unable to escape from the wake.  In MACCS, escape of a buoyant plume segment from 
a building wake is governed by a liftoff criterion (Equation (3-17) below), which was originally 
proposed by Briggs (1973) and validated by experiments performed at the Warren Spring 
Laboratory in Great Britain (Hall and Waters, 1986). The criterion states that plume rise occurs 
only when the wind speed upon release of the segment is less than a critical wind speed (uc) that 
is calculated using the following formula: 

𝑢𝑐 = [
9.09𝐹

𝐻𝑏
]

1
3
  (3-17) 

Where 

𝐻𝑏 = the height of the building from which the plume is escaping (m) 

𝐹  = the buoyancy flux (m4/s3), which under standard atmospheric conditions is = 

8.79 ⋅ 10−6𝑄̇ 

𝑄̇ = the sensible heat release rate of the plume (W) (i.e., the sensible heat content of 
the plume divided by its release duration).  Sensible heat is measured relative to 
ambient temperature. 

This equation indicates that there is little or no possibility of plume liftoff when the sensible heat 
release rate is less than 105 W for a typical, 50-m high, reactor or containment building.  Even 
when the rate of release of sensible heat is 1 MW, the plume only lifts off when wind speed is less 
than approximately 1.2 m/s.  Larger release rates of sensible heat, like 10 MW, produce lift off 
under a significant set of weather conditions for most sites.  

Plume rise, when atmospheric conditions are neutral or unstable (stability classes A through D), 
is treated using the “two thirds” law for bent over plumes of Hanna et al. (1982): 

𝛥ℎ(𝑥) =
1.6𝐹

1
3𝑥

2
3

𝑢̄
  (3-18) 

Where 

h = height of the plume centerline (m) 

𝛥ℎ(𝑥) = plume rise (m) as a function of 𝑥 measured from the initial release height 

𝑢̄ = wind speed (m/s) averaged between the initial release height and the final rise 

height (h) 
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Buoyant plume rise is terminated when any of the following conditions occur:  

(1). 𝛥ℎ(𝑥) reaches a final rise height, 𝛥ℎ, as defined below, 

(2). the height of the plume centerline reaches the mixing height (height of the capping 
inversion layer), or 

(3). one hour has elapsed since release of the plume segment began. 

In the original MACCS plume rise model, the following equation recommended by Briggs (1975) 
was used to determine the final rise height for stability classes A to D: 

𝛥ℎ = 300𝐹/𝑢̄3 
 (3-19) 

In the currently recommended, improved MACCS plume rise model, a different formula is used, 
also based on the work of Briggs (Hanna, 1982): 
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  (3-20) 

In the original MACCS model, plume rise under stable atmospheric conditions (stability classes E 
and F) is calculated using the Briggs equation for the final rise (𝛥ℎ) Hanna (1982): 

  (3-21) 

In the improved MACCS model, plume rise under stable atmospheric conditions (stability classes 
E and F) is calculated using a slightly modified version of the above equation: 

𝛥ℎ = 2.4 [
𝐹

𝑢̅𝑆
]

1
3
  (3-22) 

In Equations (3-21) and (3-22), the stability parameter, S, is defined as follows: 

S = stability parameter (s-2) defined by the following equation: 

𝑆 =
𝑔

𝑇𝑎
[
𝜕𝑇𝑎

𝜕𝑧
+

𝑔

𝑐𝑝
]  (3-23) 

Where 

g = acceleration due to gravity (9.8 m/s2) 

𝑇𝑎 = ambient temperature (K) 
𝜕𝑇𝑎

𝜕𝑧
 = ambient temperature lapse rate (K/m) 

𝑐𝑝 = heat capacity of air at constant pressure (J/kg/K) 
𝑔

𝑐𝑝
 = dry adiabatic lapse rate (0.98 K/100 m = 0.0098 K/m) 
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Regulatory Guide 1.23 (NRC, 1972) specifies ranges for temperature lapse rates (𝜕𝑇𝑎 𝜕𝑧⁄ ) for the 
six atmospheric stability classes A through F.  The values of the stability parameter S used in 
MACCS were derived using midpoint values for these lapse-rate ranges.  The lapse rate ranges 
specified for Stability Classes E and F are -0.5 K/100 m to 1.5 K/100 m and 1.5 K/100 m to 
4.0 K/100 m.  Thus, Class E has a lapse rate range midpoint of 0.5 K/100 m and Class F a 
midpoint of 2.75 K/100 m.  Substitution of these midpoint values and the International Civil 
Aviation Organization standard atmosphere (West, 1972) value of 288.16 K (15°C) into 

Equation (3-13) results in values of 5.04  10-4 s-2 and 1.27  10-3 s-2 for the stability parameter S 
for Stability Classes E and F, respectively.  

Because near-surface wind speeds generally increase with altitude, Equations (3-19) through 
(3-22)  overestimate plume rise if surface wind speeds are used to calculate ∆h.  Since this could 
underestimate radiation exposures, for purposes of calculating plume rise, wind speeds aloft are 
estimated from surface wind speeds using the following equation (Hanna, 1982): 

𝑢 = 𝑢0 (
ℎ

ℎ𝑟
)

𝑝

  (3-24) 

Where 

𝑢0 = surface wind speed measured at the reference height, ℎ𝑟 (usually 10 m above 
ground level) 

p = exponential coefficient (dimensionless), which depends on stability class and 
surface roughness. Values are provided in Table 3-33. 

Table 3-33 Values of exponential coefficient, p, in Equation (3-24) for six stability classes. 

Stability class A B C D E F 

Urban Surfaces 0.15 0.15 0.20 0.25 0.40 0.60 

Rural Surfaces 0.07 0.07 0.10 0.15 0.35 0.55 

 

To calculate plume rise, the weather conditions that characterize the time at which release of the 
plume segment begins are used to calculate the entire rise of the segment.  In other words, 
transitions in stability class and wind speed are not considered for the purpose of plume rise 
(e.g., a buoyant plume segment released at 1:59 PM would have its entire rise calculated using 
1:00 PM weather). 

In MACCS, plume rise is calculated in three steps.  First, the surface wind speed u0 and one of 
the Equations (3-19) through (3-22), as appropriate, are used to make a first-order estimate of 
the final centerline height (h) of the plume segment after plume rise has taken place (ℎ = ℎ0 + 𝛥ℎ), 
where h0 is the initial release height of the plume segment.  Then the wind speed u at the height 
h is calculated using Equation (3-24).  Finally, an average wind speed over this range is estimated 
by averaging u0, the reference wind speed, and u, the wind speed at the first-order estimate of the 
final height of the plume centerline.  This average value of u is used in Equations (3-19) through 

(3-22) to make a second-order estimate of the amount of plume rise, h, which is used to evaluate 
the final plume centerline height of the plume segment, h.  

The individual numerical coefficients used by these models are fixed in the code with no provision 
for their convenient modification by the user. While it is not possible for the user to vary the 
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individual coefficients used by the three components of the plume rise model, it is possible to 
modify the end results by specifying linear scaling factors, SCLCRW, SCLADP, and SCLEFP.  

Two optional sets of inputs are available in MACCS to determine plume buoyancy.  When Power 
Model is selected on the Plume/Source tab (specified via the MACCS parameter PLMMOD), the 

plume buoyancy is calculated using the rate of release of sensible heat content in a plume (𝑄̇ in 
the equations above).  In some cases, it is simpler for the user to estimate the rate of mass release 
and the density of a plume segment rather than the rate of release of sensible heat. The second 
option, the Density and Flow Model, allows these values to be specified in place of the rate of 
release of sensible heat.  The required values, plume density and mass flow rate, are related to 
the buoyancy flux, F, by the following formula: 

𝐹 =
𝑔

𝜋
(1 −

𝜌

𝜌𝑎
)

𝑚̇

𝜌
  (3-25) 

Where 

g = acceleration due to gravity (9.8 m/s2) 

𝜌 = mass density of the plume (kg/m3) 

𝜌𝑎 = mass density of surrounding air at ambient conditions (1.178 kg/m3 for standard 
atmospheric conditions) 

𝑚̇ = mass flow rate of the plume (kg/s) 

Equation (3-25) can be used to account for release of gases that are lighter than air, such as 
hydrogen and steam, as well as releases at elevated temperatures.  Generally, the presence of 
aerosols can be neglected when plume density and flow rate are calculated. 

 Release Description 

Release Info Form 

The Release Info form allows the user to describe the source term and other ATMOS input 
parameters through MACCS parameter ATNAM2.  This identifying information is printed in the 
output file. 

OALARM is used as a reference time that provides user flexibility should it be desirable to shift 
the entire response timeline. It is important to note that response actions cannot occur before 
OALARM.   Traditionally it has been used to define the time at which the public is notified, which 
could either be aligned with the declaration of site area emergency or general emergency.  
However, it’s use is very flexible and there is no requirement to align it with the declaration of 
either of these emergency levels.  The user should be aware that whatever time is assigned to 
OALARM has implications for other delays discussed subsequently.  
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Figure 3-39 Release Information Form 

Table 3-34 Release Information Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

ATNAM2 Yes Character None 1 to 80 characters 

OALARM Yes Real None 0. to 2,592,000. s (30 d) 

 

Plume of Maximum Risk Form 

The Plume of Maximum Risk form is required when Multi Source Term is not selected on the 
Plume/Source tab.  

MAXRIS specifies which plume segment is to be considered risk dominant.  The selection of this 
plume segment is usually based on its potential for causing early fatalities.  Selecting a value is 
not always obvious, but the user should select a plume segment with relatively large release 
fractions that occurs early in the overall release timing.  Release of the risk-dominant plume is 
aligned with the first hour of the selected weather sequence.  The upper limit on this parameter, 
NUMREL, is defined below.  
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Figure 3-40 Plume of Maximum Risk Form 

Table 3-35 Plume of Maximum Risk Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

MAXRIS Yes Integer None 1 to NUMREL 

 

Plume Parameters Form 

The Plume Parameters form is required when Multi Source Term is not selected on the 
Plume/Source tab. It contains four parameters that define the timing of plume segments and the 
initial release height.  

NUMREL defines the number of plume segments that are released.  This value is determined by 
the number of rows in the grid containing values of PDELAY, PLHITE, REFTIM, and PLUDUR.  

PDELAY specifies the start time of each plume segment from the time of reactor scram, which is 
usually the time of accident initiation.  Sequential, overlapping, and gaps between plume 
segments are allowed.  

PLHITE specifies the height above ground level at which each plume segment is released. 

REFTIM specifies the representative location for each plume segment (e.g., 0.0 = leading edge, 
0.5 = midpoint, 1.0 = trailing edge).  This parameter allows the user to locate the contents of the 
plume in a bucket of material situated at some point along the plume segment.  Radioactive decay, 
dry deposition, and dispersion are all calculated as if the entire contents of the plume segment 
were located at this point.  The choice of this parameter has no impact on the wet deposition 
calculations since those are performed as if the entire contents of the plume are uniformly 
distributed along its length.  

PLUDUR specifies the duration of each plume segment.  
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Figure 3-41 Plume Parameters Form 

Table 3-36 Plume Parameters Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUMREL Linked Integer None 1 to 500 

PDELAY Yes Real NUMREL 0.0 to 2,592,000 s (30 d) 

PLHITE Yes Real NUMREL 0.0 to 1000.0 

REFTIM Yes Real NUMREL 0.0 to 1.0 

PLUDUR Yes Real NUMREL 60.0 to 86,400.0 s (1 min to 1 d) 

 

Particle Size Distribution Form 

The Particle Size Distribution form is required when Multi Source Term is not selected on the 
Plume/Source tab. It defines the aerosol-size distribution for each chemical group in the analysis.  

PSDIST defines the fraction of the released material allocated to each of the particle-size 
(deposition-velocity) groups.  The initial particle-size distribution for a chemical group is the same 
for all plume segments.  The deposition velocity (VDEPOS) is shown as the column header.  
There are NSPGRP columns (taken from the number of particle size groups in the Dry Deposition 
form) and MAXGRP rows (taken from the number of chemical groups in the Chemical Names 
form).  The fractions across a row (over the set of size groups) must sum to approximately 1.0. 
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Figure 3-42 Particle Size Distribution Form 

Table 3-37 Particle Size Distribution Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

PSDIST Yes Real MAXGRP by NSPGRP 0.0 to 1.0 

 

Inventory Scale Factor Form 

The Inventory Scale Factor form is required when Multi Source Term is not selected on the 
Plume/Source tab. CORSCA, the only parameter on this form, is a linear scaling factor that can 
be used to adjust the inventory of all the radionuclides defined in the model.  This factor is useful 
for modeling similar reactors with different power ratings.  

It is preferable to obtain new sets of inventory values when studying reactors with different power 
ratings, fuel burnup levels, or fuel management histories, but this is not always practical.  When 
facility-specific inventories are not available, a representative inventory may be obtained by linear 
scaling of the inventory of a similar reactor having a different thermal power level.  The scale 
factor is usually chosen to be the ratio of the two reactors' thermal power levels. 
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Figure 3-43 Inventory Scale Factor Form 

Table 3-38 Inventory Scale Factor Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

CORSCA Yes Real None 2.7×10-10 to 1016 

 

Daughter Ingrowth Flag Form 

The Daughter Ingrowth Flag form is required when Multi Source Term is not selected on the 
Plume/Source tab. APLFRC, the only parameter on this form, specifies how release fractions are 
applied to decay products.  PARENT indicates that decay products formed after reactor shutdown 
are released in the same fraction as their parent; PROGENY indicates decay products formed 
after reactor shutdown are released according to their own chemical group. PARENT is preferred 
when using MELCOR data because MELCOR does not account for radioactive decay and 
ingrowth. 
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Figure 3-44 Daughter Ingrowth Flag Form 

Table 3-39 Daughter Ingrowth Flag Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

APLFRC Yes Character None PARENT, PROGENY 

 

Release Fractions Form 

The Release Fractions form is required when Multi Source Term is not selected on the 
Plume/Source tab.  RELFRC defines the release fraction for each of the plume segments and for 
each chemical group.  Each row represents one of the plume segments declared on the Plume 
Parameters form.  All radionuclides in a chemical group are released from the facility in the same 
fraction.  Normally, the values of RELFRC summed over the set of plume segments should not 
exceed 1.0, but this requirement is not imposed by either WinMACCS or MACCS.  
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Figure 3-45 Release Fractions Form 

Table 3-40 Release Fractions Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

RELFRC Yes Real NUMREL by MAXGRP 0.0 to 1.0 

 

Wake Effect Data Form 

The Wake Effect Data form is required when Multi Source Term is not selected on the 
Plume/Source tab. BUILDH defines the height of the facility building or building complex.  This 
value is used to evaluate whether a buoyant plume is entrained in the turbulent wake of the 
building based on Equation (3-17).  

SIGYINIT defines the initial value of sigma-y for each plume segment released. 

SIGZINIT defines the initial value of sigma-z for each plume segment released. 
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Figure 3-46 Wake Effect Data Form 

Table 3-41 Wake Effect Data Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

BUILDH Yes Real NUMREL 0.1 to 1000.0 m 

SIGYINIT Yes Real NUMREL 0.1 to 1000.0 m 

SIGZINIT Yes Real NUMREL 0.1 to 1000.0 m 

 

Heat Form 

The Heat form is required when the Power Model is selected on the Plume Rise tab and Multi 
Source Term is not selected on the Plume/Source tab.  The values are used to determine buoyant 
plume rise.  

PLHEAT specifies the rate of release of sensible heat in each plume segment.  This quantity is 
traditionally calculated based on the difference between the plume and ambient temperatures, 
the heat capacity of air, and the flow rate of the plume.  This value is used to determine the amount 
of buoyant plume rise. 
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Figure 3-47 Bouyancy by Heat Form 

Table 3-42 Bouyancy by Heat Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

PLHEAT Yes Real NUMREL 0.0 to 1010 W 

 

Density and Flow Form 

The Density and Flow form is required when the Density and Flow Model is selected on the Plume 
Rise tab and the Multi Source Term is not selected on the Plume/Source tab.  The values on this 
form are used to determine the amount of buoyant plume rise.  This formulation is more general 
and sometimes more convenient than specifying rate of release of sensible heat, although these 
values are ultimately converted to buoyancy fluxes and those values are used in the same way 
as buoyancy fluxes derived from PLHEAT in calculating plume rise.  This implies that one could 
derive values of PLHEAT that are exactly equivalent to the values from the density and flow 
model.  

PLMFLA is the average mass flow rate for a plume segment. 

PLMDEN is the average gas density for a plume segment. 
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Figure 3-48 Bouyancy by Density and Flow Form 

Table 3-43 Bouyancy by Density and Flow Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

PLMFLA Yes Real NUMREL 10-6 to 1032 kg/s 

PLMDEN Yes Real NUMREL 0.02 to 5.0 kg/m3 

 

 Weather 

 Weather Model Description 

There are five options available to the user for specifying the weather data that are used by 
ATMOS.  MACCS can run either a single weather sequence or multiple weather sequences, as 
described in the following paragraphs.  

When a single weather sequence is desired, there are three ways to specify the weather data.  
The user can (1) specify data for 120 hr, (2) specify a starting day and time period in the weather 
data file, or (3) specify constant weather conditions. 

For the specified starting day and time period option, weather data are taken from the 
meteorological data file beginning at the specified day and time. A file of weather data covering a 
period of 365 days (8760 hr) is required.  The file can be defined to have 15 min, 30 min, or 1 hr 
time periods.  
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The two methods of weather sampling are (1) a modified version of the weather bin sampling 
method used in CRAC2 (Ritchie et al., 1984) and (2) a stratified, random sampling approach. The 
weather bin sampling method sorts weather sequences into categories and assigns a probability 
for each category, depending on the number of data points that fit into that category.  The 
categories (i.e., bins) are defined by ranges of wind speeds paired with stability class or by the 
occurrence of rain.  The rain bins depend on rain intensity as well as the downwind distance at 
which rain begins.  The user is required to supply the parameters that define the rain bins as part 
of the ATMOS input file.  The definitions of the weather bins that depend on stability class and 
wind speed are fixed in the code and are defined in the output file.  

The stratified random sampling method allows the user to sample weather from each day of the 
year.  For each day, a user-defined number of samples are selected randomly.  Because of the 
way the samples are selected, each weather sequence has the same probability of occurrence, 
that is, P = 1/(number of samples).  

 Mixing Height Option 

Daytime and nighttime values for mixing height are specified for each of the four seasons in the 
last line of the meteorological data file.  An option is available in MACCS to account for night-to-
day transitions in mixing height.  This is activated by checking the box Adjust mixing height based 
on time of day on the Weather tab.  This option only applies when a meteorological file is used 
(i.e. METCOD = 1, 2, or 5).  

The meteorological file contains 2 sets of 4 values for mixing height at the end of the file.  The 
first set is the morning mixing height values for each of the four seasons.  The second set is 
afternoon mixing height values for each of the four seasons. 

If Adjust mixing height based on time of day is unchecked, only the afternoon mixing heights are 
used. That is, the mixing height only depends on the season for which the calculation is 
performed, not on time of day.  

When Adjust mixing height based on time of day is selected, mixing height is adjusted depending 
on time of day.  This model uses both the morning and afternoon values.  When the start time is 
between sunset and sunrise, the morning value for the appropriate season is used until the first 
hour after sunrise.  At the first hour after sunrise and until the hour of sunset, the maximum mixing 
height is calculated by linearly interpolating between the morning value and the afternoon value 
for that season.  Once the first sunset in the simulation is reached, the afternoon mixing height is 
used until the end of the weather trial.  The mixing height is never allowed to decrease in the 
MACCS treatment because that would violate the second law of thermodynamics.  

Calculations based on time of day require the user to supply the latitude and longitude of the 
accident site.  This is done on the form labeled Site Location.  Sunrise and sunset are calculated 
according to the site latitude. No adjustments are made to account for the east/west location of a 
site within a time zone or for switching to daylight savings time.  Thus, the current version does 
not use the longitude value in the mixing height model.  

 Weather Forms and Parameters 

Constant or Boundary Conditions Form  

The Constant or Boundary Conditions form is required. This form allows the user to specify 
constant weather (METCOD = 4) or boundary weather conditions (METCOD = 1, 2, 3, or 5). 
Boundary weather is implemented when the radial interval greater than the value specified by 
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LIMSPA is entered by a plume segment. Boundary weather allows the user to prescribe simple, 
constant weather conditions (in place of measured or simulated weather conditions taken from 
the meteorological data file) in the outer portion of the computational grid.  This has traditionally 
been used to implement boundary rain, one purpose of which is to prevent the aerosols from 
escaping the grid. Using boundary rain tends to force a conservative result.  A more realistic result 
can be obtained by setting LIMSPA = NUMRAD so that real weather data are used all the way to 
the edge of the grid.  A second reason to use boundary weather is that the mean time between 
precipitation events is on the order of 10 days, so precipitation is likely to occur during the 
transport of a plume through a MACCS grid when the grid is large (e.g., 1600 km). At longer 
distances, precipitation may not be correlated with precipitation at the origin of the MACCS grid. 
Boundary weather can be used to force precipitation to occur before plume segments exit the 
grid.  

BNDMXH is the mixing layer height that is used for the constant weather conditions (METCOD = 
4). Mixing height is determined separately for all other values of METCOD and this value is not 
used.  

IBDSTB is the stability class that is used for constant and boundary weather conditions. The 
integers 1 through 6 represent Pasquill-Gifford stability classes A through F, respectively. 

BNDRAN is the rain rate that is used for the constant and boundary weather conditions. 

BNDWND is the wind speed that is used for constant and boundary weather conditions. 

 

Figure 3-49 Constant or Boundary Conditions Form 
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Table 3-44 Constant or Boundary Conditions Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

BNDMXH Yes Real None 100.0 to 10,000.0 m 

IBDSTB Yes Integer None 1 to 6 

BNDRAN Yes Real None 0 .0 to 99.0 mm/hr 

BNDWND Yes Real None 0.5 to 30.0 m/s 

 

Fixed Start Time Data Form 

The Fixed Start Time Data form is required when Constant Weather, User Supplies 120 Weather 
Points, or Fixed Start Time is selected on the Weather tab.  For the first option, the start time is 
only used in conjunction with the COMIDA2 food-chain model.  However, MACCS requires these 
input parameters even when the COMIDA2 food-chain model is not used.  

ISTRDY is the day of the year when the weather sequence begins. 

ISTRHR is the starting time period of the weather trial.  A 24-hour day is divided into 15-, 30-, or 
60-minute time periods in the meteorological file, depending on the value of PERIOD in the 
meteorological data file.  These divisions correspond to 96 time periods per day, 48 time periods 
per day, or 24 time periods per day, respectively.  Table 3-45 contains the ranges of ISTRHR 
enforced by MACCS. 

Table 3-45 ISTRHR Allowable Ranges 

Allowed Range of ISTRHR Data Interval Third line of 
meteorological file 

1 to 24 60 minutes /PERIOD 60 (default) 

1 to 48 30 minutes /PERIOD 30 

1 to 96 15 minutes /PERIOD 15 

 

Additionally, the food pathway calculations of the CHRONC module depend on the day the 
accident occurs when the COMIDA2 food-chain model is used.  If the user has chosen the Fixed 
Start Time option, the values of ISTRDY and ISTRHR specify the starting day and time period in 
the weather file of the single weather trial that is performed.  This time point in the weather file is 
aligned with the release of the MAXRIS plume segment.  
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Figure 3-50 Fixed Start Time Data Form 

Table 3-46 Fixed Start Time Data Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

ISTRDY Yes Integer None 1 to 365 

ISTRHR Yes Integer None 1 to 96 

 

User-Supplied Weather Form 

The User-Supplied Weather form is required when User Supplies 120 Weather Points is selected 
on the Weather tab.  There must be one data record for each hour of weather in the sequence. 
Shorter time periods for meteorological data are not supported on this form.  

HRMXHT is the set of mixing layer heights that is used.  The user can provide mixing heights in 
a general fashion in the input, but MACCS only allows HRMXHT to increase in the implementation 
of the Gaussian model to avoid unphysical plume behavior (i.e., to allow air concentration to 
increase at some downwind location).  The user must supply 120 values, one per hour.  

IHRSTB defines the list of stability classes that are used.  The integers 1 through 6 represent the 
Pasquill-Gifford stability classes A through F, respectively.  The user must supply 120 values, one 
per hour. 

HRRAIN defines the list of rain rates that are used.  The user must supply 120 values, one per 
hour. 

HRWNDV defines the list of wind speeds that are used.  The user must supply 120 values, one 
per hour. 
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IHRDIR defines the list of wind directions that are used.  They are given as integers corresponding 
to each of the compass directions starting with north (1) and ending with the direction just to the 
west of north.  The user must supply 120 values, one per hour. 

 

Figure 3-51 User-Supplied Weather Form 

Table 3-47 User-Supplied Weather Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

HRMXHT Yes Real 120 100.0 to 10,000.0 m 

IHRSTB Yes Integer 120 1 to 6 

HRRAIN Yes Real 120 0.0 to 99.0 mm/hr 

HRWNDV Yes Real 120 0.5 to 30.0 m/s 

IHRDIR Yes Integer 120 1 to NUMCOR 

 

Site Location Form 

The Site Location form is required when Adjust mixing height based on time of day is selected on 
the Weather tab. The user must also specify the latitude and longitude of a site when map files 
need to be generated with MapGen, which allows maps to be displayed behind speed multiplier 
and network evacuation forms.  

The latitude and longitude of a site can be found on a site file generated by SecPop as a comment 
line; however, this information must be entered manually because WinMACCS does not read this 
comment line from a site file.  

LATITU_DEG, LATITU_MIN, and LATITU_SEC represent the degrees, minutes, and seconds of 
the latitude. These values are used to calculate the time of sunrise and sunset. 
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LATITU_DIREC indicates hemisphere, N(North) or S(South). 

LONGIT_DEG, LONGIT_MIN, and LONGIT_SEC represent the degrees, minutes, and seconds 
of the longitude.  

LONGIT_DIREC indicates hemisphere, E(East) or W(West). 

 

Figure 3-52 Site Location Form 

Table 3-48 Site Location Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

LATITU_DEG Yes Real None 0.0 to 90.0˚ 

LATITU_MIN Yes Real None 0.0 to 60.0′ 

LATITU_SEC Yes Real None 0.0 to 60.0″ 

LATITU_DIREC Yes Character None N, S 

LONGIT_DEG Yes Real None 0.0 to 180.0˚ 

LONGIT_MIN Yes Real None 0.0 to 60.0′ 

LONGIT_SEC Yes Real None 0.0 to 60.0″  

LONGIT_DIREC Yes Character None E, W 
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Samples per Bin Form 

The Samples per Bin form is required when Uniform Bin Sampling (METCOD=2) is selected on 
the Weather tab.  The bins are defined to represent rain conditions at different distance intervals 
downwind from the accident site together with 16 bins for initial conditions organized by stability 
class and wind speed.  The rain intensities and distance intervals that define the rain bins are 
chosen by the user.  These values are specified on forms Rain Distances and Rain Intensities. 

The total number of weather bins is determined by the number of rain intensities, NRINTN, and 
the number of rain distances, NRNINT.  These are set in the Rain Distances and Rain Intensities 
forms, respectively.  The total number of weather bins is NRNINT•(NRINTN+1)+16.  The total 
number of bins can range from 28 to 40, depending on the number of rain distances and intensities 
supplied by the user.  The 16 initial weather bins are fixed in MACCS according to the definitions 
given in Table 3-49. 

Table 3-49 Definition of the 16 standard weather bins in MACCS. 

Bin number Stability Class Wind Speed 

1 A/B 0 m/s < u  3 m/s 

2 A/B 3 m/s < u 

3 C/D 0 m/s < u  1 m/s 

4 C/D 1 m/s < u  2 m/s 

5 C/D 2 m/s < u  3 m/s 

6 C/D 3 m/s < u  5 m/s 

7 C/D 5 m/s < u  7 m/s 

8 C/D 7 m/s < u 

9 E 0 m/s < u  1 m/s 

10 E 1 m/s < u  2 m/s 

11 E 2 m/s < u  3 m/s 

12 E 3 m/s < u 

13 F 0 m/s < u  1 m/s 

14 F 1 m/s < u  2 m/s 

15 F 2 m/s < u  3 m/s 

16 F 3 m/s < u 

 

NSMPLS defines the number of weather sequences to be chosen from each of the individual bins.  
The more samples that are taken, the better is the statistical representation of the results.  The 
actual number of samples taken from a weather bin is the minimum of the number of time periods 
in the bin and the number of NSMPLS.  
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Table 3-50 Range of Weather Sequence Samples 

Range for NSMPLS 

(365 x number time periods per day) 

Weather Data 
Time Interval 

Third Line of 
Meteorological File 

1 to 8760  60 minutes /PERIOD 60 (default) 

1 to 17520 30 minutes /PERIOD 30 

1 to 35040 15 minutes /PERIOD 15 

 

 

Figure 3-53 Samples per Bin Form 

Table 3-51 Samples per Bin Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NSMPLS Yes Integer None 0 to 35040 

 

Samples per Day Form 

Samples per Day is required when Stratified Random Sampling (METCOD=5) is selected on the 
Weather tab.  

NSMPLS defines the number of weather sequences to be chosen from each day of the year. 
Table 3-52 contains the range of NSMPLS enformed by MACCS. 

Table 3-52 Range of Weather Sequences 

Range for NSMPLS Data Interval Third Line of Meteorological File 

1 to 24 60 minutes /PERIOD 60 (default) 

1 to 48 30 minutes /PERIOD 30 

1 to 96 15 minutes /PERIOD 15 
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Although not enforced by MACCS or WinMACCS, NSMPLS should be set to be a factor of 24 
when the meteorological data are hourly (i.e., 1, 2, 3, 4, 6, 8, 12, or 24), a factor of 48 when there 
is one record of data for every 30 minutes, or a factor of 96 when there is one record of data for 
every 15 minutes.  This is because the sampling algorithm begins by dividing each day up into 
NSPLS time intervals.  One sample is selected randomly from each time interval.  For example, 
if NSPLS is 4 and hourly weather data are specified, each day is divided into 4 6-hr intervals. 
MACCS selects a single random starting time from each of these 4 intervals.  Because the 
duration of each of the intervals is the same, each of the trials is equally probable.  Selecting an 
integer that is not a factor causes some of the time intervals to be longer than others and leads 
to a bias in the sampling algorithm.  

 

Figure 3-54 Samples per Day Form 

Table 3-53 Samples per Day Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NSMPLS Yes Integer None 1 to 96 

 

Seed Form 

Seed is required when any of the sampling options (METCOD=2 or 5) is selected on the Weather 
tab.  

IRSEED defines the seed of the random number generator. Changes to this value cause different 
weather trials to be selected. 
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Figure 3-55 Seed for Weather Sampling Form 

Table 3-54 Seed for Weather Sampling Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

IRSEED Yes Integer None 0 to 255 

 

Boundary Limit Form 

The Boundary Limit form is required when anything but Constant Weather (METCOD=4) is 
selected on the Weather tab. 

LIMSPA is the limiting spatial interval for using recorded weather data. Spatial intervals greater 
than with this value use the boundary weather conditions specified on form Constant or Boundary 
Conditions.  Boundary weather conditions are applied to all spatial intervals when a value of 0 is 
specified for this parameter.  No boundary weather is employed when LIMSPA = NUMRAD.  
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Figure 3-56 Limiting Spatial Interval Form 

Table 3-55 Limiting Spatial Interval Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

LIMSPA Yes Integer None 0 to NUMRAD 

 

Bins Form 

The Bins form is required when Nonuniform Bin Sampling (METCOD=2, NSMPLS=0) is selected 
on the Weather tab.  Sampling a subset of all the weather bins allows the effects of weather type 
to be examined.  This is accomplished by setting INWGHT to zero for one or more of the bins.  
Another option for examining the importance of various weather bins is to set the RISCAT flag to 
True, as described below in the section on EARLY. 

NSBINS defines the number of bins from which weather sequences are to be chosen. Its value is 
determined by the number of rows in the grid containing values of INDXBN and INWGHT. 
However, the user should ensure that the number of bins is consistent with the value of 
NRNINT•(NRINTN+1) +16.  WinMACCS does not perform a consistency check on NSBINS, but 
MACCS does perform this check and issues an error message when it is inconsistent.  

INDXBN defines the list of bins from which weather sequences are to be selected when 
nonuniform bin sampling is chosen. Indices are reported in the MACCS output under 

METEOROLOGICAL BIN SUMMARY.  MACCS requires that the range of values is 1  value  
NSBINS. The total number of bins depends on the rain distances and intensities supplied by the 
user, as described above. 

INWGHT defines the number of weather sequences to be selected from each weather bin. If this 
number exceeds the number of sequences in the specified bin, the code selects all the sequences 
in that bin. To find the index number for a rain bin, refer to the output titled METEOROLOGICAL 
BIN SUMMARY.  MACCS requires that the sum of the values of INWGHT must be greater than 
or equal to one. Table 3-56 contains the range of INWGHT enforced by MACCS. 
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Table 3-56 Ranges for INWGHT 

Range for INWGHT Data Interval Third line of 
meteorological file 

1 to 8760  60 minutes /PERIOD 60 (default) 

1 to 17520 30 minutes /PERIOD 30 

1 to 35040 15 minutes /PERIOD 15 

 

 

Figure 3-57 Bins Form 

Table 3-57 Bins Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NSBINS Linked Integer None 1 to 40 

INDXBN Yes Integer NSBINS 1 to 40 

INWGHT Yes Integer NSBINS 0 to 35040 
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Rain Distances Form 

The Rain Distances form is required when either Uniform Bin Sampling (METCOD=2) or 
Nonuniform Bin Sampling (METCOD=2, NSMPLS=0) is selected on the Weather tab.  

NRNINT defines the number of rain distance intervals used for weather binning.  The value is 
determined by the number of entries in vector RNDSTS. 

RNDSTS defines the rain distance interval endpoints used for the weather binning.  MACCS 
requires that each of these distances lie within 10% of one of the spatial-interval endpoint 
distances, SPAEND, and that the user supply unique values in ascending order. 

For example, if the user specifies 2, 4, 8, and 16 km, these values define the following four rain 
distance intervals: 

(1). 0 km  distance of first rain occurrence  2 km 

(2). 2 km < distance of first rain occurrence  4 km 

(3). 4 km < distance of first rain occurrence  8 km 

(4). 8 km < distance of first rain occurrence  16 km. 

Rain that occurs beyond 16 km in this example is not categorized as being in a rain bin.  These 
weather sequences are categorized under the 16 bins defined in Table 3-49. 

 

Figure 3-58 Rain Distances Form 
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Table 3-58 Rain Distances Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NRNINT Linked Integer None 4 to 6 

RNDSTS Yes Real NRNINT 0.001 to 99.9 km 

 

Rain Intensities Form 

The Rain Intensities form is required when either Uniform Bin Sampling (METCOD=2) or 
Nonuniform Bin Sampling (METCOD=2, NSMPLS=0) is selected on the Weather tab.  The user 
must specify either two or three rain intensities that are used as breakpoints in the categorization 
of precipitation rate.  For example, if the user specifies two rain intensity breakpoints of 1 and 4 
mm/hr, the following three rain intensity intervals, where x is the rain intensity, are used: 

(1). 0 mm/hr < x  1 mm/hr 

(2). 1 mm/hr < x  4 mm/hr, 

(3). 4 mm/hr < x. 

NRINTN defines the number of rain intensity breakpoints to be used for weather binning.  

RNRATE defines the rain intensity breakpoints. MACCS requires that unique values are supplied 
in ascending order. 

 

Figure 3-59 Rain Intensities Form 
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Table 3-59 Rain Intensities Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NRINTN Linked Integer None 2 to 3 

RNRATE Yes Real NRINTN 0.001 to 100.0 mm/hr 

 

 Output Control 

When requested by the user, the ATMOS module generates outputs for ten atmospheric modeling 
results for user-specified distances and plume segments, as listed in Table 3-60.  Air and ground 
concentrations are reported for the radionuclide specified by the parameter NUCOUT.  In addition, 
the total activity on the ground (from all radionuclides) is reported.  Within a single run of the code, 
there is no provision for generating CCDFs of air and ground concentrations for multiple individual 
radionuclides.  When such outputs are needed, separate MACCS runs are required to produce 
results for each radionuclide.  

Table 3-60 Results available from ATMOS in statistical form. 

Selected Radionuclide Centerline Air Concentration (Bq∙s/m3) 

Selected Radionuclide Ground-Level Air Concentration (Bq∙s/m3) 

Selected Radionuclide Centerline Ground Concentration (Bq/m2) 

Total Centerline Ground Concentration (Bq/m2) 

Ground-Level /Q Dispersion Factor (s/m3) (Undepleted) 

Selected Radionuclide Adjusted Source Strength, Qa (Bq) 

Plume y, Crosswind Dispersion Parameter (m) 

Plume z, Vertical Dispersion Parameter (m) 

Plume Centerline Height (m) 

Plume Arrival Time at CenterPoint (s) 

 

In the Gaussian plume equations, Q is commonly used to represent the amount released activity. 
When material decays or is deposited onto the ground during transport, the effective source 
strength for downwind distances is reduced.  This is treated in MACCS through the definition of 
an adjusted source strength, Qa, which is reduced by deposition and radioactive decay that occur 
over plume trajectory up to the current location.  Note that all the concentration results shown in 

this table account for plume depletion; however, the value for /Q does not.  This quantity simply 
represents the normalized concentration (s/m3) from dispersion at a downwind distance.  

 Output Forms and Parameters 

Output Control Form 

The Output Control form is required.  The user has the option of printing tables of dispersion data 

for all the trials that are performed.  This information includes air and ground concentrations, y 

and z values, arrival time, and time overhead for each plume segment at each spatial interval.  
These data are written to the output file. 
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The following parameters can be written to the output file using the parameter IDEBUG. 

Table 3-61 Additional ATMOS output information. 

NUCNAM name of the radionuclide for which results are reported  

DISTANCE distance from the point of release to the center of the spatial interval (m) 

GL AIRCON centerline ground-level time-integrated air concentration from this plume segment 
averaged over the spatial interval (Bq∙s/m3) 

GRNCON centerline ground concentration after passage of this plume averaged over the spatial 
interval (Bq/m2) 

GL /Q centerline ground-level /Q, the ratio of time-integrated air concentration () to source 
strength (Q), averaged over the spatial interval (s/m3). Values reported do not account 
for plume depletion by deposition or radioactive decay. 

WETREM fraction of material remaining in the plume segment after wet deposition along the 
plume trajectory up to the current location (dimensionless) 

DRYREM fraction of material remaining in the plume segment after dry deposition along the 
plume trajectory up to the current location (dimensionless) 

REMINV adjusted source strength of the plume accounting for losses over the plume trajectory 
from radioactive decay and wet and dry deposition (Bq) 

PLSIGY crosswind dispersion parameter, y, at the current location (m) 

PLSIGZ vertical dispersion parameter, z, at the current location (m) 

WEATHER indices to the first and last hours of the weather sequence used for determining 
atmospheric conditions during transport across each spatial interval 

HTFCTR ratio of the centerline ground-level air concentration (z=0) to the plume centerline air 
concentration (z=H), (dimensionless) 

AVGHIT average height (H) of the plume as it traversed the spatial interval (m) 

TIMCEN time after reactor shutdown at which the leading edge of the plume arrived at the 
current location (s) 

TIMOVH duration for which the plume was overhead at the current location (s) 

MXMIXH mixing height during plume passage through the current location (m)  

 

IDEBUG specifies the quantity of debug output to be printed.  For normal runs, IDEBUG should 
be set to 0 and no debug output is printed.  If IDEBUG is set to 1 or 2, detailed results for 
atmospheric transport are generated for each weather trial and each plume segment. If IDEBUG 
is set to a value of 3 or more, the meteorological data used for each weather trial are also printed.  

NUCOUT specifies which radionuclide is reported in the dispersion results.  Debug results are 
only reported if IDEBUG is greater than zero.  The specified radionuclide name must be in the 
previously defined list of radionuclides. 
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Figure 3-60 ATMOS Output Control Form 

Table 3-62 ATMOS Output Control Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

IDEBUG Yes Integer None -1 to 8 

NUCOUT Yes Character None Must be a radionuclide 
defined in vector NUCNAM 

 

Spatial Intervals for Output Form 

There are two Spatial Intervals for Output forms. The first one is used if Multi Source Term is not 
selected in the Properties form. The second one is used if Multi Source Term is selected.  The 
Spatial Intervals for Output form is optional. 

NUM0 specifies the number of results.  For each request, a set of ten results describing 
atmospheric transport and dispersion is reported. The value of NUM0 is determined by the 
number of rows in the grid containing values of vectors INDREL, INDRAD, and Report Options. 

INDREL specifies the index of the plume segment for which results are to be reported. 

INDRAD specifies the index of the radial grid element for which results are to be reported.  The 
reported values are evaluated at the radial midpoint of the grid element by averaging the results 
at the grid boundaries. 

When Report Options are set to CCDF or CCDF & REPORT, the complementary cumulative 
distribution function data are reported in the MACCS output file.  When set to REPORT or CCDF 
& REPORT, WinMACCS automatically generates a report over all realizations based on the 
quantile values specified on the Reporting Options form. 



 

3-94 

 

Figure 3-61 Spatial Intervals for Output Form 

Table 3-63 Spatial Intervals for Output Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUM0 Linked Integer None 0 to 35 

INDREL Yes Integer None 1 to NUMREL 

INDRAD Yes Integer NUM0 1 to NUMRAD 

Report Options Yes Character NUM0 CCDF, NONE, REPORT, 
CCDF & REPORT 

 

3.3 EARLY Input and Model Description 

 Overview of EARLY 

The EARLY module models the period starting with accident initiation.  This period is commonly 
referred to as the emergency phase. It may extend up to 40 days after the arrival of the first plume 
segment at any downwind spatial interval.  The subsequent intermediate and long-term phases 
are treated by CHRONC.  

In the EARLY module the user may specify emergency response scenarios that include 
evacuation, sheltering, and dose-dependent relocation.  The EARLY module has the capability to 
combine results from one to twenty different emergency response cohorts.  The number of cohorts 
is specified on the Evac/Rotation tab found on the GENERAL main category under Properties in 
WinMACCS.  
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Results are output for each of the user-defined emergency response cohorts and for a weighted 
sum of the cohorts. Cohorts may be combined by assigning time fractions (frequencies of 
occurrence) to each cohort, population fractions (fraction of the population engaging in the 
specified behavior) to each cohort, or by a simple summation of the results for each emergency 
response cohort (when a unique population distribution is defined for each cohort). The weighting 
method is specified from the Project/Site Data tab. 

CCDFs calculated for emergency response cohorts combined based on time fractions are a 
function of the probability for each meteorological trial/wind direction multiplied by the time fraction 
applied to the emergency response cohort.  This assumes that all the population behaves like 
each of the cohorts some fraction of the time.  Emergency response cohorts combined using 
population fractions are a function of the consequence calculated for each meteorological 
trial/wind direction multiplied by the fraction of people assigned to the cohort.  This assumes that 
the population is divided into a set of responses, but those responses apply all of the time.  The 
approach selected (fraction of people or fraction of time) affects the shape of the CCDF but does 
not affect the mean consequences. 

For results that are calculated by both EARLY and CHRONC, such as population dose and cancer 
cases, the consequence calculated by CHRONC is added to the value of the same consequence 
measure produced by EARLY to generate the overall combined results.  When more than one 
EARLY emergency response cohort is being run, these results are combined according to the 
weighting fractions supplied for each scenario parameter WTFRAC.  The weighted sum is 
combined with the CHRONC result to produce the overall result. MACCS models the entire 
population as behaving the same in the CHRONC module, so only one CHRONC cohort exists. 
Whenever multiple cohorts are defined, the output file lists the overall combined results as well 
as results for each of the individual cohorts. 

 Dose Calculation 

The calculation of radiation doses from early exposure considers five pathways: (1) direct external 
exposure to radiation from the plume (cloudshine), (2) exposure from inhalation of radionuclides 
in the cloud (cloud inhalation), (3) exposure to radioactive material deposited on the ground 
(groundshine), (4) inhalation of resuspended material (resuspension inhalation), and (5) skin 
dose from radionuclides deposited onto the skin. 

Two kinds of doses are calculated: (1) acute doses used for estimating occurrences of early 
fatalities and injuries and (2) lifetime doses used for estimating occurrences of cancers resulting 
from the early exposure. The accumulation of radiation doses from early exposure is strongly 
dependent on the assumed emergency response (i.e., evacuation, sheltering, and relocation).  
Cloudshine and cloud inhalation exposures are limited to the time of cloud passage. Groundshine 
and resuspension inhalation doses from early exposure (emergency phase) are limited to the 
duration of the emergency phase. 

In general, the dose equation for an early exposure pathway in each spatial element is the product 
of the following quantities: radionuclide concentration, usage factor, duration of exposure, DCF, 
and shielding or protection factor.  The quantities used in the dose equations depend on the 
exposure pathway.  For example, for the cloud inhalation exposure pathway, these quantities are 
the ground-level air concentration within a spatial element, breathing rate, duration of inhalation, 
inhalation DCF, and inhalation protection factor. 

The DCFs for all exposure pathways are provided in the DCF files distributed with WinMACCS.  
However, the user can modify any of these factors by defining constant or uncertain values in 
WinMACCS.  
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DCFs are selected to be used with MACCS in one of the following three ways: 

• A single, predefined file.  In this case, the LNT model is selected on the Properties/Dose 
tab. Files based on DOSFAC2, FGR-11 and -12, and FGR-13 are distributed with 
WinMACCS. The user selects a file from the WinMACCS GENERAL main category 
under File Specifications/Dose Conversion Factor File. 

• A set of 51 predefined files, a base file and a file for each of the 50 years of dose 
commitment.  In this case, the PL or AT model is selected.  Files of this type based on 
DOSFAC2 and FGR-13 are distributed with MACCS.  The user selects a base file, e.g., 
FGR13DCF.INP, on the form found in the WinMACCS GENERAL main category under 
File Specifications/Annual Differential DCF Files. 

• A single file or 51 files created by WinMACCS based on user input values. In this case, a 
predefined DCF file or files are used as the basis. The source of the DCF file is set to 
Create DCF File on the Properties/Dose tab. Values in the DCF file are modifiable for 
nuclides selected on the DOSE COEFFICIENTS/Reveal Nuclides form.  

A MACCS user has some flexibility in the selection of a DCF file. Files based on (1) DOSFAC2, 
a pre-processer using data from DOE/EH-0070 and tissue weighting factors from ICRP-26 and -
60; (2) based on Federal Guidance Reports 11 and 12, and (3) files based on Federal Guidance 
Report 13 (FGR-13).  The DCF set based on FGR-13 is the most complete and current and is 
recommended for most consequence analyses. 

As a side note, the ICRP traditionally used the term DCFs to refer to coefficients that convert 
activity levels for an exposure pathway to doses.  The newer ICRP term is dose coefficients. In 
this document and in the WinMACCS interface, the two terms are used interchangeably.  

The list of organs that can be used in a calculation depends on which DCF file is selected. 
WinMACCS forms show organ doses with an A- or an L- prefix.  Organ doses beginning with A- 
(e.g., A-SKIN) are used for acute exposure doses in the EARLY module; organ names beginning 
with L- (for example L-THYROID) are lifetime, 50-year doses that are used in both the EARLY 
and CHRONC modules. Acute internal doses from inhalation are calculated over a much shorter 
commitment period than lifetime doses. Because of the shorter commitment period, acute doses 
are less than or equal to lifetime doses for the same organ.  The method used to construct the 
acute doses accounts for dose protraction by weighting internal doses received after the first day 
less heavily than doses received during the first day.  

The DCF files do not use the A- or L- prefix for the organ names.  They contain columns of data, 
some of which correspond to acute doses, some to lifetime doses, and some are used for both. 
The DCFs for acute or lifetime exposures depend on exposure pathway.  

Though SKIN is listed as an organ in the FGRDCF DCF file, the numbers for SKIN in the DCF file 
are not used in the acute exposure calculation for A-SKIN.  Dose to the skin is calculated directly 
in MACCS based on beta energy depositing in the skin from radionuclides that have deposited 
onto the skin.  This is different than the long-term skin dose (L-SKIN), which is calculated using 
values in the FGRDCF file.  To make this distinction clear, the lifetime organ dose is labeled 
L-SKIN(FGR).  

Organ choices shown on MACCS forms depend on the choice of DCF file type selected on the 
Properties/Dose tab.  These choices are shown in Table 3-64.  Organs not included on this list, 
even though present in the DCF files, cannot be used in MACCS version 3.10 calculations 
because the list of organs is hardwired in MACCS version 3.10.  However, MACCS version 3.11.2 
and versions thereafter enables more user flexibility to include other organs.  
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Table 3-64 Organ doses defined in MACCS for each type of DCF file. 

FGR-13 DOSFAC2 FGRDCF 

A-SKIN A-SKIN L-GONADS 

A-RED MARR A-RED MARR L-BREAST 

A-LUNGS A-LUNGS L-LUNGS 

A-THYROID A-THYROIDH L-RED MARR 

A-STOMACH A-STOMACH L-BONE SUR 

A-LOWER LI A-LOWER LI L-THYROID 

L-ICRP60ED L-EDEWBODY L-REMAINDER 

L-RED MARR L-RED MARR L-EFFECTIVE 

L-BONE SUR L-BONE SUR L-SKIN(FGR) 

L-BREAST L-BREAST  

L-LUNGS L-LUNGS  

L-THYROID L-THYROID  

L-LOWER LI L-LOWER LI  

L-BLAD WAL L-BLAD WAL  

L-LIVER L-LIVER  

 L-THYROIDH  

 

When a COMIDA2-generated input file is used in a MACCS run, MACCS must use the same DCF 
file as the one used to generate the COMIDA2 file.  The first two header records of the DCF files 
used by MACCS and COMIDA2 are read and compared to ensure that the two sets of calculations 
used the same DCF file.  This is important when predefined COMIDA2 files are used. 

The duration of exposure depends on the exposure pathway and the emergency response at a 
spatial element and is calculated based on user-supplied data.  The shielding factor is a 
dimensionless quantity used to reduce the radiation dose as a result of shielding protection 
provided by a given protective action for a given exposure pathway.  Shielding factors for the 
various exposure pathways (cloudshine, inhalation, groundshine, and skin dose) and for three 
different groups of people (evacuees, people continuing normal activity, and people taking shelter) 
are specified by the user. 

The evacuation model incorporates two delay times that affect the timing of evacuation: one is a 
delay to shelter and the second is a delay to evacuate.  Different shielding factors and breathing 
rates can be used while people continue normal activity, take shelter, or evacuate.  

The EARLY calculation accumulates the radiation doses for an evacuating population by adding 
the doses they receive during normal activity, sheltering, and evacuation.  This is done until the 
evacuees reach a user-defined distance where they are assumed to avoid further exposure. 
Evacuees can return to their residences during the emergency phase, depending on user inputs, 
only when no additional radiation exposure would be received.  
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The CHRONC module allows the user to define dose projection criteria that determine whether 
evacuees return to their original locations during the intermediate and long-term phases. 
Additional radiation doses are calculated in the CHRONC module. 

Before a population shelters, the members of the population are assumed to be carrying out 
normal activities. Shielding factors (cloudshine, groundshine, inhalation, and skin) for normal 
activity apply to them during this period. When the members take shelter, shielding factors for 
sheltering apply. After they begin to evacuate, shielding factors for evacuation apply.  The user 
defines the durations of each of these activities; a null period is possible (e.g., no time duration 
for sheltering).  

The plume transport model assigns the plume a finite length calculated by using the assigned 
release duration and wind speed(s) during the release.  The length of a plume segment is constant 
following the release (i.e., the front and back of the plume travel at the prevailing wind speed), 
and the concentration of radioactive material is assumed to be uniform over the length of a 
segment.  The radial position of evacuating persons, before or during evacuation, is compared 
with the positions of the front and back of the plume as a function of time to determine the period 
of exposure to airborne radionuclides.  

 Model Basis 

 Basic Model Description 

Grid Subdivisions 

The basic nodalization used in MACCS is defined above in the description of the spatial grid in 
the ATMOS section. In addition to this basic grid, a more refined grid, called the fine grid, is used 
in EARLY to calculate off-centerline doses.  The fine grid is used both for calculation of early and 
latent health effects during the early (i.e., emergency) phase.  

Each one of the compass sectors is further subdivided into several fine grid divisions.  The number 
of fine grid divisions is specified by the user and can be 3, 5, or 7.  

The off-centerline correction factor of a fine spatial element for the cloudshine pathway is 
calculated in a different manner than the correction factors for the other exposure pathways during 
the emergency phase. For the cloudshine pathway, the off-centerline correction factor within a 
fine spatial element is the finite cloud correction factor discussed below.  This factor considers 
both the total distance to the plume centerline and the size of the plume. It accounts for the 
geometrical view factor between the plume and the receptor.  

For cloud inhalation, groundshine, resuspension inhalation, and skin exposure pathways during 
the emergency phase, the Gaussian crosswind distribution is evaluated at the CenterPoint of 
each fine grid.  The outermost extent of the plume is taken to be the azimuthal location where the 
Gaussian distribution falls to one-tenth of its peak, i.e., the outermost fine grid that contains the 
point where the crosswind distance (measured around a circular arc) is (2.15 x σy) from the plume 
centerline. 

Weather Sampling and Wind Rose Probabilities  

One of the basic options in MACCS that affects weather sampling is chosen under the 
Evac/Rotation tab. This choice defines the MACCS parameter, IPLUME.  These options capture 
two independent concepts for weather sampling: wind shift and rotation. 
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Wind shift carries the idea of variations in wind direction. Wind shift only matters when a release 
is divided into multiple plume segments.  The simplest Gaussian plume methods do not allow any 
variations in wind conditions.  These methods treat the entire plume as following along a single 
direction, at a single speed, with a single stability class.  The MACCS implementation of the 
Gaussian plume model is much more general.  One of the generalizations is that plume segments 
can travel in different directions, depending on the directions indicated in the weather data that 
are being used.  For example, suppose the wind blows toward the north in the first hour and 
toward the east in the second hour.  When two plume segments are modeled, each with release 
duration of one hour, the first plume segment travels north.  The direction of the second plume 
segment depends on whether wind shift is included in the calculation or not.  When it is, the 
second plume segment travels in the direction that the weather data indicate, to the east.  When 
wind shift is not included, both plume segments travel in the same direction, to the north. 

Rotation is a numerical convenience for squeezing more information out of a set of results without 
significantly increasing the computational time required. Rotation uses wind-rose probabilities to 
expand a result for a single weather trial into a set of NUMCOR results, where NUMCOR is the 
number of compass directions treated in the calculation.  For example, suppose MACCS performs 
a weather trial for which the initial wind direction is to the north.  When rotation is not used, this is 
the only result that is computed.  When rotation is used, NUMCOR results are constructed.  These 
results are based on the probabilities that the wind might have blown in each of the compass 
directions, given that other weather conditions (e.g., stability class and wind speed, are within the 
same bin (weather binning is described previously)).  As a simple example, suppose the 
probability of the wind blowing in each compass direction is 1/NUMCOR.  For this case, MACCS 
constructs the consequences assuming the initial wind direction was toward each of the compass 
sectors and assigns each result a probability of 1/NUMCOR times the probability of the original 
weather trial selected from one of the weather bins.  The rotation option is only available when 
the weather bin option for constructing a set of weather trials.  The wind rose probability for each 
result is the value for the wind direction and the weather bin (i.e., a wind rose is calculated for 
each weather bin and used for weather trials belonging to that bin).  

The assumption that the conditional probability of a weather trial occurring in any compass 
direction is the same as the wind rose probability for that direction is perfectly reasonable when 
only a single plume segment is modeled.  Even when two plume segments are treated, the 
underlying assumption becomes somewhat questionable.  The larger the number of plume 
segments modeled in a calculation, the more dubious this assumption becomes.  This is because 
the underlying assumption is that the entire pattern of wind shifts that define a weather trial can 
be rotated in any direction around the compass, and that the likelihood only depends on the wind-
rose probability of the initial wind direction for that weather trial.  Thus, for extended releases 
modeled with more than a few plume segments, modeling plume transport without rotation is the 
preferred option.  

There are three options allowed by MACCS, which are defined as follows: 

• No Wind Shift with Rotation. In this case, all plume segments follow the same direction 
as the first plume segment.  However, for each weather trial, results are constructed as 
though the wind had blown in each compass direction.  The relative probability of the 
wind blowing in each compass direction is taken from wind rose data, usually 
constructed from the weather file.  Optionally, the user can specify a wind rose in the 
input. 

• Wind Shift with Rotation. In this case, all plume segments follow the direction indicated 
by the weather data when the plume segment begins to be released.  Depending on the 
weather data, each plume segment can travel in a different direction than the other 
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plume segments.  Wind rose probabilities are used to construct N different results where 
the wind shift pattern is preserved for each of these results.  For example, suppose that 
in the initial calculation, plume segment 1 travels toward compass sector 1 (north) and 
plume segment 2 travels toward compass sector 2.  In the first rotation, plume segment 
1 travels toward compass sector 2 and plume segment 2 travels toward compass sector 
3. This pattern continues for each possible compass direction.  

• Wind Shift without Rotation. In this case, wind shift is performed but wind rotation is 
not. This is the only option that is allowed when the network evacuation model is 
selected or either the speed multiplier or keyhole evacuation model is activated.  This is 
because the symmetry assumptions required for rotation to be valid are violated with 
these options.  This is the preferred option when multiple plume segments are treated.  

MACCS supports six choices for selection of one or more weather trials.  Three of these are single 
weather-trial options; the remaining three support random sampling from annual data.  These 
weather sampling options are described in this section.  Specifically, the interaction between wind 
rose data and sampling option is described.  

• Constant Weather. Conditions are specified on the Constant or Boundary Conditions 
form. However, the user is not allowed to specify wind direction.  When wind rotation is 
not included, wind direction is always to the north.  When wind rotation is included, wind 
directions are assumed to be distributed uniformly around the compass.  Wind shift has 
no affect since wind directions are constant for each weather trial.  

• User Supplies 120 Weather Points. Weather conditions are specified on the User 
Supplied Weather form. This form allows the user to specify hourly wind directions. 
When wind rotation is used, the wind rose is assumed to be uniform around the 
compass. When wind shift is used, the direction taken by each plume segment is defined 
by the user-specified wind direction at the time it is released.  

• Fixed Start Time. This option works the same as the User Supplies 120 Weather Points 
option except that the weather data are extracted from the weather file, beginning with 
the day and time period specified under the Fixed Start Time Data form. When weather 
data are read from the weather file, however, 1200 hours of data are extracted rather 
than only 120 hours to represent temporal weather variations.  

• Uniform Bin Sampling. Weather data, including wind direction, are taken from the 
weather file. When wind rotation is performed, the default is that a separate wind rose is 
constructed within MACCS for each weather bin.  Therefore, the wind rose varies from 
weather trial to weather trial, depending on which weather bin the trial is taken from. 
When OVRRID = True, the data on the Wind Rose Probabilities form are used for all 
weather trials, regardless of which weather bin they are taken from. 1200 hours of data 
are extracted from the weather file to represent temporal weather variations for each 
weather trial.  

• Nonuniform Bin Sampling. This option works the same as Uniform Bin Sampling, 
except that the user defines the number of weather trials to be sampled from each 
weather bin. 1200 hours of data are extracted from the weather file to represent 
temporal weather variations for each weather trial. 

• Stratified Random Sampling. No weather binning is performed for this option. Instead, 
a user-specified number of weather trials are selected randomly from each weather day. 
Because weather bins are not created, MACCS does not assemble wind rose data and, 
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thus, each weather trial is handled similarly as in the User Supplies 120 Weather Points 
option. When wind rotation is not used, wind directions are taken directly from the 
weather file. When wind rotation is used, the wind rose is assumed to be uniform around 
the compass. 1200 hours of data are extracted from the weather file to represent 
temporal weather variations for each weather trial.  

Relocation Model Description 

Relocation is a post-accident protective measure designed to limit radiation exposure and is 
implemented in MACCS following plume arrival.  The model provides four alternatives for 
relocation, including hot-spot relocation during the emergency phase, normal relocation during 
the emergency phase, relocation during the intermediate phase, and relocation during the long-
term phase.  During the emergency phase, relocation occurs at a user-specified time after plume 
arrival, conditional on a projected dose from cloudshine, groundshine, cloud inhalation, and 
resuspension inhalation that exceeds a user-specified limit. 

MACCS includes the ability to simulate relocation of residents from areas of elevated dose rate 
through the hotspot and normal relocation parameters.  The user can specify a hotspot relocation 
criterion and a normal relocation criterion.  For both relocation criteria, the user specifies a dose 
limit, a dose projection period, the critical organ for the dose limit, and a relocation time. MACCS 
requires that the dose for hotspot relocation be greater than or equal to the dose for normal 
relocation and the delay time for hotspot relocation be less than or equal to the delay time for 
normal relocation.  The concept is that the segment of the public that would receive larger doses 
would be relocated more urgently than those who would receive smaller doses.  However, the 
two criteria can be collapsed into a single criterion by specifying all the parameters to be the same 
for the two relocation types.  

To evaluate the need for relocation during the emergency phase, the dose received from the sum 
of the following dose pathways is considered: cloudshine, inhalation of the cloud during plume 
passage, groundshine, and inhalation of resuspended contamination.  These doses are assessed 
beginning with the arrival of the first plume segment for the dose-projection period.  They are 
based on lifetime doses. 

The relocating population is assumed to be in normal activity before relocation.  Thus, the 
shielding factors for normal activity are used.  Once the population is relocated, no further dose 
is calculated for them during the emergency phase. Additional doses could be calculated in the 
CHRONC module for the intermediate and long-term phases.  The criterion for determining 
whether they return to their original spatial element depends on dose projections.  The dose 
projection criterion used for relocation during the long-term phase is commonly referred to as the 
habitability criterion.  

Emergency Phase Resuspension 

The resuspension model in MACCS is the following: 

𝐶 = 𝐺 ⋅ 𝑅𝐸𝑆𝐶𝑂𝑁 ⋅ 2−𝑡/𝑅𝐸𝑆𝐻𝐴𝐹  (3-26) 

Where 

C = Air concentration at ground level from resuspension (Bq/m3) 

G = Concentration on ground (Bq/m2) 

t = Time measured from the time of deposition (s) 
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RESCON is the initial value of the resuspension coefficient (m-1) and RESHAF is the resuspension 
coefficient half-life (s), which accounts for weathering. 

Keyhole Model 

The standard MACCS evacuation model assumes that the evacuation region is a circular area. 
With keyhole evacuation, the evacuation area is a keyhole-shaped area (i.e., a circular area 
surrounding the site and an odd number of consecutive sectors projecting out to a larger radius), 
as illustrated in Figure 3-62.  The region is defined by the radius of the inner, circular area, the 
number of sectors to evacuate beyond the circular area, and the outer radius of the evacuation 
area.  

Initially, the keyhole is centered on the wind direction, as shown by the yellow and purple portions 
of the keyhole in Figure 3-62.  The keyhole is expanded as the wind direction changes in 
subsequent hours, as illustrated by the green and orange portions of the keyhole.  The purple and 
orange sectors are in the downwind directions before and after the wind shift, respectively.  

 

Figure 3-62 Illustration of the MACCS keyhole evacuation model 

An additional concept employed with the keyhole model is to allow the keyhole to be expanded 
in advance of an actual wind shift to account for weather forecasting.  The parameter in 
WinMACCS to accomplish this is named KEYFORCST.  The user must specify the number of 
hours of weather forecasting to use in the model.  When the number of hours is four, for example, 
the model considers the wind directions that occur over the next four hours and expands the size 
of the keyhole accordingly.  The MACCS implementation inherently assumes that wind shifts are 
forecasted with 100% accuracy for KEYFORCST hours, so this value should be considered in 
this light.  
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 Basic Early Forms and Parameters 

Early Description Form 

The Early Description form has one parameter that contains a brief description of the early model. 
This description is printed in the output file.  This form is required when Early Consequences are 
selected on the Properties/Scope tab.  

 

Figure 3-63 Early Site and Model Description Form 

Table 3-65 Early Site and Model Description Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

EANAM1 Yes Character None 1 to 80 characters 

 

Property Form Parameters Form 

The Property Form Parameters form shows how selections under the Properties form define some 
important parameters that are required in the EARLY input to MACCS.  The parameters cannot 
be changed from this form; they are read only.  Details about these parameters are provided in 
the following paragraphs. 

POPFLG determines the source of population data.  The value is set to FILE when the population 
is provided by a file either generated by the preprocessor, SecPop, or separately.  POPFLG is 
set to UNIFORM when the population is to be treated as uniformly distributed on the grid. 

WTNAM determines the method used for combining results from different cohorts when 
generating overall results.  When PEOPLE or TIME is selected, the weighting factor for each 
cohort is determined by the value of WTFRAC.  Results from CHRONC are included as a single, 
separate cohort, and are simply added to the weighted results from EARLY.  When WTNAM is 
set to SUMPOP, the population for each cohort is present in the site file under headings 
POPULATION1, POPULATION2, etc., for each cohort.  Such a site data file can be created by 
hand or by using a relatively new feature of WinMACCS described below. When this option is 
used, the values of WTFRAC are not needed to combine results from the EARLY cohorts.  
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KIMODL determines whether consequence calculations consider potassium iodide (KI) ingestion. 
The value is set to KI when the effect of KI is to be included or to NOKI when it is not to be included 
in a calculation.  When included, parameters regarding the percentage of the population ingesting 
KI and its efficacy at reducing thyroid dose must be defined, as explained below.  

DOSMOD determines which model is used for calculating dose.  The choices are LNT, Annual 
Threshold (AT), or piecewise linear (PL).  The simplest and traditional choice is the LNT model, 
for which only one DCF file is required.  That file contains internal dose coefficients for a 50-year 
commitment period. Other choices require additional user input for threshold values and a set of 
51 dose coefficient files.  The additional 50 files break down the dose-commitment period of 50 
years into annual periods.  

EVATYP determines the evacuation model. The choices are NONE, RADIAL, or NETWORK. 
When RADIAL or NETWORK is chosen, further user input to define evacuation behavior is 
required. RADIAL models evacuation as being radially outward within each sector. NETWORK 
allows evacuees to travel from one grid element to any of the four adjacent grid elements.  

OVRRID is a flag set to either True or False. This flag allows the user to override the default 
values used for wind rose probabilities. When either uniform or nonuniform weather bin sampling 
is selected, the wind rose probabilities are usually calculated from the weather file; when OVRRID 
is set to True, the default wind rose probabilities are replaced by user-specified values. When 
weather binning is not selected, equal probabilities (1/NUMCOR) are assumed for each compass 
direction regardless of the value of OVRRID. OVRRID can be set to True when a meteorological 
file is not available for the actual site being studied but wind rose data are available for the site. 
This option allows local wind rose characteristics to replace those contained in a meteorological 
data file. It assumes that other weather characteristics of the site are like those in the file. Wind 
rose data are only needed when rotation is chosen (IPLUME = 1 or 2); otherwise, wind directions 
are taken directly from the weather file and wind rose probabilities are not used.  

IPLUME defines two characteristics regarding plume transport.  When set to 1, no wind shift is 
modeled; when set to 2 or 3, wind shift is modeled. No wind shift means that all plume segments 
travel in the same direction; wind shift means that each plume segment can travel in its own 
direction, depending on the wind direction at the time of its release. The second characteristic is 
rotation. When IPLUME is set to 1 or 2, rotation is used; when IPLUME is set to 3, no rotation is 
used. These two concepts, wind shift and rotation, are discussed in more detail above.  

KEYAVAIL determines whether the keyhole evacuation model can be chosen for evacuation. 
When KEYAVAIL is equal to KEY_NOT_AVAIL, the choices for the cohort evacuation are circular 
or none. When KEYAVAIL is equal to KEY_AVAIL, the choices for the cohort evacuation are 
circular, none, or keyhole. When set to KEY_AVAIL, the only choice is IPLUME = 3.  
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Figure 3-64 Property Form Parameters Form 

Table 3-66 Property Form Parameters Form Inputs 

Parameter 
Name 

Definable Type Dimensions Allowed Values Defined on 
Form 

POPFLG Read Only Character None FILE, UNIFORM Site Data tab on 
Properties  

WTNAME Read Only Character None PEOPLE, 

TIME, SUMPOP 

Site Data tab on 
Properties  

KIMODL Read Only Character None KI, NOKI Dose tab on 
Properties  

DOSMOD Read Only Character None LNT, AT, PL Dose tab on 
Properties  

EVATYP Read Only Character None RADIAL, 
NETWORK, NONE 

Evac/Rotation tab 
on Properties  

OVRRID Read Only Logical None True, False Wind Rose tab on 
Properties  

IPLUME Read Only Integer None 1 to 3 Evac/Rotation tab 
on Properties  

KEYAVAIL Read Only Character None KEY_AVAIL, 
KEY_NOT_AVAIL 

Evac/Rotation tab 
on Properties 
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 Basic Model Forms 

Grid Subdivisions Form 

The Grid Subdivisions form is required. NUMFIN is the number of fine-grid subdivisions used by 
the model.  The fine grid is used to improve the resolution of doses in EARLY.  This is especially 
important for non-linear dose responses such as early health effects.  Each of the grid elements 
is subdivided into NUMFIN fine-grid elements in the azimuthal direction.  NUMFIN is used in the 
calculations performed by EARLY to improve resolution for consequences that behave nonlinearly 
with dose, e.g., early health effects.  Values in CHRONC are averaged over the fine grid at the 
course grid level because the consequences evaluated for the intermediate and long-term phases 
behave relatively linearly with dose.  

 

Figure 3-65 Grid Subdivisions Form 

Table 3-67 Grid Subdivisions Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUMFIN Yes Character None 3, 5, 7 

 

Wind Rose Probabilities Form 

The Wind Rose Probabilities form is required when the user selects User Supplied on the Wind 
Rose tab.  

WINROS contains the probabilities of the wind blowing from the site toward each of the compass 
sectors.  Values are listed clockwise starting with the value for north.  When these values do not 
approximately sum to unity, MACCS validation fails and generates an error message.  
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Figure 3-66 Wind Rose Probabilities Form 

Table 3-68 Wind Rose Probabilities Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

WINROS Yes Real NUMCOR 0.0 to 1.0 

 

Uniform Site Data Form 

The Uniform Site Data form is required when the user selects Uniform on the Site Data tab of the 
Properties form. This information is required when a site data file is not used. 

IBEGIN specifies the spatial interval beyond which the population begins. Inside the radius 
corresponding to IBEGIN, the assumption is that there is no population.  This can be used to 
represent the exclusion area. 

POPDEN specifies the uniform population density of the region. 

FRACLD specified the average fraction of the region that is land.  
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Figure 3-67 Uniform Site Data Form 

Table 3-69 Uniform Site Data Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

IBEGIN Yes Integer None 1 to NUMRAD  

POPDEN Yes Real None 0 to 1,000,000 people/km2 

FRACLD Yes Real None 1×10-6 to 1.0 

 

Population from Site File Form 

The Population from Site File form is active when the user selects “Import from File” on the Site 
Data tab of the Properties Window.  The Population from Site File form contains a table with 
columns for the set of compass sectors and rows labeled with values of SPAEND (radial distance). 
The table contains the total population in each grid element read from the site file.  
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Figure 3-68 Population from Site File Form 

Organs of Risk DOSFAC2 Form 

The Organs of Risk DOSFAC2 form is required when the user selects File Created by DOSFAC2 
on the Dose tab.  

ORGNAM is the organ name with the appropriate prefix of A- or L-, where A- (e.g., A-LUNGS) 
indicates an acute dose and L- (e.g., L-LUNGS) indicates a lifetime (50-year) dose.  

ORGFLG specifies whether the associated organ is to be included in the calculations. When the 
organ is not included, doses and health effects related to that organ cannot be calculated. 
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Figure 3-69 Organs of Risk DOSFAC2 Form 

Table 3-70 Organs of Risk DOSFAC2 Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

ORGNAM No Character 16 N/A  

ORGFLG Yes Logical 16 True, False 

 

Organs of Risk FGR-13 Form 

The Organs of Risk FGR-13 form is required when the user selects File Created from FGR13 on 
the Dose tab.  

ORGNAM and ORGFLG have the same meaning as in the Organs of Risk DOSFAC2 form. 
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Figure 3-70 Organs of Risk FGR-13 Form 

Table 3-71 Organs of Risk FGR-13 Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

ORGNAM No Character 15 NA  

ORGFLG Yes Logical 15 True, False 

 

Duration of Early Phase Form 

The Duration of Early Phase form is required. 

ENDEMP defines the duration of the emergency phase. Calculation of doses in each grid element 
start with the arrival of the first plume segment at that location and continue for the period defined 
by ENDEMP.  This period should normally be chosen to be large enough so that all plume 
segments have time to exit the problem domain.  The allowed range is 1 to 40 days.  
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Figure 3-71 Duration of Early Phase Form 

Table 3-72 Duration of Early Phase Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

ENDEMP Yes Real None 86,400 to 3,456,000 s 

 

Evacuee Return Time Form 

The Evacuee Return Time is an optional form. When this form is not used, MACCS assumes the 
value of TIMRTN is the same as the value specified for ENDEMP. 

TIMRTN defines the elapsed time between the time of evacuation and return to the home for an 
evacuee whose location on the grid is not affected by any contamination. In previous versions of 
MACCS, this value was assumed to be the duration of the emergency phase.  This value only 
affects the time used to evaluate economic losses.  
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Figure 3-72 Evacuee Return Time Form 

Table 3-73 Evacuee Return Time Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

TIMRTN Yes Real None 0 to ENDEMP  

 

Normal Relocation Form 

The Normal Relocation form is required. 

TIMNRM defines the normal relocation action time measured from plume arrival.  Normal 
relocation applies to everyone who does not evacuate; it does not apply to evacuees.  Normal 
relocation is based on a dose projection criterion to determine the need to relocate.  TIMNRM 
must be greater than or equal to TIMHOT and less than or equal to ENDEMP.  The value of 
TIMNRM can account for the fact that the initial priority may be to evacuate the public within the 
emergency planning zone, for time needed to evaluate releases and project doses to the public, 
and for time needed for the public to receive notification and begin to relocate.  Relocation is 
modeled as being instantaneous, so TIMNRM may also account for some portion of a realistic 
relocation time.  

The normal relocation dose, DOSNRM, along with the critical organ and dose projection period, 
determines where relocation is required.  When total projected dose commitment exceeds 
DOSNRM, people in an area are relocated at the normal relocation time, TIMNRM. DOSNRM 
cannot exceed DOSHOT, which is described below. 

The dose used to evaluate normal relocation is the dose commitment projected for an individual 
who remains in place for the dose projection period (defined below) while engaging in normal 
activity. The dose pathways used to calculate the projected dose commitment are cloudshine, 
groundshine, direct inhalation, and resuspension inhalation.  Any individuals relocated due to 
normal relocation receive no additional dose during the emergency phase. 
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Figure 3-73 Normal Relocation Form 

Table 3-74 Normal Relocation Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

TIMNRM Yes Real None 0 to 3,456,000 s (0 to 40 d) 

DOSNRM Yes Real None 0 to 1010 Sv 

 

Hot Spot Relocation Form 

The Hot Spot Relocation form is required when EARLY is selected on the Scope tab. 

TIMHOT defines the hot-spot relocation action time after plume arrival.  Hot-spot relocation 
applies to everyone who does not evacuate; it does not apply to evacuees.  Hot-spot relocation 
works similarly to normal relocation but is used to prioritize relocation of the population at higher 
risk. TIMHOT must be less than or equal to TIMNRM and less than or equal to ENDEMP.  The 
same time elements described for defining TIMNRM also apply to TIMHOT.  

The hot-spot relocation dose (DOSHOT) is intended to trigger relocation beyond the evacuation 
area, although it also applies to nonevacuees who reside within the evacuation area.  Areas 
identified for hotspot relocation usually take priority once evacuation is completed or well along 
and occur before normal relocation. When dose projections for individuals exceed DOSHOT, they 
are relocated at the hot-spot relocation time (TIMHOT).  

The dose used to evaluate hotspot relocation is the dose projected for an individual who remains 
in place for the dose projection period while engaging in normal activity. The dose pathways used 
to calculate the dose commitment are cloudshine, groundshine, direct inhalation, and 
resuspension inhalation. Any individuals relocated due to hot-spot relocation receive no additional 
dose during the emergency phase. 



 

3-115 

 

Figure 3-74 Hot Spot Relocation Form 

Table 3-75 Hot Spot Relocation Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

TIMHOT Yes Real None 0 to 3,456,000 s (0 to 40 d) 

DOSHOT Yes Real None 0 to 1010 Sv 

 

Dose Projection Form 

The Dose Projection form is an optional form.  When it is not used, MACCS assumes the value 
of DPPEMP is the same as the value specified for ENDEMP. 

DPPEMP is the dose-projection period for the emergency phase.  It defines the dose projection 
period used for normal and hot-spot relocation.  A full definition of the dose projection criteria for 
normal and hot-spot relocation includes the dose level (DOSNRM and DOSHOT, respectively), 
the target organ (CRIORG, defined below), the dose projection period (DPPEMP), the 
commitment period for the dose (standard value of 50 years for internal doses), and the set of 
dose pathways that are included, which are cloudshine, groundshine, direct inhalation from the 
plume, and inhalation of resuspended aerosols.  The dose projection period begins with plume 
arrival and ends after the time interval specified by DPPEMP.  Older versions of MACCS used 
ENDEMP for the dose projection period.  
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Figure 3-75 Dose Projection Form 

Table 3-76 Dose Projection Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DPPEMP Yes Real None 0 to 1010 s 

 

Emergency Phase Resuspension Form 

The Emergency Phase Resuspension form is required. Resuspension can be excluded from a 
calculation by setting RESCON to be zero.  

RESCON is the linear factor for the emergency phase resuspension concentration factor.  

RESHAF is the emergency phase resuspension concentration weathering half-life.  
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Figure 3-76 Emergency Phase Resuspension Form 

Table 3-77 Emergency Phase Resuspension Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

RESCON Yes Real None 0 to 1 m-1 

RESHAF Yes Real None 1 to 1010 s 

 

Keyhole Forecast Form 

The Keyhole Forecast form is required when Activate Keyhole Evacuation Model is checked on 
the Evac/Rotation tab.  

KEYFORCST defines the advance time for which wind shifts can be reliably forecast by weather 
forecasters (e.g., the National Weather Service). The model expands the number of sectors 
included in a keyhole evacuation, as illustrated in Figure 3-62, KEYFORCST hours before a wind 
shift occurs. This model is currently implemented as if the forecasting were infallible (i.e., it uses 
wind shifts from the recorded meteorological data and these are correct 100% of the time).  Real 
weather forecasting is less than 100% reliable, but that is not accounted for in the current model. 
To compensate for the assumption of perfect forecasting, this value should normally be chosen 
to be a relatively small number of hours.  
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Figure 3-77 Keyhole Forecast Form 

Table 3-78 Keyhole Forecase Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

KEYFORCST Yes Real None 0 to 432,000 s (5 d) 

 

Cohort Units Form 

The Cohort Units form is required, but it contains a set of default units and the user is not required 
to reset these units. 

The default units in MACCS are SI units.  This form allows the user to change the units for a set 
of cohort parameters for all the cohorts.  Units can be changed on this form for delays, phase 
durations, breathing rate, and evacuation speeds.  To avoid confusion when entering input values 
for individual cohorts, these units are applied to all cohorts.  
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Figure 3-78 Cohorts Unit Form 

Table 3-79 Cohorts Units Form Allowable Units 

Parameter Name Allowed Units for Variable 

DLTSHL (s), (min), (hr), (day), (yr) 

DURBEG (s), (min), (hr), (day), (yr) 

DLTEVA (s), (min), (hr), (day), (yr) 

BRRATE (m3/s), (l/s), (l/day), (m3/day), (m3/yr) 

DURMID (s), (min), (hr), (day), (yr) 

ESPEED (m/s), (cm/s), (km/hr), (mi/hr), (in/hr), (mm/hr) 

 

 Dose-Response Models 

 Dose-Response Model Description 

Three optional dose-response models are available to calculate latent-cancer injuries and 
fatalities.  The three types of models are illustrated in Figure 3-79.  
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Figure 3-79 Three types of dose-response models for latent cancer health effects 
supported by MACCS 

The first uses the standard, LNT hypothesis.  This was the only model available in earlier versions 
of MACCS. In the linear, no-threshold model, the relationship between dose and health effects is 
linear in the low-dose range, even for infinitesimal doses.  However, the LNT dose-response 
model implemented in MACCS includes a discontinuity and has a change in slope at a threshold 
dose, as shown in Figure 3-79.  In the MACCS model, for latent health effects, doses are divided 
by a dose and dose-rate effectiveness factor (DDREFA) for dose levels below the threshold but 
not for doses above the threshold. MACCS uses the standard implementation of the LNT model 
in which internal doses over an exposure period are calculated as 50-year doses and it combines 
internal and external doses to estimate a total organ dose, including the effective pseudo organ.  
This total organ dose is compared with the dose threshold to determine whether to divide by 
DDREFA. Doses after the emergency phase are assumed to stay below the threshold, so they 
are always divided by DDREFA.  

Figure 3-79 illustrates the simplified situation where all doses are delivered to an individual during 
the first year (i.e., internal doses from inhalation and ingestion have diminished to zero by the end 
of the first year).  This allows all three dose-response models to be compared on the same basis. 
Furthermore, the figure shows a typical dose response when radiation is assumed to be uniformly 
distributed over the body, although this assumption is not essential to the illustration.  For 
example, effective dose could be replaced by equivalent dose to a specific organ and latent 
cancer health effects could represent just the cancers associated with that organ.  The figure 
shows typical values of 0.2 Sv for the threshold and a value of 2.0 for DDREFA.  The solid curve 
in Figure 3-79 shows the individual risk of a cancer fatality using typical values for cancer induction 
and the LNT dose-response model.  

Effective dose is the term used by ICRP when the weighted sum of equivalent organ doses is 
calculated using ICRP 60 tissue weighting factors.  An equivalent organ dose accounts for 
biological damage using a radiation weighting factor, which is generally unity for beta and gamma 
radiation and 20 for alpha radiation. Effective dose is the same in concept as the older term of 
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total effective dose equivalent (TEDE).  Technically, TEDE is based on older tissue weighting 
factors from ICRP 26. (The latest tissue weighting factors from ICRP are in ICRP 103, but these 
are not currently used in the MACCS dose coefficient files.) 

The second option for dose-response model is called the AT model.  In this model, the user can 
specify one or more thresholds, up to one for each year of the exposure period.  The thresholds 
are specified in terms of effective dose. When the predicted effective dose is below an AT, there 
are no contributions to any latent cancer health effects for that year; when the predicted effective 
dose exceeds the AT, contributions to health consequences are calculated in the same way as 
with the LNT model. Contributions to health effects are summed over all exposure years.  This 
dose response model is illustrated in Figure 3-79 for the case that the AT is 0.05 Sv (5 rem).  To 
compare with the threshold, internal doses are calculated as annual doses rather than 50-year 
committed doses. The process for doing this in MACCS is described a few paragraphs below.  

The third option for dose-response model is called the PL model.  In this model, the user can 
construct a series of line segments that define the functional dependence of health effects on 
annual dose, as illustrated in Figure 3-79.  The line segments are required to form a continuous 
curve.  To define the PL function, the user defines a multiplicative factor that is applied to the LNT 
model as a function of annual dose.  This model can be used to approximate a dose threshold, to 
create a sublinear dose-response model, or to create a supra-linear dose-response model. It 
cannot be used to construct a hormesis model because MACCS does not allow beneficial health 
effects (negative risk) from radiation exposure.  Figure 3-79 illustrates a PL model that is sublinear 
below 0.1 Sv (10 rem) and supra-linear between 0.1 Sv and 0.175 Sv (17.5 rem).  Above 0.175 
Sv, the PL model is identical to the LNT model in this illustration.  The PL model operates on 
annual doses in the same way as the AT model described in the previous paragraph.  

For the general case where exposures occur over many years and internal dose pathways 
potentially deliver a dose over the 50-yr dose commitment period, the model is somewhat more 
complicated than it is for the LNT model.  For the two non-LNT models discussed above, AT and 
PL, annual doses are estimated for each year during the exposure and commitment periods. The 
models depend on the actual dose delivered to an individual during a one-year period, referred to 
as an annual dose. Annual doses account for external radiation received during the year and the 
first year of the commitment period for all internal exposures during the year. They also account 
for the current year of dose commitment for internal exposures in all previous years. Once the 
annual doses are calculated for an individual, the latent cancer risk is the sum of the risks over 
the relevant set of years. In other words, the risk illustrated in Figure 3-79, which is for a single 
year, is summed over all the years for which doses are received by that individual.  Years in which 
the annual doses are below the dose threshold are assumed not to contribute to latent health 
effects in the AT model. Similarly, annual doses contribute based on the PL factor using the PL 
model.  

Even when radiation is not distributed uniformly over the body, the effective dose is still used to 
determine whether an AT is exceeded. When the threshold is exceeded, equivalent organ doses 
are used to estimate the contributions to cancer risks for each type of cancer.  Total cancer risks 
are summations of the cancer types considered in the consequence analysis.  In Figure 3-79, 
nonuniform radiation could increase or decrease the cancer risks, depending on the radio 
sensitivity of the organs receiving larger and smaller doses.  

The AT model allows for an optional lifetime threshold, which is also based on effective dose. 
When the lifetime threshold is exceeded, the health effects are calculated to be identical to those 
for the LNT model. In that case, dose contributions to health effects are counted for all years, no 
matter how small the dose in any of the years.  
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 Dose Model Forms and Parameters 

Annual Threshold Form 

Annual Threshold is required when the user selects Late Consequences on the Scope tab and 
Annual Threshold on the Dose tab. 

DTHNUM is the number of annual dose threshold values.  This value is determined from the 
number of entries for DTHANN.  

DTHANN is a vector containing the annual dose threshold for latent cancer models.  The first 
entry corresponds to year one, the second to year two, etc. When calculated annual effective 
dose per person is below the specified threshold for a year, all latent health consequences are 
calculated to be zero for that year.  The value specified for the last year is used for all subsequent 
years. When a single value is listed, it applies to every year of the exposure period.  

 

Figure 3-80 Annual Threshold Form 

Table 3-80 Annual Threshold Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DTHNUM Linked Integer None 1 to 398 

DTHANN Yes Real DTHNUM 0 to 1030 Sv/yr 
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Lifetime Threshold Form 

Lifetime Threshold is optional when the user selects Annual Threshold on the Dose tab. 

DTHLIF is the lifetime dose restriction. When this dose is exceeded, all doses are used to estimate 
health effects the same as with the LNT model, regardless of AT values.  

 

Figure 3-81 Lifetime Threshold Form 

Table 3-81 Lifetime Threshold Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DTHLIF Yes Real DTHNUM 0 to 1030 Sv 

 

Piecewise Linear Form 

The Piecewise Linear form is required when the user selects Late Consequences on the Scope 
tab and Piecewise Linear on the Dose tab. 

PWLNUM is the number of piecewise dose values entered by user.  Its value is determined by 
the number of values of PWLDOS and PWLFAC entered by the user.  

PWLDOS is the effective dose associated with multiplier, PWLFAC. Values of PWLDOS must be 
specified in ascending order.  Linear interpolation is used to calculate a multiplicative factor for an 
annual effective dose between those supplied by the user.  Health consequences are calculated 
for each annual effective dose using the multiplicative factor calculated from this model as a 
multiplier on the LNT model.  The health effects are summed for all the annual dose contributions, 
accounting for the number of exposure years and the commitment period for each exposure year, 
as described above.  

PWLFAC is a multiplicative factor associated with PWLDOS.  The last value in vector PWLFAC 
must be one. Above the last dose specified on this form, the LNT model is used.  
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Figure 3-82 Piecewise Linear Form 

Table 3-82 Piecewise Linear Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

PWLNUM Linked Integer None 2 to 99 

PWLDOS Yes Real PWLNUM 10-10 to 1030 Sv/year 

PWLFAC Yes Real PWLNUM 0 to 1×1030 

 

 Population by Cohort 

The characteristics of each evacuation cohort are assigned on the Emergency Cohorts forms. 
The forms in the Population by Cohort category enable assigning portions of the population to 
different evacuation cohorts for each spatial grid element.  Each cohort should represent a 
segment of the population that displays a distinct evacuation behavior (e.g., the general populace 
vs. people with special needs).  First, populations are defined on the Populations forms, where a 
population is defined by a set of cohort fractions.  Next, populations are assigned to spatial grid 
elements.  This defines the population fraction of each evacuation cohort that belongs to that grid 
element.  The total population per grid element is defined in the site data file. See Section 4.4.7.2 
for more guidance. 

Populations Form 

The Populations form is required when the user assigns SUMPOP to the Results Weighting 
Factor and selects Create from Existing Site File on the Site Data tab.  

N_POP_DIST is the number of population distributions entered by the user. 
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POP_DIST defines the population distributions to be assigned to the grid.  One distribution is 
entered per row. The cohort fractions on each row should sum to one.  Each column of the grid 
is associated with a cohort.  

 

Figure 3-83 Populations Form 

Table 3-83 Populations Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

N_POP_DIST Linked Integer None 1 to 90 

POP_DIST Yes Real N_POP_DIST by 
NUM_EVAC_SCEN 

0 to 1.0 

 

Population Labels Form 

The Population Labels form is required when the user assigns SUMPOP to the Results Weighting 
Factor and selects Create from Existing Site File on the Site Data tab. 

DIST_SYMB is a single character that is used to assign a population to a grid element in the 
spatial grid form. 

DIST_LABEL is a descriptive label associated with the population. 
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Figure 3-84 Population Labels Form 

Table 3-84 Population Labels Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DIST_SYMB Yes Character N_POP_DIST 1 character 

DIST_LABEL Yes Character N_POP_DIST 1 to 20 characters 

 

Populations Assigned Form 

The Populations Assigned form is required when the user assigns SUMPOP to the Results 
Weighting Factor and selects Create from Existing Site File.  Both are specified on the Site Data 
tab of the Properties form 

The Populations Assigned form allows the user to assign populations, identified by the symbol, 
DIST_SYMB, defined on the Population Labels form, to grid elements.  After this form is saved, 
each Population form for each cohort in the calculation is updated to show the population by grid 
element. Before the MACCS simulation is run, a new site file is constructed with the populations 
shown on the Populations forms for each cohort.  The site file is created to be compatible with the 
MACCS SUMPOP option and includes a section defining the population for each cohort.  

POP_DIST is defined on the Populations form. 

DIST_SYMB associates a population distribution with a symbol. 

DIST_LABEL is a descriptive label associated with a population. 

COHORT_POP3D is an array defining the population assigned to each of the spatial grid 
elements.  

COHORT_POP is the population array associated with a cohort.  
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Figure 3-85 Populations Assigned Form 

Table 3-85 Populations Assigned Form Inputs 

Parameter 
Name 

Definable Type Dimensions 
Allowed 
Values 

Defined on 
Form 

POP_DIST No Real N_POP_DIST by 
NUM_EVAC_SCEN 

0 to 1.0 Populations 

DIST_SYMB No Character N_POP_DIST 1 character Population Labels 

DIST_LABEL No Character N_POP_DIST 1 to 20 
characters 

Population Labels 

COHORT_ 

POP3D 

Yes Character NUMRAD by 
NUMCOR 

1 character Populations 
Assigned 

COHORT_POP Yes Real NUMRAD by 
NUMCOR 

0 to 1×109  Populations 
Assigned 
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 Emergency Response Cohorts 

WinMACCS supports up to twenty emergency cohorts.  The number of cohorts is defined on the 
Evac/Rotation tab. Several cohort forms must be defined under the Emergency Cohort One 
category.  When there is more than one cohort, additional, identical, forms must be defined under 
the Additional Emergency Cohorts category.  The form names and parameters are the same for 
each cohort. For example, a critical organ can be specified for each cohort on the Critical Organ 
form. Each form must be filled out for set of cohorts defined in the model.  However, data entry 
can be reduced by selecting Edit/Auto Propagate Cohort Values on the main menu as described 
in Section 4.2.2.  

 Emergency Cohort Model Description 

For the purposes of accounting for dose and health effects, the dose received by an evacuee is 
attributed to the location in which the evacuee originates.  Evacuees travel from the center of one 
grid element to the center of another in discrete steps.  The transit time for an evacuee to move 
from one grid element to another is determined by several input values.  Dose calculations are 
performed as though the evacuee is located at the center of one grid element for a period then 
suddenly moves to the center of the next grid element along the path of evacuation.  The top-hat 
approximation for concentration is used to calculate doses for evacuees.  The top hat 
approximates the Gaussian profile as a constant concentration over a width of 3 ∙ 𝜎𝑦, as shown in 

Figure 3-86.  

 

Figure 3-86 Top-hat approximation for plume concentration used for evacuees 

The starting point for all evacuees is the center of the element in which they begin.  The transit 
time to arrive at the center of the next grid element depends on the choice of the parameter, 
TRAVELPOINT. When this parameter is equal to BOUNDARY, the evacuee is in the next grid 
element upon crossing the grid boundary; when equal to CENTERPOINT, the evacuee is 
considered to be in the next grid element upon arrival at the center of the destination grid element. 
The following formulae are used in the case when TRAVELPOINT = BOUNDARY: 

when the evacuee moves radially and resides in the current grid element 
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𝑇𝑡,𝑛 = (𝑟𝑛 − 𝑟𝑛−1)/(2 ⋅ 𝑉)  (3-27) 

when the evacuee moves radially and does not reside in the current grid element 

𝑇𝑡,𝑛 = (𝑟𝑛 − 𝑟𝑛−1)/𝑉  (3-28) 

when the evacuee moves around the compass and resides in the current grid element 

𝑇𝑡,𝑛 = 𝜋 ⋅ (𝑟𝑛 + 𝑟𝑛−1)/(2 ⋅ 𝑁𝜃 ⋅ 𝑉) 
 (3-29) 

when the evacuee moves around the compass and does not reside in the current grid element 

𝑇𝑡,𝑛 = 𝜋 ⋅ (𝑟𝑛 + 𝑟𝑛−1)/(𝑁𝜃 ⋅ 𝑉) 
 (3-30) 

The following formulae are used in the case when TRAVELPOINT = CENTERPOINT: 

when the evacuee moves radially outward 

𝑇𝑡,𝑛 = (𝑟𝑛+1 − 𝑟𝑛−1)/(2 ⋅ 𝑉) 
 (3-31) 

when the evacuee moves radially inward 

𝑇𝑡,𝑛 = (𝑟𝑛 − 𝑟𝑛−2)/(2 ⋅ 𝑉) 
 (3-32) 

when the evacuee moves around the compass 

𝑇𝑡,𝑛 = 𝜋 ⋅ (𝑟𝑛 + 𝑟𝑛−1)/(𝑁𝜃 ⋅ 𝑉) 
 (3-33) 

Where 

Tt,n = transit time to move from the current to the next grid element.  For dose 
calculations, this value is used as the residence time at the center point of the 
element. The evacuee jumps instantaneously from the center point of one 
element to the next. 

rn = the outer radius of grid element n 

V = the speed at which an evacuee moves through an element. This value is given 

by the equation ESPGRDESPEEDV =  when no precipitation is occurring and 

by ESPGRDESPMULESPEEDV =  when precipitation is occurring. ESPGRD 

corresponds to ESPGRD_RAD or ESPGRD_NET, depending on whether radial 
or network evacuation is selected, respectively. The values of ESPEED and 
ESPMUL depend on the phase of the evacuation period, as described below. 
The value of ESPGRD depends on the grid element through which the evacuee 
travels. 

𝑁𝜃 = number of compass sectors in the grid, i.e., 16, 32, 48, or 64. 

The evacuee’s location as a function of time is compared with the location of the head and tail of 
the plume. For periods of time when the evacuee is located within the plume, the doses from 
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direct exposure pathways are accumulated (i.e., cloudshine, direct inhalation of the plume, and 
skin deposition).  Doses from groundshine are always accounted for when the evacuee is at a 
location where the ground is contaminated.  Resuspension inhalation is only considered once the 
plume segment has exited the grid element.  

 Emergency Cohort Forms and Parameters 

Basic Parameters Form 

Basic Parameters are required for each Emergency Cohort category.  

EVAKEY determines the algorithm used in evacuation. CIRCULAR implies all sectors are subject 
to evacuation. KEYHOLE limits the number to NSECTR sectors beyond an inner circular region. 
NONE means that there is no evacuation.  The evacuation type is defined for each cohort under 
the Project Properties/Evac Rotation tab. 

EANAM2 is a name that identifies each cohort. 

WTFRAC is a weight fraction to be applied to results from each emergency response cohort.  The 
value is used when combining results for the overall weighted sum over all evacuation cohorts.  
The meaning depends on the value of the Results weighting factor as follows:  

• PEOPLE – WTFRAC represents the fraction of the population that belongs to this 
cohort. With this option, a fraction of the population follows each cohort definition all the 
time.  

• TIME – WTFRAC represents the fraction of the time or probability that this cohort is 
applicable. With this option, the entire population follows each cohort definition a fraction 
of the time. 

• SUMPOP – WTFRAC must be defined but isn’t used by MACCS. Instead, weighting 
information is based on population distributions read from the site data file.  

MACCS requires that the sum of values of WTFRAC over all evacuation scenarios must add up 
to 1.0 within a tolerance of 0.001. WinMACCS does not enforce this requirement.  
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Figure 3-87 Basic Parameters Form 

Table 3-86 Basic Parameters Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

EVAKEY No Character None NONE, CIRCULAR, KEYHOLE 

EANAM2 Yes Character None 1 to 80 characters 

WTFRAC Yes Real None 0.0 to 1.0 

 

Phase Durations and Speeds Form 

This form is required for Emergency Cohort One and any subsequent cohorts when the 
evacuation type is circular or keyhole.  

The evacuation phase is divided into three subphases defined by DURBEG, DURMID, and the 
remainder of the emergency phase.  The purpose for the evacuation subphases is to allow 
evacuation speed parameters to vary over time. 

REFPNT defines the reference time point for actions in the evacuation and sheltering zone.  The 
user may choose to have the reference time be alarm time (ALARM), which is established by the 
value of OALARM, or first plume arrival (ARRIVAL) at each grid element.  With keyhole 
evacuation, ALARM is the only legal choice for this variable.  

TRAVELPOINT determines whether evacuees move from a spatial element when they cross the 
boundary between the two elements (BOUNDARY) or when they reach the center point of the 
destination element (CENTERPOINT). 
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DURBEG is the duration of the initial subphase of evacuation.  This phase starts when the cohort 
in the shelter and evacuation region begins to evacuate, which is defined by the minimum over 
all radial distances (i) of DLTSHL(i) + DLTEVA(i) after the time designated by REFPNT.  The 
evacuation speed used during this phase is the initial value of ESPEED.  

DURMID defines the duration of the middle subphase of evacuation.  The evacuation speed used 
during this subphase is the middle value of ESPEED.  The evacuation speed used during the final 
subphase, which extends until evacuation is complete or until the end of the emergency phase, 
is the third value of ESPEED.  

The evacuation phase begins when the first individual begins to travel out of the region.  The 
durations of the initial and middle subphases of evacuation are defined by input parameters 
DURBEG and DURMID.  The late phase of evacuation extends until all individuals complete their 
travel or until the end of the emergency phase, whichever is sooner.  Normally, all evacuation 
should be complete by the end of the emergency phase.  

Vectors ESPEED and ESPMUL contain a set of values that correspond to each of the three 
evacuation phases. 

ESPEED is the travel speed of the evacuees.  Three values are required, one for each of the 
evacuation (travel) subphases: initial, middle and late. MACCS requires that all three values be 
the same when TRAVELPOINT is set to BOUNDARY.  They can be different when 
TRAVELPOINT is set to CENTERPOINT.  

ESPMUL is a multiplicative factor that affects ESPEED during adverse weather, i.e., when 
precipitation is occurring. The occurrence of precipitation is determined from HRRAIN, BNDRAN, 
or the meteorological file, depending on the weather option. The value of evacuation speed in an 
element is calculated with the following formulae, where ESPGRD is the grid-level speed 
multiplier ESPGRD_NET or ESPGRD_RAD (supplied on another form):  

Evacuation Speed = ESPEED * ESPMUL * ESPGRD  when precipitation is occurring  

Evacuation Speed = ESPEED * ESPGRD    when no precipitation is occurring  

ESPEED is defined for each of the three subphases (initial, middle, and late) of evacuation, but 
is independent of grid elements. ESPGRD, a speed multiplier defined on the forms Radial 
Evacuation Speed or Network Evacuation Speed, is independent of subphase, but is defined for 
each grid element. When ESPGRD is not defined because Activate Speed Multiplier Model has 
not been selected on the Project Properties/Evac Rotation tab, a value of one is assumed. 

Three values of ESPEED are required, one for each of the evacuation (travel) phases as follows: 
initial, middle, and late. MACCS requires that all three values must be the same when 
TRAVELPOINT is equal to BOUNDARY. 
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Figure 3-88 Phase Duration and Speeds Form 

Table 3-87 Phase Duration and Speeds Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

REFPNT Yes Character None ALARM, ARRIVAL 

TRAVELPOINT Yes Character None BOUNDARY, CENTERPOINT 

DURBEG Yes Real None 0.0 to 86400.0 s 

DURMID Yes Real None 0.0 to 86400.0 s 

ESPEED Yes Real 3 10-6 to106 m/s  

ESPMUL Yes Real 3 0.0 to 1.0 
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Critical Organ Form 

This form is required for Emergency Cohort One and any additional cohorts. 

CRIORG is the critical organ for relocation decisions during the emergency phase.  People remain 
in the grid element when the projected total dose to the critical organ is less than the values that 
trigger relocation. 

 

Figure 3-89 Critical Organ Form 

Table 3-88 Critical Organ Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

CRIORG Yes Character None Must select an Organ name. 
Choice depends on DCF file.  

 

KI Ingestion Linear No Threshold Form 

This form is required for Emergency Cohort One and any subsequent cohorts when the LNT 
dose-response model and the Activate KI Model are selected on the Dose tab of the Properties 
form. 

The KI ingestion model accounts for potential reduction in uptake of inhaled radioiodine by the 
thyroid gland.  The ingested KI saturates the thyroid gland so that the effect of inhaling iodine 
from a plume can be significantly diminished.  The KI ingestion model allows the user to specify 
a population fraction that ingests KI and an associated efficacy factor.  The efficacy factor defines 
the fractional dose reduction to the thyroid gland from inhaled radioiodine.  The efficacy factor 
depends on the relative timing between KI ingestion and exposure to radioiodine.  
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POPFRAC is the fraction of a cohort that ingests KI. A fraction of the population ingesting KI is 
allowed when the LNT dose-response model is used; it must be 0 or 1 when a non-LNT option is 
chosen, as described below.  

EFFACY is a factor used to reduce the dose to the thyroid from inhalation of radioiodine. The 
dose to a population is modified by a factor of (1 - EFFAC) × POPFRAC. 

 

Figure 3-90 KI Ingestion Linear No Threshold Form 

Table 3-89 KI Ingestion Linear No Threshold Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

POPFRAC Yes Real None 0 to 1 

EFFACY Yes Real None 0 to 1 

 

KI Ingestion Threshold or Piecewise Form 

This form is required for Emergency Cohort One and any subsequent cohorts when the Annual 
Threshold or Piecewise Linear dose-response model and the Activate KI Model are selected on 
the Dose tab. 

POPFRAC is the fraction of the population that ingests KI.  When the PL or AT dose-response 
model is used, either all the population or none of the population ingest KI.  A cohort can be split 
into two cohorts, one that takes KI and one that does not to accommodate this restriction.  

EFFACY is a factor used to reduce the dose to the thyroid from inhalation of radioactive iodine. 
The dose to a population is modified by a factor of (1 - EFFAC) when the population ingests KI. 
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Figure 3-91 KI Ingestion Threshold or Piecewise Form 

Table 3-90 KI Ingestion Threshold or Piecewise Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

POPFRAC Yes Real None 0 or 1 

EFFACY Yes Real None 0 to 1 

 

Sheltering and Evacuation Boundary Form 

This form is required for Emergency Cohort One and any additional cohorts when the evacuation 
type is circular or keyhole. When the Radial Evacuation Speed, Network Evacuation Direction, or 
the Network Evacuation Speed forms are used for any of the additional Emergency Cohort 
categories, this form must be completed first to define distances on those forms.  

LASMOV indicates the outer boundary at which evacuees are assumed to disappear from the 
early health effects model and receive no further dose.  MACCS requires that the value be greater 
than or equal to NUMEVA and less than or equal to NUMRAD.  

NUMEVA defines the outer boundary of the sheltering and evacuation region (often the same as 
the emergency planning zone). MACCS requires that NUMEVA be no larger than LASMOV.  
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Figure 3-92 Sheltering and Evacuation Boundary Form 

Table 3-91 Sheltering and Evacuation Boundary Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

LASMOV Yes Integer None 1 to NUMRAD 

NUMEVA Yes Integer None 1 to NUMRAD, but MACCS 
requires 1 to LASMOV 

 

Shielding and Exposure Form 

This form is required for Emergency Scenario One and for each additional Emergency Scenario 
category. 

This section defines the shielding factors for exposure to cloudshine, groundshine, inhalation, and 
deposition onto skin for three types of activities: normal activity, evacuation, and sheltering.  A 
breathing rate is also specified for each type of activity. Normal activity values are used throughout 
the emergency phase for nonevacuating cohorts. 

CSFACT is cloudshine shielding factor. This value is used as a multiplier on the value of 
cloudshine dose that would have been received if the person were standing outside in an 
unshielded location. A value of 0 indicates complete shielding; a value of 1 indicates no shielding. 

PROTIN is inhalation protection factor. This value is used as a multiplier on the value of inhalation 
dose that would have been received if the person were standing outside. A value of 0 indicates 
complete protection from inhalation of radioactive materials; a value of 1 indicates no protection. 

BRRATE is average breathing rate for the specified cohort and activity. 
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SKPFAC is skin protection factor.  This value is used as a multiplier on the value of skin dose that 
would have been received if the person were standing outside.  A value of 0 indicates complete 
protection from aerosol deposition onto the skin; a value of 1 indicates no protection. 

GSHFAC is groundshine shielding factor.  This value is used as a multiplier on the value of 
groundshine dose that would have been received if the person were standing outside in an 
unshielded location and the ground were a perfectly flat surface.  A value of 0 indicates complete 
shielding from groundshine; a value of 1 indicates no protection.  

 

Figure 3-93 Shielding and Exposure Form 

Table 3-92 Shielding and Exposure Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

CSFACT Yes Real 3 0.0 to 1.0 

PROTIN Yes Real 3 0.0 to 1.0 

BRRATE Yes Real 3 0.0 to 1.0 m3/s 

SKPFAC Yes Real 3 0.0 to 1.0 

GSHFAC Yes Real 3 0.0 to 1.0 
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Response Delays Form 

This form is required for Emergency Scenario One and for each additional Emergency Cohort 
category. 

This form defines the delay from the time indicated by REFPNT until the beginning of sheltering 
and the delay from the beginning of sheltering until the beginning of evacuation. 

DLTSHL defines the delay from the time represented by REFPNT to the start of sheltering. Normal 
activity shielding factors are used during this delay. Sheltering shielding factors are used following 
this delay.  One value of DLTSHL must be supplied for each ring in the sheltering/evacuation 
region. 

DLTEVA defines the delay from the beginning of the sheltering period to the beginning of 
evacuation. Sheltering is assumed during this delay.  Evacuation shielding factors are used 
following this delay.  One value must be supplied for each ring in the sheltering/evacuation region. 

 

Figure 3-94 Emergency Actions Delays Form 
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Table 3-93 Emergency Actions Delays Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DLTSHL Yes Real NUMEVA 0 to 3.456 x 106 s or 40 days 

DLTEVA Yes Real NUMEVA 0 to 3.456 x 106 s or 40 days 

 

Radial Evacuation Speed Form 

This form is required for Emergency Cohort One when the Problem Model is Radial and Activate 
Speed Multiplier Model is selected on the Project Properties/Evac Rotation tab.  This form is 
required for each additional Emergency Cohort category when evacuation type is circular or 
keyhole and Activate Speed Multiplier Model is selected. 

ESPGRD_RAD defines the speed multiplier for each grid element where evacuation is treated. 
This includes all grid elements from the center to the outer boundary of evacuation movement, 
defined by LASMOV.  A value of one indicates the speed is the same as the value of ESPEED. 
The ranks of these numbers are shown in the interface.  See Section 4.4.7 for more information. 

 

Figure 3-95 Radial Evacuation Speed Form  
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Table 3-94 Radial Evaucation Speed Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

ESPGRD_RAD Yes Real LASMOV by NUMCOR 0.001 to 1000.0 

 

Network Evacuation Direction Form 

This form is required for Emergency Scenario One when the Problem Model is chosen to be 
Network on the Project Properties/Evac Rotation tab.  This form is required for each additional 
Emergency Cohort category when evacuation type is circular or keyhole. 

ESPGRD_NET is a read-only parameter on this form and is defined on the form Network 
Evacuation Speed. When this parameter is undefined, a value of 1 is used for both the rank and 
the value of the speed multiplier.  

IDIREC defines the evacuation direction.  A value of one indicates an outward evacuation to the 
next grid element, two indicates clockwise evacuation, three indicates inward evacuation, and 
four indicates counterclockwise evacuation.  These numbers are input in the interface as arrows 
that can be clicked to change the evacuation direction. 

 

Figure 3-96 IDIREC values in network evacuation grid 
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Figure 3-97 Network Evacuation Direction Form 

Table 3-95 Network Evacuation Direction Form Inputs 

Parameter 
Name 

Definable Type Dimensions Allowed Values Defined on Form 

ESPGRD_NET No Real LASMOV by 

NUMCOR 

0.001 to 1000.0 Network Evacuation 
Speed 

IDIREC Yes Integer LASMOV by 

NUMCOR 

1 to 4 Network Evacuation 
Direction 

 

Network Evacuation Speed Form 

This form is required for Emergency Cohort One when the Problem Model is Network and Activate 
Speed Multiplier Model is selected on the Project Properties/Evac Rotation tab.  This form is 
required for each additional Emergency Cohort category for which the evacuation type is keyhole 
or circular.  This set of parameters is useful for adjusting speeds to account for bottlenecks in the 
road network or for areas of freely flowing traffic. 
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ESPGRD_NET defines the speed multiplier for each grid element where evacuation is treated. 
This includes all grid elements from the center to the outer boundary of the evacuation movement, 
defined by LASMOV.  A value of one indicates the speed is the same as the value of ESPEED. 
The ranks of these numbers are shown in the interface. See Section 4.4.7 for more information. 

IDIREC is a read-only parameter on this form and is defined on the form Network Evacuation 
Direction.  A value of one indicates an outward evacuation to the next grid element, two indicates 
clockwise evacuation, three indicates inward evacuation, and four indicates counterclockwise 
evacuation.  These numbers are shown in the interface as arrows that display the direction of 
evacuation.  

 

Figure 3-98 Network Evacuation Speed Form 

Table 3-96 Network Evacuation Speed Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values Defined on Form 

ESPGRD_NET Yes Real LASMOV by 

NUMCOR 

0.001 to 1000.0 Network Evacuation 
Speed 

IDIREC No Integer LASMOV by 

NUMCOR 

1 to 4 Network Evacuation 
Direction 
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Population Form 

The Population form is relevant for each emergency cohort when the user chooses SUMPOP as 
the Results Weighting Factor and selects Create from Existing Site File on the Site Data tab. 
When the Populations Assigned form is completed or modified, the Population form is updated. 
The values shown are the number of people assigned to each spatial grid element for the given 
cohort. 

COHORT_POP defines the number of people associated with each spatial grid element for a 
cohort. 

 

Figure 3-99 Population Form 

Table 3-97 Population Form Inputs 

Parameter 
Name 

Definable Type Dimensions Allowed Values Defined on Form 

COHORT_PO
P 

No Real NUMRAD by 

NUMCOR 

0 to 109 Populations 
Assigned 
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Keyhole Definition Form 

The Keyhole Definition form is required when the evacuation Type field is set to Keyhole. 

NSECTR defines the number of sectors to be considered in keyhole evacuation.  This number 
should not exceed NUMCOR/2 – 1. If it does, the evacuation model defaults to a circular one.  

KEYDIS is the radius of the circular portion of the keyhole. KEYDIS is the index of a radius in 
SPAEND. The outer radius of the evacuation region is defined by NUMEVA. Setting KEYDIS to 
zero eliminates the circular portion of the keyhole. Setting KEYDIS to NUMEVA eliminates the 
key portion of the keyhole. 

 

Figure 3-100 Keyhole Definition Form 

Table 3-98 Keyhold Definition Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NSECTR Yes Integer None 1, 3, 5, 7, …, 31 

KEYDIS Yes Integer None 0 to NUMEVA 

 

 Early Fatality and Injury Parameters 

 Fatality Model Description 

The individual risk of early fatality is modeled in MACCS using a two-parameter Weibull function, 
termed a hazard function (Evans, Moeller, and Cooper, 1985).  The hazard function is used to 
sum the cumulative risk from several potential types of damage as follows: 
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𝑅𝐼𝑆𝐾 = 1 − 𝑒− ∑ 𝐻𝑖𝑖   (3-34) 

Where  

𝐻𝑖 = 0.693 (
𝐷𝑂𝑆𝐸𝑖

𝐸𝐹𝐹𝐴𝐶𝐴𝑖
)

𝐸𝐹𝐹𝐴𝐶𝐵𝑖

 

DOSEi = effective acute dose to organ i (described later), 

EFFACAi = the alpha (LD50) parameter in the hazard function (Evans, Moeller, and 
Cooper, 1985, p. II-8) for organ i, and 

EFFACBi = the beta or exponential parameter in the hazard function that defines the 
steepness of the dose-response function for organ i. 

In addition to the two Weibull parameters, a dose threshold is incorporated into the early fatality 
model. When the dose to any organ is below the user-specified threshold (see EFFTHR below), 
the hazard function (Hi) for that organ is set to 0. 

When radioactive material is inhaled and retained in the respiratory system, an individual may 
continue to receive a radiation dose for extended periods of time after the material was inhaled. 
Depending on particle size and chemical form, clearance mechanisms may remove the material 
from the body or transport it from the respiratory system to other organs of the body.  Acute 
radiation doses represent doses delivered to an organ over a relatively brief period.  The concept 
of lifetime dose commitment is widely used in radiation protection (Eckerman, Wolbarst, and 
Richardson 1989), but is not appropriate for estimating acute health effects.  

As applied in MACCS, lifetime dose refers to the dose received over a 50-year commitment period 
following inhalation by a standard reference person who is 30 years old.  Lifetime doses are used 
to determine the need for mitigative actions and to estimate cancers occurrences and population 
doses. 

Implementation of the Evans, Moeller, and Cooper (1985) early health effects models requires a 
calculation method that takes account of dose protraction for radioactive material inhaled and 
retained in the respiratory system.  The assumption is that the exposure occurs on the first day 
but that dose is received by an organ over a period of time.  MACCS applies dose reduction 
factors to protracted doses that contribute to early health effects.  Dose reduction factors are 
derived from LD50 or D50 values that apply to a sequential set of time periods of fixed length.  In 
addition, for the calculation of early fatalities and injuries in MACCS, a new measure of dose was 
defined to reduce the computational demands of the calculations.  This dose is termed an effective 
acute dose.  This dose is different than the effective dose defined by ICRP. 

The effective acute dose, De, is the dose, which if it were delivered entirely in one day, would 
induce the same health effects as an actual dose delivered over many days.  Thus, 

𝐻 = 𝑙𝑜𝑔2 (
𝐷𝑒

𝛼1
)

𝛽

= 𝑙𝑜𝑔2 (∑
𝐷𝑡

𝛼𝑡
𝑡

)

𝛽

  (3-35) 
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Where  

De  = C ∙ Fe  

Dt  = C ∙ Ft 

C  = the amount of material inhaled from the plume,  

Fe  = the effective acute DCF, 

Ft  = the DCF for the actual dose, Dt, delivered over time t.  

t  = the LD50 or D50 delivered over time t. 

1  = the LD50 or D50 delivered over 1 day. 

Substitution yields the following result: 

𝐹𝑒 = ∑ (
𝛼1

𝛼𝑡
𝐹𝑡)

𝑡

   
 (3-36) 

Effective acute DCFs are supplied only for the organs used for calculating early health effects.  
The acute dose commitment period from inhaled and internally deposited radionuclides is from 
one week to one year, depending on the organ.  The organs in the DCF file for which effective 
acute dose coefficients have not been assessed are assigned values of -1.0, which prevents their 
inadvertent use since any resulting doses would be negative.  The dose reduction factors 

(i.e., 1/t) that underly the acute values in the dose coefficient files supplied with WinMACCS are 
shown in the table below.  The values in this table are taken from Evans, Moeller, and Cooper 
(1985) and are also documented in H-N Jow et al. (1990).  

Table 3-99 Effective Acute Dose Reduction Factors Used to Construct Acute Dose 
Coefficients for Inhalation in MACCS DCF Files. 

 Period after Initial Exposure (Days) 

 0–1 1–7 7–14 14–30 30–200 200–365 

Organ Name Effective Acute Dose Reduction Factors (1 /t) (Dimensionless) 

 RED MARR 1.0 0.5 0.5 0.25   

LUNGS 1.0 0.0625 0.0625 0.027 0.027 0.0109 

THYROID 1.0 0.2 0.2 0.2   

STOMACH 1.0 0.37     

LOWER LI 1.0 0.43     

SMALL IN 1.0 0.43     

 

For early fatalities (with supportive treatment) for bone marrow irradiation, Evans, Moellen, and 
Cooper (1985) show LD50 values of 4.5 Gy for the 0- to 1-day period, 9 Gy for the 1- to 14-day 
period, and 18 Gy for the 14- to 30-day period. Instead of calculating three different red marrow 
doses and applying the three different values of LD50 to calculate risk, a single red marrow dose 
is calculated using the effective acute DCF, as described above.  The result is the same as the 
one that would have been obtained if doses over all three periods had been obtained and 
Equation (3-35) had been used directly.  

In the MACCS model, exposure via the inhalation pathway is assumed to occur on the first day, 
and this exposure results in committed doses for each of the periods listed in the table.  To 
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illustrate use of the above table, effective acute red marrow dose from inhaling a contaminant is 
100% of the first day's committed dose, 50% of the next 13 days' committed dose, plus 25% of 
the subsequent 16 days' committed dose.  The effective acute dose from inhalation is added to 
doses from external sources to get a total acute dose.  The external exposures are also assumed 
to occur in the first day, so they are applied with a dose reduction factor of one.  The total effective 
acute dose is used in the risk equation with the LD50 for the 0- to 1-day period to evaluate the 
hazard function for bone marrow.  

The current implementation of the early health effect models does not distinguish between 
cloudshine, groundshine, and the 0- to 1-day inhalation dose commitment.  These pathways are 
considered in this model to be equally effective in causing damage.  Finally, the radiation 
weighting factor used for acute alpha radiation is 10 instead of the conventional value of 20 used 
for lifetime DCFs, which corresponds to the fact that the endpoint of the damage for early and 
latent health effects is different (i.e., the former corresponds to cell death and the latter to 
chromosome damage).  

The error introduced by attributing the entire direct exposure dose to the first day is usually small 
and is in the direction of overestimating the hazard function and resulting value of risk of an early 
fatality. In most cases, emergency plans should ensure that no individuals are permitted to remain 
in a contaminated area for much longer than one day when dose levels are high enough to pose 
a risk of early health effects.  

This section describes the MACCS models used to estimate early health effect cases and 
individual risks. Results to be processed (e.g., total cases of early fatalities, average individual 
risk of early fatalities, and centerline risk vs. distance of early fatalities) are described in later 
sections of this document. To produce early fatality results, the early fatality model must be 
activated on the Properties form.  

 Injury Model Description 

The individual risk of each type of early injury is modeled in MACCS using an approach analogous 
to the one used for early fatality risk (Evans, Moller and Cooper 1985).  The early injury risk model 
differs from the early fatality model in that, instead of summing the damage from more than one 
organ, only a single organ is evaluated at a time. The early injury risk function is as follows: 

𝑅𝐼𝑆𝐾 = 1 − 𝑒− ∑ 𝐻𝑖𝑖   (3-37) 

Where  

𝐻𝑖 = 0.693 (
𝐷𝑂𝑆𝐸𝑖

𝐸𝐼𝐹𝐴𝐶𝐴𝑖
)

𝐸𝐼𝐹𝐴𝐶𝐵𝑖

 

DOSEi = effective acute dose (described in Section 3.3.7.1 Fatality Model 
Description) to organ i, 

EIFACAi = the alpha (D50) parameter in the hazard function (Evans, Moller and Cooper 
1985, p. II-8) for a one-day dose to organ i, and 

EIFACBi = the beta or exponential parameter in the hazard function that defines the 
steepness of the dose-response function for organ i. 
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In addition to the two Weibull parameters, a dose threshold is incorporated into the early injury 
model. When the dose to any of the target organs is below the user-specified threshold (see 
EITHRE in the following discussion), the hazard function for this type of early injury is set to 0, 
which results in the risk being zero. 

In addition to the values described above, the user must specify the fraction of the population that 
is susceptible to the injury, EISUSC. Results to be processed (e.g., total cases of a given injury, 
average individual risk, and centerline risk vs. distance of a given injury) are described in later 
sections. To produce early injury results, early injuries must be activated on the Properties form. 

 Latent Cancer Model Description 

The cancer risk model included in the first public release version of MACCS was based on a 
linear-quadratic risk model. In response to recommendations presented in an NRC-sponsored 
reassessment of cancer risk models published in 1991 and referred to as LMF-132 (Abrahamson 
et al. 1991), the cancer risk model was updated in MACCS version 1.5.11.1 (Chanin et al. 1993) 
to include a linear, no-threshold dose-response function. The capability to exercise the linear-
quadratic risk model was retained although it is not typically used at present for calculation of 
cancer-induction risk. 

Linear-Quadratic Dose-Response Model 

The linear-quadratic dose-response model assumes that risk, R, increases linearly with increases 
in dose, D, at low doses and that risk increases quadratically with respect to dose at higher dose 
levels. The linear-quadratic dose-response function has the form (ICRP, 1991): 

𝑅(𝐷) = 𝐷 ⋅ (𝑎 + 𝛽𝐷)  (3-38) 

The implementation of the linear-quadratic dose-response model in MACCS is based on the 
recommendations of NRC-sponsored work (Evans 1990) and is described as follows.  In the 
period modeled by EARLY, a quadratic dose-response relationship is used when dose to the 
target organ is less than a user-specified limit (MACCS ACTHRE input parameter).  The dose-
response function used in this case has the form: 

R(DOSE) = DOSE • CFRISK • (DOSEFA + DOSE • DOSEFB) • ACSUSC  (3-39) 

Where 

DOSE = 50-year lifetime dose commitment to the target organ, 

CFRISK = lifetime risk factor for cancer injury, 

DOSEFA = the linear factor, , of the dose dependence, 

DOSEFB = the quadratic factor, , of the dose dependence, and 

ACSUSC = fraction of the population susceptible to the latent cancer. 

When dose to the target organ is greater than the dose limit ACTHRE, the upper-bound linear 
dose-response relationship is used: 

R(D) = DOSE • CFRISK • (DOSEFA + ACTHRE • DOSEFB) • ACSUSC  (3-40) 

The change from Equation (3-39) to Equation (3-40) at the threshold value causes a discontinuity 
in the slope but not of the risk factor itself.  
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During the long-term phase modeled by CHRONC, it is assumed that exposure of the population 
is limited to low levels by mitigative actions and therefore the quadratic term of the risk equation 

is ignored. Cancer risk is calculated using only the linear term, R(D) = D, of the quadratic dose 
response function. Cancer risk from all pathways (groundshine, resuspension inhalation, and 
ingestion) is modeled with the linear dose-response function given below: 

R(D)= DOSE • CFRISK • DOSEFA • ACSUSC  (3-41) 

The meaning of DOSE and CFRISK depends on whether individual risk (groundshine and 
resuspension) or collective risk (also including ingestion and decontamination worker doses) is 
being calculated. 

The quadratic form of the dose-response relationship is deactivated by assigning zero to the 
ACTHRE input parameter. 

Dose and Dose-Rate Effectiveness Factor 

In response to recommendations presented in LMF-132, the MACCS cancer risk model was 
updated in MACCS version 1.5.11.1 to include a dose and dose-rate effectiveness factor in the 
dose-response function as follows: 

𝑅( 𝐷) = 𝛼 ⋅
𝐷

𝐷𝐷𝑅𝐸𝐹
  D < 0.2 Gy or 0.1 Gy per hour  (3-42) 

𝑅( 𝐷) = 𝛼 ⋅ 𝐷  D > 0.2 Gy or 0.1 Gy per hour  

This function is shown as the LNT curve in Figure 3-79. DDREF is the dose and dose rate 
effectiveness factor. The LMF-132 report states that the DDREF is to be applied "when the total 
dose is less than 0.2 Gray, and for higher doses when the dose rate is less than 0.1 Gray per 
hour." This guidance for the application of the DDREF is identical to the recommendations 
provided in ICRP 60. The DDREF is given a value of 2 in LMF-132 for central estimates of most 
cancer types; for central estimates of breast and thyroid cancers, DDREF is assigned a value of 
1 in LMF-132. In current modeling with FGR-13 dose coefficient files, DDREF is generally chosen 
to be 2 for all organs but breast, which is assigned a value of 1.  

The user defines the lifetime dose commitment, input parameter DDTHRE, below which the 
DDREFA is applied to cancer risk calculations for emergency-phase exposures. MACCS applies 
DDREFA to all the dose calculations in the CHRONC module because doses should always be 
less than 0.2 Gy after the end of the emergency phase.  

 Injury and Fatality Forms and Parameters 

Early Fatality Parameters Form 

The Early Fatality Parameters form is not used when the DCF file FGRDCF is selected on the 
Project Properties/Dose tab or when Early Fatality Effects is not checked on the Project 
Properties/Early Effects tab. It is required when either of the other DCF file types is selected and 
Early F atality Effects is checked.  

NUMEFA is the number of early fatality effects to be included in the total risk of early fatality. 
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ORGNAM is an organ name. The possible values depend on the DCF file chosen. Possibilities 
are limited to supported acute organs (ones beginning with A-).  

EFFACA is the Alpha factor (LD50) in the hazard function for the target organ. 

EFFACB is the beta factor (shape parameter) in the hazard function for the target organ. 

EFFTHR is the threshold dose below which the risk of a fatality is zero. 

 

Figure 3-101 Early Fatality Parameters Form 

Table 3-100 Early Fatality Parameters Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUMEFA Linked Integer None 1 to 5 

ORGNAM Yes Character NUMEFA Acute Organ name 
from list in Table 3-64 

EFFACA Yes Real NUMEFA 1.0 to 100. Gy 

EFFACB Yes Real NUMEFA 1.0 to 100.  

EFFTHR Yes Real NUMEFA 0.0 to 100. Gy 
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Early Injury Parameters Form 

The Early Injury Parameters form is not used when the DCF file FGRDCF is selected on the 
Project Properties/Dose tab or when Early Injury Effects is not checked on the Project 
Properties/Early Effects tab. It is required when either of the other DCF file types is selected and 
Early Injury Effects is checked. 

NUMEIN is the number of early injury types that are to be calculated. 

EINAME is the name of each type of early injury.  This is a user-defined label. 

ORGNAM is an organ name. The possible values depend on the DCF file chosen. Possibilities 
are limited to organs with acute dose coefficients (ones beginning with A-).  

EISUSC is the fraction of the population that is susceptible to the type of early injury. 

EITHRE is the threshold dose below which risk of the injury is zero. 

EIFACA is the alpha factor (D50) in the hazard function for the injury. 

EIFACB is the beta (shape) factor in the hazard function for the injury. 

 

Figure 3-102 Early Injury Parameters Form 
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Table 3-101 Early Injury Parameters Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUMEIN Linked Integer None 1 to 10 

EINAME Yes Character NUMEIN 1 to 16 characters 

ORGNAM Yes Character NUMEIN Acute Organ name from list in Table 
3-64 

EISUSC Yes Real NUMEIN 0.0 to 1.0 

EITHRE Yes Real NUMEIN 0.0 to 1000.0 Gy 

EIFACA Yes Real NUMEIN 0.0 to 1000.0 Gy 

EIFACB Yes Real NUMEIN 0.0 to 100.0 

 

Latent Cancer Parameters Form 

The Latent Cancer Parameters form is required when Latent Cancer Effects is checked on the 
Project Properties/Early Effects tab.  

NUMACA is the number of latent cancers that are to be calculated. 

ACNAME is the name of each type of latent cancer.  

ORGNAM is the name of the target organ for each type of latent cancer effect. The possible 
values offered depend on the DCF file. Possibilities are limited to supported latent organs (ones 
beginning with L-). 

ACSUSC is the fraction of the population that is susceptible to the latent cancer. 

DOSEFA defines the linear factor, alpha, of the dose dependence in the cancer risk model. 

DOSEFB defines the quadratic factor, beta, of dose dependence in the cancer risk model. It is 
used in EARLY, but not in CHRONC. The quadratic factor is used when dose to an organ is below 
ACTHRE. The user should assign a value of zero to deactivate the quadratic portion of the linear-
quadratic risk model. 

CFRISK is the lifetime risk factor for a cancer fatality. This parameter has units of risk/Sievert.  

CIRISK is the lifetime risk factor for a cancer incidence (injury). This parameter has units of 
risk/Sievert.  

DDREFA is the dose and dose-rate effectiveness factor. When the lifetime dose commitment to 
an organ during the EARLY exposure period is less than DDTHRE, the risk of cancer for that 
organ is divided by DDREFA. Doses calculated in CHRONC are always divided by DDREFA 
because the doses are assumed to be below DDTRHE. 
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Figure 3-103 Latent Cancer Parameters Form 

Table 3-102 Latent Cancer Parameters Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUMACA Linked Integer None 1 to 10 

ACNAME Yes Character NUMACA 1 to 10 characters 

ORGNAM Yes Character NUMACA Lifetime Organ name 
from list in Table 3-64 

ACSUSC Yes Real NUMACA 0.0 to 1.0 

DOSEFA Yes Real NUMACA 0.0 to 2.0 

DOSEFB Yes Real NUMACA 0.0 to 2.0 

CFRISK Yes Real NUMACA 0.0 to 1.0 per Sv 

CIRISK Yes Real NUMACA 0.0 to 1.0 per Sv 

DDREFA Yes Real NUMACA 1.0 to 10.0 
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Latent Cancer Thresholds Form 

The Latent Cancer Thresholds form is required when Latent Cancer Effects is checked on the 
Project Properties/Early Effects tab. 

ACTHRE is the dose limit for the linear-quadratic dose-response relationship.  For doses less 
than ACTHRE, a quadratic relationship is used.  This parameter should be assigned a value of 
zero when the user wishes to deactivate the linear-quadratic risk model in favor of a linear 
relationship.  This parameter might better be described as a breakpoint in the dose-response 
curve and its use is distinct from the model for a threshold in the dose-response function described 
in Section 3.3.4.  

DDTHRE is the threshold dose for applying the dose and dose-rate effectiveness factor DDREFA. 
When the lifetime dose commitment incurred during the EARLY exposure period is less than 
DDTHRE, the risk of cancer from irradiation of that organ is reduced by dividing by DDREFA.  

 

Figure 3-104 Latent Cancer Threholds Form 

Table 3-103 Latent Cancer Thresholds Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

ACTHRE Yes Real None 0.0 to 10.0 Sv 

DDTHRE Yes Real None 0.0 to 1.0 Sv 
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 Output Control 

 Output Control Forms and Parameters 

Debug Options Form 

IPRINT specifies the quantity of debug output that is desired.  The higher the value, the more 
output that is printed. Normal runs should use a value of zero.  

Normally, centerline doses can be selected when IPLUME = 1 from the Centerline Dose form 
under EARLY/Output Control. An alternative method for evaluating centerline doses from EARLY 
is to set the output control variable, IPRINT, to a value greater than zero. When this is done, a 
listing of dose vs. distance for all the organs is included in the output. Since this is written for each 
weather trial, this option is normally used for single weather trial runs. 

For various values of IPRINT, the output file contains some intermediate results.  These are 
described below.  

IPRINT ≥1: This option produces skin DCFs, centerline doses for all organs (when 
IPLUME=1), Gaussian histogram and cloudshine correction factors, and return code values 
(RETCOD). 

IPRINT ≥2: This option produces final groundshine dose rate for each organ and each plume 
segment. 

IPRINT ≥4: This option produces total acute dose for organs 2 and 3, early fatality, early injury, 
and cancer risk values for each spatial element.  

IPRINT ≥8: This option produces acute dose to organs 2 and 3 after completion of subroutine 
RELZON, acute dose to organs 2 and 3 after completion of subroutine ESTAT. 

When RISCAT is set to True and weather bin sampling is selected, the relative contribution of 
each of the weather-category bins to the mean consequence value is included in the MACCS 
output. 
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Figure 3-105 Debug Options Form 

Table 3-104 Debug Option Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

IPRINT Yes Integer None 0 to 10 

RISCAT Yes Logical None True, False 

 

Health-Effect Cases Form 

The Health Effect Cases form is optional. Cancer results requested from this form are 
automatically produced by CHRONC so that the results can be combined in the output.  In the 
results calculated by CHRONC, the cancer results include the following dose pathways: 
(1) groundshine to the residents, (2) inhalation of resuspended aerosols by the residents, 
(3) consumption of food and water produced in the region (not necessarily by the residents), and 
(4) groundshine exposure to workers required to decontaminate the area.  

NUM1 specifies the number of results. The value is determined by the number of rows in the grid 
containing values of vectors NAME, I1DIS1, I2DIS1, and Report Options. 

NAME indicates the type of result desired. Choices for this are presented by WinMACCS, and 
depend on the values of parameter EINAME, which represents the types of early injuries, and 
ACNAME, which represents the types of latent cancers.  Totals for early fatalities and cancer 
fatalities are also available.  

I1DIS1 defines the inner spatial interval of the region of interest.  The distance corresponds to the 
inner boundary of this ring.  
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I2DIS1 defines the outer spatial interval of the region of interest.  The distance corresponds to the 
outer boundary of this ring.  MACCS requires that the value must be greater than or equal to 
I1DIS1. 

Report Options determine whether CCDF data are written to the MACCS output file and whether 
the results are to be included in the WinMACCS summary report. WinMACCS reports can also 
be generated on demand and independently of the choice of Report Options. 

 

Figure 3-106 Health-Effect Cases Form 
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Table 3-105 Health-Effect Cases Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUM1 Linked Integer None 0 to 40 

NAME Yes Character NUM1 ERL FAT/TOTAL, 

ERL INJ/[EINAME], 

CAN FAT/[ACNAME], 

CAN FAT/TOTAL, 

CAN INJ/[ACNAME], 

CAN INJ/TOTAL 

I1DIS1 Yes Integer NUM1 1 to NUMRAD 

I2DIS1 Yes Integer NUM1 1 to NUMRAD (MACCS 
requires I2DIS2 ≥ I1DIS1) 

Report Options Yes Character NUM1 CCDF, NONE, REPORT, 
CCDF & REPORT 

 

Early-Fatality Radius Form 

The Early-Fatality Radius form is optional.  This result type is unavailable when Federal Guidance 
Report FGRDCF is selected on the Dose tab of the Properties form or when Early Fatality Effects 
is not selected under the Early Effects tab of the Properties.  

NUM2 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors RISTHR and Report Options.  

RISTHR defines the risk threshold used for calculating the fatality radius.  It estimates the 
maximum distance at which a specified level of early fatality risk is exceeded.  The user can obtain 
information about the size of the region in which early fatalities may possibly occur by setting this 
parameter to zero.  

Report Options determine whether additional CCDF data are written to the MACCS output file 
and whether the results are to be included in the WinMACCS summary report. 
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Figure 3-107 Early-Fatality Radius Form 

Table 3-106 Early-Fatality Radius Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUM2 Linked Integer None 0 to 10 

RISTHR Yes Real NUM2 0.0 to 1.0 

Report Options Yes Character NUM2 CCDF, NONE, REPORT, 
CCDF & REPORT 

 

Population Exceeding Threshold Form 

The Population Exceeding Threshold form is optional. 

This output type provides an estimate of the number of people who receive acute or lifetime doses 
exceeding a user-definable level.  This consequence measure is for doses calculated in the 
EARLY module.  There is no analogous capability for doses estimated in CHRONC or for 
combined doses estimated in EARLY and CHRONC. 

NUM3 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors NAME, DOSTH3 and Report Options. 

NAME defines the name of the organ to which the dose threshold applies.  
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DOSTH3 defines the dose threshold that is used for counting the population. 

Report Options determine whether CCDF data are written to the MACCS output file and whether 
they are included in the WinMACCS summary report. 

 

Figure 3-108 Population Exceeding Threshold Form 

Table 3-107 Population Exceeding Threshold Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUM3 Linked Integer None 0 to 10 

NAME Yes Real NUM3 Organ name from list in Table 3-64 

DOSTH3 Yes Real NUM3 0.0 to 1000.0 Gy or Sv 

Report Options Yes Character NUM3 CCDF, NONE, REPORT, CCDF & 
REPORT 

 

Average Individual Risk Form 

The Average Individual Risk form is optional. Average individual risk is obtained by taking the sum 
of the risk values in all sectors at a given distance and dividing it by the number of sectors.  The 
result is based on a phantom person residing in each grid element and does not depend on site 
data (i.e., population distribution).  

Cancer results are automatically produced by CHRONC so that the results can be combined in 
the MACCS output. When this result is produced by CHRONC, it is only a measure of the risk 
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from the dose pathways of groundshine and inhalation of resuspended aerosols.  The risk 
presented in this result does not include doses from ingestion of food and water by the population 
or doses to workers required to decontaminate the region.  The reason these doses are excluded 
is that they cannot necessarily be attributed to the same population that resides in the area being 
evaluated.  

NUM4 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors I1DIS4, NAME, and Report Options. 

I1DIS4 specifies outer spatial boundary.  For example, when I1DIS4 is two, the associated 
average risk is calculated from the center of the grid to the value of SPAEND(2).  

NAME indicates the type of result desired. Choices are contained in a dropdown menu and 
depend on the values of parameter EINAME, which are the types of early injuries, and ACNAME, 
which are the types of latent cancers. Totals for early fatalities and cancer fatalities are also 
available.  

Report Options determine whether CCDF data are written to the MACCS output file and whether 
they are included in the summary report. 

 

Figure 3-109 Average Individual Risk Form 
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Table 3-108 Average Individual Risk Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUM4 Linked Integer None 0 to 20 

I1DIS4 Yes Integer NUM4 1 to NUMRAD 

NAME Yes Real NUM4 ERL FAT/TOTAL, 

ERL INJ/[EINAME], 

CAN FAT/[ACNAME], 

CAN FAT/TOTAL, 

CAN INJ/[ACNAME] 

Report Options Yes Character NUM4 CCDF, NONE, REPORT, 
CCDF & REPORT 

 

Population Dose Form  

The Population Dose form is optional.  This form requests that population dose to a given organ 
be reported.  The user must supply the name of the target organ as well as the inner and outer 
spatial intervals of the region of interest. When only the EARLY module is run, this result reflects 
only the pathways considered by EARLY.  When both EARLY and CHRONC are run, the 
population dose from all pathways is included in the calculation.  The CHRONC pathways include 
(1) groundshine dose to the population, (2) inhalation of resuspended aerosols by the population, 
(3) food and water ingestion doses resulting from deposition within the region (not necessarily 
ingested by the population within the region), and (4) doses to workers decontaminating the 
region.  

NUM5 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors NAME, I1DIS5, I2DIS5, and Report Options. 

NAME is the name of the target organ for the dose calculation.  The possible values offered 
depend on the DCF file chosen and include only lifetime doses. 

I1DIS5 defines the inner spatial interval of the region of interest. The distance is the inner radius 
of the specified ring.  

I2DIS5 defines the outer spatial interval of the region of interest. The distance is the outer radius 
of the specified ring. MACCS requires that its value must be greater than or equal to I1DIS5. 

Report Options determine whether CCDF data are written to the MACCS output file and whether 
they are included in the summary report. 
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Figure 3-110 Population Form Dose 

Table 3-109 Population Form Dose Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUM5 Linked Integer None 0 to 10 

NAME Yes Character NUM5 Organ name from list in Table 3-64 

I1DIS5 Yes Integer NUM5 1 to NUMRAD 

I2DIS5 Yes Integer NUM5 1 to NUMRAD (MACCS requires 
I2DIS5 ≥ I1DIS5) 

Report Options Yes Character NUM5 CCDF, NONE, REPORT, CCDF & 
REPORT 

 

Centerline Dose Form 

The Centerline Dose form is optional. This form is available when No Wind Shift with Rotation 
(IPLUME=1) is selected on the Evac/Rotation tab on the Properties form. In this case, MACCS 
reports the centerline dose between a range of distances for a set of dose pathways and for acute 
and lifetime doses. 
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The following pathways/dose types are supported: 

Pathway Description Calculation 

CLD cloudshine dose EARLY 

GRD groundshine dose EARLY, CHRONC 

INH ACU acute dose from inhalation of the passing plume EARLY 

INH LIF lifetime dose from inhalation of the passing plume EARLY, CHRONC 

TOT ACU total acute dose from all direct exposure pathways EARLY 

TOT LIF total lifetime dose from all direct exposure pathways EARLY, CHRONC 

RES ACU acute dose from inhalation of resuspended material after 
plume passage 

EARLY 

RES LIF lifetime dose from inhalation of resuspended material after 
plume passage 

EARLY, CHRONC 

 

Depending on the exposure pathways and dose types requested, the results are calculated by 
EARLY and/or CHRONC. When both EARLY and CHRONC are being run, CHRONC 
automatically produces all the results for the pathways it includes. When pathways 'GRD', ‘INH 
LIF’, 'RES LIF', or 'TOT LIF' are chosen, those results are automatically produced by CHRONC. 
The other pathway values are only produced by EARLY. 

An alternative method to request centerline doses from EARLY is to set the output control 
variable, IPRINT, to a value greater than 0.  When this is done, a listing of dose vs. distance for 
all organs or risk are included in the output.  

NUM6 specifies the number of centerline dose results to be reported.  Its value is determined by 
the number of rows in the grid containing vectors ORGNAM, PATHNM, I1DIS6, I2DIS6, and 
Report Options. 

ORGNAM is the name of the target organ for the dose calculation.  The possible values offered 
depend on the DCF file chosen.  

PATHNM indicates the pathway/dose type to be used for the calculation.  The pathway name is 
ignored when ‘A-SKIN’ is specified as the target organ because direct dry deposition is the only 
exposure pathway considered for skin. 

I1DIS6 defines the inner spatial interval of the region of interest.  The distance is the inner 
boundary of the specified ring.  

I2DIS6 defines the outer spatial interval of the region of interest.  The distance is the outer 
boundary of the specified ring. MACCS requires that the value must be greater than or equal to 
I1DIS6. 
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Figure 3-111 Centerline Dose Form 

Table 3-110 Centerline Dose Form Inputs 

Parameter 
Name 

Definable Type Dimensions Allowed Values 

NUM6 Linked Integer None 0 to 10 

ORGNAM Yes Character NUM6 Organ name from list in Table 3-64 

PATHNM Yes Character NUM6 CLD, GRD, INH ACU, INH LIF, TOT 
ACU, TOT LIF, RES LIF, RES ACU 

I1DIS6 Yes Integer NUM6 1 to NUMRAD 

I2DIS6 Yes Integer NUM6 1 to NUMRAD (MACCS requires 
I2DIS6 ≥ I1DIS6) 

Report Options Yes Character NUM6 CCDF, NONE, REPORT, CCDF & 
REPORT 

 

Centerline Risk Form 

The Centerline Risk form is optional. This form is available when Wind Shift and Rotation is set 
to No Wind Shift with Rotation (IPLUME=1) on the Evac/Rotation tab on the Properties form. 

Centerline risk is calculated for phantom individuals located directly under the plume centerline 
who are exposed to air and ground concentrations.  The centerline risk at each distance in the 
region is treated as a separate result and MACCS generates a distribution of the consequence 
measure for each of the spatial intervals within the specified range. 

Cancer results are automatically produced by CHRONC.  The CHRONC values represent risk 
from groundshine and inhalation of resuspended aerosols.  This risk does not include doses from 
ingestion of food and water or doses to workers decontaminating the area. 

NUM7 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors NAME, I1DIS7, I2DIS7, and Report Options. 
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NAME indicates the type of health effect requested. Choices are listed in a dropdown menu and 
depend on the values of parameter EINAME, the types of early injuries, and ACNAME, the types 
of latent cancers.  

I1DIS7 defines the inner spatial interval of the region of interest.  The distance is the inner 
boundary of this ring.  

I2DIS7 defines the outer spatial interval of the region of interest. MACCS requires that the value 
must be greater than or equal to I1DIS7. The distance is the outer boundary of this ring.  

Report Options determine whether CCDF data are written to the output file and whether the data 
are included in the report generated after simulations are completed. 

 

Figure 3-112 Centerline Risk Form 

Table 3-111 Centerline Risk Form 

Parameter Name Definable Type Dimensions Allowed Values 

NUM7 Linked Integer None 0 to 10 

NAME Yes Character NUM7 ERL FAT/TOTAL, 

ERL INJ/[EINAME], 

CAN FAT/[ACNAME], 

CAN FAT/TOTAL, 

CAN INJ/[ACNAME], 

CAN INJ/TOTAL 

I1DIS7 Yes Integer NUM7 1 to NUMRAD 

I2DIS7 Yes Integer NUM7 1 to NUMRAD (MACCS 
requires I2DIS7 ≥ I1DIS7) 

Report Options Yes Character NUM7 CCDF, NONE, REPORT, 
CCDF & REPORT 



 

3-168 

Population Weighted Risk Form 

The Population Weighted Risk form is optional. Population-weighted health effect risk is obtained 
by calculating the number of cases of a health effect within a region and dividing by the total 
population of that region. It accounts for the population distribution.  

Cancer results are automatically produced by CHRONC. CHRONC risks include the exposure 
pathways of groundshine and inhalation of resuspended aerosols.  

The population-weighted risk in CHRONC is calculated by estimating the number of cancer cases 
and dividing that value by the population of the region.  The risk presented in this result does not 
include the societal pathways of (1) ingestion of contaminated food and water or (2) doses to 
workers decontaminating the area. 

NUM8 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors NAME, I1DIS8, I2DIS8, and Report Options. 

NAME indicates the type of health effect desired. Choices depend on the values of parameter 
EINAME, the types of early injuries, and ACNAME, the types of latent cancers.  

I1DIS8 defines the inner radius of the region of interest.  The radius is the inner boundary of this 
ring.  

I2DIS8 defines the outer boundary of the region of interest.  The radius is the outer boundary of 
this ring. MACCS requires that the value must be greater than or equal to I1DIS8. 

Report Options determine whether CCDF data are written to the output file and whether they are 
included in the MACCS report generated after simulations are completed. 

 

Figure 3-113 Population Weighted Risk Form 
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Table 3-112 Population Weighted Risk Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUM8 Linked Integer None 0 to 20 

NAME Yes Character NUM8 ERL FAT/TOTAL, 

ERL INJ/[EINAME], 

CAN FAT/[ACNAME], 

CAN FAT/TOTAL, 

CAN INJ/[ACNAME], 

CAN INJ/TOTAL 

I1DIS8 Yes Integer NUM8 1 to NUMRAD 

I2DIS8 Yes Integer NUM8 1 to NUMRAD (MACCS 
requires I2DIS8 ≥ I1DIS8) 

Report Options Yes Character NUM8 CCDF, NONE, REPORT, 
CCDF & REPORT 

 

Peak Dose Form 

The Peak Dose form is optional. Results are based on the dose at each distance for a range of 
distances, analogous to centerline dose results.  Reporting of centerline doses is not an option 
when wind shift is considered because a centerline does not exist when multiple plume segments 
each travel in their own direction.  Peak dose is more general than centerline dose because it 
calculates the maximum dose around the compass for any of the plume transport options.  The 
implementation of this result differs from centerline dose in two ways:  (1) there is no option to 
report a breakdown of individual doses by pathway and (2) peak dose represents an average 
dose over the width of a fine grid and is not a point value like centerline dose.  

Peak doses are produced for each emergency response cohort.  The doses depend on the 
definition of that cohort in terms of evacuation and relocation.  When the CHRONC module is 
exercised, this result is automatically produced by CHRONC as well. However, the peak dose is 
calculated on the fine grid level in EARLY but only on the course grid level in CHRONC. 

The overall results represent the combination of doses calculated by EARLY and CHRONC. 
However, the overall results may be misleading because peak doses for the various cohorts may 
occur at different angular locations.  Summation of these values may be questionable when 
multiple plume segments travel in different directions (i.e., when NUMREL is greater than 1 and 
IPLUME is 2 or 3).  

NUMA specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors NAME, I1DISA, I2DISA, and Report Options. 

NAME is the name of the target organ for the dose calculation.  The possible values depend on 
the choice of DCF file.  

I1DISA defines the inner radius of the region of interest.  The radius is the inner boundary of this 
ring.  

I2DISA defines the outer radius of the region of interest.  The radius is the outer boundary of this 
ring. MACCS requires that the value must be greater than or equal to I1DISA. 

Report Options determine whether CCDF data are written to the output file and whether they are 
included in the summary report.  
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Figure 3-114 Peak Dose Form 

Table 3-113 Peak Dose Form Inputs 

Parameter 
Name 

Definable Type Dimensions Allowed Values 

NUMA Linked Integer None 0 to 10 

NAME Yes Character NUMA Organ name from list in Table 
3-64 

I1DISA Yes Integer NUMA 1 to NUMRAD 

I2DISA Yes Integer NUMA 1 to NUMRAD (MACCS requires 
I2DISA ≥ I1DISA) 

Report Options Yes Character NUMA CCDF, NONE, REPORT, CCDF 
& REPORT 

 

Peak Dose Polar Form 

The Peak Dose Polar form is optional. In this output type, the peak dose is calculated for a user-

specified (r,) grid location.  Individual doses at locations other than directly under the plume(s) 
are reported with this option.  There is no option to report individual doses by dose pathway. 

When CHRONC is used, these results are generated by CHRONC as well as by EARLY.  The 

total dose is estimated for a representative individual assumed to be at a (r,) grid location.  The 
dose depends on the definition of that cohort in terms of evacuation and relocation.  Exposures 
resulting from the ingestion of contaminated food and water are not included because this in an 
individual dose and ingestion dose is not attributed to a specific individual.  
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The location for which this result is to be calculated is specified as a radial index (which can range 
from 1 to NUMRAD) and an angular index (which can range from 1 to NUMCOR).  Following the 
convention used throughout MACCS, an angular index of 1 represents a compass sector centered 
to the north of the release point. Numbering of compass sectors increases in the clockwise 
direction from north. 

NUMB specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors NAME, IRAD_B, IANG_B, and Report Options. 

NAME is the name of the target organ for the dose calculation.  The possible values depend on 
the DCF file chosen.  

IRAD_B defines the radial interval of the grid element for which this result is calculated.  

IANG_B defines the angular index of the grid element for which this result is calculated. 

Report Options determine whether CCDF data are written to the MACCS output file and whether 
they are included in the summary report. 

 

Figure 3-115 Peak Dose Polar Form 

Table 3-114 Peak Dose Polar Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUMB Linked Integer None 0 to 32 

NAME Yes Character NUMB Organ name from list in Table 
3-64 

IRAD_B Yes Integer NUMB 1 to NUMRAD 

IANG_B Yes Integer NUMB 1 to NUMCOR 

Report Options Yes Character NUMB CCDF, NONE, REPORT, CCDF 
& REPORT 
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Land Area Exceeding Dose Form 

The Land Area Exceeding Dose form is optional.  The land area that exceeds a user-specified 
dose level to an organ is reported.  Optionally, dose values for all grid elements and selected 
organ can be displayed.  

NUMC specifies the number of results.  Its value is determined by the number of rows in the grid 
containing values of vectors ORGNAM, ELEVDOSE, and PRINT_FLAG_C. 

ORGNAM is the name of the target organ for the dose calculation.  The possible values depend 
on the DCF file chosen.  

ELEVDOSE is the threshold dose value for calculating land contamination areas.  Land area that 
is contaminated above the threshold dose level is reported in the output.  The dose level is 
calculated a representative individual in a grid element who evacuates or relocates according to 
the parameters defining a cohort.  Results are provided for each cohort.  

PRINT_FLAG_C set to True means that the output includes dose levels to the specified organ for 
each grid element.  Otherwise, these results are suppressed.  

 

Figure 3-116 Land Area Exceeding Dose Form 
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Table 3-115 Land Area Exceeding Dose Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUMC Linked Integer None 0 to 40 

ORGNAM Yes Character NUMC Organ name from list in Table 
3-64 

ELEVDOSE Yes Real NUMC 0.0 to 1012 Gy or Sv 

PRINT_FLAG_C Yes Logical NUMC True, False 

 

Land Area Exceeding Concentration Form 

The Land Area Exceeding Concentration form is optional.  This output type provides the land area 
that exceeds a user-specified ground concentration for a specified radionuclide.  Optionally, the 
user can request ground concentrations and time-integrated, ground-level, air concentrations be 
reported for every grid element. 

NUMD specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors I1DISD, NUCLIDE, ELEVCONC, and PRINT_FLAG_D. 

I1DISD is the outer spatial interval bounding the region of interest.  The radius corresponds to the 
outer radius of the specified ring.  The area in the calculation is from a radius of zero to the outer 
spatial interval.  

NUCLIDE is the radionuclide of interest.  The value must be an element of vector NUCNAM. 

ELEVCONC is the threshold value for calculating the land contamination area.  The land area 
that is contaminated above this threshold value is reported in the output. 

PRINT_FLAG_D set to True means that the output includes ground and ground-level air 
concentrations for each grid element. Otherwise, this output is suppressed. 
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Figure 3-117 Land Area Exceeding Concentration Form 

Table 3-116 Land Area Exceeding Concentration Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUMD Linked Integer None 0 to 40 

I1DISD Yes Integer NUMD 1 to NUMRAD 

NUCLIDE Yes Character NUMD Must select a radionuclide 
from NUCNAM 

ELEVCONC Yes Real NUMD 0.0 to 1012 Bq/m2 

PRINT_FLAG_D Yes Logical NUMD True, False 

 

Population Movement Form 

The model reports the fraction of each cohort and of the total population that has left the circular 
boundary corresponding to the I1DISE radial distance.  The output reports the result at the time 
interval specified by TIMDIVE if the fraction has changed since the previous time interval. For the 
case that the network evacuation model is used and some portion of the population exits the 
boundary then later returns into the circular region defined by the boundary, only the first crossing 
of the boundary is considered by the model. 

NUME specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors I1DISE, TIMDIVE, and Report Options. 

I1DISE specifies the radial index for which results are to be reported. The region is defined by the 
outer boundary of the specified radial grid element. The fraction of the population within this 
boundary exiting the region as a function of time is reported in the output.  

TIMDIVE is the time interval for reporting.  

Report Options determine whether CCDF data are written to the output file and whether they are 
included in the summary report.  
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Figure 3-118 Population Movement Form 

Table 3-117 Population Movement Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUME Linked Integer None 0 to 35 

I1DISE Yes Integer NUME 1 to LASMOV 

TIMDIVE Yes Integer NUME 60 to 86400 s 

Report Options Yes Character NUME CCDF, NONE, REPORT, 
CCDF & REPORT 

 

3.4 CHRONC Input and Model description 

 Overview of CHRONC 

The CHRONC module simulates the events that occur following the emergency phase modeled 
by EARLY. Various long-term protective actions can be taken during this period to limit radiation 
doses to acceptable levels.  

CHRONC calculates the individual health effects that result from both external and internal dose 
pathways. CHRONC also calculates the economic costs of the long-term protective actions as 
well as the cost of the emergency response actions that were modeled in the EARLY module. 

Three long-term exposure pathways are modeled to predict the radiation exposures from 
accidental radiological releases: groundshine, resuspension inhalation, and ingestion of 
contaminated food and water.  The models used to predict the doses from these three pathways 



 

3-176 

are described individually in the following sections.  The dose from each of the long-term pathways 
is evaluated for each spatial element surrounding the accident site.  For the intermediate phase, 
only the groundshine and resuspension inhalation exposure pathways are treated.  The implicit 
assumption is that contaminated food and water would not be ingested during the intermediate 
phase.  

The radiation dose for the exposure pathways of the intermediate and long-term phases is 
calculated for each of the coarse spatial elements using the initial ground concentration under the 
plume centerline calculated by the ATMOS module. Like the early exposure pathways, MACCS 
uses centerline and off-centerline concentrations to estimate the initial ground concentration for 
any spatial element.  By contrast with EARLY, which estimates deposition at the fine grid level, 
CHRONC only resolves deposition at the course grid level.  The Gaussian distribution is averaged 
over the width of a compass sector to estimate a ground concentration for each grid element.  

CHRONC incorporates calculations for two distinct periods of time, the intermediate phase and 
the long-term phase. These phases are described in the following subsections.  

 Intermediate Phase 

The intermediate phase begins immediately after the emergency phase.  The user can define the 
duration of the intermediate phase to be zero (i.e., no intermediate phase) or up to one year.  

The only response considered during the intermediate phase is continued relocation for areas 
that are too heavily contaminated for the population to return.  The criterion for relocation during 
the intermediated phase is based on a user-defined dose projection and dose level.  The dose 
projection is defined in terms of an exposure period and a target organ. The user also specifies 
the maximum acceptable dose level.  When the intermediate-phase dose criterion is satisfied, 
which is that the projected dose is less than the maximum acceptable dose, the residential 
population of a grid element is assumed to be present and subject to radiation exposure from 
groundshine and resuspension inhalation for the entire intermediate phase.  When the criterion is 
exceeded, the population is assumed to be relocated to uncontaminated areas for the entire 
intermediate phase, with a corresponding per-capita economic cost defined by the user through 
the input parameter POPCST.  

 Long-Term Phase 

The long-term phase follows the intermediate phase or directly follows the emergency phase 
when the duration of the intermediate phase is set to zero.  A set of protective actions are 
implemented during the long-term phase, which are decontamination, interdiction, and 
condemnation of land that exceeds the habitability level set by the user.  

Decisions on mitigative actions during the long-term phase are based on two independent criteria 
as follows: 

• Decisions are made relating to whether land at a specific location and time is suitable for 
human habitation. This criterion is often called the habitability criterion.  

• Decisions are made relating to whether land at a specific location and time is suitable for 
agricultural production. This criterion is often called the farmability criterion.  

In addition to these two criteria on usability of land for its intended purpose, MACCS also 
considers cost effectiveness of decontamination.  If it is not cost effective to decontaminate (plus 
additional interdiction when required to reach habitability), then land is condemned.  
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 Division Between Farm and Population 

The long-term phase incorporates a fundamental distinction between the consequences 
associated with agricultural uses of land (denoted FARM-DEPENDENT in the code output) and 
habitation of land by humans (denoted POP-DEPENDENT in the code output). 

 Habitability Decision Making 

Habitability decision making determines whether land is immediately habitable, land is habitable 
after decontamination, land is habitable after a combination of decontamination and additional 
interdiction, or land is condemned.  

The first step in the decision-making regarding habitability is to determine whether, in the absence 
of any mitigative actions, the land in a grid element is suitable for habitation during the long-term 
exposure period. This is done by comparing the projected, lifetime, individual dose to the target 
organ (CRTOCR) for the long-term dose projection period (TMPACT) against the user-specified 
dose for long-term exposure (DSCRLT). When the projected individual dose does not exceed 
DSCRLT, the land is considered immediately habitable, and no further tests regarding habitability 
are made. Residents are assumed to return to the grid element and no further costs are tallied.  

When the land is not immediately habitable, a progressive series of actions are evaluated, 
beginning with decontamination for the various user-defined decontamination levels.  The 
influence of decontamination is twofold:  

• Doses are reduced by a dose reduction factor (DRF, input parameter DSRFCT), which is 
a scaling factor by which the doses are reduced.  

• Doses are also reduced by weathering and radioactive decay during the 
decontamination period. 

The influence of these two factors is independent.  That is, when the user specifies a DRF of 3 
and a decontamination period of 1 year, the doses to the population after decontamination are 
generally less than one-third of the doses before decontamination because decontamination, 
weathering, and radioactive decay all work to reduce subsequent doses.  

The first level (smallest DRF) of decontamination is considered first.  When this DRF plus 
weathering and decay is enough to meet the habitability criterion immediately after 
decontamination, this level of decontamination is performed, and the population is assumed to 
return.  When the first level of decontamination is not sufficient, higher levels of decontamination 
are considered. MACCS allows up to three levels.  

When the highest level of decontamination is insufficient to restore habitability, MACCS evaluates 
whether performing this level of decontamination plus additional interdiction would restore 
habitability. MACCS allows up to 30 years of interdiction when it performs this calculation. 
However, decontamination plus additional interdiction is usually not cost effective when the 
required interdiction period is significantly less than 30 years.  

MACCS declares land to be condemned under two conditions: 

• Habitability cannot be restored after decontaminating at the highest level plus additional 
interdiction. 

• The total cost to restore habitability is greater than the cost to condemn the land.  
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Under either of these conditions, the land is condemned immediately at the beginning of the long-
term phase; the model assumes that decontamination is not performed and that the population 
never returns.  Thus, MACCS calculates the corresponding long-term food and population doses 
to be zero for the condemned land and assesses an economic cost for condemnation of the 
property equal to the value of the land plus the cost of permanent relocation.  

The effect of weathering and decay over the interdiction period is calculated with an interpolation 
technique that uses doses for predefined interdiction periods of 1, 5, and 30 years. These three 
predefined interdiction periods all begin at the conclusion of the maximum-level decontamination 
effort, which is a user-specified duration that can extend up to 1 year. So, the three dose 
projections are calculated at starting times of 1, 5, and 30 years after the maximum level of 
decontamination would be complete.  

For the two land uses, farm and population, mitigative actions are chosen to yield the lowest-cost 
approach to satisfying the applicable criteria.  For farms, the criteria define acceptable levels of 
foodstuff contamination; for populations, the criteria define acceptable levels of radiation 
exposures to individuals.  The maximum duration of temporary farmland interdiction is 8 years; 
as previously discussed, the corresponding maximum duration for populated areas is 30 years.  
It is likely that neither of these limiting cases would be applied in practice because the cost of 
decontamination and interdiction would normally exceed the cost of condemnation before these 
time limits are reached.  

 Primacy of Habitability over Farmability Decisions 

For both food-chain model options, farm production can occur only when the environmental 
contamination levels are sufficiently low to allow habitation.  The implicit assumption is that people 
cannot work on land that is not habitable.  When farmland is not habitable, it is treated the same 
as described in the previous subsection on habitability decision making.  

 Farmability Decision Making 

As described in the previous subsection, the decision on whether farmland can be used for 
agriculture is based first on evaluations of its suitability for human habitation.  When farmland is 
immediately habitable or is restored to being habitable, it is next evaluated for farmability, which 
means that contamination levels of the agricultural products are low enough to be consumed.  
The criterion for farmability is specified through a set of maximum allowable food doses, which 
are input parameters DOSEMILK, DOSEOTHR, and DOSELONG. These parameters are 
discussed below.  

Most often the farmability criterion is stricter than the habitability criterion, so it is not unusual that 
farmland is habitable but not farmable.  Decontamination is only implemented in MACCS to 
restore habitability, not farmability.  Land that is initially habitable but not farmable is either 
interdicted without decontamination or condemned. 

 Basic Parameters 

 Basic Forms and Parameters 

Chronc Description Form 

The Chronc Description form contains one variable, which is a brief description of the CHRONC 
model used in the calculation.  This form is required.  
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Figure 3-119 Chronc Site and Model Description Form 

Table 3-118 Chronc Site and Model Description Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

CHNAME Yes Character None 1 to 80 characters 

 

Property Form Parameters Form 

This form allows the user to observe how the choices made on the Properties form define some 
important parameters that are required in the CHRONC input.  The parameters on this form are 
read-only and cannot be changed from this form.  Details about the effect of these parameters 
are provided in the subsections below. 

FDPATH determines the food-chain model used. When this parameter is set to OLD the food-
chain model developed for MACCS 1.5 is used.  NEW means the COMIDA2 food-chain model is 
used. When this parameter is set to OFF, no food-chain model is used. 

NTTRM is the number of terms used in the growing crop retention model.  This parameter is only 
relevant when FDPATH is set to OLD. 
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Figure 3-120 Property Form Parameters Form 

Table 3-119 Property Form Parameters Form Inputs 

Parameter 
Name 

Definable Type Dimensions Allowed 
Values 

Defined on Form 

FDPATH Read Only Character None NEW, OFF, 
OLD 

Food tab on Properties form 

NTTRM Read Only Integer None 1 to 3 Number of Crop Weathering 
Terms found on Food tab of 
the Properties form 

Economic 
Model? 

     

 

 Shielding and Exposure 

 Shielding and Exposure Model Description 

Shielding and exposure factors are specified separately for EARLY and CHRONC but serve the 
same purpose. These factors account for long-term behavior of the public and for the shielding 
offered by structures in which people dwell, work, and spend time.  

Older versions of MACCS assumed that the long-term shielding and exposure factors in the 
intermediate and long-term phases are identical to those for normal activity during the emergency 
phase.  This is still a reasonable assumption and is commonly used.  However, there are some 
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reasons why the factors could be different for these phases.  The main reason is potential 
equilibration of contamination levels between the exterior and interior of buildings after an 
extended period.  The usual assumption in estimating these factors for the emergency phase is 
that the exterior is contaminated but the interior is relatively clean.  This may be a reasonable 
assumption for the short term but may be less reasonable for the long term.  Even for the short 
term, air exchange between the interior and exterior of a building can cause some level of 
contamination on the interior.  Filtered air exchange between the atmosphere and a control room 
is generally included when assessing doses to control-room workers for design-basis accidents. 
Similarly, ventilation systems in a home or other building would gradually introduce contaminants 
into the interior, which in turn would affect the shielding and exposure factors.  After a long time, 
it is possible that the interior and exterior of a building would equilibrate. In other words, the 
contamination level of the interior of a building would be lower but proportional to the 
contamination level of the exterior of the building. By allowing a distinction between short-term 
and long-term shielding and exposure factors, MACCS can be used to evaluate possible longer-
term influences on these factors.  

 Shielding and Exposure Forms and Parameters 

Shielding and Exposure Form 

The Shielding and Exposure form is required. 

LPROTIN is the long-term inhalation protection factor. A value of 0 indicates complete protection 
from inhalation of radioactive materials; a value of 1 indicates no protection and corresponds to a 
person standing outdoors with no protection from the surrounding atmosphere.  

LBRRATE is the long-term breathing rate.  There is a range of breathing rates that can be 
assigned based on level of activity and other factors. This value should reflect a long-term average 
that is consistent with the exposure period used for the long-term phase.  

LGSHFAC is the long-term groundshine shielding factor.  This value is used as a multiplier on the 
value of groundshine dose that would have been received if the person were standing outside 
and the ground were a perfectly flat surface. A value of 0 indicates complete shielding from 
groundshine; a value of 1 indicates no protection. A typical surface roughness of the ground 
affords some shielding, which is typically taken to be 0.7. Other shielding from houses and building 
would be expected to reduce this factor below 0.7.  
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Figure 3-121 Shielding and Exposure Form 

Table 3-120 Shielding and Expsure Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

LPROTIN Yes Real None 0.0 to 1.0 

LBRRATE Yes Real None 0.0 to 1.0 m3/s 

LGSHFAC Yes Real None 0.0 to 1.0 

 

 Dose Projection Model Description 

Dose projection is used to determine the need for relocation during the intermediate phase and 
to determine habitability during the long-term phase.  Dose projection is defined by an exposure 
period and a critical organ for the dose.  It is used to estimate a dose that would occur if no 
protective action were taken.  The purpose is to protect the population by ensuring that the 
projected dose is small enough; otherwise a protective action is taken to eliminate or reduce the 
projected dose.  

The dose criterion for habitability is discussed in a subsequent subsection.  The dose criterion for 
relocation during the intermediate phase is based on a dose projection period defined by 
DPP_INTERPHAS, and a target organ, CRTOCR. The criterion is that the projected dose is less 
than a user input dose defined by parameter DSCRTI. These parameters are discussed in this 
and subsequent subsections. 
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Dose Projection Form 

The Dose Projection form is optional. It contains a single parameter that defines the exposure 
period for dose projection used in the relocation criterion for the intermediate phase.  

DPP_INTERPHAS is the dose projection period for relocation during the intermediate phase. 

 

Figure 3-122 Dose Projection Form 

Table 3-121 Dose Project Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DPP_INTERPHAS Yes Real None 0.0 to 1010 s 

 

 Evacuation/Relocation Cost Model Description  

The evacuation and relocation costs describe the expected compensation for people who take 
these protective actions.  Evacuation only occurs during the emergency phase.  It is triggered by 
an emergency declaration at a nuclear plant or facility (e.g., declaration of a general emergency).  

Relocation of individuals can occur during the emergency or intermediate phases.  It can also 
occur during the long-term phase but is commonly referred to as interdiction in that case.  

In the presentation of economic cost results, the costs associated with the emergency phase 
(i.e., for evacuation and short-term relocation) are reported separately from the costs associated 
with the intermediate phase (i.e., for relocation) and the long-term phase (i.e., decontamination, 
interdiction, condemnation, loss of use, and permanent relocation costs).  
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 Emergency Response Cost Forms and Parameters 

Compensation Costs Form 

The Compensation Costs form is required.  

Some of the compensation parameters are for actions taken during the emergency phase. 
Nonetheless, these parameters are CHRONC inputs because the costs of these actions are only 
tallied when CHRONC is run.  

EVACST defines the daily cost of compensation for evacuees and short-term relocatees who are 
removed from their homes during the emergency phase. MACCS does not impose any specific 
set of costs for this parameter; it is entirely up to the user to determine which costs should be 
included.  The value usually includes food, housing, and transportation costs. It can optionally 
include lost income when this cost is not included in other cost inputs.  

RELCST defines the daily cost of compensation for individuals relocated from their homes during 
the intermediate phase of CHRONC.  MACCS does not impose any specific set of costs for this 
parameter; it is entirely up to the user to determine which costs should be included.  This value 
usually includes food, housing, and transportation costs. It can optionally include lost income and 
lost personal property when these are not included in other input parameters.  

POPCST defines the per-capita, one-time relocation cost for temporary or permanent relocation 
of population and businesses in a region rendered uninhabitable during the long-term phase. This 
cost is assessed when any of the following actions are required: decontamination alone, decon-
tamination followed by interdiction, or condemnation. This value can account for personal and 
corporate income losses for a transitional period and/or moving expenses.  

 

Figure 3-123 Compensation Costs Form 
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Table 3-122 Compensation Costs Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

EVACST Yes Real None 0 to 1000 $/person-day 

RELCST Yes Real None 0 to 1000 $/person-day 

POPCST Yes Real None 10-6 to 106 $/person 

 

 Long-Term Protective Action Model Description 

The long-term protective action parameters define the intermediate and long-term action time 
periods as well as the maximum doses that people can receive during these periods.  The 
maximum allowable doses defined here are used to determine the need for relocation, 
decontamination, interdiction, and condemnation.  

 Long-Term Protective Action Forms and Parameters 

Long-Term Exposure Period Form 

The Long-Term Exposure Period form is required. 

DUR_INTPHAS is the duration of the intermediate phase. This phase follows the emergency 
phase. In the MACCS model, each phase is distinct and contiguous.  The U.S. Environmental 
Protection Agency (EPA) definition allows for some overlap between the emergency and 
intermediate phases and of the intermediate and long-term phases (EPA, 2013). While this 
distinction should be recognized, it has little or no effect on the consequence results estimated by 
MACCS.  

TMPACT is the long-term dose projection period corresponding to the long-term dose limit, 
DSCRLT, which is described below.  The dose projection is performed at the beginning of the 
long-term phase for the target organ specified by CRTOCR (also discussed below) to determine 
whether land is immediately habitable.  The combination of these three parameters establishes 
the criterion commonly referred to as the habitability criterion. When habitability is not met at the 
beginning of the long-term phase, a set of actions are evaluated to determine whether habitability 
can be restored later, as described in Section 3.4.1.  

EXPTIM is the long-term exposure period. It begins when people return to their property.  For 
example, when the code estimates that 5 years of interdiction are needed at a specific location to 
satisfy the habitability criterion and EXPTIM is 30 years, doses to the resident population is 
calculated for an exposure period that begins at the beginning of year 6 and ends at the end of 
year 35 of the long-term phase. 

The accrual of doses from food and water ingestion is not affected by the user-specified value of 
EXPTIM. This accrual is not strictly associated with the population from which the contaminated 
food and water originate. The ingestion of contaminated food and water is estimated as a societal 
dose to an unspecified population. However, the ingestion dose is accounted for in the grid 
element from which the food and water originate.  
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Figure 3-124 Long-Term Exposure Period Form 

Table 3-123 Long-Term Exposure Period Form 

Parameter Name Definable Type Dimensions Allowed Values 

DUR_INTPHAS Yes Real None 0 to 3.15×107 s (1 yr) 

TMPACT Yes Real None 0 to 1010 s 

EXPTIM Yes Real None 0 to 1010 s 

 

Long-Term Dose Criterion Form 

The Long-Term Dose Criterion form is required. 

DSCRTI is the maximum allowable dose commitment to the long-term critical organ (CRTOCR) 
over the intermediate-phase dose projection period (DPP_INTERPHAS).  The exposure 
pathways considered in the dose projection are groundshine and resuspension inhalation. When 
the intermediate-phase dose criterion (DSCRTI) is exceeded within a grid element, the population 
there is relocated for the entire intermediate phase.  

DSCRLT is the maximum allowable dose commitment to the long-term critical organ (CRTOCR) 
during the long-term dose-projection period (TMPACT). These three parameters establish the 
habitability criterion. The exposure pathways considered in the dose projection are groundshine 
and resuspension inhalation. When the long-term-phase dose criterion (DSCRLT) is exceeded 
within a grid element, the population there is relocated until the habitability criterion can be met. 
When it is not possible to reduce doses to the level specified by this criterion in a cost-effective 
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manner, the property is condemned, and the resident population is permanently relocated. When 
this occurs, no doses are accrued during the long-term phase.  

CRTOCR defines the critical organ that is used for both the intermediate and long-term phases.  

 

Figure 3-125 Long-TermDose Criterion Form 

Table 3-124 Long-Term Criterion Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DSCRTI Yes Real None 0 to 105 Sv 

DSCRLT Yes Real None 10-20 to 105 Sv 

CRTOCR Yes Character None Organ names from Table 
3-64 

 

 Decontamination Plan 

The decontamination plan data block defines the decontamination actions that may be taken 
during the long-term period to reduce doses to acceptable levels.  Each decontamination level 
represents an alternative strategy that would reduce the projected long-term groundshine and 
resuspension doses by a factor called the dose reduction factor. 
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 Decontamination Plan Model Description 

The objective of decontamination is to reduce projected doses below the long-term dose criterion 
in a cost-effective manner. When the maximum decontamination level is insufficient to restore an 
area to immediate habitability, a period of temporary interdiction following the maximum 
decontamination level is considered to reduce doses through radioactive decay and weathering. 
When the property cannot be made habitable within 30 years or when the cost of reclaiming the 
property exceeds the cost of condemning it, the property is condemned and permanently 
withdrawn from use. 

Decontamination cost is divided into two categories and these two types of cost are calculated 
separately. Farm-dependent decontamination cost represents the cost of farmland 
decontamination in a grid element. Farm-dependent decontamination cost is a function of the 
area of the grid element devoted to agriculture.  Population-dependent decontamination 
represents the cost of non-farmland decontamination.  Population-dependent decontamination 
cost is a function of the population residing in the grid element. The strategy of decontamination 
within a grid element is largely independent of the type of area being decontaminated, with the 
exception that farmland can be decontaminated to restore habitability but not to restore 
farmability, as explained above. 

For a given decontamination level, the same decontamination time and effectiveness apply to 
both farmland and non-farmland, but the two costs are unique and are assigned independently 
for each type of decontamination.  Owing to the requirement that the recovery of property must 
be cost-effective, it is possible that non-farmland is decontaminated and restored to use but 
farmland is instead condemned within the same grid element. 

Decontamination of a grid element serves to reduce the dose level in that element by the dose 
reduction factor associated with the decontamination effort being applied. Everything else being 
equal, a decontamination factor of 10 causes the integrated dose over any exposure period to be 
reduced by a factor of 10 of what it would have been without decontamination.  Dose reduction 
factors are presented in Table 3-125.  

Table 3-125 Decontamination factors. 

Dose Reduction 
Factor 

Percent of Dose 
Reduction 

2 50% 

3 66.7% 

5 80% 

10 90% 

15 93.3% 

20 95% 

 

During the decontamination period, which is assumed to begin at the start of the long-term phase, 
the population is relocated from areas that are decontaminated. 

While engaged in cleanup efforts, decontamination workers are assumed to wear respiratory 
protection devices.  Therefore, they accumulate only groundshine doses.  These doses contribute 
to the population dose tabulated in the MACCS output.  
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Decontamination reduces direct exposure doses (both groundshine and resuspension) caused 
by contamination of land and buildings. Some decontamination processes reduce groundshine 
and resuspension doses by washing surface contamination down into the ground.  These 
processes do not eliminate contamination from the area, but they do reduce doses to the 
population by adding shielding. Since these processes may not move contamination out of the 
root zone, the WASH-1400-based economic cost model of MACCS assumes that farmland 
decontamination reduces direct exposure doses to farmers without reducing uptake of 
radioactivity by root systems.  Thus, decontamination of farmland does not reduce the ingestion 
doses produced by consumption of crops that are contaminated by root uptake.  Therefore, 
decontamination is not considered for restoring farmability. Nonetheless, contamination levels 
from produce, meat, and dairy products drops significantly in the second year because edible 
surfaces can be contaminated by direct deposition only in the first year of the accident.  

 Decontamination Plan Forms and Parameters 

Number of Plan Levels Form 

The Number of Plan Levels form is required. 

LVLDEC is the number of decontamination levels that can be used.  Each decontamination level 
represents an alternative strategy to reduce the projected long-term groundshine and 
resuspension inhalation doses. 

 

Figure 3-126 Number of Plan Levels Form 

Table 3-126 Number of Plan Levels Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

LVLDEC Yes Integer None 1 to 3 
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Plan Definition Form 

The Plan Definition form is required. 

DLBCST is the labor cost of a decontamination worker. 

TIMDEC defines the time required for completion of each level of decontamination. 
Decontamination begins at the end of the intermediate phase (TMIPND).  The values must be 
monotonically increasing when there is more than one decontamination plan. 

DSRFCT defines the effectiveness of the various decontamination levels for reducing dose. A 
dose reduction factor of 3 means that the resulting population dose at that location is reduced to 
one-third of what it would have been without decontamination. The values must be monotonically 
increasing when there is more than one plan. 

TFWKF defines the fraction of the decontamination period (TIMDEC) that a farmland 
decontamination worker spends in the contaminated area for each level of decontamination.  

TFWKNF defines the fraction of the decontamination period (TIMDEC) that a non-farmland 
decontamination worker spends in the contaminated area during the decontamination period for 
each level of decontamination.  

 

Figure 3-127 Plan Definition Form 
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Table 3-127 Plan Definition Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DLBCST Yes Real None 1.0 to 106 $/person-yr 

TIMDEC Yes Real LVLDEC 10-6 to 3.15576×107 s (1 yr) 

DSRFCT Yes Real LVLDEC 1.01 to 100.0 

TFWKF Yes Real LVLDEC 0.0 to 1.0 

TFWKNF Yes Real LVLDEC 0.0 to 1.0 

 

Farmland Costs Form 

The Farmland Costs form is required. 

CDFRM defines the farmland decontamination costs for each level of decontamination.  Values 
must be monotonically increasing when more than one plan is defined.  

FRFDL defines the fraction of the farmland decontamination cost that is due to labor for each level 
of decontamination.  

 

Figure 3-128 Farmland Costs Form 
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Table 3-128 Farmland Costs Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

CDFRM Yes Real LVLDEC 1.0 to 105 $/ha 

FRFDL Yes Real LVLDEC 0.0 to 1.0 

 

NonFarmland Costs Form 

The Non-Farmland Costs form is required. 

CDNFRM defines the non-farmland decontamination costs for each level of decontamination. 
Values must be monotonically increasing when more than one plan is defined. 

FRNFDL defines the fraction of the non-farmland decontamination cost that is due to labor for 
each level of decontamination.  

 

Figure 3-129 NonFarmland Costs Form 

Table 3-129 NonFarmland Costs Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

CDNFRM Yes Real LVLDEC 1.0 to 105 $/person 

FRNFDL Yes Real LVLDEC 0.0 to 1.0 
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 Interdiction Costs 

The interdiction plan cost data block defines the parameters needed to calculate the cost of 
interdiction.  The values supplied here are combined with values in the site data file (if one is 
used) and the regional characteristics data to estimate losses. 

 Interdiction Cost Model Description 

The model used in MACCS for assessing the cost of interdiction is based on the model described 
in WASH-1400, Appendix 6.  It is currently used to calculate the economic cost from depreciation 
and loss of use during both decontamination and temporary interdiction periods.  

 Interdiction Cost Forms and Parameters 

Interdiction Costs Form 

The Interdiction Costs form is required. 

DPRATE defines the depreciation rate that applies to property improvements during a period of 
interdiction.  This depreciation rate is intended to account for the loss of value of buildings and 
other improvements resulting from a lack of habitation and maintenance.  Depreciation losses are 
compounded continuously.  

DSRATE defines the expected rate of return from land, buildings, equipment, etc.  It also used for 
discounting losses that occur in future years. Losses are compounded continuously.  

 

Figure 3-130 Interdiction Costs Form 



 

3-194 

Table 3-130 Interdiction Costs Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DPRATE Yes Real None 0.0 to 1.0 yr-1 

DSRATE Yes Real None 0.0 to 1.0 yr-1 

 

 Weathering 

 Weathering Model Description 

The groundshine weathering relationship from Gale, Miller, and Fisher (1964) is described as 
follows:  

GW(t) = GWCOEF(1) • exp[−ln(2) • t/TGWHLF(1)] + 

GWCOEF(2) • exp[−ln(2) • t/TGWHLF(2)] 
 (3-43) 

Where  

GW(t) represents groundshine weathering factor at time t, given the weathering coefficients, 
GWCOEF(i), and the weathering half-lives, TGWHLF(i).  

The resuspension weathering relationship is defined as: 

RW(t)  = RWCOEF(1) • exp[−ln(2) • t/TRWHLF(1)] + 

RWCOEF(2) • exp[−ln(2) • t/TRWHLF(2)] 

RWCOEF(3) • exp[−ln(2) • t/TRWHLF(3)]  
 (3-44) 

Where 

RW(t) represents the resuspension weathering at time t, given the weathering coefficients, 
RWCOEF(i), and the weathering half-lives, TRWHLF(i). 

The values are defined under the Weathering category in the WinMACCS interface. 

 Weathering Forms and Parameters 

Groundshine Weathering Terms Form 

The Groundshine Weathering Terms form is required. 

NGWTRM defines the number of terms in the groundshine weathering relationship.  
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Figure 3-131 Groundshine Weathering Terms Form 

Table 3-131 Groundshine Weathering Terms Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NGWTRM  Yes Integer None 1 or 2 

 

Groundshine Weathering Coefficient Form 

The Groundshine Weathering Coefficient form is required. 

GWCOEF is the set of linear coefficients in the groundshine weathering equation. 

TGWHLF is the set of half-lives in the groundshine weathering equation. 
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Figure 3-132 Groundshine Weathering Coefficients Form 

Table 3-132 Groundshine Weathering Coefficients Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

GWCOEF Yes Real NGWTRM  10-20 to 1.0 

TGWHLF Yes Real NGWTRM  10-6 to 1012 s 

 

Resuspension Weathering Terms Form 

The Resuspension Weathering Terms form is required. 

NRWTRM defines the number of terms in the resuspension weathering relationship.  



 

3-197 

 

Figure 3-133 Resuspension Weathering Terms Form 

Table 3-133 Resuspension Weathering Terms Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NRWTRM Yes Integer None 1 to 3 

 

Resuspension Weathering Coefficient Form 

Resuspension Weathering Coefficient is required. 

RWCOEF is the set of linear coefficients in the resuspension weathering equation. 

TRWHLF is the set of resuspension weathering half-lives. 
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Figure 3-134 Resuspension Weathering Coefficients Form 

Table 3-134 Resuspension Weathering Coefficients Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

RWCOEF Yes Real NRWTRM 10-20 to 1.0 m-1 

TGWHLF Yes Real NRWTRM 10-6 to 1012 s 

 

 Regional Characteristics 

The regional characteristics data block defines the average economic and agricultural 
characteristics of the area surrounding the accident site. 

 Regional Characteristics Model Description 

When mitigative actions are needed to restore habitability or farmability, the regional characteristic 
values are used to evaluate the cost-effectiveness of those actions.  For instance, when the 
average property values supplied here indicate that decontaminating a piece of land costs more 
than condemning it, the land is condemned. 
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To implement the rotation strategy when the user has chosen the option of No Windshift with 
Rotation (IPLUME=1) or Windshift with Rotation (IPLUME=2), the result of the cost-effectiveness 
test must be the same in any direction.  Thus, instead of using actual property values from the 
site file, uniform values defined in the following section are used to make the decision on whether 
it is cost effective to decontaminate.  When no site file is supplied by the user, land values are 
assumed to be uniform over the grid and so the regional characteristic values are also used to 
calculate economic losses.  

 Regional Characteristic Forms and Parameters 

Farmland Wealth Form 

The Farmland Wealth form is required. 

VALWF defines the average value of farm wealth in the region.  This value should include both 
publicly- and privately-owned grazing lands, farmland, farm buildings, and nonrecoverable farm 
machinery, as well as any publicly owned infrastructure serving the farm industry in the region.  A 
corresponding value (VFRM) is calculated for each economic region by SecPop.  The SecPop 
value is not averaged over the entire region, so it is able to represent variations in farmland wealth 
within the computation grid.  When a site file is used in a calculation, the actual losses are 
estimated from the site file values (VFRM) rather than the input value (VALWF).  

FRFIM defines the fraction of farm wealth in the region due to improvements.  This value includes 
farm buildings and nonrecoverable machinery as well as any infrastructure, such as silos and 
irrigation that exclusively support farming. 

 

Figure 3-135 Farmland Wealth Form 
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Table 3-135 Farmland Wealth Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

VALWF Yes Real None 10-6 to 106 $/ha 

FRFIM Yes Real None 0.0 to 1.0 

 

Non-farmland Wealth Form 

The Non-Farmland Wealth form is required. 

VALWNF defines the value of the nonfarm wealth in the region.  Nonfarm wealth includes all 
public and private property not associated with farming that would be unusable while the region 
is uninhabitable.  This value should include the cost of land, buildings, infrastructure, and the cost 
of any nonrecoverable equipment or machinery.  A corresponding value (VNFRM) is calculated 
for each economic region by SecPop.  The SecPop value is not averaged over the entire region, 
so it is able to represent variations in non-farmland wealth within the computation grid. When a 
site file is used in a calculation, the actual losses are estimated from the site file values (VNFRM) 
rather than the input value (VALWNF).  

FRNFIM defines the fraction of nonfarm wealth in the region due to improvements.  This value 
includes buildings and infrastructure, such as roads and utilities, as well as any nonrecoverable 
equipment or machinery.  

 

Figure 3-136 Non-Farmland Wealth Form 
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Table 3-136 Non-Farmland Wealth Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

VALWNF Yes Real None 10-6 to 106 $/person 

FRNFIM Yes Real None 0.0 to 1.0 

 

Land Usage Form 

Land Usage is required when Uniform is selected on the Site Data tab on the Properties form. 
When Import from File is selected on the Site Data tab, the values needed in the calculation are 
taken from the site data file. 

FRCFRM defines the average fraction of land in the region devoted to agriculture.  The land area 
devoted to agriculture is calculated as follows: 

agricultural area = total area • FRACLD • FRCFRM  (3-45) 

FRMPRD defines the value of the average annual farm production (gross sales) in the region. 

DPFRCT defines the fraction of annual farm production (gross sales) in the region resulting from 
dairy production. 

 

Figure 3-137 Land Usage Form 
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Table 3-137 Land Usage Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

FRCFRM Yes Real None 10-6 to 1.0 

FRMPRD Yes Real None 0 to 105 $/ha 

DPFRCT Yes Real None 0.0 to 1.0 

 

 Food Chain 

MACCS incorporates three optional food-ingestion models as follows: 

• the food-ingestion model from the original MACCS code, as used in NUREG-1150 

• the COMIDA2 food ingestion model 

• no food-ingestion model.  

The MACCS food ingestion model is based on the principle that the long-term dose produced by 
any radionuclide to an organ via the food-ingestion pathway is the product of the ground 
concentration of the radionuclide, the integrated transfer factor for the radionuclide to human 
intake for the pathway, and the ingestion DCF.  

There are several limitations in the MACCS food-ingestion model.  A main drawback is that the 
integrated transfer factors for food pathway radionuclides not included in the MACCS sample 
problems must be derived externally.  Calculation of the transfer factors is difficult and error prone. 
A second limitation is that it is not capable of distinguishing the effects of contamination at different 
times during the growing season.  The difference is substantial, depending on whether deposition 
occurs directly onto standing crops or not.  

By contrast, the COMIDA2 ingestion model is based on a preprocessor that can be exercised by 
the user, with consideration of site-specific data, when such data are available.  Alternatively, the 
user can use a COMIDA2 file distributed with the code that provides typical values for the U.S. 
The COMIDA2 model considers a set of times during the growing season, so variations in food 
contamination over the growing season are automatically treated.  

The user has a choice of using one of two food-chain models or specifying that food-chain doses 
should not be treated. These choices are made on the Food tab of the Properties form.  When 
the user selects No Food Model on the Food tab, user input is not required in this section; 
otherwise, some input is required. When the MACCS Food Model is chosen on the Food tab, all 
the inputs to the food-chain model are contained in this section.  When the COMIDA2 food-chain 
model is used, MACCS uses a binary data file created by the preprocessing program, COMIDA2, 
that contains the results of the COMIDA2 food-chain modeling calculations. 

When User Supplies COMIDA2 File is specified, the user must specify the COMIDA2 binary file 
to be used. The name of the files is specified on the COMIDA2 File form found under the 
GENERAL/File Specifications category. Additionally, the same DCF file used to create the user 
supplied COMIDA2 file must be specified as the DCF file on the GENERAL/File Specifications/ 
Dose Conversion Factor File form. 

When Create COMIDA2 File is specified, the user must complete the forms found in the main 
model category titled COMIDA2. In this case, when the model is executed, the COMIDA2 pre-
processor is run first.  This pre-processor uses the DCF file specified and creates a binary file to 
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be used by MACCS.  One purpose for using this option is that uncertainty in food-chain 
parameters can be included in MACCS calculations. 

When one of the dose threshold models is used, either Annual Threshold or Piecewise Linear, 
creating COMIDA2 binary files is not supported.  Also, the MACCS food-chain model is not 
compatible with these choices.  

 Food-Chain Model Descriptions 

Modeling of Agricultural Countermeasures 

LASTACUM, a COMIDA2 input parameter, specifies the maximum duration of the ingestion dose 
period. MACCS calculates the accumulated societal dose starting with the year that the land 
satisfies the human consumption criteria specified by DOSEMILK, DOSEOTHR, and 
DOSELONG, with the exposure period ending in the LASTACUM year after the accident.  The 
allowable range for the LASTACUM parameter is from 1 to 50 years.  The value of the 
LASTACUM parameter is defined in the COMIDA2 user input file.  It is communicated to MACCS 
as part of the header information on the .bin file written by COMIDA2.  

Consistent with the MACCS interdiction model, the maximum farmland interdiction period 
considered is eight years.  Land that cannot be returned to production after eight years is 
condemned. MACCS condemns land that cannot be returned to production within LASTACUM 
years when the COMIDA2 model is used and the LASTACUM input parameter is assigned a value 
less than 9. 

To preserve the functionality of the MACCS food-chain model, agricultural countermeasures are 
always subordinate to the code's evaluation of habitability.  That is, when land is uninhabitable 
because projected groundshine and resuspension doses exceed the long-term dose criterion, 
DSCRLT, agricultural production at that location is not allowed.  

Furthermore, when the resident population is never allowed to return, either because of a failure 
to meet the dose criterion or because the costs to restore habitability exceed the value of the 
property, farmland is also assumed to be condemned, irrespective of the projected doses from 
food ingestion.  When the farmland is condemned, none of the additional tests described below 
are performed.  The costs associated with the condemnation of the farmland are based on the 
value of the property. 

Milk and crop disposal during the year of the accident are triggered when the habitability criterion 
(DSCRLT) is exceeded.  Milk and crop disposal costs are calculated only for the year of the 
accident. When DSCRLT does not lead to milk and nonmilk crop disposal, the maximum dose 
levels for the first year's milk production (DOSEMILK) and the first year's nonmilk crops 
(DOSEOTHR) are examined separately to find whether either is exceeded. The first-year dose 
criteria are evaluated using the consumption rates specified by the COMIDA2 input parameter 
CONSUM_RATES. Crop or milk disposal is triggered when the corresponding dose level is 
exceeded.  Beginning with the second year following the accident, year 2, the long-term ingestion 
dose criterion (based on DOSELONG) is evaluated.  The disposal of milk and/or nonmilk crops is 
triggered when the projected ingestion dose for food and milk combined exceeds DOSELONG.  

When the projected individual dose for a year does not exceed the dose level DOSELONG, 
agricultural production for that year and all subsequent years is allowed. Implicit in the model is 
the assumption that the food doses resulting from successive years of production do not increase 
with time.  Also, just as with the MACCS food-chain model, the long-term interdiction of farmland 
applies to all crop categories; there is no provision for long-term interdiction of a subset of the 
crops.  
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When the projected individual dose from the second year of agricultural production exceeds the 
dose criterion, the projected doses for up to eight successive annual periods are each examined 
to determine whether production can be resumed within the first nine years after the accident.  

When the projected doses in each of years two through nine exceed DOSELONG, no further tests 
are performed and the farmland is condemned.  When farmland is condemned, the associated 
cost is the market value of the farmland, VALWF, with dollar values reported on the output listing 
as FARM DEPENDENT CONDEMNATION COST.  

When the projected doses for one of the years satisfies the long-term dose criterion, agricultural 
production is assumed to resume in that year. Societal ingestion doses are assessed for the 
period ending with the LASTACUM year. 

For example, when DOSELONG is satisfied in year three, and LASTACUM has a value of 9, 
societal doses are accrued for the period denoted as years three to nine.  Since agricultural 
production was not allowed in the first and second years, economic costs for two years of 
interdiction are assessed for farmland.  The model calculates the cost of temporary interdiction 
as the loss of return on investment on the land and improvements (see parameters VALWF and 
FRFIM) and accounts for depreciation on the improvements. 

First-Year Crop Disposal Cost 

The economic cost of milk and/or nonmilk crop disposal during year one is modeled based on the 
economic costs assessed for the loss of sales.  The two crop disposal cost calculations, however, 
consistent with CRAC2, are treated differently, as follows.  

When the disposal of the first year's milk production is triggered because the dose criterion 
DOSEMILK is exceeded, milk disposal costs are assessed as 0.25 of annual milk sales (see 
parameters FRMPRD and DPFRCT).  The 0.25 adjustment factor assumes that cows would be 
taken off pasture and fed uncontaminated feed, allowing dairy production to resume after one-
quarter of a year.  To maintain consistency with the MACCS food-chain model, the application of 
the fixed 0.25 adjustment factor on milk disposal costs is also implemented for the COMIDA2 
food-chain model. 

It is noted that the model implemented in MACCS for crop disposal costs, and the 0.25 factor for 
lost dairy sales, is not based on WASH-1400 because WASH-1400 did not account for crop 
disposal costs. CRAC2, in contrast to WASH-1400, did implement separate milk and nonmilk crop 
disposal costs, providing the technical basis for the MACCS model to assess such costs. CRAC2, 
however, in assessing the costs of milk and nonmilk crop disposal, assessed a milk disposal cost 
based on the full year's dairy sales.  

Water Ingestion Model 

When radioactive material is deposited on the ground, it is expected that some fraction of this 
material makes its way into drinking water that is consumed by humans (Helton, Muller, and 
Bayer, 1985).  MACCS models this uptake into drinking water as two separate paths: 
(1) deposition of contaminants directly onto freshwater bodies and (2) deposition of contaminants 
onto land with subsequent wash off into freshwater bodies. 

The water ingestion model assumes that the area surrounding the site is divided into two 
categories: water and land. The radioactive material deposited on a spatial element is initially 
apportioned between water and land according to the fraction of the region covered by land. For 
coastal sites, where both fresh water and ocean water need to be treated, the user can manually 
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edit the site data file to account for more than one watershed.  A site data file can define up to 
four watersheds. One or more of those watersheds (e.g., ocean) can be defined to have no uptake 
fraction. 

The parameters described below are used to define the behavior of the single watershed; 
however, the discussion is easily extended to multiple watershed where the parameter values 
depend on grid element.  The user specifies which radionuclides are to be included with the water 
ingestion pathway.  

Of the activity deposited directly onto water or transferred from land to water, the fraction 
represented by WINGF determines how much of that deposited activity is eventually consumed 
by humans. Once the activity is transferred to the water body, there is no adjustment to account 
for radioactive decay.  

Of the activity that is initially deposited on land, some fraction makes its way through runoff into 
the freshwater supply over a relatively brief period following deposition.  This fraction is specified 
by the value of WSHRTI.  The remainder of the material deposited on land is assumed to be 
washed off to the freshwater supply at a constant fractional rate over the time from t=0 to t=infinity. 
The rate at which this subsequent wash off occurs is specified by the value of the rate constant 
WSHRTA. 

The model uses the values of the two variables, WSHRTI and WSHRTA, and evaluates the 
integral of the wash off fraction in a way that takes account of radioactive decay of the material 
deposited on land surfaces.  The model is described by Helton, Muller, and Bayer (1985).  The 
evaluation of this integral produces a numerical value, F, that represents the fraction of activity 
falling on land that is eventually transferred to surface water bodies that supply drinking water. 

With the value of F, the uptake fraction of activity deposited on land can be calculated, which is 
WINGF • F. The input parameter WINGF is the ratio of the total amount of a radionuclide 
consumed via the drinking-water pathway (i.e., by the entire population of the region surrounding 
the facility) and the amount entering potable surface-water bodies.  Ideally, a value for WINGF 
should be derived from a model for radionuclide transport through the surface-water system of 
the surrounding region. 

The models used to determine WINGF can vary in complexity from the very simple (e.g., a single 
uniformly mixed cell) to the very complex (e.g., three-dimensional fluid transport with temporal 
and spatial variability).  The value of WINGF supplied with the sample problems was derived in a 
very simple manner. See Bixler et al. (2020) for a more extensive discussion of the water ingestion 
parameters, including WINGF.  

MACCS Food-Chain Model 

When the MACCS food-chain model is selected, MACCS performs food and water ingestion 
calculations in the same manner as the original MACCS code used in NUREG-1150.  

When radioactive material is deposited on land, some fraction of this material may make its way 
through the food chain and ultimately be consumed by humans in the form of contaminated food 
or drinking water.  The ingestion pathway is modeled in MACCS as a series of transfer processes 
that the material must undergo between the time of deposition and the consumption of the 
contaminated food products by humans; these processes decrease the amount of material 
passed on to the next step in the food chain. 
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To calculate the population dose resulting from the accumulated contamination of an area, it is 
necessary to know the efficiency of the entire food chain for transferring material from the ground 
to man. MACCS calculates the overall efficiency of two ingestion sources (food and water) by 
multiplying all the individual transfer factors that are described in Section 3.4.11.2, yielding an 
overall weighted sum representing the effectiveness of the pathway in transferring contaminants 
from the ground to human consumption. 

When an accident occurs during the growing season, part of the radioactive material deposited 
on farmland is retained on plant surfaces and the remainder falls on the ground.  Between the 
time of deposition and the time of harvest, radioactive material can be lost from plant surfaces 
due to weathering, radioactive decay, translocation to interior portions of the plant, and the 
harvesting process. 

The fraction of radioactive material that is removed from the air due to dry and wet deposition that 
ends up in edible portions of the harvested plant is referred to as the growing crop retention factor. 
Specifically, this factor is defined to be the ratio between the amount of a radionuclide present in 
the crop at harvest and the total amount of material initially deposited onto the land used for 
producing that crop. 

For all crops except pasture, harvesting occurs at the end of the growing season.  The harvesting 
of pasture differs from other crops in that it assumed to be continuous.  In MACCS it is assumed 
that grazing takes exactly one growing season to harvest the year's entire production of the 
pasture crop.  The numerical integration used in the pasture dose calculations is therefore 
different from that used for the other crop categories.  The type of integration performed by the 
code is determined by the name given to the crop categories.  Crop names beginning with 
PASTURE are treated differently from the rest. 

For crops where the edible portion of the plant is exposed to the environment, weathering losses 
over the period from deposition to harvesting decreases the activity of radionuclides retained as 
a function of time.  That is, the longer the time between deposition and harvesting, the lower the 
resulting dose. 

Crops such as grains and legumes, which have the edible portions internal to the plant, may show 
the opposite behavior, with material being absorbed into the plant over time.  Since this is a slow 
process and data on translocation rates are hard to obtain, the user should try to define an 
average retention factor appropriate for deposition onto crops that is independent of time during 
the growing season, and not use the weathering model for these types of crops.  The situation is 
further complicated by the fact that available data suggest that total retention for grains is greatest 
when the deposition occurs near the middle of the growing season rather than at the end of it. 

Both types of crops are modeled with a weathering equation that can have up to three exponential 
terms, each with a different weathering rate.  For the types of crops not subject to weathering 
losses (that is, grains and legumes), a very long half-life can be specified for the weathering rate 
as a way of replacing the weathering function with a constant transfer fraction. 

In MACCS the removal of radioactivity from plant surfaces by weathering is treated as a sum of 
terms that have the following form: 

CTCOEF • exp (–• t), 

Where CTCOEF represents the fraction of material deposited on a cultivated field that is removed 

by weathering with a decay rate of  = 0.693 / CTHALF. 
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CTCOEF equals the product of two quantities: the interception fraction and the availability fraction. 
The interception fraction is the fraction of material deposited onto a field that is intercepted by 
crop surfaces and the availability fraction is the fraction of material deposited onto crop surfaces 
that remains after weathering, with the half-life CTHALF. 

When CTCOEF includes the effects of weathering, as suggested above, the exponential part of 
the weathering decay expression associated with this empirical value for CTCOEF is reduced to 
unity by setting CTHALF to the maximum allowable value, 3.15 x 1013 s (106 yr).  Because 
translocation from the plant surface to interior portions influences the retention of radioactivity for 
grains, legumes, and root crops, the weathering model can be modified to provide a transfer factor 
that is nearly constant in time. 

Since long-term uptake is treated separately from the growing-season portion of the model, this 
may cause the long-term uptake dose from grains and legumes to be double counted in the first 
growing season. However, since root uptake in a single season is typically small relative to the 
contamination resulting from direct deposition, the potential impact of such a double counting is 
unlikely to be significant. 

The number of terms in the weathering equation is defined in on the Food tab. Up to three terms 
are supported. 

In the unlikely event of an accident at a nuclear facility, an assessment of the accident's impact 
on agricultural production in the surrounding region can be performed with MACCS.  Based on a 
projected dose to an individual consuming locally produced food products, the local authorities 
determine whether local agricultural products are safe to eat.  When the food product is judged to 
be unsafe, two kinds of actions can be taken: disposal of current-year crops and long-term 
restriction of agricultural production in subsequent growing seasons. 

The MACCS food-chain model divides agricultural activities into four components representing 
two sets of binary pairs: 

• MILK DIRECT-DEPOSITION 

• CROP DIRECT-DEPOSITION 

• MILK ROOT-UPTAKE 

• CROP ROOT-UPTAKE 

This terminology is defined as follows. MILK refers to fresh milk and dairy products, such as 
cheese and butter. CROP refers to all other foodstuffs. DIRECT-DEPOSITION refers to doses 
that result when an accident occurs during the growing season and the doses are incurred in the 
single annual period following the accident.  When an accident occurs outside of the growing 
season, the code does not evaluate the need for disposal of crops, and the corresponding doses 
from DIRECT-DEPOSITION are reported as zero.  By contrast, ROOT-UPTAKE refers to food 
doses that result regardless of whether the accident occurs during the growing season, and these 
are calculated over an infinite period.  For accidents that occur during the growing season, first-
year doses are from both direct-deposition and root-uptake in the MACCS food-chain model. 

The stringency (degree of protection) for both types of mitigative actions is specified by the user 
through input parameters. These parameters are specified in terms of allowable ground 
concentration and are referred to as "action guides." 
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 Food Chain Forms and Parameters 

Maximum Food Ingestion Dose Form 

The Maximum Food Ingestion Dose form is required when the COMIDA2 Food Model is selected 
on the Food tab.  When it is not acceptable to produce milk or crops, production is interdicted for 
up to LASTACUM–1 or 8 years, whichever is smaller, until farmability is restored.  When the 
allowed years of interdiction are insufficient to restore farmability, farmland is condemned. 

DOSEMILK, DOSEOTHR, and DOSELONG are vectors of size two.  The first entry corresponds 
to a limit on effective dose; the second corresponds to a limit on thyroid dose.  These parameters 
define the allowable individual food doses that determine farmability.  

DOSEMILK is the maximum allowable food ingestion dose from milk products during the year of 
the accident.  For dairy to be allowed in the first year after an accident, individual milk doses must 
be below this limit. In addition, second-year individual doses from milk products plus crops must 
not exceed DOSELONG.  DOSEMILK is intended to fulfill a purpose like that served by the 
parameter PSCMILK of the MACCS food-chain model. 

DOSEOTHR is the maximum allowable food ingestion dose from non-milk crops during the year 
of the accident.  For crops to be produced in the first year after an accident, individual doses from 
consumption of crops must be below this limit.  In addition, second-year doses from milk plus 
crops must not exceed DOSELONG.  This parameter is intended to fulfill a purpose like that 
served by the parameter PSCOTHR of the MACCS food-chain model. 

DOSELONG is the maximum allowable "long-term" annual dose to an individual from ingestion 
of the combination of milk and non-milk crops.  These parameter values are used for determining 
whether agricultural production is suitable for consumption in years after the year of the accident. 

To use the COMIDA2 food-chain model in MACCS, the user must at a minimum select the lifetime 
(L-) organ flags to be true for two organs, effective and thyroid, for the EARLY parameter 
ORGFLG. 
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Figure 3-138 Maximum Food Ingestion Dose Form 

Table 3-138 Maximum Food Ingestion Dose Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DOSEMILK Yes Real 2 0.0 to 1010 Sv 

DOSEOTHR Yes Real 2 0.0 to 1010 Sv 

DOSELONG Yes Real 2 0.0 to 1010 Sv 

 

Radionuclides Form 

The Radionuclides form is required when MACCS Food Model is selected on the Food tab.  This 
model does not account for the food ingestion doses from decay products of the food pathway 
radionuclides defined in NAMIPI when radioactive decay occurs before consumption.  Dose 
coefficients implicitly account for decay products of a parent radionuclide when the decay occurs 
after consumption.  

NFIISO defines the number of radionuclides for the food-ingestion pathway. 

NAMIPI defines the set of radionuclides used in the food-pathway model.  This list must include 
all the radionuclides that are specified for the drinking water pathway, and they must appear in 
the same order as in NAMWPI. 



 

3-210 

 

Figure 3-139 Radionculides used in Food Path Form 

Table 3-139 Radionuclides used in Food Path Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NFIISO Linked Integer None 1 to 10 

NAMIPI Yes Character NFIISO Radionuclides defined in ATMOS 
parameter NUCNAM 

 

Crop Ingestion Form 

The Crop Ingestion form is required when the MACCS Food Model is selected on the Food tab. 

NFICRP defines the number of crop categories that are used by the food-pathway model. 

NAMCRP defines the name of a crop category used in the food-pathway model.  MACCS 
distinguishes between two types of crops: those harvested at the end of the growing season, and 
those harvested continuously over the entire growing season.  The first seven letters of the crop 
names supplied here are used to distinguish between these two types of crops.  When a crop's 
name begins with 'PASTURE', it is harvested continuously; when it doesn't, it is harvested at the 
end of the growing season. 
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FRCTCH specifies the fraction of the edible portion of the harvested crop that is consumed by 
humans. The user must supply NFICRP values for this parameter in column 2 of the data block. 

FRCTCM specifies the fraction of the edible portion of the harvested crop that is consumed by 
milk-producing animals. 

FRCTCB specifies the fraction of the edible portion of the harvested crop that is consumed by 
meat-producing animals. 

 

Figure 3-140 Crop Ingestion Form 

Table 3-140 Crop Ingestion Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NFICRP Linked Integer None 1 to 10 

NAMCRP Yes Character NFICRP 6 to 20 characters 

FRCTCH Yes Real NFICRP 0.0 to 1.0 

FRCTCM Yes Real NFICRP 0.0 to 1.0 

FRCTCB Yes Real NFICRP 0.0 to 1.0 

 

Meat/Milk Ingestion Form 

The Meat/Milk Ingestion form is required when the MACCS Food Model is selected on the Food 
tab. 

DCYPMH is the transfer factor describing the processing losses and radioactive decay that occur 
between the production and the consumption of milk products.  Specifically, it is the ratio of the 
amount of a radionuclide in milk products at the time of consumption to the amount in the milk at 
the time of its production (milking).  The values are multiplied by the values of TFMLK to define 
the efficiency of the milk-to-man food pathway.  
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DCYPBH is the transfer factor describing the processing losses and radioactive decay that occur 
between the production and the consumption of meat products.  It is the ratio of the amount of a 
radionuclide in meat products at the time of consumption to the amount of that radionuclide in the 
meat at the time of its production (slaughter).  The values given here are multiplied by the values 
given for TFBF in order to define the efficiency of the meat-to-man pathway.  

TFMLK is the transfer factor describing how much of a radionuclide ingested by milk-producing 
animals ends up in milk products at the time of their production (milking). It is the ratio of the 
amount of a radionuclide in fresh milk to the amount of the radionuclide consumed by 
milk-producing animals. It accounts for biological transport within the animal as well as radioactive 
decay. The values are multiplied by the values of DCYPMH to define the efficiency of the 
milk-to-human food pathway.  

TFBF is the transfer factor describing how much of the material ingested by meat-producing 
animals is in meat products at the time of their production. It is the ratio of the amount of a radio-
nuclide in edible meat at the time of slaughter to the amount of the radionuclide that was 
consumed by the meat-producing animals. It takes account of biological transport within the 
animals as well as radioactive decay. The values are multiplied by the values of DCYPBH to 
define the efficiency of the meat-to-man food pathway. 

 

Figure 3-141 Meat/Milk Ingestion Form 

Table 3-141 Meat/Milk Ingestion Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DCYPMH Yes Real NFIISO 0.0 to 1.0 

DCYPBH Yes Real NFIISO 0.0 to 1.0 

TFMLK Yes Real NFIISO 0.0 to 1.0 

TFBF Yes Real NFIISO 0.0 to 1.0 
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Soil to Edible Crops Form 

The Soil to Edible Crops form is required when MACCS Food Model is selected on the Food tab. 

TCROOT defines the transfer factor for long-term transfer of radionuclides from soil to edible 
crops.  This is the ratio of the amount of a radionuclide taken up from soil into edible portions of 
a crop to the amount that was deposited onto the soil.  The long-term transfer of radionuclides 
from soil to plants occurs principally by uptake (sorption) by plant root systems.  Transfer to plant 
surfaces by rain up splash and by deposition of materials resuspended from surface soil can also 
contribute to this pathway.  

The values of TCROOT supplied in the data block should be calculated by integrating the overall 
uptake rate over the period from t=0 to infinity.  In other words, TCROOT incorporates the total 
uptake over time after the initial deposition.  Since radionuclides are removed from the soil 
compartment not only by root uptake but also by radioactive decay, percolation, and irreversible 
chemical binding, these processes should be incorporated into the derivation of TCROOT.  

The annual rate at which the material is made unavailable by these processes is specified by the 
input parameter QROOT.  

 

Figure 3-142 Soil to Edible Crops Form 
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Table 3-142 Soil to Edible Crops Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

TCROOT Yes Real NFIISO by NFICRP 0.0 to 1.0 

 

Crop Radioactive Decay Loss Form 

The Crop Radioactive Decay Loss form is required when MACCS Food Model is selected on the 
Food tab. 

DCYPCH is the ratio of the amount of a radionuclide present in a crop at the time of consumption 
and the time of harvest, accounting for losses due to radioactive decay.  The values are used to 
calculate ingestion doses arising from both direct deposition onto growing crops and the long-term 
uptake processes of subsequent growing seasons.  It is only applied to crops that are directly 
consumed by humans (e.g., grains, vegetables, and legumes).  Values supplied for crops not 
consumed by humans have no impact on the calculations.  The values are multiplied by the 
corresponding values of FPLSCH, which characterizes processing losses, to obtain the overall 
transfer factor for this part of the food chain. Values of DCYPCH must be specified for each crop 
category for all radionuclides treated by the food pathway model (i.e., for all possible 
radionuclide/crop combinations). 

 

Figure 3-143 Crop Radioactive Decay Loss Form 
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Table 3-143 Crop Radioactive Decay Loss Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DCYPCH Yes Real NFIISO by NFICRP 0.0 to 1.0 

 

Meat/Milk Radioactive Decay Loss Form 

The Meat/Milk Radioactive Decay Loss form is required when MACCS Food Model is selected on 
the Food tab. 

DCYPCM is the ratio of the amount of a radionuclide in the crop at the time of its consumption to 
the amount at the time of harvest.  The values are used to calculate ingestion dose arising from 
both direct deposition onto growing crops and the long-term uptake processes of subsequent 
growing seasons.  It is applied only to crops that are directly consumed by milk-producing animals 
(e.g., pasture and forage).  Any values supplied for crops not consumed by milk-producing 
animals have no impact on the calculations.  

For pasture crops, harvest and consumption are simultaneous and so DCYPCM should be set to 
1.0 for the pasture crop categories.  Values of DCYPCM must be specified for each crop category 
for all radionuclides treated by the food pathway model (i.e., for all possible radionuclide-crop 
combinations). 

 

Figure 3-144 Meat/Milk Radioactive Decay Loss Form 
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Table 3-144 Meat/Milk Radioactive Decay Loss Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DCYPCM Yes Real NFIISO by NFICRP 0.0 to 1.0 

 

Crop Radioactive Retention Form 

The Crop Radioactive Retention form is required when the MACCS Food Model is selected on 
the Food tab.  

FPLSCH is the ratio of the amount of a radionuclide in the crop after it has been processed for 
human consumption to the amount before processing.  The retention factor reflects the fraction 
of radioactive material in the edible portion of the plant that is retained after washing, peeling, or 
cooking.  The values apply only to crops that are directly consumed by humans. Values specified 
for crops such as pasture have no impact on calculations. 

Values of FPLSCH must be specified for each crop category for all radionuclides treated by the 
food pathway model (i.e., for all possible radionuclide-crop combinations).  The values are 
multiplied with the corresponding values of DCYPCH to obtain the overall transfer factor for this 
part of the food chain. 

 

Figure 3-145 Crop Radioactive Retention Form 
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Table 3-145 Crop Radioactive Retention Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

FPLSCH Yes Real NFIISO by NFICRP 0.0 to 1.0 

 

Meat/Milk Radioactive Retention Form 

The Meat/Milk Radioactive Retention form is required when MACCS Food Model is selected on 
the Food tab. 

DCYPCB is the ratio of the amount of a radionuclide in the crop at the time of its consumption to 
the amount of that radionuclide in the crop at the time of harvest.  This factor is only applied to 
crops that are directly consumed by meat producing animals (e.g. pasture and forage). Values 
supplied for crops not consumed by meat-producing animals have no impact on the calculations. 

Values of DCYPCB must be specified for each crop category for all radionuclides treated by the 
food pathway model (i.e., for all possible radionuclide-crop combinations).  

 

Figure 3-146 Meat/Milk Radioactive Retention Form 
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Table 3-146 Meat/Milk Radioactive Retention Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

DCYPCB Yes Real NFIISO by NFICRP 0.0 to 1.0 

 

Term One CTCOEF for Weathering Form 

The Term One CTCOEF for Weathering form is required when MACCS Food Model is selected 
on the Food tab.  

CTCOEF corresponds to the constant multiplier of the first term in the weathering equation, as 
described in Subsection 3.4.11.1.  This parameter defines the product of the interception fraction 
and the availability fraction for each term in the weathering model for crops with exposed edible 
portions.  For plants with edible portions internal to the plant, this defines the combined transfer 
fraction for interception, weathering, and translocation averaged over an entire growing season. 
Values of CTCOEF must be specified for each crop category and for all radionuclides treated by 
the food pathway model.  

 

Figure 3-147 Term One CTCOEF for Weather Form 
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Table 3-147 Term One CTCOEF for Weather Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

CTCOEF Yes Real NFIISO by NFICRP 0.0 to 1.0 

 

Term One CTHALF for Weathering Form 

The Term One CTHALF for Weathering form is required when MACCS Food Model is selected 
on the Food tab.  

CTHALF corresponds to the half-life value of the first term in the weathering equation, as 
described in Subsection 3.4.11.1.  The values supplied for CTHALF must be properly paired with 
the corresponding values of CTCOEF defined in the previous form. Values of CTHALF must be 
specified for each crop category for all radionuclides treated by the food pathway model. 

 

Figure 3-148 Term One CTHALF for Weathering Form 

Table 3-148 Term One CTHALF for Weathering Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

CTHALF Yes Real NFIISO by NFICRP to 3.15×1013 s 

 



 

3-220 

Term Two CTCOEF for Weathering Form 

The Term Two CTCOEF for Weathering form is required when MACCS Food Model is selected 
on the Food tab and the Number of Crop Weathering Terms is set to Two Terms or Three Terms.  

CTCOEF corresponds to the constant multiplier of the second term in the weathering equation, 
as described in Subsection 3.4.11.1.  It defines the product of the interception fraction and the 
availability fraction for each term in the weathering model for crops with exposed edible portions. 
For plants with edible portions internal to the plant, it defines the combined transfer fraction for 
interception, weathering, and translocation to seeds averaged over an entire growing season. 
Values of CTCOEF must be specified for each crop category and for all radionuclides treated by 
the food pathway model.  

 

Figure 3-149 Term Two CTCOEF for Weathering Form 

Table 3-149 Term Two CTCOEF for Weathering Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

CTCOEF Yes Real NFIISO by NFICRP 0.0 to 1.0 

 

Term Two CTHALF for Weathering Form 

The Term Two CTHALF for Weathering form is required when MACCS Food Model is selected 
on the Food tab and the Number of Crop Weathering Terms is set to Two Terms or Three Terms.  
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CTHALF corresponds to the half-life value of the second term in the weathering equation, as 
described in Subsection 3.4.11.1.  Values must be specified for each crop category for all 
radionuclides treated by the food pathway model. 

d  

Figure 3-150 Term Two CTHALF for Weathering Form 

Table 3-150 Term Two CTHALF for Weathering Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

CTHALF Yes Real NFIISO by NFICRP 1.0 to 3.15×1013 s 

 

Term Three CTCOEF for Weathering Form 

The Term Three CTCOEF for Weathering form is required when MACCS Food Model is selected 
on the Food tab and the Number of Crop Weathering Terms is set to Three Terms. In this case, 
parameter NTTRM is set to three. 

CTCOEF corresponds to the constant multiplier of the third term in the weathering equation, as 
described in Subsection 3.4.11.1  This parameter defines the product of the interception fraction 
and the availability fraction for each term in the weathering model for crops with exposed edible 
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portions.  For plants with edible portions internal to the plant, this defines the combined transfer 
fraction for interception, weathering, and translocation averaged over an entire growing season. 

Values of CTCOEF must be specified for each crop category and for all radionuclides treated by 
the food pathway model.  

 

Figure 3-151 Term Three CTCOEF for Weathering Form 

Table 3-151 Term Three CTCOEF Weathering Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

CTCOEF Yes Real NFIISO by NFICRP 0.0 to 1.0 

 

Term Three CTHALF for Weathering Form 

The Term Three CTHALF for Weathering form is required when MACCS Food Model is selected 
on the Food tab and the Number of Crop Weathering Terms is set to Three Terms.  In this case, 
parameter NTTRM is set to three. 
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CTHALF corresponds to the half-life value of the third term in the weathering equation, as 
described in Subsection 3.4.11.1.  The values supplied for CTHALF must be properly paired with 
the corresponding values of CTCOEF defined in the previous form. 

Values of CTHALF must be specified for each crop category for all radionuclides treated by the 
food pathway model. 

 

Figure 3-152 Term Three CTHALF for Weathering Fomr 

Table 3-152 Term Three CTHALF for Weathering Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

CTHALF Yes Real NFIISO by NFICRP 1.0 to 3.15×1013 s 

 

Crop Share and Growing Season Form 

The Crop Share and Growing Season form is required when the MACCS Food Model is selected 
on the Food tab and the Site Data Specification is set to Uniform on the Site Data tab.  Values 
are taken from the site file when Import from File is chosen on the Site Data tab.  

TSGBEG defines the start of the growing season for the named crop category in terms of Julian 
day (January 1 is day 1; December 31 is day 365 for a non-leap year). 
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TGSEND defines the end of the growing season for the named crop category in terms of Julian 
day. 

FRCTFL defines the fraction of cultivated farmland that is used to grow the named crop category. 

 

Figure 3-153 Crop Share and Growing Season Form 

Table 3-153 Crop Share and Growing Season Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

TGSBEG Yes Real NFICRP 1.0 to 365.0 Julian day  

TGSEND Yes Real NFICRP 1.0 to 365.0 Julian day 

FRCTFL Yes Real NFICRP 0.0 to 1.0 

 

Protective Action Form  

The Protective Action form is required when MACCS Food Model is selected on the Food tab. 

For an accident that occurs during the growing season, there are two types of actions that can 
occur: disposal of milk and its products and disposal of crops other than milk (nonmilk crops). All 
agricultural production is divided between these two categories.  The action levels used for 
determining when these two actions are necessary are the input parameters PSCMLK and 
PSCOTH, which are defined below. 

When contamination levels are too high, agricultural production is restricted for one or more years 
after an accident. A single set of values for allowable ground concentration (parameter GCMAXR) 
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is used to make this determination. During the long-term interdiction period, either all crops (both 
milk and nonmilk) can be produced or no crops can be produced. 

For accidents that occur outside the growing season, MACCS, evaluates only the long-term action 
level (GCMAXR). The growing season action levels, PSCMLK and PSCOTH, are not evaluated 
since crop disposal can only occur during the growing season.  For accidents that occur during 
the growing season, however, both types of criteria (growing season and long-term) may be 
evaluated by the code. It is up to the user to determine whether these two types of evaluations 
are performed either independently of each other (uncoupled) or in such a way that the 
exceedance of one type of criteria automatically forces the exceedance of the other criteria 
(coupled).  The choice of these two options is defined by the user-specified input parameter, 
COUPLD. 

When the two types of criteria are chosen to be evaluated independently, there are no interactions 
between the growing season pathway and the long-term pathway.  The resulting doses and 
economic costs from these two components of the food model are calculated in a completely 
independent manner. 

When the user chooses the option of a coupled evaluation, the following rules define the 
interactions between two types of actions.  Whenever the long-term criteria (GCMAXR) are 
exceeded, the disposal of any growing crops (both milk and nonmilk) is automatically triggered. 
Alternatively, whenever both milk and nonmilk crop disposal are called for because of exceeding 
both the PSCMLK and PSCOTH criteria, the code automatically imposes at least one year of 
long-term farmland interdiction. 

COUPLD defines whether the growing season and the long-term action levels are evaluated in a 
coupled manner (True) or in a totally independent manner (False). 

PSCMLK defines the growing season protective action level (i.e., maximum permissible surface 
concentration), for milk and milk products for the named radionuclide. 

PSCOTH defines the growing season protective action level, maximum permissible surface 
concentration, for non-milk crops and their products for the named radionuclide. 

The long-term uptake fractions for root uptake and soil ingestion by animals have been previously 
defined by parameter TCROOT.  These uptake fractions are integrated over all time, that is, from 
t=0 to t=infinity.  MACCS allows the user to define a model for the temporary interdiction of the 
long-term uptake pathway when certain ground contamination levels are exceeded at the time of 
the accident.  When this model is activated, and temporary interdiction of long-term uptake is 
needed, the period of temporary interdiction is the shortest number of whole years that allows the 
long-term criteria to be met.  The longest allowed period of long-term interdiction is 8 years. When 
8 years of weathering and radioactive decay are insufficient, the farmland is condemned and 
permanently removed from production. 

GXMAXR defines the protective action level (i.e., maximum permissible surface concentration) 
for long-term crop production for the named radionuclide. This is the criteria to be met for each 
ingestion radionuclide. 

QROOT defines the rate constant for the decrease in availability over the temporary interdiction 
period.  This value accounts for radioactive decay, irreversible chemical binding to the soil, 
percolation downward into the soil and uptake into plants or ingestion by animals. 
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The value assigned to QROOT is used to determine how effective temporary interdiction of the 
long-term agricultural pathway is for reducing ingestion doses.  For example, when the depletion 
rate is 0.5 per year, a year of temporary interdiction causes the integrated dose to be Exp(–0.5) 
of what it would be if there were no interdiction. 

The MACCS food model input parameters PSCMILK, PSCOTH, and GCMAXR are specified in 
terms of maximum allowable ground concentrations for each food radionuclide.  The model sums 
the ratios of the actual to the maximum concentrations for the set of radionuclides.  When this 
value is greater than 1.0, interdiction is imposed.  

 

Figure 3-154 Protective Action Form 

Table 3-154 Protective Action Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

COUPLD Yes Logical None True, False 

PSCMLK Yes Real NFIISO 10-6 to 1020 Bq/m2 

PSCOTH Yes Real NFIISO 10-6 to 1020 Bq/m2 

GXMAXR Yes Real NFIISO 10-6 to 1035 Bq/m2 

QROOT Yes Real NFIISO 0.0 to 1035 yr-1 

 

Water Ingestion Radionuclides Form 

The Water Ingestion Radionuclides form is required when either MACCS Food Model or 
COMIDA2 Food Model is selected on the Food tab. 

When Import from File is selected on the Site Data tab, the entries on this form must agree with 
the water ingestion radionuclides specified in the site data file. 
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NUMWPI defines the number of water ingestion radionuclides.  Its value is determined by the 
number of rows in the grid containing values of NAMWPI. 

NAMWPI defines the name of a radionuclide used in the drinking water pathway.  The user must 
supply these nuclides in the same order that they specified in the relevant food-chain model, 
either MACCS or COMIDA2.  Nuclide choices are from parameter NAMIPI when the MACCS 
food-chain model is used.  The choices must be consistent with radionuclides specified by 
parameter PARENTS when the COMIDA2 food-chain model is used. 

 

Figure 3-155 Water Ingestion Radionuclides Form 

Table 3-155 Water Ingestion Radionuclides Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUMWPI Linked Integer None 1 to 10 

NAMWPI  Yes Character NUMWPI Must select a radionuclide 
defined in NAMIPI 
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Water Washoff Fraction Form 

The Water Washoff Fraction form is required when either the MACCS Food Model or COMIDA2 
Food Model is selected on the Food tab. 

The water-ingestion model does not account for the decay of parents or the buildup of decay 
products from radioactive decay that occurs between deposition and ingestion. 

WSHFRI defines the initial wash-off fraction for the specified radionuclide.  This is the fraction of 
material deposited on land that is easily washed off into the watershed drainage system shortly 
after the deposition of that radionuclide. 

WSHRTA defines the annual wash-off rate for the specified radionuclide.  This is the annual rate 
at which material deposited on land is washed off into the watershed drainage system following 
the initial deposition. 

 

Figure 3-156 Water Washoff Fraction Form 

Table 3-156 Water Washoff Fraction Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

WSHFRI Yes Real NUMWPI 0.0 to 1.0 

WSHRTA Yes Real NUMWPI 0.0 to 1.0 yr-1 

 



 

3-229 

Water Ingestion Factor Form 

The Water Ingestion Factor form is required when the MACCS Food Model or COMIDA2 Food 
Model is selected on the Food tab and the Site Data Specification is set to Uniform on the Site 
Data tab.  

WINGF defines the water ingestion factor for the radionuclide.  This factor specifies the fraction 
of the radioactivity washed into the drainage system of the watershed that is ultimately consumed 
by humans.  The values are taken from the site file when one is used.  

 

Figure 3-157 Water Ingestion Factor Form 

Table 3-157 Water Ingestion Factor Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

WINGF Yes Real NUMWPI 0.0 to 1.0 
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 Output Control 

 Output Control Forms and Parameters 

Debug Flag Form 

The Debug Flag form is required.  This flag allows the user to print a detailed listing of values for 
intermediate parameters used in CHRONC calculations.  The results for this option are written to 
the output file. Most of the parameters are CHRONC internal variables.  Thus, this output may be 
more useful to MACCS developers than to a user. 

KSWTCH is used to print intermediate results on the output listing.  This parameter should be set 
to 0 for normal calculations.  Because setting this parameter to 1 generates a large amount of 
output, it is usually preferable to use this option for single weather trial runs. 

 

Figure 3-158 Debug Flag Form 

Table 3-158 Debug Flag Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

KSWTCH Yes Integer None 0 or 1 
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Population Dose Results Form 

The Population Dose Results form is optional. 

The CHRONC module calculates long-term population dose broken down by pathway for a list of 
organs defined in the EARLY input file.  This result type has no counterpart in the EARLY module. 
The EARLY module does not allow for population dose to be broken down by exposure pathway. 

No long-term population dose results for an organ are produced in the output listing unless the 
user requests it.  Each request for the breakdown of long-term population dose to an organ 
produces a block of either 12 or 15 dose results (depending on which food-chain model is being 
used), as identified below.  All the dose results are reported in person-Sv by default, although the 
units are listed simply as Sieverts (Sv) in the output file.  The following dose results are reported: 

• TOTAL LONG-TERM PATHWAYS DOSE—total long-term population dose from 
groundshine and resuspension, from the consumption of contaminated food, from the 
ingestion of contaminated surface water, and from decontamination work. 

• LONG-TERM DIRECT EXPOSURE PATHWAYS—total long-term population dose to 
resident population from groundshine and inhalation of resuspended aerosols. 

• TOTAL INGESTION PATHWAYS DOSE—total long-term population dose from the 
consumption of contaminated dairy products, contaminated nondairy products, and 
contaminated water. 

• LONG-TERM GROUNDSHINE DOSE—total long-term population dose received by 
resident population from groundshine. 

• LONG-TERM RESUSPENSION DOSE—total long-term population dose received by 
resident population from inhalation of resuspended aerosols. 

• POP-DEPENDENT DECONTAMINATION DOSE—total long-term population dose 
received by groundshine to workers performing "population dependent" (nonfarm) 
decontamination (decontamination workers receive no inhalation dose). 

• FARM-DEPENDENT DECONTAMINATION DOSE—total long-term population dose 
received from groundshine by workers performing farm-dependent (farmland) 
decontamination (decontamination workers receive no inhalation dose). 

• WATER INGESTION DOSE—total long-term population dose from ingestion of 
contaminated surface water. 

When the MACCS food-chain model is used, the following food pathway results are reported: 

• MILK GROWING SEASON DOSE—total long-term population dose resulting from 
consumption of milk and dairy products contaminated because of deposition onto crops 
during the growing season.  

• CROP GROWING SEASON DOSE—total long-term population dose resulting from 
consumption of nonmilk food products contaminated because of deposition onto crops 
during the growing season. 
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• MILK LONG-TERM DOSE—total long-term population dose resulting from consumption 
of milk and dairy products contaminated by long-term uptake during the entire period 
following the accident. 

• CROP LONG-TERM DOSE—total long-term population dose resulting from 
consumption of nondairy crops and their products contaminated by long-term uptake 
during the entire period following the accident. 

When the COMIDA2 food-chain model is used, the following food pathway results are reported: 

• INGESTION OF GRAINS—total long-term population dose resulting from consumption 
of grains by humans. 

• INGESTION OF LEAF VEG—total long-term population dose resulting from 
consumption of leafy vegetables by humans. 

• INGESTION OF ROOT CROPS—total long-term population dose resulting from 
consumption of root crops by humans. 

• INGESTION OF FRUITS—total long-term population dose resulting from consumption of 
fruits by humans. 

• INGESTION OF LEGUMES—total long-term population dose resulting from 
consumption of legumes by humans. 

• INGESTION OF BEEF—total long-term population dose resulting from consumption of 
beef by humans. 

• INGESTION OF MILK—total long-term population dose resulting from consumption of 
milk by humans. 

• INGESTION OF POULTRY—total long-term population dose resulting from consumption 
of poultry by humans. 

• INGESTION OF OTHER MEAT CROPS—total long-term population dose resulting from 
consumption of other meat crops by humans. 

The region of interest is used to determine the size of the potentially contaminated area being 
evaluated.  In the context of this consequence measure, the population dose within a region is 
the population dose that occurs because of activity deposited within the region.  For groundshine 
and resuspension inhalation, the dose is received by the resident population, but for ingestion 
and doses to decontamination workers, the dose could be received by individuals who reside 
elsewhere.  

NXUM9 specifies the number of results. Its value is determined by the number of rows in the grid 
containing vectors ORGNAM, IX1DS9, IX2DS9, and Report Options. 

ORGNAM defines the name of the organ for which the long-term dose breakdown is to be 
reported.  The possible values depend on the DCF file chosen.  

IX1DS9 defines the inner spatial interval of the region of interest.  The location is the inner radius 
of the specified ring.  
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IX2DS9 defines the outer spatial interval of the region of interest.  The location is the outer radius 
of the specified ring.  MACCS requires that the value must be greater than or equal to IX1DS9. 

Report Options determine whether CCDF data are written to the MACCS output file and whether 
the data are included in the summary report. 

 

Figure 3-159 Population Dose Results Form 

Table 3-159 Population Dose Results Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NXUM9 Linked Integer None 0 to 10 

ORGNAM Yes Character NXUM9 Long Term Organ name 
specified in EARLY 

IX1DS9 Yes Integer NXUM9 1 to NUMRAD 

IX2DS9 Yes Integer NXUM9 1 to NUMRAD 

Report Options Yes Character NXUM9 CCDF, NONE, REPORT, 
CCDF & REPORT 

 

Economic Cost Results Form 

The Economic Cost Results form is optional.  The CHRONC module calculates the economic 
costs of all the long-term protective actions as well as the cost of the emergency response actions 
that were modeled by EARLY.  
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No economic costs are printed unless the user specifically requests them.  When Flag10 is set to 
true, each request for economic results produces the block of 13 economic results described 
below. All the economic cost measures are reported in dollars.  

• TOTAL ECONOMIC COSTS—the sum of population- and farm-dependent costs 

• POP-DEPENDENT COSTS—the sum of population-dependent decontamination, 
interdiction, and condemnation costs 

• FARM-DEPENDENT COSTS—the sum of farm-dependent decontamination, 
interdiction, and condemnation costs as well as milk and crop disposal costs 

• POP-DEPENDENT DECONTAMINATION COST—decontamination cost of nonfarm 
property (i.e., property associated with resident population) 

• FARM-DEPENDENT DECONTAMINATION COST—decontamination cost of farm 
property 

• POP-DEPENDENT INTERDICTION COST—depreciation and loss of use of nonfarm 
property during both decontamination and extended interdiction plus a one-time cost to 
relocate the population (see POPCST in Section 7.6) 

• FARM-DEPENDENT INTERDICTION COST—depreciation and loss of use of farm 
property during both periods of decontamination and interdiction 

• POP-DEPENDENT CONDEMNATION COST—compensation paid for permanent loss of 
nonfarm property plus a one-time cost to relocate the population  

• FARM-DEPENDENT CONDEMNATION COST—compensation paid for permanent loss 
of farm property because it was not returned to production within 8 years of the accident 

• EMERGENCY PHASE COSTS—per-diem costs to compensate people for being away 
from home due to evacuation and relocation during the emergency phase  

• INTERMEDIATE PHASE COSTS—per-diem costs to compensate people for being 
away from home due to relocation for the duration of the intermediate phase when the 
projected dose exceeds DSCRTI. 

• MILK DISPOSAL COSTS—compensation for lost milk sales during a quarter of a year 
when the first year's crops require disposal. This cost is incurred when the accident 
occurs during the growing season and any of the following conditions occur: the 
growing-season milk action guide is exceeded, or any decontamination actions are 
required, or (for MACCS food model only) when COUPLD=.TRUE. and any long-term 
interdiction is required. 

• CROP DISPOSAL COSTS—compensation for lost nonmilk crop sales during a full year. 
This cost is incurred when the accident occurs during the growing season and any of the 
following conditions are found: the growing-season nonmilk action guide is exceeded, or 
any decontamination actions are required, or (for MACCS food model only) when 
COUPLD=.TRUE. and any long-term interdiction is required. 

NXUM10 specifies the number of results. Its value is determined by the number of rows in the 
grid containing values of vectors I1DS10, I2DS10, and Report Options. 
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I1DS10 defines the inner spatial interval of the region of interest.  The boundary is the inner radius 
of the specified ring. 

I2DS10 defines the outer spatial interval of the region of interest.  The boundary is the outer radius 
of the specified ring.  MACCS requires that the value must be greater than or equal to I1DS10.  

FLAG10 equal to true extends the output to include an expanded breakdown of costs. 

Report Options determine whether CCDF results are written to the MACCS output file, and 
whether the results are to be included in the WinMACCS summary report. 

 

Figure 3-160 Economic Cost Results Form 

Table 3-160 Economic Cost Results Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NXUM10 Linked Integer None 0 to 10 

I1DS10 Yes Integer NXUM10 1 to NUMRAD 

I2DS10 Yes Integer NXUM10 1 to NUMRAD 

FLAG10 Yes Logical NXUM10 True, False 

Report Options Yes Character NXUM10 CCDF, NONE, REPORT, 
CCDF & REPORT 
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Action Distance Results Form 

The Action Distance Results form is required when the MACCS Food Model or COMIDA2 Food 
Model is selected on the Food tab. 

The long-term protective actions that result from the calculations of the CHRONC module depend 
on the data supplied by the user.  Associated with the long-term actions of decontamination, 
interdiction, and crop disposal are the maximum distances to which these actions are 
implemented.  

The option to print these long-term action distances is controlled by a flag specified by the user. 
When FLAG11 is set to true, MACCS produces the eight maximum action distance results that 
are described below.  Each result is identified by the result name used on the output file along 
with a description of the result.  

• FARM-DEPENDENT DECONTAMINATION DIST.—distance to which farmland 
decontamination is required. 

• POP-DEPENDENT DECONTAMINATION DIST.—distance to which non-farmland 
decontamination is required. 

• FARM-DEPENDENT INTERDICTION DIST.—distance to which farmland interdiction is 
required. 

• POP-DEPENDENT INTERDICTION DIST.—distance to which non-farmland interdiction 
is required. 

• FARM-DEPENDENT CONDEMNATION DIST.—distance to which farmland 
condemnation is required. 

• POP-DEPENDENT CONDEMNATION DIST.—distance to which non-farmland 
condemnation is required. 

• MILK DISPOSAL DIST.— distance to which milk disposal is required. 

• CROP DISPOSAL DIST.— distance to which crop disposal is required. 

FLAG11 set to true indicates that the output file includes maximum action distances. 

The value chosen for Report Options determines whether CCDF values are written to the MACCS 
output file and whether they are included in the WinMACCS report generated after simulations 
are complete.  
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Figure 3-161 Action Distance Results Form 

Table 3-161 Action Distance Results Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

FLAG11 Yes Logical 1 True, False 

Report Options Yes Character 1 CCDF, NONE, REPORT, 
CCDF & REPORT 

 

Impacted Area/Population Results Form 

The Impacted Area/Population Results form is optional when MACCS Food Model or COMIDA2 
Food Model is selected on the Food tab.  Associated with the long-term actions of 
decontamination, interdiction, condemnation, and crop disposal are the areas and populations 
that are affected by these actions.  The option to print these impacted area/population results is 
controlled by the user. 

Each request for impacted farm-area/population results produces the block of eight results 
described as follows:  

• FARM DECONTAMINATION (ha)—farmland area that requires decontamination  

• POP. DECONTAMINATION (INDIVIDUALS)—population of areas that require 
decontamination of nonfarm property 
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• POP. DECONTAMINATION AREA (ha)—land area of nonfarm property requiring 
decontamination  

• FARM INTERDICTION (ha)—farmland area that requires interdiction 

• POP. INTERDICTION (INDIVIDUALS)—population of areas that require interdiction 

• POP. INTERDICTION AREA (ha)— area of nonfarm property requiring interdiction  

• FARM CONDEMNATION (HECTARES)— farmland area that requires condemnation 

• POP. CONDEMNATION (INDIVIDUALS)—population of areas that require 
condemnation  

• POP. CONDEMNATION AREA (ha)—area requiring condemnation of nonfarm property 

• MILK DISPOSAL AREA (ha)—area requiring milk disposal 

• CROP DISPOSAL AREA (ha)—area requiring crop disposal 

NUM12 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors I1DS12, I2DS12, and Report Options. 

I1DS12 defines the inner spatial interval of the region of interest.  The location is the inner radius 
of the specified ring. 

I2DS12 defines the outer spatial interval of the region of interest.  The location is the outer radius 
of the specified ring. MACCS requires that the value must be greater than or equal to I1DS12. 

Report Options determine whether CCDF values are written to the MACCS output file, and 
whether they are to be included in the summary report. 
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Figure 3-162 Impacted Area/Population Results Form 

Table 3-162 Impacted Area/Population Results Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUM12 Linked Integer None 0 to 10 

I1DS12 Yes Integer NUM12 1 to NUMRAD 

I2DS12 Yes Integer NUM12 1 to NUMRAD 

Report Options Yes Character NUM12 CCDF, NONE, REPORT, 
CCDF & REPORT 

 

Individual Food Ingestion Dose Form 

The Individual Food Ingestion Dose form is optional when the COMIDA2 Food Model is selected 
on the Food tab. 

MACCS reports statistics on the maximum food ingestion dose calculated within a user-specified 
spatial interval for effective dose or thyroid dose.  No other organs are available for this result.  

The maximum dose is the dose calculated using the food consumption rates specified in the 
COMIDA2 input file for a representative individual.  The projected doses in years 1 through 9 are 
examined in turn, and the maximum value found is used in generating this result. 

NUM13 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors I1DS12, I2DS12, and Report Options. 
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IRAD13 defines the spatial interval of the region of interest.  The location is the outer radius of 
the specified ring. The inner radius is taken to be zero.  

ORGN13 defines the organ to be used for each requested result. 

Report Options determine whether CCDF values are written to the MACCS output file, and 
whether they are included in the summary report. 

 

Figure 3-163 Individual Food Ingestion Dose Form 

Table 3-163 Individual Food Ingestion Dose Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUM13 Linked Integer None 0 to 20 

IRAD13 Yes Integer NUM13 1 to NUMRAD 

ORGN13 Yes Character NUM13 EFFECTIVE, THYROID 

Report Options Yes Character NUM13 CCDF, NONE, REPORT, 
CCDF & REPORT 
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Impacted Population Results Form 

The Impacted Population Results form is optional. 

The results from this output type convey information about evacuees, relocatees, and impacted 
individuals for each phase.  The output includes the following results: 

• EVACUEES NOT AFFECTED BY PLUME—the number of evacuees whose property is 
not contaminated and can return during or immediately after the emergency phase 

• EVACUEES AFFECTED BY PLUME—the number of evacuees whose property is 
contaminated and may not be able to return immediately after the emergency phase 

• NORMAL EMERGENCY PHASE RELOCATION—the number of relocatees who are 
affected by normal relocation during the emergency phase 

• HOTSPOT EMERGENCY PHASE RELOCATION—the number of relocatees who are 
affected by hotspot relocation during the emergency phase 

• INTERMEDIATE PHASE RELOCATION—the number of relocatees during the 
intermediate phase 

• LEVEL 1 DECONTAMINATION RELOCATION—the number of people whose property 
requires the first level of decontamination during the long-term phase 

• LEVEL 2 DECONTAMINATION RELOCATION—the number of people whose property 
requires the second level of decontamination during the long-term phase 

• LEVEL 3 DECONTAMINATION RELOCATION—the number of people whose property 
requires the third level of decontamination during the long-term phase, but can return 
immediately after the decontamination is completed 

• DECONTAMINATION+INTERDICTION RELOC—the number of people whose property 
requires the highest level of decontamination (depending on the number of levels 
specified in the input) plus additional interdiction following the decontamination  

• CONDEMNATION RELOCATION—the number of people whose property is condemned 

NUM14 specifies the number of results. Its value is determined by the number of rows in the grid 
containing values of vectors I1DS14, I2DS14, and Report Options. 

I1DS14 defines the inner spatial interval of the region of interest.  The location is the inner radius 
of the specified ring. 

I2DS14 defines the outer spatial interval of the region of interest.  The location is the outer radius 
of the specified ring. MACCS requires that the value must be greater than or equal to I1DS14. 

Report Options determine whether CCDF values are written to the MACCS output file, and 
whether they are to be included in the summary report. 
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Figure 3-164 Impacted Population Results Form 

Table 3-164 Impacted Population Results Form Inputs 

Parameter Name Definable Type Dimensions Allowed Values 

NUM14 Linked Integer None 0 to 10 

I1DS14 Yes Integer NUM14 1 to NUMRAD 

I2DS12 Yes Integer NUM14 1 to NUMRAD 

Report Options Yes Character NUM14 CCDF, NONE, REPORT, 
CCDF & REPORT 
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4. WINMACCS REFERENCE GUIDE 

4.1 Software Components 

The MACCS suite is a set of interconnected software components.  This section describes the 
main software components. 

 WinMACCS 

The WinMACCS user interface was created using Microsoft Visual Basic Pro 6.0 (Service Pack 5) 
and Microsoft Access 2010. WinMACCS is the graphical user interface used to modify input 
parameters and model settings to support MACCS calculations.  WinMACCS creates input files, 
initiates the MACCS model, and post-processes MACCS results.  It can also run several 
preprocessors that support a variety of functions described below.  

The following initialization files are used by WinMACCS: 

• WinMACCS.ini contains initial settings. This file resides in the same folder as 
WinMACCS.exe. It is self-documenting and can be edited in an ASCII editor such as 
Notepad.  

• Initialize2000.mdb is a Microsoft database used to create a new project file and when 
importing a project file in an older format, i.e., created by an older version of 
WinMACCS.  

 MACCS 

The MACCS executable file is created using Intel Visual FORTRAN Version 11.1. MACCS is the 
modeling engine and can be initiated from WinMACCS or independently from a command prompt 
window.  

The following input files may be required, depending on modeling choices.  These files are either 
created by WinMACCS or supplied by the user when MACCS is initiated via a command prompt 
window: 

• ATMOS input file containing parameters pertaining to atmospheric transport, dispersion, 
deposition, and source term; 

• EARLY input file containing parameters pertaining to the emergency phase, which lasts 
up to forty days from the beginning of release; and  

• CHRONC input file containing parameters used to model the intermediate and long-term 
phases. 

Additional files used by MACCS are as follows: 

• INDEXR.DAT is an ASCII file containing decay-chain information.  This file is included as 
part of the installation. 

• maccs2.ini. is an initialization file that contains two flags.  When FileTempMem is set to 
true, temporary files are used instead of dynamic memory.  The default value for 
FileTempMem is .FALSE. When BinFileFlag is set to true, all dose values for all grid 
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elements per cohort per weather trial is printed to a file for each source term in the 
ATMOS input file. The default value of BinFileFlag is .FALSE. 

• MACCS.tmp is a text file containing the paths and names for the MACCS input files. The 
name of this file can be modified with a command line parameter.  

• The meteorological file is an optional file that describes the weather conditions for one 
year. 

• The site file is an optional file that defines population, land use, and economic 
parameters for each grid element. 

• The DCF file is an optional file used to calculate doses to a set of organs from 
radionuclide exposures corresponding to a set of exposure pathways. 

• The COMIDA2 binary file, created by COMIDA2.exe, is an optional file used to define 
food-chain DCFs.  

Several output files are created by MACCS (e.g., model1.out, model2.out, etc.), where the 
number corresponds to the realization or calculation number.  When the calculation is 
deterministic and the cyclical file option is not used, only model1.out is created.  

• Modeln.out is a text file containing output from MACCS. 

• Modeln.bin is a binary file containing output from MACCS.  This file can be viewed as 
text using the File→Export Binary Results as Text option in the WinMACCS main menu 
or can be used to create plots from within the WinMACCS interface. 

• FortErr.log is created when MACCS terminates abnormally.  

• MaxStat.log contains the character string “OK” when MACCS terminates normally, “NO” 
when MACCS detects an error or when MACCS does not complete the simulation. This 
file contains an error message when termination is due to an error detected by MACCS. 

 Latin Hypercube Sampling (LHS) 

The executable file, lhs.exe, generates values of uncertain parameters using LHS.  This program 
is initiated from WinMACCS.  The code, published by SNL, is used to perform sampling from user-
defined probability distributions that represent uncertain input parameters.  LHS allows the 
uncertain distributions to be correlated.  

The following required input files are transparent to the user when running LHS from within 
WinMACCS: 

• Lhs.inp is generated by WinMACCS. This file contains the probability distribution types 
and values and the number of samples to generate. 

• sipra.inp contains software settings used by LHS. 

The following output files are generated when using LHS: 

• Lhs.out contains sampled values created by the LHS execution.  This file is read by 
WinMACCS and it is used to create MACCS and COMIDA2 input files and uncertain 
DCFs using the sampled values. 
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• Lhs.err is created when an error is detected during LHS execution. 

• Lhs.msg contains details of LHS execution. 

 COMIDA2 

The executable file, Comida2.exe, is a semi-dynamic food chain model that estimates annual 
concentrations in various food sources given a set of radionuclides and transfer coefficients for 
each crop type considered.  

The input files are generated by WinMACCS. Uncertainty is supported in this input.  The following 
input files are required: 

• Comida2.inp, a parameter input file 

• Comida2.var, a parameter input file 

• Comida2.par, a parameter input file. 

• A DCF file 

The following output files are generated by COMIDA2: 

• Comida2.bin, a binary file that is used as input to MACCS 

• Comida2.dmp, a text output file 

• Comida2.lst, a text output file 

• Comida2.cnc, a text output file 

 PopMod 

PopMod was written to allow MACCS to support more than sixteen compass directions by 
interpolating an older site data file created by SecPop version 4.2.2 or older.  This function is no 
longer needed when the user can create site files supporting the number of compass directions 
required for their simulation using current versions of SecPop.  

PopMod reads a site file and creates a new population file containing more compass sectors.  The 
work of PopMod is primarily interpolating and reformatting.  No new information is added to the 
site file created by PopMod. 

PopMod requires for input a site data file and the required number of angular sectors needed in 
the new file. The number of final sectors must be greater than the original site data file. PopMod 
generates a modified site data file.  

Even though PopMod is still part of WinMACCS, it is not needed when SecPop 4.0 or later is used 
to create the site file. SecPop 4.0 uses Census 2010 data and supports up to 64 compass sectors. 

 CombineSource 

The executable file CombineSource.exe is integrated into WinMACCS to support the multiple 
source model.  The input files required are result files from MelMACCS, a separate software 
component used to extract source-term data from MELCOR (a reactor modeling product) results. 
Optionally, a user could create their own source files by replicating the format of a MelMACCS 
file.  
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 Project Files 

Data files managed by WinMACCS include a set of auxiliary files, such as the site file, the 
meteorological file, the COMIDA2 binary file(s), cyclical file(s), source term file(s), and DCF file(s). 

Input files are created by WinMACCS using the model and input settings.  This set can include 
Atmosn.inp, Earlyn.inp, Chroncn.inp, Comidan.inp, and Lhs.inp input files. 

Output files are created by MACCS and its preprocessors (e.g., LHS and COMIDA2).  One or 
more sets of MACCS output files, Modeln.out and Modeln.bin, are normally created. Other files 
may or may not be created, depending on settings. 

A project database (e.g., project.mxd), is created from an Access 2010 database file, 
Initialize2000.mdb, by WinMACCS when a new project is created.  The project database contains 
the following information: 

• Input values specified by user, 

• Default input values, 

• Parameter descriptions and limits, 

• Information to construct input forms,  

• Information to construct input files, 

• LHS results, and 

• MACCS results read from binary files. 

4.2 Main Menu Items 

The main menu contains six drop-down menus that allow the user to control WinMACCS projects 
and perform several useful functions.  These are described in the following subsections for each 
of the menu items.  

 File Menu 

The File menu shown in Figure 4-1 allows the user to do the following: 

• Manage MACCS projects via the New Project, Open Project, Save Project, SaveAs 
Project, and Close Project commands.  

• Refresh the view of the project files using Refresh File View. 

• Import a MACCS input file (ATMOS, EARLY, CHRONC, or a combination of these files) 
using Import MACCS Input File. 

• Import custom report definitions from another WinMACCS project using Import Custom 
Report Definitions. 

• View a MACCS binary output file in a text format using utility Export Binary Results as 
Text. 

These commands are explained in more detail below. 
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Figure 4-1 File menu 

File→New Project  

The command File→New Project is used to create a new WinMACCS project, as shown in Figure 
4-2.  The user is required to type a name for the project in the Project Name text box.  This name 
is used as a folder name and as the prefix of the .mxd project file.  The user is limited to enter 
only names that are legal names for windows folders and files.  Optionally, the user can change 
the drive and parent folder for this new project. 

By default, the project location is on the drive where MACCS is installed.  If the program was 
installed on the C:\ drive, the default project folder is C:\WinMACCS Projects\. 

The user should click OK to close this window and complete the operation of creating a new 
project or click Cancel to close this form without creating a new project. 

 

Figure 4-2 New project form 
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File→Open Project 

The command File→Open Project opens an existing WinMACCS project.  The user opens a 
project by selecting the .mxd file in the project root folder. When the project file was not created 
with the same WinMACCS version, a box like one shown in Figure 4-3 is displayed.  

 

Figure 4-3 Example of database inconsistency 

The database is upgraded to the current version of WinMACCS by clicking Yes. The original .mxd 
file is not modified unless the user selects File→Save. The user can also retain the old project 
version by selecting File→SaveAs Project to store the upgraded version under a different name.  

File→Save Project 

The command File→Save Project saves the changes made to the parameters and settings. 

File→SaveAs Project 

The command File→SaveAs Project creates a new WinMACCS project, as shown in Figure 4-2, 
based on the current project settings. The folder structure and all files are copied to the new 
project. 

File→Close Project 

The command File→Close Project closes the current project. The current project must be closed 
before opening another project because the interface supports only one project at a time. 
However, multiple instances of WinMACCS can be open at the same time provided each instance 
corresponds to a different project folder. 

File→Refresh File View 

The command File→Refresh File View refreshes the data displayed on the project Files tab.  This 
causes WinMACCS to update the files shown in the Input and Output entries on the project Files 
tab to be consistent with the files saved on the computer in the project Input/ and Output/ folders. 
This is done automatically when simulations are run.  However, when a file is copied or deleted 
manually from the computer, the file view may become out of date unless this command is used. 
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File→Import MACCS Input File 

The command File→Import MACCS Input File prompts the user to select a MACCS input file such 
as an Atmos, Early, or Chronc input file (e.g., Atmos1.inp).  The file contents are read and data 
values are imported into WinMACCS parameters in the current project.  The file can also contain 
combinations of Atmos, Early, and Chronc parameters.  When some of the WinMACCS 
parameters were previously defined, the values read from the file replace the old values. 

The MACCS input file does not need to be complete.  The MACCS input lines are read and the 
values overlaid onto the existing project. When a vector or array is present in the MACCS input 
file, all values associated with that vector or array are cleared before the new data are assigned 
to the project.  

The model settings may also be modified while importing a MACCS input file.  For example, the 
MACCS input file modifies the weather sampling method when a METCOD card is included in the 
file. When the model settings are modified, data relevant to those modified settings are imported. 
Data not relevant to the model settings are not imported. 

File→Import Custom Report Definitions 

The command File→Import Custom Report Definitions is used to import custom report definitions 
created in another WinMACCS projects into the current project.  The WinMACCS project file is 
selected as shown in Figure 4-4.  A new report definition is valid only when the results requested 
in the Output Control form that created that result is identical between the two projects.  

 

Figure 4-4 Import report definitions 

File→Export Binary Results as Text 

The command File→Export Binary Results as Text allows the user to open a MACCS binary 
output file in text format. These files are found in the Project\Output\ folder, one for each 
simulation, as shown in Figure 4-5. The binary output files are the same files that are used by the 
WinMACCS postprocessor to display MACCS results graphically. 
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Figure 4-5 Export binary file as text 

File→Exit 

The command File→Exit closes the WinMACCS application. If the project has changed since the 
last time it was saved, a message box is displayed as shown in Figure 4-6. 

 

Figure 4-6 Message box to save project 

 Edit Menu 

The Edit menu shown in Figure 4-7 allows the user to do the following: 

• Show and hide the legend by checking or unchecking Show Legend. The legend defines 
the icons associated with forms in the Project window, 

• Propagate parameters from one cohort to subsequent cohorts, 

• Fill in missing cohort parameters when opening prior versions, 

• Modify data grids on parameter modification forms using commands from the submenu 
Grid, 

• Correlate uncertain parameters from the submenu Correlate Uncertain Variables, 
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• Modify form parameters by selecting the form name and selecting from the submenu 
Modify Form Variables, 

• Open parameter modification forms by choosing the parameter name using the 
command Find Parameter Window, and 

• Open the Project Properties window to modify basic modeling choices. 

These commands are explained in more detail below. 

 

Figure 4-7 Edit menu 

Edit→Show Legend 

When the Edit→Show Legend command is checked, a window appears showing a legend, 
as shown in Figure 4-8.  When the box is unchecked, the legend is hidden. 

 

Figure 4-8 Legend 

Edit→Auto Propagate Cohort Values 

When the Edit→Auto Propagate Cohort Values command is checked, the values are propagated 
from one cohort form to other forms after the OK button is clicked on the parameter modification 
form.  The propagation is applied to cohorts greater than the cohort saved that have not already 
been defined.  This option is set to off by default.  

When this option is enabled and the values are saved on a cohort form, the same values are 
saved on other undefined cohort forms for cohort numbers greater than the cohort number of the 
saved form.  For example, when the parameter CRIORG is updated on the Critical Organ form 
for cohort 3 and there are a total of 6 cohorts, CRIORG for cohorts 4, 5 and 6 is assigned the 
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same value provided this parameter is undefined for these cohorts.  When a form is encountered 
that is defined, the propagation stops and no more cohorts receive the new value. 

As an example, when Network Evacuation Speed for cohort m is completed, propagation is 
performed for cohort m+1, m+2..., until a parameter is found to be defined on the Network 
Evacuation Speed form for cohort n, where n>m. At that point, the propagation ceases.  No 
previously defined values are overwritten when using this option.  

Edit→Propagate Cohort Values on Upgrade 

The Edit→Propagate Cohort Values on Upgrade checked command was implemented to support 
backward compatibility with WinMACCS 3.6 and earlier. When this is checked, values are copied 
to undefined cohort forms when opening a project that was created earlier than the current 
WinMACCS version.  This option is checked (enabled) by default.  When this option is unchecked 
and the project saved, the unchecked state is also saved. 

In earlier versions, the MACCS paradigm of change cards for cohort parameters was used within 
the user interface. Parameters for cohort one were required, but the corresponding value used 
for subsequent cohorts were assumed to be equal to the value used for the previous cohort unless 
explicitly changed.  

All cohort forms are now required.  This means that the values to define a cohort must be defined 
for each cohort.  This option automatically fills in missing values when opening older projects with 
WinMACCS 3.10. 

Edit→Grid 

The submenu Edit→Grid provides commands to manipulate grids in parameter modification 
forms. Figure 4-9 shows a grid found on the ATMOS/Release Description/Release Fractions form. 
The options available in the Edit→Grid submenu are enabled when the current parameter 
modification form contains a grid.  

There are two types of grids on parameter modification forms, vector and array grids.  A grid 
showing an array represents a single parameter containing both rows and columns.  For example, 
parameter RELFRC is an array displayed in a grid, as shown in Figure 4-9.  A grid containing 
vectors may display multiple parameters on a single grid, one parameter for each column.  When 
a grid displays multiple vectors, each vector on the grid must have the same number of rows, as 
shown in Figure 4-10. 
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Figure 4-9 Grid showing an array of release fractions for each plume segment 

 

Figure 4-10 Grid showing multiple vectors: NUCNAM, CORINV, and IGROUP 

The array operations, Edit→Grid→Insert Columns and Edit→Grid→Delete Columns, are enabled 
when the grid contains an array but are disabled when it contains one or more vectors. 

When a parameter form contains either an array or vectors with a variable number of rows, the 
operations Edit→Grid→Insert Rows and Edit→Grid→Delete Row Hint are enabled.  These 
functions are not enabled when the grid requires a fixed number of rows (e.g., vector parameters 
CYSIGA, CYSIGB, CZSIGA and CZSIGB all require exactly six rows).  
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Edit→Grid→Insert Rows 

The Edit→Grid→Insert Rows command is used to insert rows in a grid. A row on the grid must be 
selected before this operation can be used.  A row is selected by clicking on the small box between 
the row label and the data in the desired column.  The row becomes highlighted, as shown below 
in Figure 4-11.  

 

Figure 4-11 Grid showing a selected row 

After the Insert Rows option is selected, the Insert Row form opens, as shown in Figure 4-12.  By 
clicking on the radio button Before, the new rows are inserted before the current selected row. By 
clicking on the radio button After, the new rows are inserted after the current selected row.  The 
number of rows to insert is entered. One or more rows are inserted by clicking OK. 

 

Figure 4-12 Insert Row form 

The menu option to insert rows is not available when the number of rows on a form is fixed 
(e.g., the ATMOS/Dispersion/Dispersion Function form). 

Edit→Grid→Delete Row Hint 

The command Edit→Grid→Delete Row Hint opens a message box shown in Figure 4-13.  This 
is a hint to give the novice user instructions on how to delete a row in the grid. 
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Figure 4-13 How to delete a grid row 

Edit→Grid→Insert Columns  

The command Edit→Grid→Insert Columns is used to insert columns in an array.  A column of the 
array must first be selected by clicking the column header, as shown in Figure 4-14.  

 

Figure 4-14 Grid showing a selected column 

After the Insert Column option is selected, the Insert Column form opens, as shown in Figure 
4-15. By clicking on the radio button Before, the new columns are inserted before the selected 
column. By clicking on the radio button After, the new columns are inserted after the selected 
column.  The operation is completed by entering the number of columns to insert and clicking OK. 

The menu option to insert columns is not available when the columns on a form represent vectors 
(e.g., the ATMOS/Dispersion/Dispersion Table form). 
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Figure 4-15 Insert Column form 

Edit→Grid→Delete Columns 

The command Edit→Grid→Delete Column is used to delete the currently selected array column. 

Edit→Grid→Copy to Clipboard 

The command Edit→Grid→Copy to Clipboard is used to copy a portion of the grid data to the 
Windows clipboard.  

Data can be copied to the Windows clipboard as follows: 

(1). A portion of a grid can be selected in WinMACCS by left clicking and holding button, 
dragging over the desired area, and then releasing the mouse button. 

(2). The selected data can be copied to the clipboard by typing a keyboard short-cut for 
copying (Ctrl+F), selecting Edit→Grid→Copy to Clipboard, or right clicking and 
selecting Copy from the popup menu.  

Other methods described in Section 4.4.1.1 are available for copying portions of the grid to the 
clipboard.  

The data can be easily pasted into another application, such as Microsoft Excel, with the keyboard 
shortcut (Ctrl+V). Note that the shortcut for copying from the grid is different than the standard 
Windows shortcut because these are distinct operations.  

Edit→Grid→Paste from Clipboard 

The command Edit→Grid→Paste from Clipboard is used to transfer the grid data from the 
Windows clipboard into a grid in a parameter modification form.  

Before this can be done, clicking on a cell in the grid defines the position where the data are 
pasted.  Typing the keyboard short-cut for pasting (Ctrl+G), select Edit→Grid→Paste from 
Clipboard, or right clicking and selecting Paste completes the paste operation.  Note that the 
shortcut for pasting onto the grid is different than the standard Windows shortcut because these 
are distinct operations. 

These operations work well for transferring data from a Microsoft Excel spreadsheet into the grid. 
When data are not being transferred from Excel, it is helpful to know WinMACCS expects a TAB 
character to separate cells and a new line (i.e., the Enter key) to separate rows.  
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Edit→ Correlate Uncertain Variables 

The submenu Edit→ Correlate Uncertain Variables offers commands to correlate uncertain 
parameters. Two options are offered, either to allow LHS to enforce rank correlations or to define 
a perfect rank order of parameter values after LHS has run.  Section 4.4.3 can be referenced for 
more information.  

Edit→ Correlate Uncertain Variables→ Linear Coefficients 

The command Edit→ Correlate Uncertain Variables→ Linear Coefficients opens the Correlate 
Uncertain Variables form.  This option, only relevant when LHS is being used to sample a set of 
uncertain parameters, allows the user to correlate pairs of uncertain parameters.  The correlation 
coefficient specifies the degree to which two uncertain parameters are correlated. Section 4.4.3.1 
contains more information. 

Edit→ Correlate Uncertain Variables→ Enforce Rank Order 

The command Edit→ Correlate Uncertain Variables→ Enforce Rank Order opens the Enforce 
Rank Order of Uncertain Variables form. After LHS has run and imposed correlations specified 
by the user, WinMACCS can reorder some of the parameters to be consistent with the rank order 
of other parameters.  Section 4.4.3.2 can be referenced for more information. 

Edit→Modify Form Variables 

The submenu Edit→Modify Form Variables shown in Figure 4-16 contains commands that can 
be used to define parameters without opening the forms.  

 

Figure 4-16 Submenu Modify Form Variables 

Edit→Modify Form Variables→Reset Form Variables to Default 

The command Edit→Modify Form Variables→Reset Form Variables to Default is used to 
conveniently replace all the data on a form with default values, as shown in Figure 4-17.  

Most forms in WinMACCS are undefined by default; in a few cases, there are specific values that 
are standard for a model.  Thus, in most cases, selecting this menu option has the same effect of 
clearing the form.  

The following operations reset a form to its default values: 

• When the form is open, click anywhere on the form.  This identifies it as the form to be 
modified. Select the menu option, Reset Form Variables to Default.  The values are set 
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to the WinMACCS default values.  This is a convenient way to clear the data from a 
form. In some cases, this resets parameters to default values rather than clearing the 
values on the form.  This may produce a different outcome than that of the erase button 
found on the parameter modification form.  The Erase button clears all values from the 
form but does not replace parameters with their default values when default values exist. 

• When a form is not open, an equivalent method for resetting form parameters to their 
defaults is to click on the form name in the Parameters tab of the Project window, then 
select the menu option, Reset Form Variables to Default. Parameters defined on the 
selected form are reset to their default values.  

• Another option to reset parameters to their defaults is to right click on the form name in 
the Parameters Tab and select Reset to Default from the popup menu. 

Resetting parameters to default values does not affect read-only parameters on the form. Read-
only parameters have gray backgrounds when viewed on parameter modification forms.  They 
are defined on a different form. 

Resetting form variables, as described above, is the only way to remove data from required forms. 
Opening a required form, deleting the data, and clicking the OK button is not allowed.  

 

Figure 4-17 Reset form parameters to default 

Edit→Modify Form Variables→Copy Cohort Variables 

The command Edit→Modify Form Variables→Copy Cohort Variables is used to copy form data 
from one of the cohort forms to other cohort forms.  To use this function, a form must first be 
selected from the Parameters tab.  Section 4.4.4 can be referenced for more information. 

Edit→Find Parameter Window 

The command Edit→Find Parameter Window opens the Open Parameter Form as shown in 
Figure 4-18 to assist in locating input parameters within the user interface.  
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Figure 4-18 Open parameter form 

The list of parameters can be navigated by 

• Pressing the up and down arrow keys on the keyboard 

• Typing a letter to move to the first parameter starting with that letter.  For example, 
typing the letter m positions the list at parameters starting with the letter M.  Subsequent 
typing of that same letter moves to the next parameter starting with that letter. 

• Moving the scroll bar on the form.  

Multiple parameters can be selected in the list by: 

• Clicking more than one of the parameter names on the list. 

• By navigating through the list using the arrow keys, entries can be selected by pressing 
the space bar on the keyboard when the parameter name is highlighted. Focus is 
indicated by a dotted rectangle boxing the parameter name. 

The windows associated with the selected parameters can be opened by 

• Selecting OK 

• Pressing the Enter key on the keyboard 

In some cases, more than one form contains the same parameter name.  Sometimes parameters 
have different meanings on different forms, e.g., ORGNAM has a different usage on the Early 
Fatality Effects form and Off Centerline Dose form. All the forms that contain the selected 
parameter are opened. 

Edit→Project Properties 

The command Edit→Project Properties opens the Properties form.  This form is used to modify 
the basic model choices.  By selecting models using the Properties form, other values may be 
required.  Sections 3.1.1 and 4.3 contain more details. 
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 Execute Menu 

The Execute menu shown in Figure 4-19 allows the user to do the following: 

• Control options on MACCS input files with respect to validation and creation before the 
MACCS simulations 

• Switch from LHS to SRS for creating a set of Monte Carlo realizations to estimate the 
effects of parameter uncertainty.  LHS is selected by default. 

• Control whether binary result files are imported into WinMACCS and reports are created. 
Auto Create Reports is selected each time WinMACCS is started. 

• Open the Run Models form to initiate a MACCS simulation. 

  

Figure 4-19 Execute menu 

Execute→Validate Data before Running  

The command Execute→Validate Data before Running has the following meaning: 

• When checked, all input parameters are tested for consistency before a simulation 

• When unchecked, consistency testing is skipped.  This may be desired when a minor 
modification was made and the user doesn't want to wait for the consistency checking to 
be performed before executing MACCS.  

Execute→Refresh Template Input files before Running 

The command Execute→Refresh Template Input files before Running has the following meaning: 

• When checked, the template files are deleted and recreated based on the values and 
settings stored in WinMACCS when Run Simulation is clicked.  

• When unchecked, the template files are not recreated.  This option is used to allow 
direct editing of the MACCS input files. In this case, the user can directly modify the file 
atmosTemplate.txt, earlyTemplate.txt, chroncTemplate.txt, and comidaTemplate.txt.  
The template files are than used by WinMACCS to create the actual MACCS input files. 
Links to these files can be found in the Files tab in the project window.  
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Changing parameters in a template file does not modify parameters in the database.  The files 
used with MACCS, atmos1.inp, early1.inp, etc., are always recreated using the template files. 

Execute→Simple Random Sampling 

The command Execute→Simple Random Sampling has the following meaning: 

• When checked, uncertain input parameter sampling uses SRS. 

• When unchecked, a stratified sampling method known as LHS is used. 

WinMACCS allows input parameter values to be made uncertain and enables sampling of the 
uncertain variables.  Section 4.4.1.3 contains more information about uncertain variables.  Note 
that LHS is the name of the underlying code that performs the sampling, but it supports both LHS 
and SRS.  

Execute→Auto Create Reports 

The command Execute→Auto Create Reports has the following meaning: 

• When checked and reports have been requested, the binary files are imported into the 
project database and the requested report is created without additional action by the 
user following completion of an execution. 

• When not checked, reports are not created after execution.  The user has the option to 
create reports by selecting PostProcessing→Create Custom Report from the main 
menu. Probabilities used in reporting can be modified after execution on the 
General→Reporting Options form.  

Execute→Run Models…  

The command Execute→Run Models… opens the form used to initiate simulations.  This can be 
used to perform a simulation after all model data have been defined.  Section 4.5.1 contains more 
information. 

 PostProcessing Menu 

The PostProcessing menu shown in Figure 4-20 and Figure 4-21 allow the user to do the 
following: 

• Open various graphics windows using the Scalar Results, Statistical Summary Results, 
and Results over all Weather Trials options. 

• Modify plot labels, save plots in various file formats, and select, unselect and delete 
series from plots.  

• Create custom reports using the Create Custom Report command for user-defined 
probabilities. 

• Create a summary report. 
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Post processing results are available after the simulations have completed.  If the MACCS binary 
result files have not already been imported into WinMACCS, requesting a plot or report causes 
all binary files to be imported. 

 

Figure 4-20 Postprocessing/Graphical Results menu 

 

Figure 4-21 Postprocessing/Report Results menu 

PostProcessing→Graphical Results→Scalar Results  

The command PostProcessing→Graphical Results→Scalar Results is used to view released 
activity by radionuclide as a CCDF, as shown in Figure 4-22.  Section 4.6.3.1 contains more 
information. 
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Figure 4-22 Plot of scalar results 

PostProcessing→Graphical Results→Statistical Summary Results 

The command PostProcessing→Graphical Results→Statistical Summary Results opens a 
graphics window to view statistical data for a set of realizations.  The probability shown in the plot 
corresponds to a set of realizations, cyclical files, or a combination of both.  The implicit 
assumption is that each of the results are equally probable. Section 4.6.3.2 contains more details. 

PostProcessing→Graphical Results→Results over all Weather Trials 

The command PostProcessing→Graphical Results→Results over all Weather Trials opens a 
graphical window to view the complementary cumulative distribution function reported on each 
individual simulation.  Each series (the set of points representing a curve) shows probability of 
exceedance based on weather variability for an individual simulation.  Section 4.6.3.2 provides 
more information. 

PostProcessing→Graphical Results→Edit Plots→Modify Titles 

The command PostProcessing→Graphical Results→Edit Plots→Modify Titles is used to change 
the plot title and the axis labels.  A description of all functions available for graphics forms is 
provided in Section 4.6.3.4 

PostProcessing→Graphical Results→Edit Plots →Select Next Series 

The command PostProcessing→Graphical Results→Edit Plots →Select Next Series is used to 
select the next series drawn on the plot.  This performs the same function as the Select button on 
the graphics screen.  A description of all functions available for graphics forms is provided in 
Section 4.6.3.4. 

PostProcessing→Graphical Results→Edit Plots →UnSelect 
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The command PostProcessing→Graphical Results→Edit Plots →UnSelect is used to remove the 
selection of a series drawn on the plot. It is possible to put the form in this same state by clicking 
the Select button repeatedly, though this is a tedious way to unselect when there are many series 
drawn on the plot.  A description of all functions available for graphics forms is available in 
Section 4.6.3.4. 

PostProcessing→Graphical Results→Edit Plots →Delete Selected Series 

The command PostProcessing→Graphical Results→Edit Plots →Delete Selected Series is used 
to remove the selected series from the plot. This can also be accomplished by clicking the Delete 
button on the graphics form. A description of all functions available for graphics forms is available 
in Section 4.6.3.4. 

PostProcessing→Graphical Results→Edit Plots → Export Plot 

The command PostProcessing→Graphical Results→Edit Plots → Export Plot is used to save the 
plot that the user has specified. A variety of formats, such as Excel (*.xls), Windows bitmap 
(*.bmp), Text (*.txt), JPEG (*.jpg), XML (*.xml), and HTML (*.html) are available.  Two of these 
capture an image of the plot (.bmp and .jpg); the others capture the data that are plotted.  

PostProcessing→ Report Results→Manage Custom Reports 

The command PostProcessing→ Report Results→Manage Custom Reports is used to open the 
Manage Reports form. Sections 4.6.2.3 contains more information. 

PostProcessing→ Report Results→Create Summary Report 

The command PostProcessing→ Report Results→Create Summary Report is used to create a 
summary report based on probabilities entered by the user on the General→Output 
Options→Reporting Options form for the selected output requests. Output requests are made on 
forms in the categories Atmos→Output Control, Early→Output Control, and Chronc→Output 
Control. Outputs are available only for form entries where Report Options is set to REPORT or 
CCDF & REPORT. Section 4.6.2.2 can be referenced for more information. 

 The Window Menu 

The Window menu shown in Figure 4-23 allows the user to do the following: 

• Cascade the parameter modification forms and the plot form windows by selecting the 
Cascade function. 

• Change the focus to another window by selecting that window from the numbered list. 
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Figure 4-23 Window menu 

 The Help Menu 

Selecting About on the Help menu, as shown in Figure 4-24 displays the version of WinMACCS. 

 

Figure 4-24 Help menu 

4.3 Selecting Models on the Properties Form 

The Properties form can be opened by selecting Edit→Project Properties from the main menu or 
by double-clicking on General/Properties/Properties from the Parameters tab in the Project 
window. 

Basic model is chosen on the Properties form.  The parameters affected by the Properties form 
can be viewed, but not modified, by opening the forms ATMOS/Property Form Parameters, 
EARLY/Property Form Parameter and CHRONC/Property Form Parameters.  

The Properties form is automatically opened when a new project is created.  Each tab of the 
Properties form has default selections.  The user should ensure that the scope and specific model 
choices on the Properties form is aligned with the problem to be solved.  
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The decisions the user makes at this point determine which parameter forms are required.  For 
example, when the Late Consequences module is not selected on the Properties/Scope tab, 
parameters in the CHRONC category are not required. Consequently, all CHRONC parameters 
in the Project window Parameters tab have gray icons associated with them.  Additionally, all tabs 
related to the Late Consequences module in the Properties form also have gray icons associated 
with them. 

Each tab on the Properties form has at least one basic model associated with it.  There is an icon 
next to the tab name. The meanings of the icons are as follows: 

 A solid green octagon means that one or more choices on this tab are required but 
have already been made either by the user or by default. When any modifications 
are made on the Properties form, the user must click OK to save them. 

 A solid gray octagon with a diagonal line means that the user has completed this tab, 
but the information is not used in a MACCS calculation given the basic modeling 
options the user has chosen.  

 An X-ed red octagon indicates that the model settings on this tab have not been 
made or are not compatible with model settings on another tab. 

Depending on the models selected, some of the radio buttons are disabled on the Project 
Properties form.  For example, when Constant Weather is selected on the Weather tab, the group 
File Sampling Method is visible with the previous choices still showing on the form as shown in 
Figure 4-25.  However, these controls are not available for editing because they are not relevant 
to the current model choices. This is indicated by light grey lettering and symbols.  
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Figure 4-25 Disabled controls on Project Properties form 

Clicking OK saves any changes that have been made. 

Clicking Cancel or closing the window ignores changes that have been made.  

The Show Required Forms button shows which forms in the Project window are required when 
the models selected in the Properties form were saved.  This does not save any changes but is a 
visual tool to help the user understand what input are required with the currently selected options. 

In Figure 4-26, Radial is selected and Show Required Forms is clicked.  As a result, the Radial 
Evacuation Speed form link on the left changes from a gray octagon to an X-ed red octagon.  This 
indicates that additional information is required for the Radial Evacuation Speed form and some 
form(s) in the Additional Emergency Cohorts category when OK is clicked, and this model option 
is saved.  
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Figure 4-26 Relating model selection to forms 

4.4 Modifying Parameters 

A parameter modification form can be opened in one of two ways: 

• By double-clicking on the parameter name or the form name containing the parameter 
found on the Parameters tab in the Project window. 

• By selecting the parameter name in the Open Parameter Form and clicking OK.  The 
Open Parameter Form can be opened as shown in Figure 4-18 or by selecting 
Edit→Find Parameter Window… from the main menu. See Section 4.2.2 for more 
information.  

 Generic Parameter Modification Forms 

There are generic parameter modification forms and custom parameter modification forms, such 
as the forms to manage evacuation directions, evacuation speeds, and reports.  This section 
describes the generic parameter modification forms. 

The following are the main components of a parameter modification form as shown in Figure 4-27: 

• Enter Comments: Optional comments can be entered in this field.  A possible usage is to 
enter comments related to the justification or derivation of parameter values. 

• : Clicking clears all values on the form. 
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• Data entry area: The portion of the form where values are entered.  These areas have a 
white background. Figure 4-27 shows examples for values of YSCALE and ZSCALE.  

• Description area: Describes the data type, limits, and units of the parameter that has 
focus on the form. Below this is a brief description of the variable. 

• Change Units: This button is used to change parameter units. See Section 4.4.2 for a 
further discussion. 

• Make Uncertain: This button is used to associate a probability distribution with a 
variable. Most real-valued parameters can be specified as uncertain. To change the 
value of a parameter to uncertain, the user can either double-click on the text box or cell 
or click Make Uncertain. This function is also used to change a parameter from uncertain 
back to a constant.  

• Clicking OK or Cancel closes the form. OK accepts any changes; Cancel ignores them. 

All the data on the form must be entered before the user can save any of the values on the form. 
When a box is left blank, and OK is clicked, an error message pops up.  This serves as a reminder 
to complete the form before clicking OK to save the values. 

 

Figure 4-27 Parameter modification form 

 Modifying a Data Grid 

Arrays and vectors are displayed in data grids. Data grids support the following operations: 

• A row is selected by clicking on the small box between the row number and the values. 

• A column is selected by clicking on the column heading. 
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• A row is deleted by pressing the Delete key on the keyboard after selecting the row.  

• A change to a row can be undone by pressing the Esc key on the keyboard if the pencil 
icon is shown on the left margin of a row.  

• Clipboard functionality is provided. To use the copy feature in the grid, select the desired 
data from the grid with a mouse down, drag, mouse up motion. Figure 4-28 illustrates a 
selected area in the grid. To copy the data in this selected area to the Windows 
clipboard, select the Edit→Grid→Copy to Clipboard function from the main menu. 
Similarly, the Edit→Grid→Paste from Clipboard function can be used to replace a 
selected area in the grid with data on the Windows clipboard. This function can be used 
to transfer data from an Excel spreadsheet into WinMACCS. 

• Rows can be selected in a non-contiguous fashion by holding the control-key down while 
clicking on rows for selection. Non-contiguous rows can also be selected for pasting in 
the same way. In other words, not only can non-contiguous rows be selected for 
copying, but the affected rows for the past operation can also be selected. 

• Columns can be selected; however, they must be contiguous. When pasting, the area 
defining the paste is required to be contiguous. 

• A rectangular area can be selected for pasting by pressing the left mouse button down 
and dragging over the desired grid data. 

• Copy and paste functions are supported with keyboard shortcuts Ctrl-F and Ctrl-G, 
respectively. 

 

Figure 4-28 Selecting grid data for copy and paste 

When modifying a grid on a parameter form, it may be desirable to insert rows or columns.  A row 
may be inserted by using the menu item Edit→Grid→Insert Rows.  A column may be inserted by 
using the menu item Edit→Grid→Insert Columns. 

 Supported Data Types 

The following data dimensions are supported: 

• Scalar data: single values that are associated with variables.  A scalar can have various 
types, as listed below.  

• Vector data: singly subscripted variables.  Multiple vectors are sometimes displayed on 
the same grid when each of the vectors has the same number of rows.  

• Array data: multiply subscripted variables. Only one array is displayed on a grid.  
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The following types are supported: 

• Integer: a number with no decimal point. An integer can be positive, negative, or zero. 

• Real: a number that has a decimal point.  

• Logical: value is either True or False. Choices are selected from a pull-down menu. 

• Characters: a character string. Size requirements are shown in blue letters below the 
data entry area. 

• Drop-Down Menu: possible values are displayed as a pull-down menu. Only a portion of 
the name needs to be typed. For example, on the ATMOS/Output Control/Spatial 
Intervals for Output form, typing a “c” for CCDF or an “n” for NONE and advancing to 
another field completes the data entry for the CCDF field. 

• File: a file name is specified by clicking the browse button on the parameter modification 
form. The selected file is copied to the project\data\ folder.  

• Linked Variables: the values of some parameters are vector or array sizes calculated by 
WinMACCS. For example, NUM_DIST is the length of the vectors DISTANCE, 
SIGMA_Y_A, etc. This parameter cannot be directly modified. When a linked parameter 
has focus, a description is displayed in the description area of the form. T he value of the 
parameter is updated as the number of grid rows increases or decreases. Linked 
parameters are of type Integer but can only take on positive values. Parameter 
MAXGRP shown in Figure 4-29 is an example of a linked variable.  
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Figure 4-29 Example of a linked variable, MAXGRP 

Note: A gray background in an input area indicates that the parameter is read-only and 
cannot be changed on that form. 

Examples of the data type and bounds that could be found in the description area are as follows: 

• Real [.01, 100.]: A number between 0.01 and 100, inclusive, must be entered in the text 
field. This is displayed in Figure 4-30.  
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Figure 4-30 Real data type 

• Integer [1, NUMREL], (NUMREL=10): An integer value from 1 to 10 must be entered in 
the text field. When the value of NUMREL, the number of plume segments, is modified 
and saved on another form, the bounds are changed to reflect the new value of 
NUMREL as shown in Figure 4-31. 

 

Figure 4-31 Parameter upper bound is a variable 

• 1 to 16 Characters:  A character string that is at least one character and not more than 
16 characters must be entered in the field as shown in Figure 4-32. 

• Row Bounds: [1, 10]: T he grid must have at least one row and not more than 10 rows as 
shown in Figure 4-32. 
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Figure 4-32 Character length limits 

• Nrows = 6: The grid must have exactly 6 rows. This is shown in Figure 4-33. 
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Figure 4-33 Grid with fixed number of rows 

 Making a Parameter Value Uncertain 

WinMACCS allows input parameter values to be made uncertain and enables sampling of the 
uncertain variables.  The sampling can be done using either SRS or a stratified method known as 
LHS.  The sampling method can be changed from the default of LHS to SRS by selecting the 
main menu entry Execute→Simple Random Sampling. 

The sampling allows the effect of an uncertain input value to be explored.  Uncertain parameters 
must be assigned a distribution function from which samples are selected.  The distribution 
function usually represents degree of belief over a range of values that are considered credible 
for that parameter.  

A parameter value can be made to be uncertain by first opening the window associated with that 
parameter. This can be done by double-clicking on the parameter name in the Parameters tab in 
the Project window or by using Edit→Find Parameter Window to locate the form.  

The user can double-click on the parameter value or click on the parameter value and then click 
on the Make Uncertain button. An example uncertain parameter form is shown in Figure 4-34.  A 
form then opens with the parameter name in the form title (or caption). Use this form to: 
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• Change parameters from constants to uncertain values described by probability 
distributions. 

• Change parameters from distributions to constants. 

• Change the probability distribution associated with the variable. 

Notice that the parameter name is shown in the form caption.  When an array or vector element 
is associated with a distribution, the index is also part of the name shown in the title bar.  In Figure 
4-34, BUILDH(3) in the caption portion of the form indicates that the third value of vector BUILDH 
is being considered. 

WinMACCS supports a wide range of distribution types, and each distribution type can accept a 
range of values for its parameters.  It is possible to specify values for the distribution that lead to 
invalid parameter values, causing sampling to fail.  The parameter values that define the 
distribution should chose so that they do not lead to values out of range for the input parameter 
being sampled (e.g., a negative value for a MACCS parameter that must be greater than zero).  

 

Figure 4-34 Assigning a probability distribution to a parameter 

The value of an uncertain parameter can be modified as follows: 

(1). The user first selects the distribution from the Distribution pull down list. The 
parameter can be changed from uncertain to constant (deterministic) by setting the 
distribution to CONSTANT.  

(2). The user enters the values that define the distribution in the text boxes or tables. The 
type of distribution determines the amount and type of information needed to define 
the value. The values that define the distribution either consist of a list of (x, y) pairs 
(known as tabulated data), or a list of parameters (such as the mean and standard 
deviation of a normal distribution). An example is shown in Figure 4-35. 
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A representative sample of the current distribution can be viewed by clicking Apply Distribution, 
which causes LHS to run and create one hundred samples, and the samples to be displayed.  
The sampled values can be viewed as a CDF, CCDF, or a scatter plot.  The mean of the 
distribution is shown in each view as a vertical green line. The sampled values used when running 
an uncertain calculation may differ from those shown on this graph because the number of 
samples and the value of the seed may not be the same.  

 

Figure 4-35 Tabulated uncertain parameters 

(1). A row of tabulated data can be deleted by clicking on the left margin of the row to 
select it and by pressing the delete key on the keyboard.  

(2). By pressing the ESC key on the keyboard, typing can be undone if the pencil icon is 
shown on the left margin of a row.  

(3). A row of data can be inserted by selecting an existing row and clicking the row insert 

button ( ).  

(4). By using the left or right arrow key on the keyboard, focus can be moved to an 
adjacent cell. The Enter key also advances the curser to the next cell. 

(5). The OK button can be clicked shown in Figure 4-34 or Figure 4-35 can be clicked to 
save changes and close the window. The value of the parameter in the parameter 
modification form is set to the character string "Uncertain" and has a different colored 
background than constant values on the form, as shown in Figure 4-36.  

(6). Changes can be discarded by selecting Cancel. 
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Figure 4-36 Uncertain parameter on a paraemter modification form 

To view the set of parameters that were sampled after running MACCS, the user can open the 
LHS.inp file by clicking the Files tab, open the Input category, and double-click on the file name 
LHS.inp.  The values used in the MACCS simulation can be viewed by examining the contents of 
the LHS.out file. 

 Changing Units 

WinMACCS allows the user to change units.  There are three different types of unit changes, 
namely input units on a parameter modification form, input units on forms defining cohort 
parameters, and output units used in MACCS reporting.  

Unit changes are integrated into other WinMACCS functions as follows: 

• The function that imports MACCS input files into the user interface (menu selection 
File/Import MACCS Input File) converts values to user specified units on each form. 

• The reset to default function (right click on form name and select Reset to Default) 
respects units chosen by the user and converts default values to specified units. 

• Uncertain parameter distributions must be changed by the user to be in the units 
specified on the form. In other words, when the units are changed on a form with an 
uncertain variable, the distribution is not automatically modified to be in the new units; 
the user is responsible to convert the distribution to the new units. 

• Parameter bounds reflect the units selected on the parameter modification form. 

• Map forms (Network Evacuation Direction, Network Evacuation Speed, and Populations 
Assigned) show values and units labels (km, mi, etc.) in specified units. 

 Modify the Input Units for Non-Cohort Variables 

The user can change input units for many of the input forms by using the Change Units button on 
a parameter modification form, as shown in Figure 4-37.  Each dimensioned parameter in 
WinMACCS is assigned to a unit family.  The user can change input units and convert existing 
values to the new input units that belong to the family assigned.  When there are no parameters 
on the form with units that can be changed, this button is grayed out. The Change Units button is 
always grayed out on the cohort specific forms since those units are changed on the Cohort Units 
form, as described below. 
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Figure 4-37 Changing units on a parameter form 

When building MACCS input files, input parameter values are converted to standard MACCS 
input parameter units, which are the same as the default units shown in Table 4-1.  Thus, MACCS 
input files retain their default units and input unit conversion is handled by WinMACCS. 

Table 4-1 Default and optional units for MACCS reporting. 

Unit Family Default Unit Optional Units 

Activity Bq Ci 

Distance km mi 

Area ha km2, mi2 

Dose Sv Rem 

 

 Modify the Input Units for Cohort Variables 

To avoid confusion, units are not allowed to be different between the sets of cohorts.  To enforce 
this requirement, there is one form used to specify units for all parameters associated with cohort 
definitions. This form is opened by clicking on the EARLY/Model Basis/Cohort Units entry as 
shown in Figure 4-38.  



 

4-38 

 

Figure 4-38 Assigning units for cohort parameters 

 Modify the Output Units for MACCS reporting 

The form shown in Figure 4-39 allows the user to request results to be reported in the optional 
units. This applies to both text and binary output files created by MACCS.  

 

Figure 4-39 Specifying MACCS reporting units 
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 Correlate Uncertain Parameters 

In many cases, sets of uncertain input parameters are correlated. 

WinMACCS allows two methods for correlating uncertain input variables.  The first uses rank 
correlations; the second method performs a direct rank reordering of one parameter and is 
described in Section 4.4.3.2. 

To correlate parameters that have been chosen to be uncertain, select Edit→Correlate Uncertain 
Variables→Linear Coefficients from the main menu.  This opens the Correlate Uncertain 
Variables form, which lists each rank correlation coefficient that is currently defined and allows 
new correlations to be defined.  

 Correlation Using LHS 

After LHS (the code, not necessarily the method) has run and imposed correlations specified by 
the user, WinMACCS can reorder some of the parameters to be consistent with the rank order of 
other variables. This is a desirable feature when it is desired to impose a perfect correlation (either 
in the same or inverse order) between two sets of variables. LHS does not support perfect 
correlation (i.e., values of -1 or +1 are not allowed).  

The command Edit→Correlate Uncertain Variables→Linear Coefficients opens the Correlate 
Uncertain Variables form as shown in Figure 4-40. 

 

Figure 4-40 Correlate uncertain variables 

Correlations can be added by doing the following: 

(1). By clicking in the grid element in the Parameter One column, an uncertain parameter 
can be selected. 

(2). By clicking in the grid element in the Parameter Two column, the uncertain 
parameter to correlate with Parameter One can be selected. 
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(3). The rank correlation coefficient for the two selected parameters is entered in the third 
column.  

Parameters can be positively or negatively correlated by specifying a correlation coefficient within 
the range (-1.0, +1.0), where the values -1.0 and 1.0 are not allowed.  The correlations apply to 
the ranks of the parameter values rather than to the values themselves.  

When any two parameters are uncorrelated, they have an implied correlation coefficient of zero, 
which is the default. Implied correlation coefficients are not listed in the table.  Correlations can 
be removed (i.e., set to zero) by selecting the grid row and pressing the delete key on the 
keyboard.  

By using the arrow keys on the keyboard, focus moves from cell to cell in the grid.  

Clicking OK preserves changes. Clicking Cancel discards changes.  

WinMACCS creates a report titled SampleRank.out in the project Input/ folder that summarizes 
the correlations and the order and values of the uncertain parameters used in the MACCS 
simulations. 

There are some restrictions on the correlations that WinMACCS allows.  For example, it doesn’t 
make sense to rank correlate two variables, say A and B, with a coefficient, and impose a rank 
order of B with respect to the order of A. WinMACCS does not allow the same pair of parameters 
to be rank correlated (as described in Section 4.4.3.2) and also to be reordered. 

It is possible to specify combinations of rank correlations that are not mutually consistent.  Such 
inconsistencies are generally in the form of circular correlations. For example, two parameters "A" 
and "B" can be assigned a correlation coefficient of 0.99, parameters "B" and "C" can also be 
given a correlation coefficient of 0.99, but parameters "A" and "C" can be assigned a correlation 
of -0.99. Each correlation is valid by itself, but the three are logically incompatible.  Omitting any 
correlation between parameters “A” and “C” implies a correlation coefficient of zero, which is also 
incompatible with the other two correlations.  The parameter sampling in LHS may fail when 
circular correlations are incompatibly defined. 

This option does not accommodate perfect correlation of two parameters.  The command Edit→ 
Correlate Uncertain Variables→ Enforce Rank Order, described in the following subsection, 
enforces a perfect correlation between two or more parameters.  

 Enforcing Rank Order 

Selecting Edit→Correlate Uncertain Variables→Enforce Rank Order from the main menu allows 
ordering parameters that have been chosen to be uncertain.  This opens the Enforce Rank Order 
of Uncertain Variables form shown in Figure 4-41, which lists each rank correlation that is currently 
defined and allows new correlations to be defined.  

Rank orders are specified as follows: 

(1). The Enforce Rank Order of Uncertain Variables form is opened by selecting 
Edit→Correlate Uncertain Variables→Enforce Rank Order. 

(2). In the column labeled Reorder Basis, the user selects the first uncertain variable. 
The vector of values for this parameter is not reordered. 
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(3). In the column labeled Reorder Parameter, the user selects the uncertain parameter 
to be reordered. 

(4). In the column labeled Rank Order the user selects either Inverse Order to order the 
parameter in the inverse order of the basis parameter or Same Order to order the 
parameter in the same order as the basis parameter.  

(5). As many entries as needed may be added to the table. 

(6). Clicking OK preserves changes. Clicking Cancel discards changes. 

Rows can be deleted by selecting the grid row and pressing the delete key on the keyboard.  The 
arrow keys can be used to move from cell to cell in the table.  

 

Figure 4-41 Enforce Rank Order form 

In the example shown in Figure 4-42, a perfect positive correlation is imposed between ATMOS 
parameters BUILDH(1) and SIGZINIT(1), and a perfect negative correlation is imposed between 
COMIDA2 parameters DAIRY_RATE(1) and DAIRY_RATE(3).  This causes the values of 
DAIRY_RATE(3) and SIGZINIT(1) to be reordered.  

After execution, LHS.out can be opened by double clicking the entry LHS.out found on the Files 
Tab in the Input category. Sample values from LHS.out are shown in Table 4-2. 
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Figure 4-42 Enforce Rank Order example 

Table 4-2 Sample values LHS output file. 

Trial No. BUILDH(1) DAIRY_RATE(1) SIGZINIT(1) DAIRY_RATE(3) 

1 249.675 5.81245 295.12 9.16814 

2 123.061 10.1165 281.956 10.3411 

3 180.287 15.7363 338.324 12.1482 

4 214.842 21.8037 267.811 13.5931 

5 188.622 19.2878 312.628 5.65193 

 

The actual order used in the sequence of MACCS simulations is shown in SampleRank.out, which 
is found in the project Input folder. In this example, the rank order is shown in Table 4-3. 

Table 4-3 Sample values after enforcement of rank order prescribed in Figure 4-42. 

 Value Rank Value Rank Value Rank Value Rank 

Trial No. BUILDH(1) DAIRY_RATE(1) SIGZINIT(1) DAIRY_RATE(3) 

1 249.675 5 5.81245 1 338.324 5 13.5931 5 

2 123.061 1 10.1165 2 267.811 1 12.1482 4 

3 180.287 2 15.7363 3 281.956 2 10.3411 3 

4 214.842 4 21.8037 5 312.628 4 5.65193 1 

5 188.622 3 19.2878 4 295.12 3 9.16814 2 

 

This table lists the values used in each MACCS simulation.  For example, for trial number 3 
(corresponding to the output file Model3.out), BUILDH(1) is set to 180.287 and SIGZINIT(1) is set 
to 281.956. 

Notice that values of BUILDH(1) and DAIRY_RATE(1) are preserved from the order listed in the 
LHS output. However, values for SIGZINIT(1) and DAIRY_RATE(3) have been reordered so that 
the rank order for SIGZINIT(1) is the same as that of BUILDH(1), and the rank order of 
DAIRY_RATE(3) is the inverse of that for DAIRY_RATE(1). 

WinMACCS creates a report titled SampleRank.out in the project Input/ folder that summarizes 
the correlations and provides the order and values of the uncertain parameters used in the 
MACCS simulations. 
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 Copy Values between Cohorts 

Cohort forms are forms that are in the EARLY/Emergency Cohort One and EARLY/Additional 
Emergency Cohorts categories. Copying form data from one cohort form to another cohort form 
can be accomplished by right clicking on the form within a cohort category and selecting the popup 
menu item Copy Cohort Variables or by using the main menu function Edit→Modify Form 
Variables→Copy Cohort Variables.  A dialog box opens as shown in Figure 4-43. 

 

Figure 4-43 Copy values from one cohort form to other cohort forms 

In the following example, the user wants to copy all the values in the Network Evacuation Direction 
from cohort two to cohort five and cohort six.  

(1). The user first closes forms Emergency Cohort Two/Network Evacuation Direction, 
Emergency Cohort Two/Network Evacuation Direction and Emergency Cohort 
Two/Network Evacuation Direction.  

(2). The user clicks on the form name Network Evacuation Direction under the category 
Emergency Cohort Two, highlighting the form name as shown in Figure 4-44. 
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Figure 4-44 Select network evacuation direction form 

The user right clicks on Network Evacuation Direction and selects the pop-up menu item Copy 
Cohort Variables. Alternatively, Edit→Modify Form Variables→Copy Cohort Variables can be 
selected from the main menu as shown in Figure 4-43.  Checking the boxes labeled Cohort 5 and 
Cohort 6 and clicking OK replicates the data for this form into the cohort 5 and cohort 6 forms. 

 

Figure 4-45 Copy form values between evacuation cohorts 

(1). When an empty form is selected as the form to copy from (or base form), no data are 
replaced on the forms selected for application. 

(2). When the base form is open and this option is used, the saved values of the 
parameters are used in the copy. In other words, when the base form is opened and 
values are changed, when selecting Edit->Modify Form Variables->Copy Cohort 
Variables the values that are copied are the values saved the last time the form’s OK 
button was clicked, not the new values just entered. 

Comments on forms are not copied or propagated. 
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 Annual Dose Conversion Factor and Annual COMIDA2 Files 

When the AT or Piecewise Linear dose-response models are chosen on the Dose tab of the 
Project Properties form, a set of fifty-one DCF files are needed by MACCS.  Additionally, when 
either of these dose-response models is chosen and the COMIDA2 Food Model is chosen on the 
Food tab, a set of fifty-one COMIDA2 files are needed by MACCS, each COMIDA2 file having 
been created with its associated DOSFAC2 file. 

WinMACCS is distributed with files sets to be used with the AT or PL dose-response models.  The 
first set is based on DOE/EH-0070 (1988); the second is based on EPA (2002) Federal Guidance 
Report No.13. 

The base DCF file is one that contains the conversion factors for a fifty-year commitment period. 
The base COMIDA2 file is created using the base DCF file.  

The annual, differential DCF files contain the DCFs for each year of the 50-year commitment 
period. These file names are sequenced to enable the identification of the year number. For 
example, FGR13DCF03.inp corresponds to the DCFs used to calculate the dose in year three for 
an exposure that occurred in year one.  The annual COMIDA2 files are created using the 
corresponding annual DCF files. 

The following example shows how an annual differential DCF and COMIDA2 file set can be 
specified:  

(1). Opening the GENERAL/File Specifications/Annual Differential DCF Files form allows 
the specification of the DCF files as shown in Figure 4-46. 

(2). Opening the folder where the DCF are files are located updates the column labeled 
Click Base DCF File. This is done by selecting the correct hard drive in the Select 
Drive pull down menu and locating the folder on the form. When WinMACCS is 
installed, a copy of the DCF and COMIDA2 files are put in the Program 
Files\WinMACCS folder.  

(3). Selecting the base DCF file in the box directly under the title Click Base DCF File 
results in the fields Base DCF File and Expected Auxiliary Files to be populated. In 
the example shown in Figure 4-46, the name of the base file is FGR13DCF.inp. The 
base file name is copied in the box labeled Base DCF File. Other file names are 
generated given this base file following the algorithm of appending the year number 
to the file name. WinMACCS expects these additional files to be present in the 
current folder. 

(4). OK can be clicked to save the changes. WinMACCS copies the base DCF file and 
the fifty auxiliary files to the project\Data folder. Click Cancel to close this form 
without saving any changes. 

(5). Open the GENERAL/File Specifications/Annual Differential COMIDA2 Files form and 
repeat this process to define the COMIDA2 file set when needed 
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Figure 4-46 Threshold DCF files 

 Sequential MACCS Files 

MACCS input can be changed using successive input files.  A single MACCS simulation is run for 
each of the files specified.  

The sequential, or cyclical, files must be formatted consistently as MACCS input files.  However, 
the ATMOS, EARLY, CHRONC, and COMIDA2 input for a single simulation can be combined 
into a single file.  

The parameter values specified in each of the cyclical files are used for a simulation.  When a 
required parameter is not specified, the value of that parameter in the WinMACCS project is used. 

Before executing a set of cyclical files, a complete problem description must be defined. 
Parameter values in the cyclical files override the parameters defined in WinMACCS.  Thus, the 
cyclical files do not need to contain a complete problem description, but only the set of parameters 
to be modified. 

An example of a cyclical file with a source term definition is a MelMACCS output file. 

 Specifying Cyclical MACCS Files 

MACCS cyclical input files can be specified as follows: 
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• The MACCS Cyclical File Set model can be selected by opening the Properties 
form, checking the box MACCS Cyclical File Set on the Scope tab, and clicking 
OK. 

• The GENERAL/File Specifications/Cyclical File Set form is opened, similar to the form 
shown in Figure 4-47. 

• The location of the MACCS cyclical files should be located by selecting the correct drive 
and folder. 

• Double-clicking on the MACCS cyclical file names adds them to the list on the right side 
of the window. 

• Clicking OK saves the file selection. The files are copied to the project Data\ folder. 
Clicking Cancel closes the window without copying any files. 

 

Figure 4-47 Choose input files for cyclical execution 

A file can be removed from the cyclical set by selecting the file in the list on the right side of the 

form, as shown in Figure 4-47, and pressing the Delete key on the keyboard. 

The order of processing the files by WinMACCS can be changed by selecting the file in the list of 
cyclical files and using the up and down arrow to change the order the selected file is listed.  When 
MACCS executes, the files are used in the order they appear on this form. 



 

4-48 

An interface tool named MELMACCS can be used to create MACCS-formatted files that contain 
source term information extracted from a MELCOR plot file.  These files can be specified as 
cyclical files. In this way, a set of source terms for a plant can be run sequentially.  

 Cyclical Execution with Uncertain Parameters 

It is possible to perform calculations with a cyclical file set and to sample uncertain parameters 
using LHS simultaneously.  When this is done, the number of simulations should be set to a 
multiple of the number of cyclical files.  The values from the cyclical files are reused when the 
number of simulations is greater than the number of cyclical files. 

For example, when six simulations are requested, but there are three cyclical files, simulation one 
and four use the values from the first file, two and five the values from the second file and three 
and six the values from the last file.  LHS generates six sampled value sets and inserts these 
values into the MACCS input files as expected. 

 Spatial Grid Forms 

Spatial grid forms are applicable in the following situations: 

• Evacuation directions are required when network evacuation is enabled.  

• When the speed multiplier option has been activated on the Properties form, speed 
multipliers per grid element (i.e., for each direction and spatial distance) can be specified 
for either the radial or network evacuation models, depending on which option is 
selected. 

• When population by cohort is specified, populations per grid element can be specified. 
This option is activated on the Properties form on the Site Data tab. 

All spatial grid forms contain the following functions 

• A copy of a map with the directions and speed multipliers as is shown in the spatial grid 
form can be created by clicking on the Save Map button as shown in Figure 4-57. 

• The map shown behind the polar grid can be hidden by checking the Hide Map check 
box. 

• Comments can be entered at the top of the form. 

• The inner ring and outer ring controls allow zooming in and out. 

• Multiple radii and sectors can be selected using the Windows shift-select and control-
select functions. The selected grid elements can be assigned a common value. 

 Evacuation and Speed Multiplier Model 

Radial and network evacuation and speed multiplier model parameters are defined using spatial 
grid forms.  
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These models can be enabled as follows: 

(1). By selecting Edit→Project Properties from the main menu, the Project Properties 
form can be opened. 

(2). Clicking on the Evac/Rotation tab as shown in Figure 4-48 allows the user to select 
Radial or Network for the problem model. 

(3). The evacuation type needs to be defined for each of the cohorts. 

(4). When speeds vary within the evacuation grid elements for either the network or the 
radial evacuation models, check the box Activate Speed Multiplier Model.  

(5). Clicking OK saves the settings, clicking Cancel cancels the settings. 

When the Network evacuation is selected, the Network Evacuation Direction form is required for 
cohort one. When the Activate Speed Multiplier Model is checked, either the Radial Evacuation 
Speed or the Network Evacuation Speed form is required for cohort one.  

 

Figure 4-48 Activate speed multiplier model 

The parameters SPAEND, as shown in Figure 4-49, and LASMOV, as shown in Figure 4-50, must 
be defined before the Network Evacuation Direction forms, Radial Evacuation Speed or the 
Network Evacuation Speed forms can be successfully opened.  These two parameters are 
needed to define the evacuation grid. As a side effect, NUMEVA must also be defined because it 
is on the same form as LASMOV. 
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Figure 4-49 ATMOS radial grid, SPAEND 

 

Figure 4-50 Evacuation boundary, LASMOV 

The Network Evacuation Direction form and the Evacuation Speed form are similar.  The 
navigation of the forms is the same; however, the navigation of the forms with respect to specifying 
the direction or speed parameters is different.  
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 Population by Cohort  

Populations are assigned to grid elements using a spatial grid form, EARLY/Population by 
Cohort/Populations Assigned. 

To enable the specification of the population fraction by cohort, the Results Weighting Factor is 
set to SUMPOP in the Project Properties form as shown in Figure 4-51.  This form is opened by 
selecting Edit/Project Properties from the main menu.  

Site data files that are not used with the SUMPOP option contain one array of population data, 
specifying the population for each grid element. When using SUMPOP, there is an array of 
population data for each cohort.  The populations used per cohort are defined in forms found in 
the Project Parameters tab category EARLY/Population by Cohort.  The SecPop software is used 
to create the site data file, defining the populations to be consistent with Census data and the 
spatial grid. 

 

Figure 4-51 SUMPOP option on Project Properties form 
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An existing site file is specified to use as a basis for the new site file that supports the SUMPOP 
option.  This site file can be one that has multiple cohorts defined (e.g., already supports 
SUMPOP), or it can be a site file with a single cohort defined. 

A variable, Population, is defined when the site file is defined on the General/File 
Specifications/Site File form.  This parameter contains the population array corresponding to the 
grid population in the existing site file.  When the site file specified has multiple population arrays, 
Population is the array containing the sum of the population over all evacuation cohorts on the 
site file. 

Though this parameter is defined on the Site File form, the EARLY/Model Basis/Population from 
Site File form must be opened to view this array as shown in Figure 4-52. It is not possible to 
change any values of the Population on this form.  To change the Population values, a new site 
file must be specified on the Site File form.  This parameter is defined whenever the site file is 
updated. 

 

Figure 4-52 Population from Site File form 

To support assigning portions of the population to different evacuation cohorts for a given spatial 
grid element, population distribution was introduced into the model.  A population distribution is 
associated with a spatial grid element and defines the portion of each evacuation cohort that 
belongs to that grid element. For example, when there were two cohorts defined, a population 
distribution of (.6, .4) assigned to a spatial grid element would mean that 60% of the population 
exhibits cohort one evacuation behavior, and 40% belong to cohort two.  
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Opening the form EARLY/Population by Cohort/Distributions allows the user to define the various 
population distributions. There can be up to ninety distributions defined.  The example shown in 
Figure 4-53 shows four cohorts that are differentiated by the delay to evacuate.  To aid in 
envisioning this problem, consider cohort one to be associated with the general population 
behavior, cohort two the behavior of special needs people, cohort three the behavior of children 
in schools, and cohort four does not evacuate. 

 

Figure 4-53 Population distributions over cohorts 

To aid the user in assigning populations to spatial areas, the EARLY/Population by Cohort 
/Population Labels form, shown in Figure 4-54, allows a symbol and a label to be assigned to 
each of the population distributions.  In this example, Population 2 is assigned to a spatial area 
that contains a school.  The analyst has determined that 99.9% of the population in this area is in 
cohort 3, and .1% is in cohort 4.  The fractional cohort for each of the populations must sum to 
one. 
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Figure 4-54 Population distribution labels 

Lastly, a population distribution must be assigned to each spatial element.  Open the form 
EARLY/Population by Cohort/Populations Assigned to assign distributions to grid elements. 

 Creating Road Maps 

Radial distances vary from zero to the upper bound of SPAEND. Grid elements are numbered 
with 1 for north, 5 for east, etc., when the grid is divided into sixteen equal angles.  Each value of 
SPAEND is represented as a concentric circle. 

When a new project is created, the Network Evacuation Direction forms and the Evacuation 
Speed forms do not show a road map behind the polar grid.  Evacuation directions are initially set 
to be radially outward, as shown in Figure 4-55, and the speed multiplier is set to one. 

The number or letter drawn at the center of each of the grid elements indicates the associated 
speed multiplier rank.  This is different than the value of the speed multiplier.  If, for example, the 
speed multipliers are either .5 or 1.5, there are two possibilities for the multiplier rank, namely 1 
corresponding to a speed multiplier of .5 and 2 corresponding to a speed multiplier of 1.5. 
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Figure 4-55 Initial state of evacuation grid 

Road maps can be easily created to display behind the grid by using MapGen, a custom 
application that uses Microsoft MapPoint, by clicking the Create Map File button in any of the 
spatial grid forms in WinMACCS. When this is done, a file named MapSummary.txt is created and 
placed in the project Input\ folder. 

The file, MapSummary.txt is subsequently read by MapGen to create the road maps. MapGen is 
implemented as a separate application because of licensing issues. No license outside of the 
NRC licensing requirements is required for MACCS. However, the map interface program, 
MapGen, requires that the Microsoft Map Point 2006 libraries be installed. Thus, to enable the 
use of maps in the MACCS, Microsoft Map Point 2006 must be purchased and installed.  

WARNING:  When the Spatial Grid is modified, a consistent set of road maps must be 
regenerated. 

Background map files can be created as follows: 

(1). Opening the form ATMOS/Weather/Site Location by double-clicking on this entry in 
the Parameters tab of the Project window allows the user to enter the latitude and 
longitude of the site. This form is shown in Figure 4-56.  This form may not be 
flagged as a required data entry form for the MACCS models selected (i.e., the icon 
may have a slash through it), but to generate a set of road maps, it is necessary to 
enter the latitude and longitude of the site. 
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Figure 4-56 Enter latitude and longitude 

(2). In any form that shows the polar evacuation grid, selecting Create Map File as 
shown Figure 4-57 causes a file titled MapSummary.txt to be created and placed into 
the WinMACCS project Input folder.  

 

Figure 4-57 Create map file 

Within the Files Tab in the Project window, this file can be optionally viewed by double-clicking on 
the entry Input/MapSummary.txt.  

A sample map interface file is as follows: 

* File created using WinMaccs Version 3.10.0 SVN:2560 7/15/2015 4:52:15 PM 

* Latitude and Longitude as a decimal 

/LAT 40.17194  

/LON -88.83417  

* File Name to create, Distance in km from lat, long to edge of square map 
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/DAT Map_0.16.gif 0.1704918  

/DAT Map_0.52.gif 0.5540984  

/DAT Map_1.21.gif 1.289344  

/DAT Map_1.61.gif 1.715574  

/DAT Map_2.13.gif 2.269672  

/DAT Map_3.22.gif 3.431148  

/DAT Map_4.02.gif 4.283607  

/DAT Map_4.83.gif 5.146721  

/DAT Map_5.63.gif 5.99918  

/DAT Map_8.05.gif 8.577869  

/DAT Map_11.27.gif 12.00902  

/DAT Map_16.09.gif 17.14508  

/DAT Map_20.92.gif 22.2918  

/DAT Map_25.75.gif 27.43852  

/DAT Map_32.19.gif 34.30082 

Notice each line of the file that starts with the character string “/DAT”. Each /DAT lines directs 
MapGen to create a gif file.  

Example: 

/DAT Map_0.16.gif 0.1704918  

Two parameters are shown per input line.  The first is the name of the image file that is created 
by MapGen (e.g., Map_0.16.gif).  The second parameter is the distance in km from the center of 
the map to the edge of the map as displayed in the WinMACCS interface.  This input line 
corresponds to the spatial grid element 0.16 km.  

WinMACCS creates a line in the file for each value of SPAEND, the spatial grid distance.  The 
value of SPAEND is built into the name of the GIF file.  This ensures that an incorrect map is not 
shown behind the evacuation grid when the spatial grid entries are modified (SPAEND is changed 
in WinMACCS).  

The second number is a measure in km from the center of the map to the outer edge calculated 
in WinMACCS to allow the map to fit to the edge of the form.  

This process assumes that all maps are square. 

(1). MapGen can be started from the MapGen group found on the Windows Start Menu. 

(2). From the main MapGen menu as shown in Figure 4-58, selecting File→Generate Gif 
from File allows the user to select the file MapSummary.txt file created in the 
previous step as shown in Figure 4-59. Clicking on Open completes this form.  

(3). WinMACCS expects the map files to be located in the project Data folder. Choosing 
the Data folder for the gif file destination as shown in Figure 4-60 enables 
WinMACCS to find the map files. Clicking OK causes the maps to be generated. 
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Figure 4-58 Generate road map files 

 

Figure 4-59 Open map summary.txt 

 

Figure 4-60 Complete creation of road maps 

(4). Opening a form that shows the polar evacuation grid, for example, Radial Evacuation 
Speed, the user can observe the map updating when changing the Outer Ring 
Shown slider as shown in Figure 4-66.  The maps are displayed behind the spatial 
grid.  When the maps do not display, verifying that the Hide Map check box is 
unchecked, that the map .gif files are in the project Data folder, and that the spatial 
grid values are in agreement with the names assigned to the map .gif files should fix 
the problem. For example, Map_1609.34.gif corresponds to 1609.34 km.  This is the 
map that is displayed when the outer ring in the polar grid is at 1609.34 km. This 
corresponds to an entry in array SPAEND. 
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The Outer Ring Shown slider must be clicked to refresh the background the first time the maps 
are created.  

The roadmap can be displayed in MapGen by entering the latitude and longitude in decimal form 
and the distance from the center to the left edge as shown in Figure 4-61. These numbers can be 
read from the file MapSummary.txt as shown in the following example: 

/LAT 40.17194  

/LON -88.83417  

/DAT Map_1.21.gif 1.289344 

 

Figure 4-61 MapGen interface 

The coordinates of each of the maps centers has a latitude of 40.17194 and a longitude of -
88.83417.  The line labeled /DAT instructs MapGen to create a map file named Map_1.21.gif, 
representing an outer radius of 1.21 km.  This same line specifies that the distance from the center 
to the edge of the map is 1.289344 km. 

Entering the latitude, longitude and the distance from the center to the edge in MapGen as shown 
in Figure 4-61 and clicking the button labeled Go generates the desired map manually. The actual 
distance from the center to the edge can be verified by clicking the edge of the map in MapGen. 
This is the shortest distance from the center to the edge as calculated by MapPoint, the underlying 
Microsoft map engine.  
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The MapPoint interface internally requires that a viewing altitude be specified. It was determined 
that the viewing angle of 30.64353 degrees creates consistent maps except for very high altitudes. 
However, this does not appear to be a problem at distances less than 2000 km.  

MapGen is designed to be consistent with MapPoint 2006.  Future versions of MapPoint could 
use a different algorithm or viewing altitude formula, and so could produce unexpected results 
when used with MapGen. 

 Assigning Values to Grid Elements 

The Network Evacuation Direction form is used as an example, shown in Figure 4-66. The same 
techniques used to assign values to grid elements in the Network Evacuation Direction form is 
used for the Populations Assigned and the Radial and Network Evacuation Speed forms. The 
only difference between these forms is the possible values the grid elements can have.  In the 
example of the Network Evacuation Direction form, the values can be set to In, Out, Right or Left. 
In the case of the Populations Assigned and the Radial and Network Evacuation Speed forms, 
the values are set to user defined populations or user defined speed multipliers respectively. 

Understanding the Spatial Grid 

Spatial grids are used to enter speed multiplier data for radial and network evacuations, and 
evacuation directions in the case of the network evacuation option.  An example of this form is 
shown in Figure 4-66.  

Arrows drawn on the grid elements indicate the evacuation direction as shown in Figure 4-62. 
There are four different directions supported by MACCS, outward, inward, counterclockwise and 
clockwise. Each of these directions is shown in a different color. 

 

Figure 4-62 Evacuation grid 
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On the Radial Evacuation Speed form, all arrows are red and pointed outward as shown in Figure 
4-55. 

To the right of the map the inner and outer ring displayed on the polar grid are indicated as shown 
Figure 4-66.  The integer value shown to the left of the sliders labeled Inner Ring Shown and 
Outer Ring Shown correspond to the first column labeled Ring as shown in Figure 4-63.  In the 
example shown in Figure 4-64, the Inner Ring Shown is set to 2, corresponding to SPAEND(2) 
which is equal to 0.52. The Outer Ring Shown is set to 3, corresponding to SPAEND(3) which is 
equal to 1.21.  

 

Figure 4-63 Radius, sector and multiplier 

 

Figure 4-64 Inner ring and outer ring sliders 

The symbols shown in column four labeled Rank as shown in Figure 4-63 indicate the speed 
multiplier rank. These values are different than the actual speed multiplier. In this example, the 
number 1 corresponds to a multiplier of 0.5, 2 to a multiplier of 1, and 3 to a multiplier of 1.2 as 
shown in column five, Speed Multiplier. By showing ranks, the speed multipliers can be adjusted 
without requiring the user to adjust the settings on the polar grid. 

When the grid is clicked, the radial distance from the center of the grid to the click is shown on 
the bottom left portion of the form, as shown in Figure 4-65. This is useful for diagnostic reasons. 
Once a map is displayed behind the grid, the scale can be checked when there is a reason to 
believe that the polar scales and the map scales are inconsistent. The number shown in 
WinMACCS corresponds to the scale of the polar coordinate system. From the viewpoint of 
WinMACCS, the roadmap is simply a picture file. 

Clicking OK preserves changes. Clicking Cancel discards changes. 
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Figure 4-65 Radial click distance 

Assigning Values to the Network Evacuation Direction Form 

 

Figure 4-66 Network evacuation direction 

The evacuation direction can be modified in two ways.  

The first method is to click the grid element on the map.  The direction changes for that grid 
element each time the area is clicked. The direction rotates ninety degrees clockwise each time 
the grid element is clicked.  

When a grid element is clicked, the clicked element is selected in the Radius/Sector list.  In the 
example shown in Figure 4-67, the grid element between 3.22 km and 4.02 km in the fourth sector 
is selected.  Sector 4 corresponds to ENE in a grid that has been divided into 16 sectors. 
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Figure 4-67 Radius and sector selected 

The second method is to use the Assign button. 

Clicking the UnSelect button clears the selection of the radius and sector.  

Selecting a radius and a direction from the list and clicking the Assign button changes the direction 
for all grid elements at the selected radius. 

Similarly, selecting a sector and a direction but no radius as shown in Figure 4-68 and clicking 
the Assign button changes the direction for all grid elements in the selected sector. 

 

Figure 4-68 Select sector only 

Assigning Values to the Radial or Network Speed Multiplier Form 

The speed multiplier ranks can be modified in two ways. 

The first method is to click the grid element on the map.  The rank is incremented by one each 
time that grid element is clicked.  For example, clicking a grid element with an initial rank of four 
results in a rank of five assigned when five or more ranks are defined; otherwise, the rank cycles 
from four back to one.  

When a grid element is clicked, the clicked element is selected in the radius and sector lists. 

The second method is to use Assign button.  This method is the preferred way to change all the 
speed multipliers for a given radius or a given sector.  This can be done as follows: 
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(1). Clicking the UnSelect button clears the selection of the radius and sector.  

(2). Selecting a radius and a direction from the list and clicking the Assign button 
changes the speed multiplier for all grid elements at the selected radius. 

(3). Selecting a sector and a direction but no radius and clicking the Assign button 
changes the speed multiplier for all grid elements in the selected sector. 

(4). Selecting a radius, a sector, and a speed multiplier rank and clicking Assign only 
changes the rank of the selected grid element. 

In the example shown in Figure 4-69, the speed multiplier rank for the grid elements between 0.52 
and 1.21 in sector two is changed to 2 when Assign is clicked. 

 

Figure 4-69 Select speed multiplier 

Assigning Values to the Populations Assigned Form 

A graphical window similar to the Network Evacuation Direction and Network Evacuation Speed 
windows used to assign populations to grid elements is shown in Figure 4-70.  However, instead 
of assigning evacuation directions or evacuation speeds to the grid sectors, population 
distributions are assigned.  
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Figure 4-70 Selecting populations assigned to cohorts 

On the right side of this window there is a list titled Population.  In the example shown in  

Figure 4-70, three symbols are listed, namely N, S and G.  These symbols correspond to the 
distributions and distribution labels assigned on the forms EARLY/Population by 
Cohort/Populations and EARLY/Population by Cohort /Population Labels. A bar chart of the 
population distribution selected is shown below the radii, sector and population lists. 

A population distribution can be assigned to a sector by clicking the distribution symbol and 
clicking the sector on the map. For example, the sector (11.27, 10) is assigned the distribution N.  
This was accomplished by clicking on the N in the population list and clicking on the grid element 
on the map.  

A population can be assigned to all of the grid elements in a radius by clicking the UnSelect button 
to remove the highlighted list elements, clicking the radius of interest in the list labeled Radius, 
clicking the population in the list labeled Population, and clicking the Assign button.  Similarly, a 
population can be assigned to all grid elements in each sector by following this same procedure, 
but instead of clicking on a radius, the user should click on the sector of interest in the list labeled 
Sector. 

It can be convenient to predefine all grid elements to a population by clicking the UnSelect button, 
clicking a distribution in the Population list, and clicking the Assign button.  This can be followed 
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by manually setting less-common populations by one of the other methods described.  Clicking 
OK when completed saves the changes.  

When the MACCS simulation has finished, the site file used in the simulation, Sumpop_site.inp, 
can be viewed. This file is found in the project Input folder.  This site file, created by WinMACCS 
and used by MACCS, contains a population array for each of the evacuation cohorts.  

The population for a grid element for a single evacuation cohort is calculated by considering the 
population fraction for that grid element. For the cohort of interest, the population fraction 
associated with the evacuation cohort is multiplied by the total population for that grid element. 
Recall the total population for each of the sectors can be viewed on the EARLY/Model 
Basis/Population from Site File form. 

The population values per cohort can be viewed on the EARLY/Emergency Cohort 
One/Population, EARLY/Additional Emergency Cohorts/Emergency Cohort Two 
(etc.)/Population, … forms. Fractional populations are supported. 

 Editing the Speed Multiplier List 

The same basic form used to assign speed multipliers to grid elements is also used to specify 
evacuation directions and population assignments as shown in Figure 4-66.  The Modify 
Multipliers button is not available on the Network Evacuation Direction forms but is available on 
the Radial Evacuation Speed and Network Evacuation Speed forms. 

A speed multiplier for each grid element is used to adjust the speeds assigned for ESPEED found 
on the Evacuee Travel Speed form for each emergency cohort. A value of one for the multiplier 
indicates that the speed in that grid element is the same as ESPEED. 

The default value for the speed rank and the speed multiplier is one.  Additional speed multipliers 
can be added by clicking the Modify Multipliers button in the Radial Evacuation Speed or the 
Network Evacuation Speed form as shown in Figure 4-71.  

 

Figure 4-71 Modify multipliers 

A dialog box like the one in Figure 4-72 opens. 
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Figure 4-72 Edit speed multipliers 

Speed multipliers can be added to the list by entering a number in the text box followed by 
pressing Enter on the keyboard or clicking the arrow button on the form.  

Multipliers can be deleted by selecting a multiplier from the Speed Multiplier list and clicking the 
delete button as shown in Figure 4-73. 

 

Figure 4-73 Delete speed multiplier button 

Multipliers are automatically sorted in ascending order.  Multiple entries of the same number are 
not allowed. 

Clicking OK preserves changes. Clicking Cancel discards changes. 

Ranks shown on the spatial grid may be modified by WinMACCS when the multipliers are 
modified. For example, the default speed multiplier value is a single rank of one corresponded to 
a speed multiplier set to one. In this example, a multiplier of 0.5 is added using the Edit Speed 
Multipliers dialog box resulting in two multipliers, namely 0.5 and 1.0 with respective ranks one 
and two. After this dialog box is closed, the rank of one now corresponds to a speed multiplier of 
0.5. The polar grid is updated to show the rank of two to correspond to a speed multiplier of one 
as shown in Figure 4-74. 
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Figure 4-74 Speed multiplier ranks 

Uncertain speed multipliers are not supported in WinMACCS. 

 

Figure 4-75 Selecting a speed multiplier 

 Specifying a Site File 

Files are generally specified in a general parameter modification form.  However, the site file is 
specified in a custom form. 

The site file is usually created using an external software source, such as SecPop. When SecPop 
4.0 or later is used, it is possible to choose 16, 32, 48 or 64 compass directions (or sectors). Older 
versions of SecPop such as SECPOP2000 support only 16 compass directions.  For compatibility 
with MACCS models that require more compass directions, WinMACCS can create a site file that 
supports 32, 48 or 64 sectors from a site file that supports 16 sectors. 
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Double clicking on the GENERAL/File Specifications/Site File opens a form like the form shown 
in Figure 4-76. 

A label titled Angular Directions shows the actual number of angular directions written to the site 
file shown in the text box labeled Site File. 

Click Browse to choose a site file. After choosing a site file, the field Angular Directions is updated 
to reflect the number of sectors defined on the file.  

NUMCOR, the number of sectors in the spatial grid, is shown as a pull-down menu. It can’t be 
modified in this form but can be modified in the ATMOS/Spatial Grid form.  

 

Figure 4-76 Specify site population file 

Click Create New to create a new site file with more angular resolution. A dialog as shown in 
Figure 4-77 opens. 

 

Figure 4-77 Create site file from existing site file 

A new site file with more angular directions can be created from an existing site file as follows: 

(1). Clicking Browse…, as shown in Figure 4-77, the user can choose a site file that has 
a smaller angular resolution than the file needed.  

(2). The angular resolution can be selected from the pull-down menu labeled Possible 
angular resolutions available.  
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(3). Clicking OK preserves changes and causes a new site file to be created. An external 
software program, PopMod, has been integrated into WinMACCS to create the new 
file. Clicking Cancel discards changes and the new file is not created.  

(4). The new file created is assigned a file name that contains the number of new angles 
appended to the file name. In our example, the source file is Clinton_Site.inp. The 
new file created with 48 sectors is Clinton_Site_48.inp. No new population data was 
added to the file. The existing population data was spread out into the new sectors. 

(5). Clicking OK preserves changes as shown in Figure 4-76. Clicking Cancel closes this 
form and discards changes. 

 User Specified Dose Conversion Factors in WinMACCS 

Normally, a single DCF file is used to specify the dose coefficients.  These files have been created 
in the past using a process independent from WinMACCS, such as running the program 
DOSFAC2 to create this file or using a DCF file supplied with the WinMACCS installation such as 
one based on FGR-13. 

Default values for the DCFs are determined by a predefined DCF file chosen within the 
WinMACCS user interface. After this file is specified, it is possible to replace DCF values by 
constants or probability distributions.  This capability has been integrated into WinMACCS.  This 
allows these values to be correlated against any other parameters that have been assigned 
uncertain values, including other dose uncertain DCFs. 

The COMIDA2 Food Model is not currently integrated into the user specified DCF option. 

 Project Properties Settings 

The Project Properties form can be opened by selecting Edit/Project Properties from the main 
menu. 

The user specified DCF model can be defined on the Properties form as follows: 

(1). By selecting Early Consequences or Late Consequences on the Scope tab the user 
specified DCF model is available. 

(2). Selecting Create DCF File on the Dose tab chooses this model, as shown in Figure 
4-78. 

(3). When Late Consequences is selected on the Scope tab, the user must select the 
Food model on the Food tab as shown in Figure 4-79.  Either the No Food or the 
MACCS Food Model must be selected.  The COMIDA2 Food Model is available for 
selection but does not properly function with the Create DCF File selection. 

(4). Clicking OK preserves changes. 
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Figure 4-78 Project Properties Dose tab 
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Figure 4-79 Project Properties Food tab 

 Specify a Basis Dose Conversion Factor File 

WinMACCS requires a preexisting DCF file to use for default values.  This is specified on the 
same form used for specifying a predefined DCF file when not using the user specified option. 

The DCF file can be specified by opening the form named DCF File found on the Parameters tab 
of the main Project window in the GENERAL/File Specifications category as shown in Figure 4-80.  
Browse for the DCF file by clicking the Browse button.  In the example shown, a DCF file that is 
distributed with WinMACCS based on Federal Guidance Report 13 has been selected. 
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Figure 4-80 Identify location of the DCF file 

 ATMOS/Reveal Nuclides to modify DCF Values 

The list of radionuclides to be considered in the MACCS simulation are specified on the 
Radionuclides form found on the Parameters tab in the ATMOS/Radionuclides category as shown 
in Figure 4-81.  Modifying the DCF values of any of these radionuclides impacts subsequent 
actions by MACCS. 
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Figure 4-81 Radionuclides Used by MACCS 

 Specify Dose Coefficients to Change 

Dose coefficients can be modified by opening the form DOSE COEFFICIENTS/Reveal Nuclides 
as shown in Figure 4-82. Notice that the DCF file previously specified, referred to as the base 
DCF file, is read and a list of nuclides is shown in the left-hand portion of this form.  These are 
the radionuclides in the DCF file.  This DCF file name previously specified is saved in a parameter 
named DCF_REVEALED.  

Indicate the nuclides of interest by selecting the nuclides and clicking the arrow pointing to the 
right to move the selected nuclides from the Hidden Nuclides list to the Revealed Nuclides list. 
Double clicking on the radionuclide moves it from one list to the other list.  

Nuclides can be moved back from the revealed list to the hidden list by selecting the nuclide on 
the revealed list and clicking the arrow pointing to the left. 

Only nuclides whose DCF values need to be modified should be put on the list Revealed Nuclides. 
The original values in the DCF are used for the nuclides that are not revealed. 

Shift click and Control click can be used to select multiple nuclides. 
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Figure 4-82 Choosing nuclides from DCF file 

The check mark next to the nuclide name on the Revealed Nuclides list means that the forms for 
those nuclides are populated with default values read from the basis DCF file. 

By revealing nuclides, MACCS creates forms to allow modification of the DCFs for those nuclides. 

When these forms already exist, checking the nuclide name causes the current DCF values on 
these forms to be replaced with the default DCF values.  When the user had replaced DCF values 
on some of these forms with their own distributions or with constant values, that information is 
overwritten with the default values. 

Clicking OK preserves changes.  This can take a long time the first time a radionuclide is exposed. 
Clicking Cancel discards changes. 

 Modifying the DCF Values 

The first word in the base DCF file identifies the source of the data.  MACCS expects this first 
word to be one of the following:  

• FGR13DF 

• FGRDCF 

• DOSFAC2 

The type of the base DCF file determines the forms to be built exposing the DCF values.  This 
also determines the list of organs and pathways that are available.  



 

4-76 

In the following example the base file is of type FGR-13.  In this case and in the case of a 
DOSFAC2 file, two forms are created for each exposed radionuclide as shown in  

Figure 4-83. The Acute Inhalation pathway is relevant for a subset of organs, hence the related 
DCF values are placed on a separate form. 

 

Figure 4-83 Dose Coefficient forms for FGR-13 file 

In the example shown in Figure 4-84, the base file is of type DOSFAC2.  Notice that the organ list 
is different than the organ list shown for the FGR-13 base file. 
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Figure 4-84 Dose Coefficient forms for DOSFAC2 DCF file 

In the case of FGRDCF, there is one form per nuclide because acute health effects are not 
calculated when this DCF file is used as shown in Figure 4-85.  The acute inhalation pathway is 
not relevant in this case. 

 

Figure 4-85 Dose Coefficient form for FGR 11-12 DCF file 
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DCF values can be modified by clicking on the grid cell and typing the new value.  It is also 
possible to set any values to be uncertain by double clicking on the cell or by clicking in the cell 
and clicking the Make Uncertain button on the form.  Clicking OK preserves changes.  Clicking 
Cancel discards changes. 

 Running a Simulation 

Select Execute/Run Models from the main menu to open the Run Models form.  Notice that the 
Create DCF File check box is checked. 

When a simulation is run in this mode, a DCF file is created for each LHS realization.  The values 
are generated by LHS in the same LHS instance that generates all MACCS uncertain values.  

 

Figure 4-86 Files tab when creating DCF files 

The Files tab in the WinMACCS Project window shown in Figure 4-86 shows a new entry in the 
Data category called DCF_REVEALED.  This is the file that is used to define the DOSE 
COEFFICIENTS forms, the default values on those forms and the list of unexposed radionuclides. 
In this example, a file created by Fgr-13 was used, Fgr13dcf.inp. 

The Input category lists files that are created by WinMACCS when running model simulations. 
The following files were created in an example with two simulations:  
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• Template file dcfTemplate.txt containing deterministic DCF values and place holders for 
LHS realizations were first created. 

• Files DCF_userTemp1.inp and DCF_userTemp2.inp were created per realization. 
Uncertain values generated by LHS were inserted into these files.  These files are in a 
MACCS standard input format, not in a DCF format. 

• Files DCF_user1.inp and DCF_user2.inp are files in a standard DCF format.  These files 
are used by MACCS and contain the user specified DCFs.  There is one file per 
realization.  These files were created from the files DCF_userTemp1.inp and 
DCF_userTemp2.inp. 

 Food Model available in WinMACCS with User Specified DCF 

When the CHRONC module of WinMACCS is selected, there is an option allowing the use of a 
COMIDA2 food-chain file. It is required that the dose conversion file used in the EARLY module 
of MACCS be identical to the dose conversion file used to create the COMIDA2 food chain file. 

The capabilities that create DCF files have not been integrated into the COMIDA2 Food Model. 
Either the food-chain model must be off or the older MACCS food-chain model used.  

It is possible to create the DCF files and manually run each one through COMIDA2 by selecting 
the Predefined DCF File Option.  

 User Specified DCF file when using Annual DCF Files 

When specifying the AT or piecewise-linear dose-response model options, it is necessary to have 
the Late Consequences module on.  Additionally, it is required that the No Food Model is also 
selected.  Though the interface indicates that it is possible to use the COMIDA2 Food Model, this 
option is not functional. 

It is also necessary, as in all threshold type calculations, to specify the basis AT files as shown in 
Figure 4-46.  These files are used to create the annual user specified threshold files. 

In the following example, in the input folder, there are additional files created by WinMACCS. 

When there are two realizations, there are two files created, DCF_TH_MULT1.inp and 
DCF_TH_MULT2.inp. These files are in a MACCS recognized DCF format.  These files do not 
contain DCF values, but contain multipliers used to transform a predefined DCF file into a user 
based DCF file.  These multipliers are applied to each of the predefined DCF threshold files to 
derive the user defined DCF threshold files.  Values that are -1 indicate that the data are not used.  

For example, the following is an excerpt from one of the multiplier files.  For all DCF values used 
(values not equal to -1) the multiplier used is one.  This means that the data are used with no 
changes. Columns correspond to pathways.  Some values are set to -1 because MACCS does 
not consider these pathways. 
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Am-241 

BONE SUR           1        -1        -1         1        -1         1         1 

BREAST             1        -1        -1         1        -1         1         1 

STOMACH            1        -1        -1         1         1         1         1 

BLAD WAL           1        -1        -1         1        -1         1         1 

LOWER LI           1        -1        -1         1         1         1         1 

LIVER              1        -1        -1         1        -1         1         1 

RED MARR           1        -1        -1         1         1         1         1 

THYROID            1        -1        -1         1         1         1         1 

LUNGS              1        -1        -1         1         1         1         1 

ICRP60ED           1        -1        -1         1        -1         1         1 

There is a multiplier file for every LHS realization.  

In the following example, fgr13dcf.inp and its associated AT files, fgr13dcfYY.inp, are shown, 
where YY is the year number (01, 02…50).  Realization number 5 is shown in the following 
illustration.  

• DCF_user5.inp is the DCF file associated with realization number five.  LHS results for 
realization five have been inserted into this file.  

• DCF_TH_MULT5.inp contains the multipliers calculated by calculating the ratio of the 
user defined value in the file DCF_user5.inp to the original value in FGR13dcf.inp. After 
this step has been completed, the 50 files used by the threshold model can be 
calculated by using this multiplier as a scale factor. 

• DCF_user5_01.inp through DCF_user5_50.inp are the threshold files used for 
realization 5, derived by multiplying the DCF values in the predefined threshold DCF file, 
fgr13dcfYY.inp where YY is the year (01 through 50), with the multipliers for realization 5 
in DCF_TH_MULT5.inp. 

For example, to derive the file for realization number 5 for year 9, the multiplier file, 
DCF_TH_MULT5.inp is used with the data in the file Fgr13dcf09.inp to create a user defined input 
file DCF_user5_09.inp. 

 Multi Source Term 

A group of MelMACCS files, possibly created from a combination of different MELCOR plot files 
and single files with multiple rings, can be run using the Multi Source Term option.  This is done 
by opening a project in WinMACCS and merging the source term files using the following steps: 

(1). The multi-source option is activated by clicking on the box labeled Multi Source Term 
on the Plume/Source tab, as shown in Figure 4-87.  This setting needs to be saved 
by clicking OK in the Project Properties form. 

Source term files are selected from the GENERAL/File Specifications/Multi Source 
Term File Set form. From this form, the user can navigate to the folder containing the 
multi-source files created by MelMaccs. Files can be selected by double clicking on 
the file names or by selecting or shift selecting, right clicking, and selecting Add Files 
from the pop-up menu. The order that the files are processed can by changed by 
selecting the file in the left most window pane, and clicking the up or down arrow 
below that pane to change the order, as shown in Figure 4-88. The order of the files 
affects some of the subsequent steps.  
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Figure 4-87 Selecting Multi Source Term option 

 

Figure 4-88 Specifying Multi Source Term input files 

(2). Forms under the category, Multi Source Term, are required.  Two of the forms are 
the same or similar to the ones required for a single-unit source term, the Chemical 
Names and Radionuclides forms.  The Time Offsets form allows the user to specify 
time offsets for each source term file, as illustrated in Figure 4-89. The Plume 
Segments form shows the plume segments arranged chronologically and identifies 
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which multi source term file each plume segment is from. The plume delay values on 
this form account for the time offset values specified on the Time Offsets form. In the 
example shown, there are fifteen plume segments defined, ten from the file Ring1.inp 
and five from the file Ring2.inp. The files used by WinMACCS are copies of the 
original and are in the Input folder of the project. 

 

Figure 4-89 Forms for specifying a multi-unit source term  

(3). A special form named Spatial Intervals for Output can be found under the 
ATMOS/Output Control category.  This form has the same name as another form, as 
shown in Figure 4-90.  However, the upper bound for the parameter INDREL, 
indicating the plume segment number, is the number of plumes segments in all of the 
multi-source files.  The row number on the Plume Segments form shown in Figure 
4-89 identifies value of INDREL for a specific plume segment.  
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Figure 4-90 Specifying ATMOS output with the multi-unit source term model 

(4). Running a multi-unit source term calculation is performed from the Run Models form 
by selecting Execute/Run Models from the main menu, as shown in Figure 4-91. 
Notice that Create Multi Source Term File is checked.  This means that Combine 
Source is to be run to recreate a file called CombineSource.out.  This file is used by 
MACCS, and the file name is specified on an input card in the ATMOS input file.  

 

Figure 4-91 Running multi source term calculation with MACCS 
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4.5 Running Simulations 

Model execution can be initiated by opening the Run Models form by selecting Execute→Run 
Models… from the main menu and clicking on Run Simulation. 

This section describes the options available when running simulations. 

 Run Models Form 

The following are the main components of the Run Models form as shown in Figure 4-92.  The 
model settings are modified from the Project Properties form. The MACCS modules to be used, 
namely Atmospheric Dispersion, Early Consequences, and Late Consequences, are selected 
from the Scope tab of the Project Properties form. The MACCS Cyclical File Set is also selected 
from the Scope tab. The Create COMIDA2 File setting can be modified from the Food tab, Create 
DCF File from the Dose tab, Create Site File from the Site/Data tab, and the Create Multi Source 
Term File from the Plume/Source tab.  

None of these settings can be modified directly from the Run Models form. 

  

Figure 4-92 Run a simulation 

The Number of Simulations is the number of cyclical and/or LHS samples to be run.  However, 
MACCS attempts to prevent redundant simulations.  For example, when no cyclical files or 
uncertain parameters are specified within MACCS, only a single simulation is performed. 
Likewise, when a set of cyclical files are specified but there are no uncertain parameters, MACCS 
performs the same number of simulations as cyclical files. 



 

4-85 

The Number of Simulations can be changed by selecting Advanced to open the Advanced 
Execution Parameters form. The seed used by the LHS random number generator can also be 
modified on this form. 

Clicking Run Simulation initiates simulations. Progress is reported in the Results window. 

The current simulation number (e.g., the MACCS run number) is displayed in the status bar found 
at the bottom of the Run Models form.  

Selecting Abort Simulation aborts a MACCS run in progress. 

 Advanced Execution Parameters Form 

Opening the Run Models window by selecting Execute→Run Models from the main menu allows 
the user to set advanced execution options. Clicking the button Advanced opens the Advanced 
Execution Parameters dialog as shown in Figure 4-93. 

 

Figure 4-93 Advanced execution parameters form 

The Number of Simulations text box is the number of times MACCS runs.  

When there are uncertain parameters, set number of simulations to the number of LHS 
simulations that are to be used in the analysis. Changing this number changes the sampled values 
of the uncertain parameters used in the simulations. 

When MACCS cyclical files are used with or without LHS, enter the number of times you want 
MACCS to run. When LHS is not used, the Number of Simulations should be the same as the 
number of cyclical files; when LHS is used, the Number of Simulations must be an integer multiple 
of the number of cyclical files. When the value entered by the user is not a multiple of the number 
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of cyclical files, WinMACCS resets this value to be the next larger integer that is a multiple of the 
number of cyclical files. Statistical results for the aggregated output assume that the conditions 
represented by the cyclical files are equally likely.  

The value in the Seed for Random Generation text box is the random number seed used by LHS 
to create distribution samples of the parameters the user has chosen to be represented by 
probability distributions. Changing this number changes the sampled values of the uncertain 
parameters used in the simulations. The LHS users guide recommends choosing values of about 
1000 or greater because “certain smaller values can generate random sequences that 
compromise statistical randomness properties” (Wyss and Jorgensen, 1998). The value of the 
seed must be between 1 and 2,147,483,647. 

The section labeled Disposition of MACCS Input and Output Files gives the user the option of 
deleting various files that do not need to be referenced.  These are useful options when there are 
many simulations. The files deleted are removed after MACCS has executed a single sample 
except for the MACCS binary results files.  The template files are always retained in the project 
Input folder. 

When the Delete Atmos, Early, Chronc and COMIDA2 Input Files check box is checked, the 
MACCS input files are deleted after they have been used in a simulation.  The template files 
(e.g., AtmosTemplate.txt) are not deleted.  These files are in the project /Input folder. 

When the Delete MACCS and COMIDA2 Text Output Files check box is checked, the MACCS 
text output files and the COMIDA2 text output files are deleted after the simulations have all 
completed. These files are in the project /Output folder. 

When the Delete MACCS and COMIDA2 Binary Result Files check box is checked, the MACCS 
binary files are deleted after the reports are created.  When no reports are requested and the 
Execute→Auto Create Summary Report checked command is off the MACCS binary results files 
are removed after each MACCS run and data is not available for post processing.  In each other 
case, the binary data is imported into the project database and is available for post processing. 
Data for plots and additional reports are available through the database, even after the binary files 
are removed. 

Clicking OK preserves changes. Clicking Cancel discards changes.  

 Template files 

Template files are created by MACCS to facilitate the task of creating input files.  These are 
named atmosTemplate.txt, earlyTemplate.txt, chroncTemplate.txt and comidaTemplate.txt.  The 
positions where the values of uncertain parameters are inserted are tagged within these files.  
The tags can be used to identify the uncertain variables.  For example, notice the special 
characters around the number 309 in the following input line taken from a sample 
atmosTemplate.txt file. 

• WDCWASH1001 §309§  

This line indicates that CWASH1 is uncertain.  A sampled value from LHS is inserted into the 
space §309§ when the input file is created from the template file.  The number 309 is an internal 
key used by MACCS to identify which parameter to insert. 

The Atmos1.inp, Early1.inp, Chronc1.inp and the three COMIDA2 input files are recreated from 
the template files when the user selects Run Simulation.  
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When the user desires to manually modify one or more input parameters within the MACCS 
template files, the user must first uncheck the main menu option Execute→Refresh Template 
Input Files before Running. Otherwise, the modified file is overwritten before MACCS executes 
and the modification is lost. 

4.6 Model Results 

Results are output from MACCS in text format, e.g. Model1.out, and in binary format 
(e.g., Model1.bin).  

The binary results are available from WinMACCS as custom reports, custom plots or a text view 
of the binary file. 

 Text Results from MACCS 

Text results from MACCS can be viewed in a text editor such as Notepad.  These files can be 
opened directly by double clicking on the file name (e.g. Model1.out) found in the Project/Files 
tab. 

Most MACCS results from a single simulation are probability distributions representing uncertain 
weather. For example, in Figure 4-94, the MACCS results for Center Air Concentration for Cs-
137 for plume number one at 4.8 to 5.6 km is a probability distribution.  MACCS reports statistics 
such as Prob Non-Zero, Mean, etc., calculated from this distribution.  These statistics are listed 
as column headings in Figure 4-94. 

 

Figure 4-94 MACCS statistical summary results 

The Statistical Summary Results form described in Section 4.6.3.3 allows the user to display a 
graphical view of the CCDF for each of the entries in Figure 4-94(e.g., the mean value of Center 
Air Concentration for Cs-137 for plume number one at 4.8 to 5.6 km) over all realizations. In other 
words, a plot created with this option displays a probability distribution (CCDF) of one of the 
statistics above calculated over the set of LHS samples.  

A binned CCDF of output requests is created by MACCS when the Report Option is set to CCDF 
or CCDF & REPORT on the forms in the ATMOS/Output Control, EARLY/Output Control and 
CHRONC/Output Control categories. 

Parameters set under the EARLY and CHRONC Output Control categories of the interface 
determine the consequences calculated by MACCS. MACCS can calculate a variety of different 
consequence measures to portray the impact of a facility accident on the surrounding region. The 
user has control over the results that are produced. By choosing appropriate values in Output 
Control, the user can ensure that the code produces only desired results. This affords a great 
deal of flexibility but it also requires that the user anticipate the results that are needed. When any 
are omitted, the user needs to correct the parameter choices and rerun the calculation. 
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In this regard, a result can only be produced when the model needed for its calculation has been 
previously defined in the appropriate section. When any results pertaining to health effects are 
requested, risk factors for that model must have been supplied on forms Early Fatality 
Parameters, Early Injury Parameters, and Latent Cancer Parameters. 

EARLY can produce many different types of results. Some of these types of results are also 
calculated by CHRONC, but some are not. For instance, both EARLY and CHRONC calculate 
cancer cases and population dose, but only EARLY calculates early fatalities, and only CHRONC 
calculates economic costs. When the user requests EARLY to produce a result that is also 
produced by CHRONC, the code automatically calculates results for both EARLY and CHRONC.  

Summary statistics with respect to each requested result are reported independently of the value 
of the WinMACCS variable, Report Options. There are ten columns of numeric data which provide 
a statistical summary, as follows: 

• PROB NON-ZERO is the conditional probability of having a nonzero consequence 
estimate, conditional on the occurrence of the release under consideration. 

• MEAN is the average (expected) consequence over all weather trials.  This is calculated 

by taking the sum of all the products [(consequence value)  (conditional probability of 
that value)] for each weather trial.  The probabilities of the weather trials are not 
necessarily the same, so the conditional probabilities can be different for each weather 
trial.  

• 50TH QUANTILE is the median of the estimated CCDF. 

• 90TH QUANTILE is based on the estimated CCDF. It is the value for which there is a 
10% chance this consequence magnitude is exceeded. 

• 95TH QUANTILE is based on the estimated CCDF. It is the value for which there is a 
5% chance this consequence magnitude is exceeded. 

• 99TH QUANTILE is based on the estimated CCDF. It is the value for which there is a 
1% chance this consequence magnitude is exceeded. 

• 99.5TH QUANTILE is based on the estimated CCDF. It is the value for which there is a 
0.5% chance this consequence magnitude is exceeded. 

• PEAK CONS is the largest consequence magnitude obtained from the set of weather 
trials that were examined. 

• PEAK PROB is the conditional probability associated with the largest consequence 
magnitude. 

• PEAK TRIAL refers to the weather trial for which the largest consequence occurred. By 
referring to the ATMOS portion of the output file, the user can determine the start time 
(day and time period) of this weather sequence. 

A CCDF is an estimate of the distribution of consequence magnitudes.  The variability of 
consequence values in a single MACCS simulation is due solely to the uncertainty of the weather 
conditions existing at the time of the accident.  A MACCS output file is created for each simulation 
when any input parameters are chosen to be uncertain. In this case, the user chooses the number 
of realizations to capture the uncertainty in the input variables. MACCS produces one CCDF per 
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realization. WinMACCS can quantify the overall uncertainty in results by assembling the set of 
CCDFs into a single CCDF that accounts for both weather and input uncertainty.  

CCDFs can be viewed as spider plots (one CCDF curve per simulation) from within the 
WinMACCS interface using Post Processing/Graphical Results/Results over all Weather Trials 
under the main menu selection. Additionally, statistical results (such as the mean result over all 
weather trials) can be viewed using Post Processing/Report Results/Create Summary Report 
under the main menu. 

Report Options appears on most of the output request forms.  When set to CCDF or CCDF & 
REPORT, CCDF data are reported in the MACCS output file.  When set to REPORT or CCDF & 
REPORT, WinMACCS automatically generates a report over all realizations based on quantiles 
specified on the Reporting Options form. 

When the user did not select Report Options to be CCDF or CCDF & REPORT when requesting 
the calculation in the WinMACCS input forms, it is still possible to retrieve those data from 
WinMACCS. Though the CCDF data are not written to the output file, when the user requests a 
report based on the desired data using the custom report form, Post Processing/Create Custom 
Report, CCDF data are read into WinMACCS from the binary output file and are available in the 
Post Processing/Graphical Results forms.  The user should be aware that the method used to 
estimate quantile levels in WinMACCS differs from the one used in MACCS, so quantile values 
for a single realization produced by WinMACCS may differ slightly from those produced by 
MACCS. 

When a consequence measure was calculated by both EARLY and CHRONC, the output lists 
results separately for EARLY and CHRONC.  The weighted sum or average of all consequence 
results is presented at the beginning of the output file in a section labeled OVERALL RESULTS... 
Following the overall results, those from each of the cohorts are presented.  The total number of 
cohorts listed is one greater than the number of emergency response cohorts created in EARLY.  
The final cohort in the output represents CHRONC.  

 Custom Reporting Options 

Reports created from the MACCS binary result files are created using different methods as 
follows: 

• Reports that combine the results over the MACCS simulations can be requested on the 
forms in the ATMOS/Output Control, EARLY/Output Control and CHRONC/Output 
Control categories. These requests result in a Summary Report.  

• Reports that combine the results over the MACCS simulations can also be created using 
the custom report features. Data is available from every calculation request made from 
ATMOS/Output Control, EARLY/Output Control and CHRONC/Output Control 
categories, even when report requests were not made on those forms. These can be 
created using the Combine Realizations option on the Manage Reports form as 
described in Section 4.6.2.3. 

• Reports that display results without combining data over the MACCS simulations are 
created using the Realization Based option on the Manage Reports form as described in 
Section 4.6.2.5. 

Reports are created automatically after the simulations are completed, provided the main menu 
item Execute→Auto Create Reports is checked.  The reports created include the Summary Report 
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and all the custom reports defined.  These reports are placed in the project \Output folder, and 
are also available within WinMACCS on the Project/Files tab. 

When the menu item Execute→Auto Create Reports was not checked before the simulations 
began, the reports can still be requested from the Manage Reports form described in Section 
4.6.2.3 and Section 4.6.2.5.  The summary report can be created by selecting 
PostProcessing→Report Results→Create Summary Report. These post processing features only 
function when the MACCS binary files have not been deleted. 

Custom reports are defined using the menu item PostProcessing→Report Results→Manage 
Custom Reports.  New custom reports must be defined after the MACCS simulations have 
completed because the list of results to place in the reports is not available before the run has 
been finished. After the custom reports have been set up, it is possible to recreate them for each 
subsequent run.  

When the output requests to MACCS (see the forms in Output Control) are modified to exclude 
some output requests that were used to define the custom reports, those custom reports are not 
created. The user should be careful not to confuse reports from previous runs with current runs 
because previously created reports are not deleted unless the new file has the same name as the 
existing file.  

It is possible to import custom report definitions from other projects using the menu item 
File→Import Custom Report Definitions as described in Section 4.2.1. 

 Combining Results over Realizations 

Reports that combine realizations contain the grand mean (i.e., the mean of the means for each 
realization) and the interpolated values based on the binned CCDF results for a user entered set 
of probabilities, or quantiles.  The first step in defining these reports is to define the quantiles to 
use. When the probabilities are not defined, only the grand mean is reported.  

Opening the form GENERAL/Output Options/Reporting Options allows quantiles to be entered. 
This is shown in Figure 4-95. When the MACCS simulations have already completed, a Summary 
Report cannot be created, but custom reports can be requested that combine the realizations. 
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Figure 4-95 Specifying quantiles 

 Creating a Summary Report 

A summary report based on MACCS outputs is created after MACCS simulations have 
completed. To include a result in the summary report, the Report Options flag should be set to 
REPORT or to CCDF & REPORT as shown in Figure 4-96. 

The summary report is created after MACCS simulations have completed, provided the 
Execute→Auto Create Summary Report menu item is checked.  This report can also be created 
by selecting PostProcessing→Report Results→Create Summary Report. 

The categories ATMOS/Output Control, EARLY/Output Control and CHRONC/Output Control 
contain calculation requests. Most of the forms in these categories contain the Report Options 
flag. 
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Figure 4-96 Summary report request 

Summary reports can be requested as follows: 

(1). Quantiles are defined as shown in Figure 4-95. 

(2). The outputs of interest are selected by first opening an output request form.  This is a 
form that is in one of the Output Control categories.  

(3). In the Report Options column, by choosing either REPORT or CCDF & REPORT 
causes WinMACCS to include this result in the report after all MACCS simulations 
are completed. When the CCDF & REPORT is chosen, the additional binned data for 
each cohort is printed in each of the MACCS output files associated with the 
simulation. 

(4). This process can be repeated for all results to be included in the summary report. 
Clicking OK preserves the summary report requests. 

(5). After running the MACCS simulations, the binary result files, Model1.bin, Model2.bin, 
…, are imported into the database.  The report, summary.txt, is automatically created 
based on the user input, and placed in the project output folder. Double clicking on 
Output/Summary.txt found on the Files tab of the Project window opens the report. 

 Creating a Report that Combines Realizations 

This section describes how to create new combined-realization reports after MACCS simulations 
have completed.  

After MACCS has run, the PostProcessing menu is available.  The custom report generator can 
be opened by selecting PostProcessing→Report Results→Manage Custom Reports as shown in 
Figure 4-97 . 
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Figure 4-97 Opening the Manage Reports form 

This form lists the custom reports currently defined as shown in the example shown in  

Figure 4-98. In this example there are two reports defined.  The column labeled Type identify the 
report format as Combined.  This means that these are reports based on combining realizations. 
When the menu item Execute→Auto Create Reports is checked, all reports listed in the Manage 
Reports form are automatically created after the MACCS simulations have completed. 

 

Figure 4-98 Reports based on combining realizations 

The Custom Combined Report form as shown in Figure 4-99 lists each of the MACCS output 
requests.  This form is opened when a new Combine Realizations report is created, or when an 
existing Combine Realizations report is edited.  

The column labeled Report Description identifies the form description as found in the 
Project/Parameters tab.  For example, in Figure 4-99 the entries defining the report Population 
Dose were requested from the WinMACCS form EARLY/Output Control/Population Dose.  The 
column labeled MACCS Input Card is a copy of the line written to the MACCS input file 
EARLY1.inp.  

The Combine Realizations report contains results like the Summary.txt report. WinMACCS 
combines the CCDF data over all the MACCS binary result files and displays the grand mean and 
the interpolated quantile values.  
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Figure 4-99 Defining a Combine Realizations report 

New combine realization reports can be defined as follows: 

1. Quantiles are defined as shown in Figure 4-95. 

2. The Manage Reports form is opened by selecting PostProcessing→Report 
Results→Manage Custom Reports as shown in Figure 4-99. 

3. A new definition can be defined by first selecting the radio button Combine 
Realizations and clicking on the button New. 

4. The user can enter report name in the field labeled Report Name. 

5. The MACCS output requests are selected by clicking check boxes in the Include 
column.  

6. Clicking OK to saves the new report definition. 

If the report has already been defined, the report can be opened by checking the box in the column 
labeled Select. Selecting the radio button labeled View in the group Selected Reports and clicking 
the Apply button creates and opens the report. 

A defined report can be edited by checking the box in the column labeled Select and clicking the 
Edit button. 

A defined report can be deleted by checking the box in the column labeled Select, selecting the 
radio button labeled Delete in the group Selected Reports and clicking the Apply button.  

 Interpretation of Combining Realization Reports 

The report format used for summary reports is the same format that is used when creating a 
custom report when the combine realization is option is used as shown in Figure 4-99. 
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These reports consist of the grand mean and an estimate for the probability of exceedance for 
the probabilities requested on the General/Reporting Options form based on the binned 
cumulative probability distributions calculated by MACCS.  

If all of the CCDF values are identical, there is no variance in the parameter values. In this case 
it is not possible to calculate a meaningful value for the probability of exceedance and the report 
contains the text “Unable to transform CCDF No differences in probability values in CCDF”. 

In the following example, the report request was made on the form Early/Output Control/Health-
Effect Cases.  The statistics from each of the LHS trials are combined.  

************************************************************************ 
Request 1 Health-Effect Cases 
MACCS Image:  TYPE1OUT009 'CAN FAT/TOTAL' 1 26 REPORT 
************************************************************************ 

Evacuation CHRONC CAN FAT/TOTAL [0.,1609.34](km)  
 Probability of Exceedance 
 Grand Mean 0.5 0.9 0.95 
Health-Effect Cases (none)  2.732E+03      9.231E+02      1.006E+02      5.008E+01       

Evacuation Evac #1 CAN FAT/TOTAL [0.,1609.34](km)  
 Probability of Exceedance 
 Grand Mean 0.5 0.9 0.95 
Health-Effect Cases (none)  4.094E+02      1.017E+02      5.141E+00      1.856E+00       

Evacuation Evac #2 CAN FAT/TOTAL [0.,1609.34](km)  
 Probability of Exceedance 
 Grand Mean 0.5 0.9 0.95 
Health-Effect Cases (none)  3.637E+00      1.83E+00       3.321E-01      2.049E-01       

Evacuation Overall CAN FAT/TOTAL [0.,1609.34](km)  
 Probability of Exceedance 
 Grand Mean 0.5 0.9 0.95 
Health-Effect Cases (none)  3.145E+03      1.273E+03      1.35E+02       7.178E+01       

The first entry, CHRONC, reports the cancer fatalities due late consequences.  The next two 
entries, Evac # 1 and Evac # 2 report the cancer fatalities due to early consequences for cohort 1 
and cohort 2 respectively.  The early and late consequences are combined in the entry labeled 
Evacuation Overall.  

Interpreting the results for the overall health effects, we are 90 percent certain that the number of 
total fatalities exceeds 135. The mean number of fatalities over all LHS realizations is 3145.  This 
is precisely the sum of the mean cancer fatalities due to the late and early consequences. 

Cohort results are combined using the weighting factors stored in WTFRAC when the overall 
results are calculated for some of the results that are independent of the population such as 
Average Individual Risk, Peak Dose and Population Weighted Risk calculations.  

 Creating a Report Based on Individual Realizations 

This section describes how to create reports that show results for individual realizations after 
MACCS simulations have completed. 
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After MACCS has run, the PostProcessing menu is available. The custom report generator is 
opened by selecting PostProcessing→Report Results→Manage Custom Reports. 

This form lists the custom reports currently defined.  In the example shown in Figure 4-100 the 
column labeled Type indicates the report format. For reports based on individual realizations, the 
Type is either byVariable or byTrial depending on whether the By Variable or the By Realization 
radio button was selected on the Custom Realization Based Report form as shown in Figure 
4-101. See Section 4.6.2.3 for creating reports where the Type is Combined. 

All reports listed are automatically created after the MACCS simulations have completed provided 
the menu item Execute→Auto Create Reports is checked. 

 

Figure 4-100 Reports based on each realization 

The Custom Realization Based Report form as shown in Figure 4-101 is organized as a list of 
available results read from the MACCS binary results file.  Each available result for reporting is 
listed. A list is opened by clicking the plus sign where more specific results can be selected. In 
the example, there are two results available for Total Centerline Ground Concentration.  Items in 
the list, called qualifiers, can be individually selected or selected as a group by clicking on the box 
preceding the result name. 

This form is opened when a new Realization Based report is created, or when an existed 
Realization Based report is edited. 
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Figure 4-101 Defining a Realization Based report 

New realization-based reports can be defined as follows: 

(1). The Manage Reports form can be opened by selecting PostProcessing→Report 
Results→Manage Custom Reports from the main menu.  

(2). Selecting the radio button Realization Based and clicking the button New opens the 
Custom Realization Based Report form as shown in Figure 4-101. 

(3). A report name must be entered in the field labeled Report Name. 

(4). Results can be selected by clicking on the empty boxes in front of the result names. 
Individual items can be selected from the qualifier lists by clicking the + in front of the 
result name and clicking the empty boxes in front of the qualifiers. 

(5). Selecting either the radio button By Variable or By Realization completes the report 
definition. When By Variable is selected, the results are listed for a given trial when 
the report is created. When By Realization is selected the results for each trial are 
listed for a given result as shown in Figure 4-102. 

(6). Clicking OK saves the report definition. 

When the report has already been defined the report can be opened by checking the box in the 
column labeled Select. Select the radio button labeled View in the group Selected Reports. Click 
the Apply button. The report is created and opened. 

A defined report can be edited by checking the box in the column labeled Select and clicking the 
Edit button. 

A defined report can be deleted by checking the box in the column labeled Select, selecting the 
radio button labeled Delete in the group Selected Reports and clicking the Apply button.  
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Figure 4-102 Report of type By Realization opened in Excel  

 Custom Plotting Options 

Graphical output can be displayed after completing a MACCS run by selecting an entry from the 
main menu Post Processing→Graphical Results. The following results are available: 

• Scalar results are displayed by selecting PostProcessing→Graphical Results→Scalar 
Results from the main menu. 

• Statistical summary results are displayed by selecting PostProcessing→Graphical 
Results→Statistical Summary Results from the main menu. 

• Probability distribution results representing weather uncertainty are displayed by 
selecting Post Processing→Graphical Results→Results over all Weather Trials from the 
main menu. 

When a plot request is made after a simulation (e.g., one of the menu entries such as 
PostProcessing→Graphics→ Results over all Weather Trials) is selected, the MACCS binary 
result files (e.g., Model1.bin and Model2.bin) are imported into the project database (unless they 
were already imported to create reports).  This progress can be observed in the Results window 
as shown in Figure 4-103. 

 

Figure 4-103 Results window after processing binary files 

After the binary result files have been processed into the project database, the result information 
is available for quick access without repeating the import process. 
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 Scalar Results 

Graphical results are displayed after completing a MACCS run by selecting an entry from the 
main menu item PostProcessing→Graphical Results→Scalar Results as shown in Figure 4-104. 
This graph was made by selecting the entry under release, Plume 1 Kr-85, clicking Add and 
clicking Select to show the data points. In this example, the release duration was made uncertain. 

 

Figure 4-104 Scalar Results plot 

 Results Displayed as a Complementary Cumulative Distribution Function (CCDF) 

Graphical results are displayed after completing a MACCS run by selecting an entry from the 
main menu PostProcessing→Graphical Results→Results over all Weather Trials from the main 
menu as shown in Figure 4-105. This graph was made by selecting the entry under Ground Level 
Air Concentration, Plume 1 Cs-137(25.75, 32.19] km, and clicking Add.  In this example, uniform 
bin sampling from the weather file was used. 
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Figure 4-105 Results over all Weather Trials plot 

Early and Chronc MACCS results from a single execution are often CCDF’s or statistics 
representing uncertainty of the weather during a hypothetical accident.  This window displays the 
CCDF distributions for each MACCS calculation.  For example, when five MACCS simulations 
were run using LHS, there would be five CCDF curves for each result.  

Even when not requested by the user, all CCDF results are written to the binary results files 
(e.g., Model1.bin).  In the example shown in Figure 4-106, even though CCDF results for plume 
one (INDREL) at grid element ten (INDRAD) are not reported in the Model1.txt results files, they 
are saved in the binary-result files and are available in the plots and reports. 

 

Figure 4-106 Requesting CCDF results in WinMACCS 

 Statistical Summary Results 

Graphical results can be displayed after completing a MACCS run by selecting an entry from the 
main menu PostProcessing→Graphical Results→Statistical Summary Results from the main 
menu as shown in Figure 4-110. This graph was made by selecting the entry under Ground-Level 
Air Concentration, Plume 1 Cs-137[4.83, 5.63] km, and clicking Add.  The mean of the means 
(over all realizations) is shown on the plot as a vertical green line.  The plot is the distribution of 
the means. 
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 Navigation of the Plot window 

Multiple plot windows can be opened after simulations have completed as shown in Figure 4-107. 

 

Figure 4-107 Plot windows available 

The caption of each plot window contains the MACCS version used in the simulation.  The date 
and time correspond to a date/time stamp written on the first binary output files (e.g., model1.bin) 
as shown in Figure 4-108.  

 

Figure 4-108 Plot window caption 

A series can be added to a Statistical Summary Reports window by selecting the result to plot 
from the Select Variable list as shown in Figure 4-109, selecting the desired statistic in the Statistic 
list and clicking Add to add it to the existing graph. 

 

Figure 4-109 Add a Series to a Statistical Summary Reports Window 

When the Mean is added, notice that the grand mean (average of all means over all simulations) 
is calculated and displayed on the graph as a vertical line. 

A series can be selected by doing any of the following operations: 

• Clicking the Select button. 

• Selecting Select Next Series from the PostProcessing→Graphical Results→Edit Plots 
menu. 

• Clicking on the series on the plot. 

• Pressing the Enter key on the keyboard. 
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After a series is selected the following is true: 

• The individual points are marked. 

• The details, including the qualifier, indicating the series selected are shown in blue at the 
bottom of the window. 

• The Select Variable list and the Statistic list are selected to entries consistent with the 
selected series.  

• The series is also selected in the legend.  

• When the bulls-eye button is pushed in, the data values of the selected series are shown 
on the plot. 

Series are selected in the order they were added.  Only one series can be selected at a time. 

When the last series added is the selected series and the Select is clicked, no series is selected. 
This feature allows the user to cycle through all the series, unselect all plots, and start the 
selection again with successive mouse clicks on the Select button. 

In Figure 4-110, the Ground-Level Air Concentration for Plume 1, Cs-137 at a spatial distance of 
4.83 to 5.63 km for the mean statistic is chosen.  Notice that this information is displayed in blue 
at the bottom of the window.  Also notice that the Grand Mean is displayed on the plot as a vertical 
line.  



 

4-103 

 

Figure 4-110 Statistical Summary Results plot 

A series can be deleted by selecting the plot by clicking Select until the desired plot is selected, 
clicking Delete.  After the series has been selected, it can also be deleted by selecting Delete 
Selected Series from the PostProcessing→Graphical Results→Edit Plots menu. 

The axis labels or title of a graph can be modified by selecting the Modify Titles entry from the 
PostProcessing→Graphical Results→Edit Plots menu.  The Modify Titles form opens as shown 
in Figure 4-111.  This allows the user to modify the plot and axis titles.  Notice that by default the 
main plot title and the X axis title corresponds to the first plot placed on the graph.  Clicking OK 
saves the settings.  Clicking Cancel discards the changes. 
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Figure 4-111 Modify plot titles 

To zoom in the graphics window, hold the left mouse down in the top right corner of the desired 
area.  Drag a rectangle by moving the mouse down and to the right.  Release the mouse. 

To un-zoom or restore the graphics window to its original scale, hold the left mouse down 
anywhere in the plot.  Drag a rectangle by moving up and to the left.  Release the mouse. 

To show the values in the series select the bulls-eye toggle.  When this toggle is pushed in, as 
shown in Figure 4-112, the associated data points in the selected series are overlayed as 
coordinate pairs.  To view some of the values, it may be necessary to use the zoom feature. 
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Figure 4-112 Data values as text displayed in a plot window 

To modify the plot axis click Modify Axis to open the Modify Axis Bounds form as shown in Figure 
4-113.  This allows the user to change the axis limits or switch to a log scale. 

The X or Y axis can be rescaled by: 

• Selecting the X or Y toggles. By default, the X axis is selected. 

• Selecting the scale of the toggled axis by selecting either Linear or Log.  

• Setting the bounds of the toggled axis to Automatic or Manual.  

• Deciding whether the axis limits are to be determined by WinMACCS by selecting 
Automatic or entered by the user by selecting Manual.  

• Manually entering the axis limits if the selection was Manual in the text boxes labeled 
Minimum and Maximum.  

• Clicking OK preserves changes. Clicking Cancel discards changes.  
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Figure 4-113 Modify axis bounds 

The plots can be exported by selecting Export Plot from the PostProcessing→Graphical 
Results→Edit Plots menu.  A SaveAs dialog is opened as shown in Figure 4-114.  The following 
file types are supported: 

• Windows bit map (.bmp): A graphical format that integrates into other Microsoft 
documents such as Microsoft Word, Excel, or WordPad. Files can be edited in Microsoft 
Paint. 

• Jpeg (.jpg): Viewable as a graphic in a web browser or photo editing software. Requires 
less memory than a .bmp file. 

• Text files (.txt): ASCII text that is viewable in a text editor such as Notepad, WordPad, or 
Microsoft Word. 

• XML and HTML: Viewable in a web browser such as Internet Explorer. This file can also 
be edited in Microsoft Word. 

• Excel file (.xls): A document that can be opened with Microsoft Excel. Allows the user to 
do further data analysis in the graphical and functionally rich environment of Excel. 

The result file is saved in the Project\Output folder unless the path is modified in the Save As 
form.  Saved files are shown in the Files tab of the Project window as shown in Figure 4-115.  
Double-clicking on the exported file in the Project window causes the associated application to 
open that file for viewing.  
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The file names shown in the Files tab of the Project window are updated by selecting 
File→Refresh File View from the main window. 

 

Figure 4-114 Exporting plots 

 

Figure 4-115 Exported plots in Files tab of project window 
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5. TUTORIALS 

Sections 5.1 and 5.2 are tutorials demonstrating how to modify an existing WinMACCS project 
and how to convert a legacy MACCS project into a WinMACCS project.  Section 5.3 contains 
some guidelines for constructing a new project from scratch (i.e., without the benefit of an existing 
project).   

Tutorial One should be tried by all new users.  Tutorial Two is useful when it is necessary to 
convert MACCS input files into a WinMACCS project file. 

Tutorial One demonstrates how to:  

• open the existing sample project, Point Estimates LNT, 

• save this as a project, Sample 1, 

• modify models, 

• run a simulation, 

• modify a deterministic parameter and compare results, 

• change the number of evacuation scenarios, 

• create uncertain parameters, 

• run an uncertainty calculation, and 

• view and export results. 

Tutorial Two demonstrates how to: 

• import MACCS input files to create a sample WinMACCS project., 

• connect the meteorological file, site data file, DCF file and COMIDA2 file with the 
imported project, 

• understand how the import process is reported in the WinMACCS Results window, and 

• understand that some modifications to the input are required to run MACCS. 

5.1 Tutorial One  

What follows is a description of running six samples using sample problem “Point Estimates LNT” 
as a basis.  
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Table 5-1 Open WinMACCS project. 

User Action WinMACCS response 

Double-click on the WinMACCS icon on 
the desktop or select WinMACCS from 
the WinMACCS group within the 
Windows Start Menu. 

WinMACCS starts and displays menus on the top of the 
screen. File and Help are accessible. 

Choose File→Open Project. 

Change directory to C:\WinMACCS 
Samples\NRC Sample Problems. 

WinMACCS shows available sample project folders. 

Double-click on the Point Estimates LNT 
folder. 

Folder opens and shows the project file Point Estimates 
LNT.mxd. 

Double-click on Point Estimates 
LNT.mxd. 

WinMACCS loads the project. All projects have four 
directories, \Input, \Data, \Results_DB and \Output. 
WinMACCS displays a message and creates the missing 
folder(s) if any of these folders are missing. WinMACCS 
displays two tabs on the bottom of the Project window: 
Parameters and Files. Above the tab, WinMACCS displays a 
list containing the following headings: GENERAL, ATMOS, 
EARLY, CHRONC, DOSE COEFFICIENTS and COMIDA2. 

Select File→Save As Project from the 
main menu.  

Change to the directory in the root drive 
called WinMACCS Projects. 

Type Sample 1 in the Project Name field. 

Click OK. 

A new copy of the sample project, Sample 1, is created in the 
default WinMACCS project directory, WinMACCS Projects. 

The path shown in the caption of the main WinMACCS 
window is C:\WinMACCS Projects\Sample 1.  

Click on the Files tab in the Project 
window. 

Above the tab, WinMACCS displays a list containing the 
following headings: Data, Input, and Output. 
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Table 5-2 Viewing parameters. 

User action WinMACCS response 

Click on the Parameters tab in the 
Project window. 

Each + button, when clicked, displays sub-lists until the 
lowest level is reached. At the lowest levels, black bullets 
appear next to the names of variables. For example, 
METCOD is one of the parameters under ATMOS/Property 
Form Parameters. 

Open the ATMOS or EARLY heading by 
clicking on the + button. Peruse the 
different lists by clicking on the + 
buttons.  

   A solid green octagon indicates that all the parameters 
under that entry are required and have been properly 
defined.  

 
 A solid orange diamond indicates that all the 

optional parameters under that entry have been properly 
defined.  

 
  An empty orange diamond indicates that some of 

the optional parameters have not been defined. 

 
 An X-ed red octagon indicates that required 

parameters must be defined or corrected before proceeding 
with a MACCS simulation. 

 
  A X-ed orange diamond indicates that there is an 

error on this optional form. 

 
  A solid gray octagon with a diagonal line indicates 

that the parameters are not used in a MACCS simulation 
because they are not needed under the current choices. 
This symbol also indicates that all the parameters have 
been defined. 

 
 An empty gray octagon with a diagonal line 

indicates that the parameters are not used in a MACCS 
simulation because they are not needed under the current 
choices. This symbol also indicates that not all the 
parameters have been defined. 

Choose ATMOS/Property Form 
Parameters. 

Double-click on the word METCOD. 

The Property Form Parameters form opens. At the bottom 
of the form, the parameter type "Integer" and range of 
values "[1,5]" is shown, as well as a description of the 
METCOD variable. Values on this form cannot be modified 
as indicated by the grey background; the values indicate 
choices made on GENERAL/Properties/Properties form. 

Click inside the other parameter boxes 
in the Property Form Parameters 
window. 

Notice that the parameter type, range, and description 
change for each variable. 

Close the property form by clicking OK 
or Cancel. 

Property Form Parameters form closes. 
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User action WinMACCS response 

Open the ATMOS/Deposition category 
by clicking on the + button. 

 

Notice that this entry on the Parameters tab contains a list 
of several forms, namely Wet/Dry Depos Flags, Wet 
Deposition, and Dry Deposition. The category, Deposition, 
contains many forms. The icon next to a category name 
summarizes the state of those forms.  

  A solid green octagon means the information under 
that category is required and has been properly specified. 
This also means that there are no optional parameters in 
this category. No more user attention is required. 

Click on the ATMOS/Radionuclides 
category. 

Notice that the Pseudostable Radionuclides form is 
optional. Adding Pseudostable Radionuclides may influence 
the results, but you are not required to add them in order to 
run a MACCS simulation. However, an unstable decay 
product of an included radionuclide must either be listed as 
a radionuclide or a pseudostable radionuclide.  

 An orange diamond, empty or solid, indicates that 
there is at least one optional form in this category. 

 
 A crossed red octagon means that there are forms 

in this category containing parameters that must be defined 
or corrected before proceeding with a MACCS simulation. 

 
 A crossed orange diamond means that there are 

optional forms in this category that need to be corrected 
before proceeding with a MACCS simulation. 

Click on the COMIDA2/Model Basis 
category. 

Notice that none of these forms are used in a simulation. 
This is consistent with the current model settings on the 
GENERAL/Properties/Properties form.  

All forms in this category have a grey symbol; 
hence the category symbol is grey. No user attention is 
required. 
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Table 5-3 Changing the main model to early only. 

User action WinMACCS response 

Click on the + sign next to General. Click 
the + sign next to Properties. 
Double-click on the solid green octagon 
next to Properties. 

The Project Properties window opens with tabs showing 
different model options. The model definition state is 
displayed in color at each of the tab headings. A solid green 
octagon indicates that the data have been defined; if there 
were an empty red octagon on this form, it would indicate 
that the data were not defined or the data were inconsistent 
with other choices. 

Click on the check box next to the 
heading Early Consequences. 

Both check boxes Early Consequences (EARLY) and Late 
Consequences (CHRONC) are unchecked. If Early 
Consequences is unchecked, it is not possible to run the 
Late Consequences model. The choice means that only 
Atmospheric Dispersion (ATMOS) is run in the simulation. 

Click on the tab labeled Dispersion. 

 

Notice that the Properties form is the location where 
modeling choices are made. When the Dispersion tab is 
clicked the symbols next to the heading prefixes are 
updated to reflect that Atmospheric Dispersion is the only 
main module considered. 

Only tabs relevant to the ATMOS module, namely Scope, 
Dispersion, Weather, and Plume/Source, have a solid 
green octagon next to them in this example. The rest of the 

headings are prefixed with a solid gray octagon 
containing a diagonal line, indicating the model 

selections are valid but are not needed. 

Click on the Scope tab.  
 

Notice that all the labels within the Parameters tab in the 
Project window under the EARLY heading continue to have 
green and orange icons associated with them, even though 
the Early Consequences check box is unchecked. 

Click the Show Required Forms button. The EARLY module is temporarily deactivated. 

Notice that the symbols within the Parameters tab in the 
Project window in the EARLY category now have grey 
octagons associated with them.  

Click on the check box next to the 
heading Early Consequences. 

Click the OK button to save the model 
settings. 

By clicking OK, the simulation only calculates ATMOS and 
EARLY results. 

The Project Properties window closes.  
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Table 5-4 Run a simulation. 

User action WinMACCS response 

Choose Execute→Run Models… on the 
top menu. 

The Run Models window opens. 

Click the button labeled Advanced… The Advanced Execution Parameters window opens. 

Uncheck the check box labeled Delete 
Atmos, Early, Chronc and COMIDA2 
input files. 

Click OK. 

All check boxes should be unchecked. This ensures that all 
intermediate files are not deleted. 

Click Run Simulation. 

A message box is displayed as follows: 

“Do you want to save the project 
changes?” 

Click “Yes” or type the Enter key to save 
the project changes. 

Before running a simulation, the user is prompted to save 
the changes made to modeling parameters.  

A minimized command window is 
created. 

Bring the command window to the 
foreground to see the progress of the 
MACCS simulation.  

WinMACCS executes the run and shows the steps in the 
process in the Results window at the bottom of the screen 
(e.g., “Verifying data are defined”).  

Trials listed in the command window refer to calculating 
results for each weather trial. 

After the simulation has completed, notice one of the 
messages written in the Results window is “Model 
execution SUCCESSFUL,” indicating that the simulation 
was successful. If an error had occurred, an error condition 
would have been reported in the Results window. 

Close Run Models box by clicking on the 

. 
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Table 5-5 Viewing simulation results. 

User action WinMACCS response 

Click on the Files tab on the bottom of 
the Project window. 

Above the tab, WinMACCS shows a list containing the 
following headings: Data, Input, and Output. 

Click the + next to Input.  Notice that four files have been created as follows: 

atmosTemplate.txt, earlyTemplate.txt, Atmos1.inp, 
Early1.inp. 

Atmos1.inp and Early1.inp contain model input parameters 
to MACCS. The file atmosTemplate.txt is identical to 
Atmos1.inp because there are no uncertain parameters 
specified in this project. Similarly, earlyTemplate.txt and 
Early1.inp are identical. The template files contain 
placeholders for uncertain values when these are specified. 

Double-click on the Atmos1.inp file in 
the Input category. 

Atmos1.inp opens in Notepad. 

Notice that the creation date of the input file and version of 
WinMACCS is reported on the first line. 

Close Atmos1.inp by clicking on the 
. 

The text editor closes. 

Click on the + next to the Output 
category. 

Notice that one file is listed as follows: 

When the model was run, MACCS results were written to 
Model1.out. 

File Model1.bin is also present and contains binary results. 
This is not shown in the WinMACCS interface but is read by 
WinMACCS. The information read is saved in the 
/Results_DB folder and is used to create custom reports 
and plots upon request. 

Double-click on Model1.out.  Notepad starts and Model1.out opens.  

Notice that the creation date of the output file and version of 
MACCS is reported on the first line. 

Search for the second occurrence of the 
label AVERAGE INDIVIDUAL RISK. 
Select the row titled ERL FAT/TOTAL 
0.2-0.5 km. (The early fatality risk 
considering all radionuclides to the 
average individual at a spatial range of 
.2 to .5 km.) 

The second number in the row (mean risk) should be 
6.20E-06, reflecting a weighted combination of evacuating 
and non-evacuating cohorts.  

Values can also be located reflecting evacuation risk for 
scenario one (0.0) and non-evacuation risk for scenario two 
(1.24E-03). 

Close Model1.out by clicking on the 
. 

The text editor closes. 
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Table 5-6 Sample effect of changing a single input parameter. 

User action WinMACCS response 

Click on the Parameters tab in the 
Project window. 

Find ATMOS/Release 
Description/Inventory Scale Factor. 
Double-click on CORSCA. 

Radionuclide Inventory Scaling Factor window opens. 

Modify the value of CORSCA from 1.0 to 
2.0. 

Click OK. 

Radionuclide Inventory Scaling Factor window closes. 

Choose Execute→Run Models on the 
top menu. 

Click Run Simulation. 

Wait until the simulation has completed. 

WinMACCS executes run with the changed input. 

This may cause WinMACCS to display a warning that 
Model1.out already exists. 

In the Results window the text “Model execution 
SUCCESSFUL,” is displayed indicating that the simulations 
were successful. 

Open the file Model1.out found in the 
Output category. 

Search for the first occurrence of the 
label AVERAGE INDIVIDUAL RISK. 
Select the row titled ERL FAT/TOTAL 
0.2-0.5 km.  

The mean of AVERAGE INDIVIDUAL RISK ERL 
FAT/TOTAL 0.2-0.5 km from all causes should be larger 
than before (i.e., 6.50E-05 as compared with 6.20E-06). 

Close Model1.out. The text editor closes. 
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Table 5-7 Changing parameters from deterministic to uncertain. 

User action WinMACCS response 

Click on the Parameters tab. 

Open the category EARLY/Additional 
Emergency Cohorts by clicking on the +. 

Select Edit→Project Properties from the 
main window. 

Click the Evac/Rotation tab. 

Change the Number of Cohorts from 2 to 
1. 

Click OK. 

EARLY/Additional Emergency Cohorts graphic is now grey. 
This means that there is only one evacuation scenario to be 
considered. 

Open the parameter modification form 
that contains the parameter WTFRAC by 
selecting Edit→Find Parameter 
Window… 

from the main menu. 

Scroll down to WTFRAC using the scroll 
bar.  

Click on WTFRAC.  

Click OK. 

Change the value of parameter WTFRAC 
to 1. 

Click OK. 

Parameter WTNAME has the value PEOPLE. This means 
that the population fraction, WTFRAC, is considered for 
each cohort (defined on the Edit→Project Properties, Site 
Data tab). The previous run had two evacuation cohorts. The 
value of WTFRAC associated with cohort 1, 0.995, meant 
that 99.5% of the people would evacuate according to the 
parameters specific to cohort one. The value of WTFRAC 
associated with scenario 2, no evacuation, was set to 0.005 
(defined on the EARLY/Additional Emergency 
Cohorts/Emergency Cohort Two/Basic Parameters form). 
Because all values of WTFRAC must sum to one, WTFRAC 
needed to be set to 1. 

Using the Edit→Find Parameter Window 
open the form associated with parameter 
ESPEED. 

Parameter ESPEED is displayed in a grid. There are three 
rows shown corresponding to the Initial, Middle and Late 
evacuation phases for cohort one. 

Notice that the tree displayed on the Parameters tab is 
expanded and the parameters on the form, Phase Durations 
and Evacuee Travel Speeds for Cohort One, are listed in the 
Project window in the category EARLY/Emergency Cohort 
One/Phase Durations and Speeds. 

Double click the text box associated with 
ESPEED in row number one or click that 
text box and click the Make Uncertain 
button. 

A dialog opens with the caption ESPEED(1). 

A pull-down menu of distribution types next to the label 
Distribution is shown with CONSTANT indicated. 

Note: to change a distribution from uncertain to 
deterministic, open the distribution window and change the 
distribution to CONSTANT. It is not possible to type in a 
constant in a box on a parameter modification form that has 
been set to be uncertain. 

Click on the down arrow and select 
Uniform. Enter 0.9 in the text box labeled 
Lower Limit. Enter 3.6 in the text box 
labeled Upper Limit. 

Click OK. 

The uncertain value has been associated with parameter 
ESPEED(1). The background of the text box associated with 
ESPEED(1) is shaded and contains the text UNCERTAIN. 
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User action WinMACCS response 

Set ESPEED(2) and ESPEED(3) to a 
Uniform distribution using the same 
parameters used for ESPEED(1). 

Click OK in the Phase Durations and 
Evacuee Travel Speeds for Cohort One 
window. 

Only when OK is clicked in the main parameter modification 
form (e.g., Evacuee Travel Speed for Scenario One) are the 
uncertain values saved. 

Set parameter SCLADP to a UNIFORM 
distribution where the Lower Limit is 0.5 
and the Upper Limit is 1.5. 

Click the OK button in the Plume Rise 
Data Window. 

 The background of the text for parameter SCLADP on the 
form Plume Rise Data is shaded and contains the text 
Uncertain. 

Choose File→SaveAs Project.  

Change directory to WinMACCS 
Projects. 

Specify “sample 1 uncertain” for the 
Project name. 

WinMACCS creates a new project, sample 1 uncertain. 

Choose Execute→Run Models. 

Click on the button Advanced… 

Type 3 in the box labeled Number of 
Simulations. 

Click the OK button. 

Number of simulations is now three. 

Click the Run Simulation button. 

Click Yes when prompted to save the 
project. 

Wait for the simulations to finish.  

MACCS runs three times, creating three results files, 
model1.out, model2.out and model3.out. 

Click on the Files tab on the bottom of 
the Project window. 

Above the tab, WinMACCS shows a list containing the 
following headings: Data, Input, and Output. 

Click the + next to Input.  WinMACCS created MACCS input files Atmos1.inp, 
Early1.inp, Atmos2.inp, Early2.inp, Atmos3.inp, Early3.inp, 
one set of files for each realization from LHS using the data 
in LHS.out. 

Double-click on the input file for Latin 
Hypercube Sampling, LHS.inp.  
 

LHS.inp, a file created by WinMACCS, contains a summary 
of uncertain parameters and their distributions. The Latin 
Hypercube Sampling program, LHS, is run with input as 
reported in this file: 

ESPEED(1) UNIFORM 0.9 3.6 

ESPEED(2) UNIFORM 0.9 3.6 

ESPEED(3) UNIFORM 0.9 3.6 

SCLADP UNIFORM 0.5 1.5. 

Open the file in the Input folder created 
by LHS, LHS.out. 

File shows a list of mean values for each parameter and the 
sampled values. 

Close LHS.inp and LHS.out.  The text editors close. 

Click on the + next to Output. Model1.out, Model2.out and Model3.out are displayed. 
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User action WinMACCS response 

Choose PostProcessing→Report 
Results→Manage Custom Reports 

Click on the radio button labeled 
Combine Realizations. Click on the 
button New. 

Click on the column labeled Include for 
the first two entries labeled Spatial 
Intervals for Output. 

Click on the column labeled Include for 
all the entries where the Report 
Description column is labeled Population 
Dose. There are three entries. 

Enter report name Atmos Summary and 
Population Dose. 

Click OK to close the Custom Combined 
Report form. 

Define a new custom report. 

A copy of the MACCS output requests created by 
WinMACCS are shown in the grid. These entries are found 
in the MACCS input files. 

 

Click the Select check box to choose the 
report Atmos Summary and Population 
Dose. 

Select the radio button labeled View. 
Click the Apply button. 

Report defined in the previous step is created and is 
displayed in the Notepad text editor. 

In the report, scroll down to Request 3 
Population Dose.  

Notice that the columns labeled Probability of Exceedance 
are based on quantiles specified on the form 
GENERAL/Output Options/Reporting Options found on the 
Parameters tab. The reported data are based on binned 
CCDF tables. Variation of values for any given LHS 
simulation is due to weather sampling. These CCDF tables 
can be viewed in the MACCS output when the Report Option 
parameter is set to CCDF or CCDF & REPORT for the 
Output Control form of interest (e.g., EARLY/Ouput 
Control/Population Dose). 

Notice the following message is displayed for request 3: 

Unable to transform CCDF; No differences in probability 
values in CCDF. 

This is because the population dose was zero from 0 to 
16.09 km and did not change for the set of weather trials.  

In the report, scroll down to the entry 
labeled Request 4 Population Dose. 

 

The Population Dose corresponding to combining the LHS 
realizations is shown as follows:  

Evacuation Evac # 1 L-ICRP60ED [0.E+00,80.47](km)  

                   Grand Mean    

Population Dose (Sv)  1.36E+03  

Note: The custom reports can be used to report overall 
statistics when multiple realizations are being calculated with 
sampled variables. However, it can also be used to 
conveniently calculate additional quantile information using 
the binned CCDF results from MACCS.  
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User action WinMACCS response 

Close report. The text editor closes. 

The report, Atmos Summary and Population Dose.txt, can 
also be opened by double clicking on this named entry 
Output category found on the Files tab.  

Note: It is possible to summarize the output without 
combining the data from the realizations. When creating a 
new report, select the radio button labeled Realization 
Based on the Manage Reports form instead of the Combine 
Realizations button. 

Double-click on General/Output 
Options/Reporting Options on the 
Parameters tab to open the Reporting 
Options form. 

A form labeled Reporting Options opens. 

Clear all old entries by clicking the erasor 
icon. 

Enter the following quantiles: 

0.01, 0.25, 0.50, 0.75, 0.99. 

Click OK. 

Note: Rows can be deleted in a grid by selecting the row and 
pressing the Delete key on the keyboard. 

New rows can be added to the grid by clicking on the text in 
a row and selecting Edit →Grid →Insert Rows. 

A new row can be added to the bottom of the grid by typing 
in the text area of the last row.  

Create a new summary report by 
selecting PostProcessing→Report 
Results→Manage Custom Reports. 

Click the Select check box to choose the 
report Atmos Summary and Population 
Dose. 

Select the radio button labeled View. 
Click the Apply button. 

Data corresponding to user chosen quantiles are calculated 
by interpolating values from the binned CCDF’s that MACCS 
calculates. 
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Table 5-8 Viewing results as plots. 

User action WinMACCS response 

Choose PostProcessing→Graphical 
Results→Results over all Weather 
Trials. 

A Results Over All Weather Trials window opens with the 
version of MACCS used in the simulation displayed in the 
Window caption. 

Click the + next to Centerline Ground 
Concentration 

Click on Plume 1 CS-137[5.63, 8.05] 
(km) 

Click on Add. 

Result is placed on chart. There is a single plot 
corresponding to each of the three simulations. 

Click Modify Axis. The Modify Axis Bounds window opens with options for X- 
and Y-axis and their bounds. In addition, the user may 
choose a linear or a logarithmic scale for X and Y. The 
minimum and maximum values must be specified for the 
logarithmic scale; the linear scale can either be automatically 
set or manually set by the user. 

Click Cancel in the Modify Axis Bounds 
window. 

The Modify Axis Bounds window closes. 

Select PostProcessing→Graphical 
Results→Edit Plots→Modify Titles. 

Close the Modify Titles window by 
clicking the Cancel button. 

The plot title and axis labels can be modified. 

Click the Select button on the plot 
window three times. 

The data points representing the complementary cumulative 
distribution function (CCDF) are shown. Notice that the 
sample numbers, LHS1, LHS2, and finally LHS3 are shown.  

The bottom of the plot window displays details describing the 
selected plot series in blue lettering. 

Click the Select button again. The plot is now in an unselected state. Notice that the bottom 
of the plot window displays the words “Selected Series: 
NONE.” 

Click the Bulls-eye button. The plotted values are now displayed as text. Click and drag 
to draw a rectangle from upper left corner to lower right to 
zoom in on the plot. Click and drag from lower right to upper 
left to un-zoom. 

Click the Bulls-eye button again. The text values are no longer displayed. 

Select PostProcessing→Graphical 
Results→Edit Plots→Export Plot. 

A Save As window appears. Notice the different file formats 
available, including JPEG image, MS Excel, and ASCII text. 

Enter "MyData" in the text box labeled 
File Name. 

Select Windows BMP Image (*.bmp) in 
the Save as Type pull-down menu. 

Type the name of the file, MyData. Do 
not type an extension. 

Click Save.  

WinMACCS saves the data as a .bmp file called MyData.bmp 
into the \WinMACCS Projects\sample 1 uncertain\Output 
directory. This file can be opened in MS Paint. 

Double-click on file MyData.bmp in the 
Output directory found under the Files 
tab in WinMACCS. 

The .bmp file opens in the associated application, usually MS 
Paint. 
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5.2 Tutorial Two 

What follows is a description of how to import a MACCS input set into WinMACCS.  This is 
necessary when there are MACCS input files that have been used outside of the WinMACCS 
environment. 

Table 5-9 Create a new project based on a MACCS input set. 

User action WinMACCS response 

Double-click on the WinMACCS icon on 
the desktop or select WinMACCS from 
the WinMACCS group from the Windows 
Start Menu. 

WinMACCS starts and displays pull-down menus on the top 
of the screen. File and Help are accessible. 

Choose File→Open Project 

Open file Point Estimates LNT.mxd 
found in directory C:\WinMACCS 
Samples\NRC Sample Problems\Point 
Estimates LNT. 

Sample project Point Estimates LNT is opened. 

The following path is displayed in caption of main window:  

C:\WinMACCS Samples\NRC Sample Problems\Point 
Estimates LNT. 

Choose Execute→Run Models from the 
main menu. 

The run models window is open. 

Click the button labeled Advanced… The Advanced Execution Parameters window opens. 

Uncheck the check box labeled Delete 
Atmos, Early, Chronc and COMIDA2 
input files. 

Click OK. 

All check boxes should be unchecked. This ensures that all 
intermediate files are not deleted. The MACCS input files are 
created in the previous exercise, but are deleted because 
the box labeled Delete Atmos, Early, Chronc and COMIDA2 
input files is checked. 

Click Run Simulation. 

Click No when asked when you want to 
save the project changes. 

WinMACCS creates input files every time the Run Simulation 
button is checked. A simulation is run.  

Choose File→Close Project. 

When prompted “Do you want to save 
the project changes?” click No. 

Sample problem is closed. The following MACCS input files 
have been created. These files are in the project folder as 
follows: 

Maccs.tmp, 

\Input\Atmos1.inp, 

\Input\Early1.inp, and 

\Input\Chronc1.inp. 
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User action WinMACCS response 

Open an ASCII text editor such as 
Windows Notepad. 

Open the file C:\WinMACCS 
Samples\NRC Sample Problems\Point 
Estimates LNT\Maccs.tmp in the editor. 

Some of the files used by the MACCS simulation are listed. 
This file is read by MACCS. The full path is referenced, but 
only the file name is indicated below. These are as follows: 

Line 1: ATMOS input file 

Atmos1.inp 

Line 2: EARLY input file 

Early1.inp 

Line 3: CHRONC input file 

Chronc1.inp 

Line 4: Meteorological data file 

metsurMxHt_60min.inp 

Line 5: Site data file 

FicticiousSite.inp 

Line 6: Output data file, specified name of results file written 
by MACCS 

Model1.out. 

The file Early1.inp contains the name of the DCF file on line 
labeled DCF_FILE001 as follows: 

Data\Fgr13dcf.inp. 

Chronc1.inp contains the name of the COMIDA2 binary file 
on line labeled BIN_FILE001  

Data\fgr13samp_a.bin. 

Close the ASCII text editor. The text editor closes. 

Choose File→New Project. 

Navigate to the folder WinMACCS 
Projects.  

Enter the name Sample 2 in the Project 
Name field.  

Click OK. 

A new project is created. The Project Properties form is 
opened. This form is used to select the appropriate models 
for the simulation. 

Notice that only the ATMOS model is checked. This is the 
default setting for new projects. 

Click the Cancel button in the form titled 
Project Properties. 

It is not necessary to select models when importing MACCS 
input files such as Atmos1.inp. WinMACCS defines the radio 
buttons and check boxes in the Project Properties form 
dependent on the values in the imported files. 
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Table 5-10 Import Atmos1.inp, Early1.inp and Chronc1.inp. 

User action WinMACCS response 

On the Parameters tab of the Project 
window, click the plus sign, +, to the left of 
the headings GENERAL, ATMOS, 
EARLY and CHRONC. 

Notice the crossed red octagons next to categories of data 
in the GENERAL and ATMOS categories indicating that 
data are required but are not yet defined.  

Notice the filled in green octagon next to the heading 
Property Form Parameters. These are parameters that are 
defined and can be changed only by using the Project 
Properties form. These are set to default model settings.  

Notice the slashed grey octagons in the EARLY and 
CHRONC categories. These data are not required because 
Early Consequences and Late Consequences have not 
been checked on the Project Properties form. 

Select File→Import MACCS Input File 
from the main menu.  

Select the ATMOS input file titled 
Atmos1.inp in the directory 
C:\WinMACCS Samples\NRC Sample 
Problems\Point Estimates LNT\Input\. 

Click Open. 

The file Atmos1.inp is read by WinMACCS. The data in this 
file is loaded into the interface. The progress of processing 
this file can be seen in the WinMACCS Results window.  

The ATMOS crossed red octagons have turned into solid 
green octagons, indicating that the data on these forms are 
now defined. 

The EARLY model is now on. This is because a variable, 
ENDAT1, in the file Atmos1.inp, was set to .FALSE. 
indicating that the EARLY model should be executed.  

Observe stage one of the import process. 

Expand the Results window by moving 
the mouse to the Title bar on that window.  

When the mouse pointer turns to a 
double-sided arrow, hold the left mouse 
button down while dragging towards the 
main window caption.  

Release the mouse button to resize the 
window. 

Models are normally turned on or off in 
WinMACCS using the Project Properties 
form. This is done automatically when 
reading in a MACCS file. 

The first line shown in the Results window indicates the 
name of the file that is being imported is as follows: 

Importing MACCS input file C:\WinMACCS Samples\NRC 
Sample Problems\Point Estimates LNT\Input\Atmos1.inp. 

The next line shows that the file is being read to determine 
which models are turned on in WinMACCS.  

Processing input lines that define models 

The next set of lines report which lines of Atmos1.inp are 
used to determine the model settings.  
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User action WinMACCS response 

The models that are set in WinMACCS 
can be viewed or changed on the 
Properties form that can be opened by 
selecting Edit→Project Properties from 
the main menu. 

Open the form Project Properties 

Click on the Dispersion tab. 

This tutorial covers all the logic used to define WinMACCS 
model settings from the MACCS input files. However, 
dispersion is offered as a single example to increase 
understanding of this process. 

Some project property settings defined on the Project 
Properties form are translated into parameter values. These 
parameter values can be observed by opening the forms 

ATMOS/Property Form Parameters, 

EARLY/Property Form Parameters, and  

CHRONC/Property Form Parameters 

Notice that the dispersion model is set to Lookup Tables in 
the Project Properties form. When the MACCS parameter 
NUM_DIST is equal to zero in the imported file, the 
dispersion model is set to Power Law Functions 
(NUM_DIST=0). 

Often, there is a direct correspondence between a model 
setting and the value of a MACCS imported parameter (e.g., 
NUM_DIST). In these cases, the value of the MACCS input 
parameter is part of the model label shown on the Project 
Properties form. 

Open the file Atmos1.inp in an ASCII text 
editor such as Notepad.  

Search for the character string 
NUM_DIST001 

Notice that the value is set to 50. 

Recall, the MACCS input file Atmos1.inp can be found in the 
following folder: C:\WinMACCS Samples\NRC Sample 
Problems\Point Estimates LNT\Input\. 

The input lines that are used to define the models are 
shown in the Results window, e.g., Saving MACCS Data for 
input line: NUM_DIST. 

Setting this value to a nonzero quantity indicates that the 
source of the dispersion data is the form 
ATMOS/Dispersion/Dispersion Table.  

Observe stage two of the import process. 

The parameters relevant to the updated 
model settings are extracted from the file.  

Lines are processed until a period in 
column one is encountered. This is 
considered the end of the data to be 
imported in stage two. 

In the second stage, only the data relevant to the current 
model settings are extracted. The file is read for the second 
time. 

Example output in the Results window from the second pass 
is: 

Processing input lines for file Section 1 

Saving MACCS Data for input line: RIATNAM1 

Observe stage three of the import 
process. 

In the last step in the import process, 
WinMACCS looks for multiple cohort 
data. When other cohorts (i.e., change 
card sets) are present, they are separated 
by a period in column one. 

EARLY model input sets created by 
WinMACCS may contain up to twenty 
cohorts to support multiple evacuation 
scenarios. 

There was no additional scenario data present.  

Example output from stage three is as follows: 

Processing input lines for file Section 2 

No data to import for file Section 2 

WARNING - Check the Properties form for model settings. 

When importing older MACCS input files, some models are 
not specified. 

This concludes the import of the ATMOS input file.  

Repeat the import process and import the 
file Early1.inp and Chronc1.inp. 

Notice that two evacuation cohorts were defined in the 
Early1.inp file. WinMACCS properly processes this and sets 
the parameters accordingly. 
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Table 5-11 Define additional forms. 

User action WinMACCS response 

Click on the Parameters tab of the Project 
Window.  

Click on the plus sign, +, next to the label 
GENERAL. 

Notice that the File Specification category has an 

associated icon as follows:  

This indicates that attention is needed.  

Click the plus sign, +, to the left of the 
heading GENERAL\Properties. Double 
click on the form name Problem 
Description. 

Enter some text in the box. 

Click OK. 

Notice that the form Problem Description is an optional 

form, as indicated by the diamond shaped icon:  

After the file is defined, the diamond becomes filled. 

The text entered becomes comments in the MACCS 
input files.  

Click the plus sign, +, to the left of the 
heading GENERAL\File Specifications. 
Double click on the form name 
Meteorological File. 

Notice that all file specifications for the project are listed 
in the category File Specifications.  

The form titled Specify Meteorological File opens. 

Click on the button labeled Browse. Locate 
file titled metsurMxHt_60min.inp. 

A copy of this file is in C:\WinMACCS 
Samples\NRC Sample Problems\Point 
Estimates LNT\Data\. 

Click OK.  

A copy of this file is made and placed in the current 
projects \Data directory. 

Recall that the name of this file was referenced in the file 
Maccs.tmp. 

Define the site file by double clicking on 
the form name GENERAL/File 
Specifications/Site File.  

Click on the Browse button to find the file 
FicticiousSite.inp in the directory 
C:\WinMACCS Samples\NRC Sample 
Problems\Point Estimates LNT\Data\.  

Click OK. 

Notice that the number of angular directions shown is 16. 
WinMACCS opens and reads FicticiousSite.inp to 
determine this value. When the user needs to change the 
number of angular directions on the evacuation grid on 
an existing site file, the Create New button can be used 
to create a new site file based on the older site file. It is 
preferable to create a new site file using the program 
SecPop. 

A copy of this file is made and placed in the current 
projects /Data directory. 

Answer Yes to the following questions 
shown in the message box:  

Do you want to update the spatial grid to 
be consistent with the site file? 

This response causes WinMACCS to update the values 
of the parameter SPAEND. SPAEND and the site file 
should be consistent. NUMCOR is updated to be 
consistent with the number of angular directions specified 
on the site file independent of the answer given in the 
message box. 

Recall that the name of this file was referenced in the file 
Maccs.tmp. 

Open the form DCF File.  

Specify the file Fgr13dcf.inp in the 
directory C:\WinMACCS Samples\NRC 
Sample Problems\Point Estimates 
LNT\Data\. 

Click OK. 

A copy of this file is made and placed in the current 
projects /Data directory. 

The name of this file can be found in the file Early1.inp on 
the line containing the keyword DCF_FILE001.  

The data files can be opened by clicking on the Files tab 
of the Project window, clicking on the + next to the word 
Data, clicking on the file of interest (e.g., Site File), and 
double clicking on the file name. 
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User action WinMACCS response 

Open the form COMIDA2 File. Specify the 
file fgr13samp_a.bin in the directory 
C:\WinMACCS Samples\NRC Sample 
Problems\Point Estimates LNT\Data\. 

Click OK. 

A copy of this file is made and placed in the current 
projects /Data directory. 

The name of this file can be found in the file Chronc1.inp 
on the line containing the keyword, BIN_FILE001.  

MACCS requires that this binary file was created using 
the specified DCF file (in this example Fgr13dcf.inp) 
using the COMIDA2 preprocessor. 

Click the plus sign, +, to the left of the 
heading CHRONC. 

Notice there are no errors. Interface should appear as 
follows: 
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Table 5-12 Execute new project. 

User action MACCS response 

Select Execute→Run Models from the 
main menu. Click on the Run Simulation 
button on the Run Models form. 

Click on the entry on the task bar: 

 

The progress is displayed in the command prompt window.  

 

Successful execution can be verified by observing that the 
Results window contains the following: 

Running model as follows: 

"C:\Program Files\WinMaccs\MACCS.exe" -i "C:\WinMACCS 
Projects\Sample 2\Maccs.tmp" -p "Model1" 

Model execution SUCCESSFUL 

OK  

Run Completed  

 

5.3 Guidelines for Creating and Importing Projects 

The following are a few guidelines for creating a new project from scratch: 

• When a new project is created by selecting File→New Project from the main menu, the 
WinMACCS Properties form is opened. The settings on this form should be reviewed 
and changed as needed. After this has been reviewed, click OK to save the settings. 
These settings determine which subsequent forms are required, not required, or 
optional. 

• Starting at the top of the Parameters tab, fill in the required forms in order. There are six 
main models listed, namely GENERAL, ATMOS, EARLY, CHRONC, DOSE 
COEFFICIENTS, and COMIDA2. Each contains many forms, however only the data in 
the required forms are used. A form is not required when the icon to the left of the form 
name is a grey octagon with diagonal line. Forms with orange diamond shaped icons are 
optional. The Project Properties form can be modified as desired. It is not required that 
the forms be filled out in order, but it may be helpful because information on some forms 
is required before other forms can be completed. Filling out the forms in order avoids 
any conflicts. 

• When the X-ed red octagons have been converted to solid green octagons, select 
Execute→Run Models from the main menu. Click on Run Simulation to run. Look in the 
Results window to verify that the execution was successful. The output files from the 
execution can be opened by double clicking on the file names on the Files tab. 

• It may be easier to debug the input when only the ATMOS model is enabled the first time 
MACCS is executed. After ATMOS is running successfully, change the main model to 
include EARLY on the Properties form. When needed, continue with CHRONC and 
COMIDA2 as each set of model input is debugged. 
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The following are a few guidelines for importing a project from MACCS input files: 

• When importing MACCS input files, the improved Briggs model is always used unless 
Original MACCS 1.12 Briggs Model is manually checked on the Plume Rise tab of the 
Project Properties form. To recreate results consistent with MACCS 1.12, it is helpful for 
the plume rise model to be consistent. 

• ATMOS input for MACCS 1.12 supported multiple source terms using change card sets. 
This is not supported with WinMACCS for ATMOS. Any additional change card sets in 
an imported card set is considered to be related to additional evacuation cohorts only. 
However, multiple source terms can be modeled by using the MACCS Cyclical File Set 
feature found on the Scope tab of the Project Properties form. Multiple Source terms can 
also be modeled by selecting the Multi Source Term check box on the Plume/Source 
tab. This process requires input files in a format compatible with MelMACCS version 
1.7.3 (or greater) output files. However, this function causes the multiple source terms to 
be modeled in a single consequence analysis; the Cyclical File Set option performs a 
consequence analysis for each source term, one at a time.  

• When importing an ATMOS input deck created using MACCS 1.12, it is necessary to 
manually define the chemical group names, GRPNAM. 

• Before importing an EARLY input file, when the DCF file used is not based on Federal 
Guidance Report FGR-13, it is necessary to manually specify this on the Dose tab of the 
Project Properties form. For example, when the DCF file was created by the 
preprocessor DOSFAC2, the form EARLY/Model Basis/Organs of Risk DOSFAC2 is 
required. Similarly, the form EARLY/Model Basis/Organs of Risk FGR-13 is required 
when the DCF file was created from FGR-13 data. Neither form is required when the 
DCF file is of type FGRDCF (based on FGR-11 and FGR-12). 

• When importing an EARLY input file, the number of evacuation cohorts are not 
decreased from the number specified on the Project Properties tab. However, the 
number may be increased when more cohorts are specified than is defined on the 
Project Properties tab. This can be manually changed by using the Evac/Rotation tab of 
the Project Properties form. This is by design because of considerations with respect to 
the MACCS Cyclical File Set option that uses the same import algorithms. 

• When importing a CHRONC input deck created using MACCS 1.12, the 
CHRONC/Shielding and Exposure form is not defined. To be consistent with older 
version of MACCS, the value used for the Shielding and Exposure parameters defined 
for Normal Activity in Early should be used, as shown in Table 5-13. 
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Table 5-13 Defining CHRONC shielding and exposure. 

User action WinMACCS response 

Click on the + next to the headings 
GENERAL, EARLY and CHRONC when 
these headings are not already open. 

Double click on the form name Shielding 
and Exposure in CHRONC. 

 

Notice that the CHRONC parameters LPROTIN, 
LBRRATE and LGSHFAC are not defined. These are 
new parameters that do not have images in the imported 
file. 

Open the form EARLY/Emergency Scenario 
One/ Shielding and Exposure 

Enter the related data in the row labeled 
Normal into the CHRONC/Shielding and 
Exposure form. 

Adding these CHRONC parameters ensures that 
consistent values are independent of choices for the 
EARLY evacuation cohorts. Before this modification, 
MACCS used the values used in the last EARLY 
evacuation cohort for the CHRONC calculation; 
however, the documentation did not make this clear. 
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6. SITE FILE FORMAT 

6.1 Format Overview 

A site file contains the population distribution and land use information for the region surrounding 
the site subject to user inputs.  It contains the radial and azimuthal intervals used to define the 
grid, the population within each grid element, the fraction of the area that is land, watershed data 
for the liquid pathways model, information on agricultural land use and growing seasons, and 
regional economic information.  An example of a site file is provided in NUREG/CR-4691, 
Volume 1, Appendix D.2. 

Site files for sites within the continental US are usually created by SecPop. Users should consult 
NUREG/CR-6525, Rev. 2 (Weber et al., 2019), for details on using SecPop.  The latest version, 
SecPop 4.3.1, produces four types of result files as follows: 

• A file ending with _REAcct.econ that is required when using the RDEIM economic model 

• A file ending with _REAcct_Extended.tsv that is in tab-separated format, contains 
information like the previous file, and is convenient for examining in a spreadsheet. This 
file is not currently used by MACCS.  

• A file ending with _Site.inp that is the standard site file required by MACCS 

• A file ending with _Site_Extended.tsv that is in tab-separated format, contains 
information like the previous file but treats each grid element as its own economic 
region, and is convenient for examining in a spreadsheet. This file is not currently used 
by MACCS. 

On the Site Data tab of Properties form, the user specifies whether a site data file is to be used. 
When it is not used, the population density applied in the EARLY and CHRONC modules are 
specified on the EARLY/Model Basis/Population Data form. Beyond a user-specified radius 
representing the exclusion area boundary, this density is applied uniformly over the grid.  

The site file used in MACCS is a fixed-format file.  The data must appear exactly as described 
below and in the same order.  

The file is fixed format, which requires care to align the values into their proper fields. Any numeric 
items specified in exponential format (e.g., 1.E-6) must be right-justified in the field because 
trailing blanks are processed as zeros. To prevent errors due to right justification, it is 
recommended that a decimal point be used, and the exponential portion of the field is indicated 
using the letter E as in 1.E-6. When this recommendation is followed, the number to the right of 
the FORTRAN format descriptor (e.g., the 2 in F8.2 or E8.2) is ignored and only the field length 
is considered (e.g., the 8 in F8.2). 

The FORTRAN fixed field input rules for an edit descriptor Fw.d or Ew.d are as follows.  The input 
field consists of an optional sign, followed by a string of digits optionally containing a decimal 
point. When the decimal point is omitted, the rightmost d digits of the string are interpreted as the 
fractional part of the value represented.  The basic form may be followed by an exponent of one 
of the following forms: 

(1). Signed integer constant (e.g., 1.-6 means 1.E-6) 

(2). E followed by zero or more blanks followed by an optionally signed integer exponent. 
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Users are cautioned that site files use a fixed format. Site files are formatted correctly by SecPop, 
but there are some reasons for the user to manually edit the site file, e.g., to add a transient 
population or to modify the watershed information. Sites outside the continental US must be 
constructed manually or with other software. Failure to conform to the formatting requirements for 
a site file may lead to incorrect results in a MACCS calculation.  

When using SecPop to create a site file, quality assurance information is written to the first two 
lines that includes the version identification of SecPop and parameter settings used to create the 
site data file. For example, the first two lines in the sample site file distributed with WinMACCS 
are as follows: 

SECPOP Version: 4.3.0 SVN:2242 FileType: MACCS_Site Project: "Fictitious" Census: 
"C:\Program Files (x86)\SecPop\Census\Census2010.bin" County: "C:\Program Files 
(x86)\SecPop\Census\County2012.dat" 

Lat: 36d11'35'' Long: 115d58'55'' Latitude: 36.193058 Longitude: 115.98194 
Population_multiplier: 1.0 Economic_multiplier: 1.0 Run_Time: 2016/02/04_12:28:56 

 
Following the descriptive text fields, there are six records that specify the amount of data that are 
contained in the file. The values defined on these data records must be consistent with values 
defined in WinMACCS. The data are input as integers in FORTRAN (I4) format.  The integers 
must be right justified in the four-character input field. 

Some of the parameters defined in the site file must agree with parameters defined in WinMACCS. 
However, when the parameter is not required by WinMACCS, agreement is not required.  For 
example, when the CHRONC model is not selected, parameters such as NFICRP, NUMWPI are 
not required to be defined in WinMACCS.  When the MACCS Food Model is not selected, the 
CROP parameters are not used by WinMACCS.  The parameters listed in Table 6-1 are required 
to be defined in the site file even though they may not be used by MACCS to perform calculations. 
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Table 6-1 Basic site file parameters. 

Line in 
site file 

Columns 
FORTRAN 

Format 

MACCS 
Parameter 

Name 
Allowed Values Description 

Example line 
from 

FicticiousSite.inp 

3 1 to 4 I4 NUMRAD 2 to 35  

Must agree with 
WinMACCS 
variable 
NUMRAD 

Number of 
radial intervals. 

26 SPATIAL 
INTERVALS 

4 1 to 4 I4 NUMCOR 16, 32, 48 or 64 

Must agree with 
WinMACCS 
parameter 
NUMCOR. 

Number of 
sectors in the 
spatial grid. 

16 WIND 
DIRECTIONS 

5 1 to 4 I4 NFICRP 1 to 10 

Must agree with 
WinMACCS 
parameter 
NFICRP 

Number of crop 
categories that 
are to be used 
by the food 
pathway model 

7 CROP 
CATEGORIES 

6 1 to 4 I4 NUMWPI 1 to 10 

Must agree with 
WinMACCS 
parameter 
NUMWPI 

Number of 
radionuclides in 
drinking water 
pathway 

4 WATER 
ISOTOPES 

7 1 to 4 I4 NUMWPA 1 to 4 Number of 
watersheds 

1 WATERSHED 

8 1 to 4 I4 NECRGN 1 to 99 Number of 
economic 
regions 

97 ECONOMIC 
REGIONS 

 

SECPOP2000 only supports NUMCOR equal to 16. SecPop 4.0 and later allow the values of 
NUMCOR to be 16, 32, 48 or 64. WinMACCS can create a new site file that supports NUMCOR 
equal to 32, 48 or 64 based on an existing site file.  This feature can be accessed on the 
WinMACCS form GENERAL/File Specifications/Site File.  This is useful when WinMACCS user 
a finer grid resolution than the original site file. When not using a site data file, WinMACCS 
assumes one watershed. Water ingestion data for each radionuclide considered in the water 
pathway are defined in the WinMACCS parameter WINGF for one watershed only.  Only by using 
the site data file can more water pathways be specified. In this case, MACCS uses the ingestion 
factor read from the site file.  The format for input of the ingestion data is described below. SecPop 
enters constants for these values with the intention that they can be edited by the user if needed. 

Eight blocks of site data follow the introductory block described in Table 6-2.  Each of these data 
blocks are summarized in Table 6-2 and are introduced by a separator line that identifies the block 
of the data to follow. Data block separators start in column 2 and are right justified. 
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Table 6-2 Site file data blocks. 

Data block 
in site file 

Columns 
FORTRAN 

format 
First line of data 

block 
Description of data block 

1 2 to 23 A22 SPATIAL 
DISTANCES 

Defines the distance to the outer radii 
of each grid element 

2 2 to 23 A22 POPULATION Defines the population of each grid 
sector 

3 2 to 23 A22 LAND FRACTION Defines the fraction of land of each 
grid sector 

4 2 to 23 A22 REGION INDEX Defines the economic region for each 
grid sector. 

5 2 to 23 A22 WATERSHED 
INDEX 

Defines the appropriate watershed to 
use for each grid sector 

6 2 to 23 A22 CROP SEASON 
AND SHARE 

Defines parameters associated with 
crops 

7 2 to 23 A22 WATERSHED 
DEFINITION 

Defines water ingestion data for each 
watershed 

8 2 to 23 A22 REGIONAL 
ECONOMIC DATA 

Economic data for each economic 
region defined 

 

6.2 Spatial Distances Data Block 

The spatial distances data define the spatial grid for which the population and some other data 
are specified.  The data define the distances in kilometers to the endpoints of the spatial intervals.  
The areas between the spatial interval endpoints within each of the 16, 32, 48 or 64 direction 
sectors are referred to as grid elements.  This grid definition must agree with the grid defined by 
the ATMOS input parameter SPAEND. MACCS reads the spatial intervals distances in the site 
file and compares the values with SPAEND.  If MACCS allows a relative error of 10%, but only 
the ATMOS values for SPAEND are used in calculations.  For larger discrepancies in the 
geometry data, an error flag is set and execution terminates upon completion of the site data file 
input processing.  WinMACCS sets the values of SPAEND to be identical with the values in the 
site data file, so it is not possible to have any difference between the spatial distances data block 
in the site file and SPAEND. 

The first line of the spatial distance data block contains the 22-character separator beginning with 
SPATIAL DISTANCES in column 2.  Next, the endpoint distances in kilometers are specified, up 
to eight values per line, using the format described below, using as many lines as needed.  The 
minimum spacing between adjacent spatial intervals is 0.1 km.  

The first interval endpoint is in columns 1–10, the second interval endpoint is in columns 11–20, 
etc.  The values must be right justified within the ten columns allotted.  The values are input as 
real numbers. 

Table 6-3 Spatial Distnaces Data 

Parameter Name Dimensions 
FORTRAN 

Format 
Allowed Values Description 

SPAEND NUMRAD 8E10.2 0.05 to 9999.0 km Radial spatial intervals 
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6.3 Population Data Block 

The population data for each element in the spatial grid is defined here.  The first line of the data 
block contains the 22-character separator beginning with POPULATION in column 2.  Next, the 
number of people in each element is given for the first sector, which is centered on north.  The 
sector number increases in the clockwise direction.  

The population data are input as real numbers; fractional values are supported.  The population 
data for up to eight grid elements may be defined per line and the data are input in ten column 
intervals; i.e., the population of the first element is in columns 1–10, the population in the second 
element is in columns 11–20, etc.  The data must be right justified in the ten columns allotted to 
that value.  

Table 6-4 Population Data 

Parameter 
Name 

Dimensions 
FORTRAN 

Format 
Allowed 
Values 

Description 

POPDAT NUMRAD by 

NUMCOR 

8E10.0 0.0 to 109 Number of people living 
in grid element 

 

MACCS combines evacuation scenarios using one of three different algorithms specified by a 
parameter WTNAM.  This parameter can be set to PEOPLE, TIME or SUMPOP.  This parameter 
is defined on the Site Data tab in WinMACCS.  

When WTNAM is set to PEOPLE, the EARLY variable, WTFRAC, specified per cohort, represents 
the fraction of the population that belongs to the cohort.  When WTNAM is set to TIME, the EARLY 
parameter WTFRAC represents the fraction of time (i.e., probability) that this evacuation scenario 
is applicable.  With this option, the entire population follows an evacuation scenario a fraction of 
the time.  When the parameter WTNAM is set to SUMPOP, population data for each evacuation 
scenario are defined in the site data file as described below. 

When WTNAM is set to TIME or PEOPLE the population data block is delimited with the header 
record POPULATION beginning at column 2, followed by the population data.  

When the SUMPOP option is selected, the header lines for each population data block are 
POPULATION1, POPULATION2, and POPULATION3, corresponding to the corresponding 
emergency-phase cohorts, all beginning in column 2. MACCS reports an error when the number 
of population data blocks does not equal the number of emergency-phase cohorts defined in the 
EARLY input file. 

6.4 Land Fraction Data Block 

The fraction of each spatial element that is land (as opposed to lakes, oceans, etc.) is defined for 
each grid element. The first line of the data block contains a 22-character separator beginning in 
column 2, the character string LAND FRACTION. Next, the fraction of area that is land in each 
radial spatial interval of the first sector is given. All values must be between 0 and 1. A value of 0 
means the grid element has no land, a value of 1 means the element is all land.  The land fraction 
data are specified, 16 values per line, using the format described below. As many lines as needed 
to define all the spatial intervals in the sector are used. The land fraction data for the second and 
subsequent sectors follow in clockwise order.  The values for each sector begin on a new line. 
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The land fraction data are read as real numbers and land fractions values each occupy five 
columns. The values must be right justified in the five columns allotted. 

Table 6-5 Land Fraction Data 

Variable 
Name 

Dimensions 
FORTRAN 

Format 
Allowed 
Values 

Description 

FRCLND NUMRAD by 

NUMCOR 

16F5.2 0.0 to 1.0 Fraction of sector 
that is land 

 

6.5 Region Index Data Block 

In this data block the user assigns a user-defined economic region to each of the spatial intervals. 
The values defining each of the economic regions are in the regional economic data block.  The 
data for each sector begins on a new line. 

The first line in the Region Index data block contains a 22-character separator beginning in 
column 2 and containing the character string REGION INDEX.  The next line contains two-digit 
integers associating a region index with each of the spatial elements in the first sector, which 
limits the number of regions to 99.  For example, a region index of 09 means that economic data 
for region number nine is used to define the grid element.  Though the FORTRAN format, 40I2, 
supports up to forty values per line, the number of values considered on each line is NUMRAD.  
Each sector starts a new line and they are ordered in the clockwise direction.  For example, when 
the spatial grid is divided into 16 sectors, there are a total of 16 lines of data starting with north 
and ordered clockwise around the compass. 

Each value must be right justified in the two columns allotted.  The values are integers. 

Table 6-6 Region Index Data 

Parameter 
Name 

Dimensions 
FORTRAN 

Format 
Allowed 
Values 

Description 

INDREG NUMRAD by 

NUMCOR 

40I2 1 to NECRGN Economic region 
associated with sector 

 

6.6 Watershed Index Data Block 

Each of the spatial intervals in the grid must be associated with one of the watershed indices.  
The watershed identification data block begins with a 22-character separator beginning in 
column 2 containing the character string WATERSHED INDEX.  The next line contains two-digit 
integers associating a watershed type for each of the grid elements in the first sector.  Data for all 
sectors must be provided.  The data for each sector begins on a new line.  

A watershed index of 1 means that the water ingestion factor for watershed type 1 is used for all 
deposition in that grid element. A watershed index of 2 means that the water ingestion factor for 
watershed type 2 is used for all deposition in that spatial element. Though the FORTRAN format, 
40I2, supports up to forty values per line, the number of values on each line should be NUMRAD. 
The number of lines in this data block is the number of compass sectors, a new line for each 
sector ordered in a clockwise fashion starting from north.  
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Table 6-7 Watershed Index Data 

Parameter 
Name 

Dimensions 
FORTRAN 

Format 
Allowed Values Description 

INDWTR NUMRAD by 

NUMCOR 

40I2 1 to NUMWPA Watershed index 
associated with sector 

 

6.7 Crop and Season Share Data Block 

The length of the growing season and the average fraction of the farmland area at the site devoted 
to each crop type must be specified.  These fractions need not sum exactly to 1, but their sum 
should not exceed a value of 1.  When these values sum to a value less than 1, that sum indicates 
the fraction of farmland in production in an average year (some fraction of farmland may be 
fallow). Values must be specified for each of crop type.  

This information is used only when MACCS Food Model is specified on the Food tab in 
WinMACCS; it is not used when the MACCS Food Model is not used, but the values are required, 
nonetheless. 

When MACCS Food Model is specified on the Food tab in WinMACCS, the crop names must 
agree with the parameter NAMCRP. The data block begins with the separator CROP SEASON 
AND SHARE in column 2. This is followed by NFICRP lines of data. 

Table 6-8 Crop and Season Share Data 

Parameter 
Name 

Columns 
FORTRAN 

Format 
Allowed Values Description 

I 1 to 4 I4 1 to NFICRP Crop Index, line 
number starting at 1 

CROP 6 to 25 A20 When the MACCS Food Model 
is selected, must match with a 
value in vector NAMCRP 

Name of crop group. 

GBEG 26 to 30 F5.0 1 to GEND Day of the year the 
growing season begins 

GEND 31 to 35 F5.0 GBEG to 365 Day of the year the 
growing season ends 

FRCLCP 36 to 45 F10.0 0.0 to 1.0 Fraction of the site-
averaged farmland 
devoted to this Crop 

 

6.8 Watershed Definition Data Block 

The data block begins with a 22-character separator beginning in column 2 containing the 
character string WATERSHED DEFINITION.  For each of the radionuclides considered in the 
liquid pathways model, a single line is supplied.  Exactly NUMWPA ingestion factors are supplied 
on each line.  Values supplied override values of WinMACCS parameter WINGF when defined. 
MACCS supports up to 10 radionuclides in the liquid pathway model. 



 

6-8 

Table 6-9 Watershed Definition Data 

Parameter 
Name 

Columns 
FORTRAN 

Format 
Allowed Values Description 

I 1 to 4 I4 1 to NWPISO Radionuclide Index, line 
number starting at 1 

NMISO 6 to 13 A8 Should match WinMACCS 
parameter NAMIPI when defined. 
Otherwise, should match a value 
in vector NUCNAM. 

Radionuclide name 

WTRINF(1) 36 to 45 E10.1 to 1.0 Ingestion Factor for 
Watershed Class 1 

WTRINF(2) 46 to 55 E10.1 0.0 to 1.0 Ingestion Factor for 
Watershed Class 2 

WTRINF(3) 56 to 65 E10.1 to 1.0 Ingestion Factor for 
Watershed Class 3 

WTRINF(4) 66 to 75 E10.1 to 1.0 Ingestion Factor for 
Watershed Class 4 

 

6.9 Regional Economic Data Block 

Economic data must be specified for each of the economic regions.  The data block begins with 
the separator REGIONAL ECONOMIC DATA in column 2.  An economic region is typically 
identified with the name of a county, state, or country to provide an indication of the source of the 
data or the type of geographical area it is intended to represent.  The economic regions defined 
in this section are identified with spatial elements in the Region Index data block.  There is a line 
for each one of the economic regions. 

Table 6-10 Regional Economic Data 

Parameter 
Name 

Columns 
FORTRAN 

Format 
Allowed Values Description 

I 1 to 4 I4 1 to NECRGN Region index, starting with 1 

NMRGN 6 to 15 A10  Name of region 

FRMFRC 21 to 25 F5.3 0.0 to 1.0 Fraction of land devoted to farming 

DPF 26 to 30 F5.3 0.0 to 1.0 Fraction of farm sales from dairy 

ASFP 31 to 40 F10.1 0.0 to 109 $/hectare Total annual farm sales 

VFRM 41 to 50 F10.1 0.0 to 109 $/hectare Farmland property value 

VNFRM 51 to 60 F10.1 0.0 to 109 $/person Non-farmland property value 

 

6.10 Sample Site Data File 

This is an example site file for a fictitious site located in Pahrump, Nevada, USA.  It includes 16 
compass sectors, 26 spatial intervals, uses one watershed, and has 98 economic regions.  It uses 
the 2010 Census for population and 2012 economic data.  Multipliers for population and economic 
values are both set to unity.  Crop season and watershed definition are defaults from SecPop and 
must be edited manually if they need to be modified.  
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SECPOP Version: 4.3.0 SVN:2242 FileType: MACCS_Site Project: "Fictitious" Census: 

"C:\Program Files (x86)\SecPop\Census\Census2010.bin" County: "C:\Program Files 

(x86)\SecPop\Census\County2012.dat" 

Lat: 36d11'35'' Long: 115d58'55'' Latitude: 36.193058 Longitude: 115.98194 

Population_multiplier: 1.0 Economic_multiplier: 1.0 Run_Time: 2016/02/04_12:28:56 

  26 SPATIAL INTERVALS 

  16 WIND DIRECTIONS 

   7 CROP CATEGORIES 

   4 WATER PATHWAY ISOTOPES 

   1 WATERSHEDS 

  98 ECONOMIC REGIONS 

 SPATIAL DISTANCES     KILOMETERS 

    0.1600    0.5200    1.2100    1.6100    2.1300    3.2200    4.0200    4.8300 

    5.6300    8.0500   11.2700   16.0900   20.9200   25.7500   32.1900   40.2300 

   48.2800   64.3700   80.4700  112.6500  160.9300  241.1400  321.8700  563.2700 

  804.6700 1609.3400 

 POPULATION 

        0.        0.       44.        3.        9.      198.        0.       12. 

       29.       43.       96.      536.       25.        0.        0.        1. 

        0.        0.        0.        0.        0.       94.      203.    48711. 

   153798.  2143468. 

        0.       13.      235.       61.        0.        8.       35.        5. 

        0.        5.        0.        0.        0.        0.        5.        0. 

        2.      746.        0.        0.     1193.      136.      678.    18438. 

   949973.   929596. 

        0.        0.        4.        0.       17.       16.        0.        0. 

        0.        0.        0.        0.        0.        0.       10.       82. 

        0.     5237.        0.        0.        3.     3741.     9992.   129062. 

  1669744.   676429. 

        0.        0.        0.       15.        5.       42.        0.        0. 

      148.        0.        0.        0.        0.        0.      212.      220. 

      292.    18068.     8387.        0.     8549.   109552.    93470.    18927. 

   284016.  5256346. 

        0.        7.        0.       57.       73.      327.        0.        0. 

        0.        0.        0.        0.        0.        0.        3.        0. 

      152.   254610.   848885.   365223.      255.     1224.      500.    68862. 

   358505.  2331523. 

        0.        0.      159.       42.       31.      198.      171.      167. 

        0.       97.        5.       11.        0.        0.        0.        0. 

      107.    22919.   211576.   177910.      465.    58248.     2876.   355158. 

   147099.  2542701. 

        0.        0.       50.       15.       72.      298.      288.      303. 

       16.     1266.     1273.       10.        0.        0.        0.        0. 

      609.     1677.      169.      354.      935.    97790.    54566.  4173727. 

  1169129.    20674. 

        0.       29.       46.       79.       66.      283.      148.      130. 

      154.      605.     1963.      316.        2.       10.       45.        0. 

        0.       48.        5.       42.       46.       65.    29179.   203628. 

      106.        0. 

        0.        0.        7.       33.      333.      266.      329.      627. 

      340.     1449.      218.      311.        0.       16.        4.        0. 

        0.        0.        0.      743.       25.    63475.   412494.   199515. 

        0.        0. 

        0.        0.        0.       24.        5.      215.      284.       66. 

       25.      144.        0.        0.        0.        0.        6.        0. 

      137.        0.        0.        0.    10691.   287689.  3724726.  4275018. 

        0.        0. 

        0.       36.        0.        0.       81.      305.      283.      196. 

       46.        0.        0.        0.        0.        5.        0.       31. 

       13.        0.        0.        0.       11.   147077.  6849804.  5136399. 

        0.        0. 

        0.        0.       83.      175.      123.      425.      193.      304. 

      323.      494.       79.        0.        0.        0.        0.        0. 

        0.        0.        0.        0.     2024.    65914.   648666.   647997. 

        0.        0. 

        0.        0.      155.      131.       42.      352.      392.      307. 
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      214.      343.     1846.       74.        0.        0.        0.        3. 

        0.        0.        0.       16.       56.      688.   581198.  1608661. 

      652.        0. 

        0.        0.        0.       71.      114.      436.      616.      240. 

      461.     1494.     1536.       42.        9.        0.        0.        0. 

       89.        0.      344.      101.        3.     4595.    31218.  6807141. 

  4594572.     2463. 

        0.        0.       38.       98.      471.       92.      345.      362. 

      320.     1130.     1871.      957.      126.        0.       13.        0. 

       30.     1058.      270.     1002.       28.      330.     1578.   863619. 

   660171.   795687. 

        0.        0.        5.       60.       80.       18.       67.       33. 

       37.      500.     1571.     1242.       14.        0.        0.      100. 

        7.        0.        0.        0.        4.     2720.     1712.    37428. 

    15288.  9114675. 

 LAND FRACTION 

 0.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.99 

 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 0.00 0.00 0.00 1.00 1.00 

 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.92 0.99 

 0.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.98 0.99 0.99 

 0.00 1.00 1.00 1.00 1.00 1.00 0.00 0.00 1.00 0.98 0.93 1.00 1.00 0.00 1.00 1.00 

 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.98 1.00 0.99 

 0.00 0.99 1.00 1.00 1.00 1.00 0.00 0.00 0.00 1.00 0.00 0.00 0.00 0.00 1.00 1.00 

 1.00 1.00 1.00 0.94 0.85 0.99 1.00 1.00 1.00 1.00 

 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

 1.00 1.00 1.00 1.00 0.98 0.99 1.00 1.00 1.00 1.00 

 0.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

 1.00 1.00 1.00 1.00 0.98 0.99 0.99 1.00 1.00 1.00 

 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 

 0.00 0.00 1.00 1.00 0.99 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

 1.00 1.00 1.00 1.00 1.00 1.00 0.94 0.96 0.00 0.00 

 0.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 1.00 0.00 0.00 1.00 1.00 

 1.00 1.00 1.00 1.00 1.00 1.00 0.99 0.80 0.00 0.00 

 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 1.00 1.00 0.00 1.00 1.00 1.00 

 1.00 1.00 1.00 1.00 1.00 1.00 0.99 0.62 0.00 0.00 

 0.00 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.00 0.00 1.00 1.00 

 1.00 1.00 1.00 1.00 0.98 0.99 1.00 0.87 0.00 0.00 

 0.00 0.00 1.00 1.00 1.00 0.99 1.00 1.00 1.00 1.00 1.00 1.00 0.00 0.00 1.00 0.99 

 1.00 1.00 0.99 1.00 1.00 0.99 1.00 0.94 0.40 0.00 

 0.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

 1.00 0.99 1.00 0.99 1.00 1.00 0.98 0.98 0.88 0.69 

 0.00 0.00 1.00 1.00 0.99 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.96 0.98 0.94 

 0.00 0.00 1.00 0.98 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.98 1.00 1.00 

 1.00 1.00 1.00 1.00 1.00 1.00 1.00 0.99 0.98 0.95 

 REGION INDEX 

 1 3 4 4 4 4 4 4 4 4 4 4 4 4 4 4 5 4 6 7 8 910828298 

 1 4 4 4 4 4 4 4 4 4 3 3 3 3111213131415161718838398 

 1 3 4 4 4 4 4 4 3 4 4191313131313131320212223848498 

 1 4 4 4 4 4 3 3 4 4241313 3131313131313252627858598 

 1 4 4 4 4 4 3 3 3 4 3 3 3 3131313131313282930868698 

 1 4 4 4 4 4 4 4 3 4 4 41313131313131313313233878798 

 1 3 4 4 4 4 4 4 4 4 4 43413131313353637383940888898 

 1 4 4 4 4 4 4 4 4 4 4 441424344454647474747488989 3 

 1 3 4 4 4 4 4 4 4 4 449505050505147474747525390 3 3 

 1 3 4 4 4 4 4 4 4 4 350 3 350505455474747475691 3 3 

 1 4 4 4 4 4 4 4 4 35750 35050505058474747596092 3 3 

 1 3 4 4 4 4 4 4 4 46162 3 350505050506364656693 3 3 

 1 3 4 4 4 4 4 4 4 4 467 3 35050505050505068699494 3 

 1 4 4 4 4 4 4 4 4 4 4 4 4 4 47071725050507374959598 

 1 3 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 47576777879969698 

 1 3 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 48081979798 

 WATERSHED INDEX 
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 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

 CROP SEASON AND SHARE 

   1 PASTURE               90. 270.  0.4100 

   2 STORED FORAGE        150. 240.  0.1300 

   3 GRAINS               150. 240.  0.2100 

   4 GRN LEAFY VEGETABLES 150. 240.  0.0020 

   5 OTHER FOOD CROPS     150. 240.  0.0040 

   6 LEGUMES AND SEEDS    150. 240.  0.1500 

   7 ROOTS AND TUBERS     150. 240.  0.0030 

 WATERSHED DEFINITION  -- INITIAL AND ANNUAL WASHOFF AND INGESTION FACTORS 

   1 Sr-89                           5.00E-06       0.0 

   2 Sr-90                           5.00E-06       0.0 

   3 Cs-134                          5.00E-06       0.0 

   4 Cs-137                          5.00E-06       0.0 

 REGIONAL ECONOMIC DATA 

   1 EXCLUSION       .000 .000        .0        .0        .0 

   2 EMPTY02         .000 .000        .0        .0        .0 

   3 EMPTY03         .000 .000        .0        .0        .0 

   4 Nye04           .006 .000    2675.0    5531.0  325945.0 

   5 MIX_CNTY05      .006 .000    2635.1    5745.5        .0 

   6 MIX_CNTY06      .005 .000    2589.3    5791.5        .0 

   7 MIX_CNTY07      .004 .000    2075.2    4290.7        .0 

   8 MIX_CNTY08      .003 .000    1497.8    3096.9        .0 

   9 MIX_CNTY09      .004 .000    2099.9    4341.8  278872.3 

  10 MIX_CNTY10      .005 .000    2511.3    5331.2  325945.0 

  11 MIX_CNTY11      .003 .000    1080.0   14111.0  359500.0 

  12 MIX_CNTY12      .005 .000    2150.7    8351.3        .0 

  13 Clark13         .003 .000    1080.0   14111.0  359500.0 

  14 MIX_CNTY14      .003 .000    1079.9   14110.3        .0 

  15 MIX_CNTY15      .000 .000       2.7      35.0        .0 

  16 Lincoln16       .000 .000        .0        .0  261817.0 

  17 MIX_CNTY17      .001 .000     617.0    1275.7  261817.0 

  18 MIX_CNTY18      .002 .001     486.8    1620.2  368899.1 

  19 MIX_CNTY19      .004 .000    1681.0   10878.0        .0 

  20 MIX_CNTY20      .003 .000    1017.4   13293.0        .0 

  21 MIX_CNTY21      .000 .000      34.2     447.5  261817.0 

  22 MIX_CNTY22      .014 .005      32.5    1235.3  262068.2 

  23 MIX_CNTY23      .172 .133    1195.1    4544.1  254878.7 

  24 MIX_CNTY24      .003 .000    1080.0   14111.0        .0 

  25 MIX_CNTY25      .002 .000     831.6   10865.9  359500.0 

  26 MIX_CNTY26      .094 .006     217.8   40749.5  291911.2 

  27 MIX_CNTY27      .131 .037     192.5   37899.7  270410.3 

  28 MIX_CNTY28      .059 .000     679.8   39357.5  330392.3 

  29 MIX_CNTY29      .128 .000     190.1   70249.3  261836.0 

  30 MIX_CNTY30      .376 .000      27.0  309321.1  334469.2 

  31 MIX_CNTY31      .104 .000     356.6   59747.0  272337.5 

  32 Mohave32        .146 .000      60.0   78456.0  261836.0 

  33 MIX_CNTY33      .241 .000      79.6  155479.9  287032.1 

  34 MIX_CNTY34      .004 .000    1448.4   12129.4        .0 

  35 MIX_CNTY35      .004 .051    2397.4   15520.1  359002.3 

  36 MIX_CNTY36      .004 .108    3908.4   17345.3  359500.0 
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  37 MIX_CNTY37      .004 .179    5776.0   19480.8  354342.9 

  38 MIX_CNTY38      .014 .249    7537.0   26199.0  358495.8 

  39 MIX_CNTY39      .095 .214    6035.3   61683.1  271843.2 

  40 MIX_CNTY40      .093 .054    1542.5   51014.8  269887.5 

  41 MIX_CNTY41      .007 .000    2615.5    5468.3  325945.0 

  42 MIX_CNTY42      .025 .000    1504.1    4919.9  374168.5 

  43 MIX_CNTY43      .038 .000     445.0    5605.8  418105.5 

  44 MIX_CNTY44      .048 .000     201.4    3532.4        .0 

  45 MIX_CNTY45      .039 .180    5128.1   11304.4        .0 

  46 MIX_CNTY46      .007 .659   18361.4   33720.8  307340.0 

  47 San_Bern47      .006 .669   18636.0   34186.0  307340.0 

  48 MIX_CNTY48      .054 .174    7152.4   21712.8  310148.9 

  49 MIX_CNTY49      .023 .000    1673.8    4475.6  325945.0 

  50 Inyo50          .051 .000     146.0    2865.0  422392.0 

  51 MIX_CNTY51      .046 .075    2224.9    6386.5        .0 

  52 MIX_CNTY52      .006 .666   18571.0   34139.4  307340.3 

  53 MIX_CNTY53      .085 .133    7674.7   27115.0  311830.5 

  54 MIX_CNTY54      .042 .135    3873.5    9179.2  422392.0 

  55 MIX_CNTY55      .036 .222    6286.0   13265.8        .0 

  56 MIX_CNTY56      .061 .274   10340.4   31195.3  342463.5 

  57 MIX_CNTY57      .018 .000    2004.4    4824.1        .0 

  58 MIX_CNTY58      .048 .036    1148.5    4563.2        .0 

  59 MIX_CNTY59      .121 .468   13731.4   28287.7  310216.5 

  60 MIX_CNTY60      .057 .045    6120.4   31832.6  443771.9 

  61 MIX_CNTY61      .006 .000    2647.9    5502.4  325945.0 

  62 MIX_CNTY62      .050 .000     199.0    2920.9        .0 

  63 MIX_CNTY63      .035 .240    6793.3   14125.2        .0 

  64 MIX_CNTY64      .029 .453   12671.0   24123.4  312914.7 

  65 MIX_CNTY65      .413 .157    5060.7   13126.1  336839.9 

  66 MIX_CNTY66      .424 .115    4527.7   13533.2  337157.7 

  67 MIX_CNTY67      .024 .000    1637.8    4437.6  365045.1 

  68 MIX_CNTY68      .269 .277    5042.5   13256.6  376652.8 

  69 MIX_CNTY69      .417 .392    7587.6   18887.0  311376.9 

  70 MIX_CNTY70      .009 .000    2478.8    5324.2        .0 

  71 MIX_CNTY71      .049 .000     229.4    2952.9  327028.7 

  72 MIX_CNTY72      .049 .000     228.0    2951.4        .0 

  73 MIX_CNTY73      .094 .044    1067.0    4921.6  422392.0 

  74 MIX_CNTY74      .343 .070    5391.2   17111.6  394223.3 

  75 MIX_CNTY75      .006 .000    2674.4    5530.4  325945.0 

  76 MIX_CNTY76      .007 .000    2602.8    5454.9  325945.0 

  77 MIX_CNTY77      .018 .000    1903.3    4775.2  332834.1 

  78 MIX_CNTY78      .024 .000     802.5    4269.0  447628.5 

  79 MIX_CNTY79      .015 .000     584.1    4300.2  408604.4 

  80 MIX_CNTY80      .007 .000    2469.8    5429.5  339779.0 

  81 MIX_CNTY81      .006 .000    2338.6    5144.8  325945.0 

  82 MIX_CNTY82      .183 .126     916.5    3266.3  358653.5 

  83 MIX_CNTY83      .240 .114     794.5    4224.6  333545.4 

  84 MIX_CNTY84      .207 .091     571.4    4251.9  358974.7 

  85 MIX_CNTY85      .162 .008     260.7   13629.7  341927.2 

  86 MIX_CNTY86      .500 .010      34.1  183740.1  303938.2 

  87 MIX_CNTY87      .334 .012     167.6  145198.8  299802.0 

  88 MIX_CNTY88      .152 .149    1830.4   35440.3  364356.0 

  89 MIX_CNTY89      .070 .006    7822.9   10749.2  259639.5 

  90 MIX_CNTY90      .140 .019    8597.2   31095.0  330385.6 

  91 MIX_CNTY91      .086 .038    7810.2   45764.2  494904.5 

  92 MIX_CNTY92      .159 .000    8860.2   35902.6  453981.2 

  93 MIX_CNTY93      .458 .022    4370.8   18134.3  456231.0 

  94 MIX_CNTY94      .576 .076    5302.3   15582.4  400578.5 

  95 MIX_CNTY95      .472 .094    3086.1   18982.9  528965.4 

  96 MIX_CNTY96      .175 .023     676.9    8584.3  405306.7 

  97 MIX_CNTY97      .125 .046     533.9    3165.3  400316.2 

  98 MIX_CNTY98      .601 .039     626.9    4428.2  412895.8 
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7. METEOROLOGICAL FILE FORMAT 

7.1 Format Overview 

When running WinMACCS, a weather model is selected using the Weather tab when it is needed. 
When one of the file sampling methods is chosen, a meteorological file is required.  It is also 
required when modeling a weather sequence starting with a day and time period from the weather 
file.  

Data must be provided for a 365-day year.  The file consists of either fifteen-minute, thirty-minute, 
or hourly averages.  Each line of the file contains the Julian day of the year, the time period of the 
day, wind direction, wind speed, atmospheric stability class, and precipitation rate.  Most 
commonly, the data are taken from a weather station at the site or from a nearby weather station. 

The meteorological data file is a formatted text file.  The first two lines of contain identification 
information. Up to 80 characters may be used on each line.  This header information is printed on 
the output listing.  

Table 7-1 Meteorologica Data Indentification Information 

Line in Met 
file 

FORTRAN 
Format 

Allowed 
Values 

Description 

1 and 2 A80 N/A File identifying information. Should 
contain quality assurance information. 

 

The default recording interval for the weather data is an hour.  When 30-minute or 15-minute 
averaging times are used, the next line is required. When this line is omitted in the meteorological 
file, a period of 60 minutes is assumed. 

Table 7-2 Meteorological Data Interval Information 

Columns 
FORTRAN 

Format 
Allowed 
Values 

Description 

1 to 7 A7 /PERIOD Keyword that identifies parameter 

9-10 I2 60, 30 or 15 Time-averaging period for values in the 
file 

 

The possible values for the parameter WINDIR depend on the WinMACCS parameter NUMCOR. 
WinMACCS and MACCS allow NUMCOR to be 16, 32, 48, or 64.  The value should be consistent 
with NUMCOR in in WinMACCS and in the site data file when a site data file is used.  It is up to 
the user to select or create a meteorological file that is consistent with the value of NUMCOR 
used in MACCS.  If the meteorological file is based on fewer sectors than NUMCOR, no error 
message is created, but the results reported by MACCS are not calculated correctly.  If the 
meterological file contains values for WINDIR that exceed the value of NUMCOR, MACCS stops 
with a fatal error. 

NUMCOR can be optionally defined using a line following the /PERIOD line, or following the last 
comment line if the /PERIOD line is missing. 
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Table 7-3 NUMCOR Allowable Values 

Columns 
FORTRAN 

Format 
Allowed 
Values 

Description 

1 to 7 A7 /NUMCOR Keyword that identifies parameter 

9-10 I2 16, 32, 48 or 64 Number of compass directions. The 
parameter WINDIR must be a positive 
number less than or equal to this value. 

 

This is followed by a line for each recorded period.  There are 8760 lines when the period is 1 hr; 
there are 17520 lines when the time period is 30 min; there are 35040 lines when the period is 15 
min.  

Table 7-4 Weather Period Data 

Columns 
FORTRAN 

Format 
Variable 

Allowed 
Values 

Description 

2 to 4 I3 ISTRDY 1 to 365 Julian day of the year 

6 to 7 I2 ISTRHR 1 to 96 Interval of the day. Should not 
exceed 24 when period is 60 min; 
48 when period is 30 min; 96 
when period is 15 min.  

9 to 10 I2 WINDIR 1 to NUMCOR Direction of wind. 1 is north and 
the number increases in the 
clockwise direction.  

11 to 13 I3 WINDSPD 1 to 300* Units are 0.1 m/s.  

14 I1 ISTAB 1 to 7** Stability category. Value 
corresponds to Pasquill stability 
class A through G.  

15 to 17 I3 RNMM -1 to 999*** Rain rate in units of 0.01 in/hr.  

*  Values less than 5 are automatically changed to 5 (0.5 m/s). Values greater than 300 result in an error.  

**  A value of 7 is automatically changed to 6 by the code. 

*** Some meteorological data files use –1 to indicate a trace of precipitation during the hour.  

 MACCS interprets these values to be 0. 

Following these lines of input is a line with eight values of mixing layer height.  The units for these 
values are 100 m.  Two values of mixing height are supplied for each of the four seasons of the 
year. The first four of these values correspond to morning (average daily minimum) mixing heights 
and the final four values correspond to afternoon (average daily maximum) mixing heights.  

The FORTRAN format for these values is F10.0.  This means that the input field is ten characters 
long and should be right justified when no decimal point is included (i.e., any blanks to the right 
of the number within the field of 10 characters are interpreted as zeros).  To reduce the possibility 
of an error, it is recommended that a decimal point be used.  Engineering format can also be used 
(e.g., 1.4E1).  A real number within the allowed range of 1 to 100 (100 m to 10,000 m) is allowed.  
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Table 7-5 Mixing Height Data 

Columns 
FORTRAN 

Format 
Variable 

Allowed 
Values 

Description 

1 to 10 F10.0 HEIGHT(1,1) 1 to 100  Morning winter mixing height. Units are 100 m.  

11 to 20 F10.0 HEIGHT(2,1) 1 to 100  Morning spring mixing height. Units are 100 m. 

21 to 30 F10.0 HEIGHT(3,1) 1 to 100  Morning summer mixing height. Units are 
100 m. 

31 to 40 F10.0 HEIGHT(4,1) 1 to 100  Morning autumn mixing height. Units are 100 m. 

41 to 50 F10.0 HEIGHT(1,2) 1 to 100  Afternoon winter mixing height. Units are 100 m. 

51 to 60 F10.0 HEIGHT(2,2) 1 to 100  Afternoon spring mixing height. Units are 
100 m. 

61 to 70 F10.0 HEIGHT(3,2) 1 to 100  Afternoon summer mixing height. Units are 
100 m. 

71 to 80 F10.0 HEIGHT(4,2) 1 to 100  Afternoon autumn mixing height. Units are 
100 m. 

 

7.2 Sample Meteorological Data File 

A sample set of records from the meteorological data file is provided, which shows the first and 
last ten records of the file. NUMCOR is assumed to be 16. The weather conditions for day one, 
hour one (record number three) are: wind direction—blowing toward the SE, wind speed of 2.6 
m/s, stability category 4 (D), and precipitation rate of 0.07 in/hr (1.8 mm/hr) during the hour. The 
winter, spring, summer, and autumn mixing heights for neutral and unstable conditions (record 
8763) are all 1200 m. 

U.S. NATIONAL WEATHER SERVICE METEOROLOGICAL DATA FILE 
Sample Input for the MACCS Documentation 
 1    1  70264  7 

 1    2  60624  7 

 1    3  80414  2 

 1    4  80364 -1 

 1    5  90314  0 

 1    6 110464  0 

 1    7 110264 -1 

 1    8 110414 -1 

 . 

 . 

 . 

 365 16 120154  4 

 365 17 110154  4 

 365 18 130214  4 

 365 19 130154  3 

 365 20 130104  2 

 365 21 130154  2 

 365 22 140104  2 

 365 23 130104  2 

 365 24 140104  2 

       12.       12.       12.     1.2E1        12        12        12        12 
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8. DOSE CONVERSION FACTOR FILE 

8.1 Introduction 

WinMACCS is supplied with a set of 51 “adult” dose coefficient files which are based on the CD 
supplement to Federal Guidance Report 13 (EPA 2002). Data for 825 isotopes are provided.  This 
dose factor file set supports WinMACCS calculations using the LNT, AT, and PL dose-response 
models for latent cancer health effects and the acute health effects model.  

These dose factors use ICRP publication 60 (ICRP 1991) tissue weighting and the respiratory 
tract model defined in ICRP-publication 66 (ICRP 1994). Federal Guidance Report 13 dose 
coefficients are generally similar to those published in ICRP publication 72 (1996), but they 
incorporate modifications to ICRP publication 72 assumptions that were agreed to by the EPA 
and the Oak Ridge National Laboratory Center for Biokinetic and Dosimetric Research.  Minor 
differences between Federal Guidance Report 13 and ICRP publication 72 dose coefficients are 
largely attributable to differences in:  

1. Assumptions of shared kinetics in some decay chains 
2. Systemic biokinetic models for some elements, and  
3. Gastrointestinal tract absorption-to-blood fractions, f1.  

8.2 Lung Clearance Behavior 

With few exceptions, the absorption types are consistent with those in ICRP 72.  The dose 
coefficient files do not indicate an absorption type for certain isotopes when either there was no 
choice of clearance type in Federal Guidance Report 13, or the choice was superfluous because 
the inhalation dose coefficients were zero. 

8.3 Gastrointestinal Tract Uptake Fraction, f1 

Federal Guidance Report 13 assigned f1 values for uptake of elements from the digestive tract 
via the ingestion pathway based on the chemical form expected to be encountered in the 
environment, and these values were not necessarily consistent with the f1 values used in the 
computation of inhalation dose coefficients in FGR 13.  There were choices of f1 to be made for 
only four elements: hydrogen, sulfur, mercury, and polonium.  The ingestion dose coefficient for 
tritium was based on tritiated water (HTO). Sulfur, mercury, and polonium isotopes were assigned 
ingestion dose coefficients based on the form and f1 that gave the highest dose.  

8.4 Particle Size Distribution 

Inhalation dose coefficients for micron sized particles depend on the activity median aerodynamic 
diameter (AMAD). The Federal Guidance Report 13 inhalation dose factors are based on an 
activity mean aerodynamic diameter (AMAD) of 1 μm.  

8.5 Organs Included in Data Set 

The following organs and tissues are included in the Federal Guidance Report 13 dose coefficient 
files.  
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Table 8-1 Organs and Tissues Included in Data Set 

Organs with annual and 50-year 
equivalent dose commitment 

coefficients 

Organs with acute dose 
commitment coefficients 

Adrenals  

Urinary Bladder Wall  

Bone Surface  

Brain  

Breasts  

Stomach Wall Stomach Wall 

Small Intestine Wall Small Intestine Wall 

Upper Large Intestine Wall (ULI)  

Lower Large Intestine Wall (LLI) Lower Large Intestine Wall 

Kidneys  

Liver  

Esophagus  

Muscle  

Ovaries  

Pancreas  

Red Marrow Red Marrow 

Skin  

Spleen  

Testes  

Thymus  

Thyroid Thyroid 

Uterus  

Lungs Lungs 

Colon  

Gonads  

Remainder  

Effective  

 

8.6 Annual and 50-year Equivalent Dose Commitment Factors 

The annual and 50-year dose commitment factors are intended for stochastic health effect (cancer 
and heritable effect) estimation, so they include a radiation weighting factor of 20 for the high 
linear energy transfer contributions to these dose coefficients.  The annual files contain the 
contribution to dose in a specific year from an exposure during the first year.  
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8.7 Calculating Annual and 50-Year Dose Commitment Factors for 
“Composite Organs” 

Dose factors for composite organs were calculated from dose factors for the underlying tissues 
or organs as follows: 

(1). The esophagus was assigned the corresponding inhalation dose coefficients and 
ingestion dose coefficients of the thymus.  

(2). Inhalation and ingestion dose coefficients for the colon were calculated as a 
weighted sum of the dose coefficients for upper large intestine (57%) and lower large 
intestine (43%)  

(3). The inhalation and ingestion dose coefficients for the lung (thoracic portion of 
respiratory tract) and ETReg (the extra-thoracic region of the respiratory tract) were 
calculated using equations on page 35 of ICRP publication 66.  The lung coefficient 
is the weighted sum of the coefficients for the several respiratory tract tissues.  

(4). The dose coefficients for remainder were calculated using equations in ICRP 
publication 71 (ICRP 1995) page 27.  

(5). The dose coefficients for gonads were the larger of the dose coefficients for testes 
and ovaries. 

(6). The dose coefficients for effective were computed from the individual organ dose 
coefficients using the ICRP 60 tissue weighting method. 

8.8 Acute Inhalation Dose Factors 

Reliable data on relative biological effectiveness, RBE, of high linear energy transfer radiation at 
causing acute health effects were not located; so, the acute inhalation dose factors were based 
on an RBE of 10 for consistency with DOSFAC2 DCF files.  

Next, the resulting acute dose coefficients DCF [i, at, org, cp] were weighted by acute dose 
protraction factors, WTFRAC [cp,org], and summed to obtain adjusted acute dose coefficients, 
DCF [i, at, org]. Here, i represents an isotope, at represents absorption type (equivalent to lung 
clearance class), org represents an organ, and cp represents a commitment period. The values 
of WTFRAC [cp, org] that were used are given in the DOSFAC2 Users Manual (Young and 
Chanin, 1997).  

8.9 Designating Pseudo-Stable Isotopes When Using Federal 
Guidance Report 13 Dose Coefficient Files 

In contrast to DOSFAC2 and FGRDCF dose coefficients, Federal Guidance Report 13 dose 
coefficients do not implicitly account for doses from a decay product in the dose coefficients of 
the parent. Consequently, one must be mindful about specifying both parent and the 
corresponding progeny that are released or form as decay products in the environment via the 
WinMACCS “Radionuclide Core Inventory and Chemical Group” window. For long decay chains, 
such as uranium-238, the sixth member of the chain (thorium-230 for example) must be identified 
as pseudo-stable. When the pseudo-stable isotope conventions commonly observed for 
DOSFAC2 or FGRDCF dose factor files are used with Federal Guidance Report 13 dose factor 
files, doses and health effects may be significantly underestimated. For example, Ba-137m must 
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be listed as a pseudostable isotope when using a DOSFAC2 dose factor file because its dose is 
included implicitly with Cs-137. With the FGR-13 dose factor file, including Ba-137m as a 
pseudostable isotope could lead to a significant under-prediction of overall dose. 

8.10 Known Issues 

The FGR-13 dose coefficient files have inherited the following issues from the CD Supplement to 
FGR-13: 

(1). The ingestion and inhalation dose coefficients for four alpha-emitting rare-earth 
isotopes (Sm-146, Sm-147, Gd-148, and Gd-152) are incorrect.  

(2). The ingestion and inhalation dose coefficients for four isotopes having significant 
spontaneous fission decay modes (Cm-248, Cm-250, Cf-252, and Cf-254) are listed 
as zero. 
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9. CYCLICAL FILE FORMAT 

It is possible to run successive MACCS simulations without using LHS.  Model values can be 
varied using successive MACCS input files.  This feature is enabled in WinMACCS through the 
Project Properties form setting on the Scope tab.  The files are selected and copied into the 
WinMACCS project after the user completes the form GENERAL/File Specifications/Cyclical File 
Set.  

When the user clicks the Run button to begin a simulation, WinMACCS reads a cyclical file, and 
imports the values temporarily into the project using the algorithm identical to the File→Import 
MACCS Input File option on the main menu.  WinMACCS creates the MACCS template input 
files.  The template input files are identical to the MACCS input files when sampling is not used 
for the simulation.  

The format required for the cyclical input files is identical to the input format required for MACCS 
with the following exceptions: 

(1). ATMOS, EARLY, CHRONC and COMIDA2 model input can be grouped together in a 
single cyclical input file.  When MACCS is run directly, input for these models must 
be in separate files. 

(2). A period in column one is used solely to separate EARLY evacuation scenarios.  The 
first evacuation scenario occurs before the first period in column one. MACCS also 
supports using a period in column one to separate different source terms in the 
ATMOS input, but this is not supported in WinMACCS.  Instead, WinMACCS uses 
the cyclical file capability to support multiple source terms.  

(3). MACCS has evolved since 1.13.1, and though cyclical file input is backward 
compatible, new model options and hence new input values have been added.  
Thus, older files may not be entirely compatible with newer versions of WinMACCS 
and MACCS.  

The MACCS file format is not documented in detail here. However, note the following rules: 

(1). An asterisk (*) in column one signifies a comment. 

(2). Multiple values on an input line can be separated by any amount of white space, 
including TAB characters. 

(3). An input line begins with a prefix. Depending on the input line, this is followed by a 
two- or three-digit sequence number or by no sequence number.  The value(s) of the 
variable(s) follow, separated by white space.  For example, the following line is a 
valid MACCS input file line with a three-digit sequence number and the prefix 
“RDPDELAY” 

• RDPDELAY001 3700. 

Cyclical input files can be created in a number of ways as follows: 

(1). Modify a MACCS file to reflect the changes desired.  As a starting point, use a file 
created by WinMACCS such as Atmos1.inp, Early1.inp, etc. 
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(2). Include only relevant changes between the simulations in a cyclical input file.  As a 
starting point, edit a file created by WinMACCS, removing data that are not changed 
between cyclical runs. 

(3). Use a file created by MelMACCS when the basis of the cyclical input file is a varying 
source term created by the MELCOR modeling code. 

The easiest way to determine the proper format of a cyclical input card is to run a simulation with 
the MACCS Cyclical File Set option in the Project Properties form, Scope tab, set to OFF.  Open 
the MACCS input file (Atmos1.inp, Early1.inp, Chronc1.inp or Comida1.inp) in the project Input 
folder, and copy the relevant lines into the cyclical input file.  

For example, to find the parameter PDELAY in the MACCS input file, as referenced in the 
WinMACCS interface, search for the string PDELAY in the Atmos1.txt file.  This is first found in a 
comment immediately preceding the MACCS input lines responsible for setting the value of 
PDELAY, as shown in the following excerpt from atmosTemplate.txt: 

* PDELAY, time of release for each plume from xxxx (sec) 
RDPDELAY001 3700. 
RDPDELAY002 10000. 

These lines can be copied into a new cyclical input file created in Notepad or other basic text 
processor.  

(1). The order of the lines is not important.  

(2). Include all lines relevant to a variable. In the above example, when the second line is 
omitted, PDELAY is set to be a vector of length one. 

(3). Blank lines are allowed.  

(4). Cohort definitions are separated by a line containing a period in column one. 

The following is a sample cyclical file. Notice that there are ATMOS, EARLY and CHRONC 
parameters in the first section. The second section, separated from the first section with a period 
in column one, contains values to define the second EARLY emergency cohort.  

* CWASH1, Washout Coefficient Number One, Linear Factor 
WDCWASH1001 9.7x10-5 

* WTFRAC - weighting fraction applied to EARLYemergency response cohort one 
EZWTFRAC001 .90 

* EXPTIM - long term exposure period, CHRONC variable 
CHEXPTIM001 9.7x108 

* WTFRAC - weighting fraction applied to EARLY emergency response cohort two 
EZWTFRAC001 .1 
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10. MACCS BINARY FILE FORMAT 

10.1 Binary File Overview 

With the development of WinMACCS, it became desirable to create a file to facilitate 
communication of results from the MACCS modeling engine to WinMACCS.  The standard text 
output file created by MACCS is not an ideal basis for this communication.  As a result, a 
structured, binary output file was created.  Results in this file contain the full numerical precision 
of the MACCS calculations.  When additional parameters are added to the file, WinMACCS does 
not have to be modified to display the new data.  

The binary file supports multidimensional data.  For example, Centerline Ground Concentration 
is associated with the plume number, a radionuclide, and a position on the spatial grid. 

10.2 Mulitdimensional Data 

Many of the MACCS data are multidimensional.  Each result written to the binary file is associated 
with a set of qualifiers.  Qualifier can have one of three data types, character, 4-byte integer, and 
4-byte real.  The qualifier “MACCS2_Input” is not an additional dimension to the variable but is 
used internally by WinMACCS to identify the input line associated with the result.  The qualifier 
units for many of the results are specified in the MACCS input.  

New qualifiers can be defined without modifications to WinMACCS.  A list of the current qualifiers 
and the optional units are shown in Table 10-1. 

Table 10-1 Qualifiers associated with variables. 

Qualifier Units Data type Example value 

Nuclide none character Co-60 

Ldistance km, mi real 5.3 

Rdistance km, mi  real 6.5 

Distance km, mi  real 6.6 

Plume none integer 3 

Evacuation none integer 1 

Health Effect none character ERL INJ/PRODROMAL VOMIT 

Exceeds Risk none real 5.6 

Organ none character A-LUNGS 

Exceeds Dose Sv, rem real 5.2 

Source Term none integer 1 

Angle none character ENE 

Pathway none character GRD 

Elevation Dose Sv, rem real 10. 

Elevation Concentrat Bq/m2, 
Ci/m2 

real 4.2 

MACCS2_Input none not applicable TYPE1OUT001 ‘ERL 
FAT/TOTAL' 1 26 NONE 

Time S real 60 
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10.3 Data in the Binary File 

The results in the binary file are defined by input to MACCS. Output requests to MACCS are 
organized by an output type and details regarding the output request.  For example, the following 
EARLY input card results in a type1 output request of the total early fatalities between spatial 
intervals 1 to 26. 

TYPE1OUT001 'ERL FAT/TOTAL' 1 26 NONE  

The number of results associated with this request is one, namely the number of total early fatality 
health effects. 

The following describes the format of the binary file. Some results are available in units that 
depend on the ATMOS input. 

The data for each of the results are the statistics shown in Table 10-2 and the CCDF of the data 
stored in a binned form, the same as in the MACCS output file. 

Table 10-2 Statistics written to the binary file. 

StatID StatLab 

1 Probability Non-zero  

2 Mean  

3 50th Quantile  

4 90th Quantile  

5 95th Quantile  

6 99th Quantile  

7 99.5th Quantile  

8 Peak Concentration  

9 Peak Probability  

10 Peak Trial  

 

The types of results are shown in Table 10-3. 

Table 10-3 Binary file results records. 

VarLab Comments Qualifiers Units 

Release This output is always 
included. There are entries 
for each isotope (1 to 
NUMISO), for each plume 
release, and for each 
ATMOS change set (or 
source term) 

Source Term 

Plume 

Nuclide 

Bq,  

Ci 
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VarLab Comments Qualifiers Units 

Centerline Air 
Concentration 

Type 0 output Source Term 

Plume 

Nuclide 

Ldistance 

Rdistance 

MACCS_Input 

Bq-s/m3,  

Ci-s/m3 

Ground-Level Air 
Concentration 

Type 0 output Source Term 

Plume 

Nuclide 

Ldistance 

Rdistance 

MACCS_Input 

Bq-s/m3, 

Ci-s/m3 

Centerline Ground 
Concentration 

Type 0 output Source Term 

Plume 

Nuclide 

Ldistance 

Rdistance 

MACCS_Input 

Bq/m2, 

Ci/m2 

Total Centerline 
Ground 
Concentration 

 

Type 0 output Source Term 

Plume 

Nuclide 

Ldistance 

Rdistance 

MACCS_Input 

Bq/m2, 

Ci/m2 

Ground-Level 
Chi/Q 

Type 0 output Source Term 

Plume 

Nuclide 

Ldistance 

Rdistance 

MACCS_Input 

s/m3 

Adjusted Source 
Strength 

Type 0 output Source Term 

Plume 

Nuclide 

Ldistance 

Rdistance 

MACCS_Input 

Bq, 

Ci 

Plume Crosswind 
Dispersion 

Type 0 output Source Term 

Plume 

Nuclide 

Ldistance 

Rdistance 

MACCS_Input 

m 
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VarLab Comments Qualifiers Units 

Plume Vertical 
Dispersion 

Type 0 output Source Term 

Plume 

Nuclide 

Ldistance 

Rdistance 

MACCS_Input 

m 

Plume Centerline 
Height 

Type 0 output Source Term 

Plume 

Nuclide 

Ldistance 

Rdistance 

MACCS_Input 

m 

Plume Arrival Time Type 0 output Source Term 

Plume 

Nuclide 

Ldistance 

Rdistance 

MACCS_Input 

s 

 

Health-Effect 
Cases 

Type 1 output Source Term 

Evacuation 

Health Effect 

Ldistance 

Rdistance 

MACCS_Input 

none 

Health Effects LNT 
Adjusted 
Population Dose 

Type 1 output 

Note: This output is only printed 
when the Threshold or 
Piecewise model is used 

Source Term 

Evacuation 

Health Effect 

Ldistance 

Rdistance 

Organ 

MACCS_Input 

Sv, 

rem 

Health Effects 
Used Adjusted 
Population Dose 

Type1 output 

Note: This output is only printed 
when the Threshold or 
Piecewise model is used 

Source Term 

Evacuation 

Health Effect 

Ldistance 

Rdistance 

Organ 

MACCS_Input 

Sv, 

rem 

Early Fatality 
Radius 

Type 2 output Source Term 

Evacuation 

Exceeds Risk 

MACCS_Input 

km, 

mi 
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VarLab Comments Qualifiers Units 

Population 
Exceeding 
Threshold 

Type 3 output Source Term 

Evacuation 

Organ 

Exceeds Dose 

MACCS_Input 

none 

Average Individual 
Risk 

Type 4 output Source Term 

Evacuation 

Health Effect 

Ldistance 

Rdistance 

MACCS_Input 

none 

Population Dose Type 5 output Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

Sv, 

rem 

Centerline Dose Type 6 output Source Term 

Evacuation 

Organ 

Pathway 

Ldistance 

Rdistance 

MACCS_Input 

Sv, 

rem 

Centerline Risk Type 7 output Source Term 

Evacuation 

Health Effect 

Ldistance 

Rdistance 

MACCS_Input 

none 

Population-
Weighted Risk 

Type 8 output Source Term 

Evacuation 

Health Effect 

Ldistance 

Rdistance 

MACCS_Input 

none 

Peak dose Type A output Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

Sv, 

rem 



 

10-6 

VarLab Comments Qualifiers Units 

Peak dose Polar Type B results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

Angle 

MACCS_Input 

Sv, 

rem 

Dose by Grid 
Element 

Type C results Source Term 

Evacuation 

Organ 

Angle 

Ldistance 

Rdistance 

MACCS_Input 

Sv, 

rem 

Area that Exceeds 
Dose Threshold 

Type C results Source Term 

Evacuation 

Elevation Dose 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

Ha, 

km2, 

mi2 

Ground 
Concentration by 
Grid Element 

****here*** 

Type D output Source Term 

Evacuation 

Nuclide 

Angle 

Ldistance 

Rdistance 

MACCS_Input 

Bq/m2 

Early Ground Conc 
Area That Exceeds 
Threshold 

Type D output Source Term 

Evacuation 

Elevation Concentration 

Nuclide 

Ldistance 

Rdistance 

MACCS_Input 

Ha 

Early Air 
Concentration 

Type D output Source Term 

Evacuation 

Nuclide 

Angle 

Ldistance 

Rdistance 

MACCS_Input 

Bq-s/m3 



 

10-7 

VarLab Comments Qualifiers Units 

Tot Long-Term 
Pathways Dose 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Tot Long-Term 
Direct Exposure 
Pathways 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Tot Ingestion 
Pathways Dose 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Long-Term 
Groundshine Dose 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Long-Term 
Resuspension 
Dose 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Population 
Dependent 
Decontamination 
Dose 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Farm Dependent 
Decontamination 
Dose 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 
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VarLab Comments Qualifiers Units 

Water Ingestion 
Dose 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Milk Growing 
Season Dose 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Crop Growing 
Season Dose 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Milk Long-Term 
Dose 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Crop Long-Term 
Dose 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Ingestion of Grains Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Ingestion of Leafy 
Vegetables 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 
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VarLab Comments Qualifiers Units 

Ingestion of Root 
Crops 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

 

Ingestion of Fruits Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Ingestion of 
Legumes 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Ingestion of Beef Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Ingestion of Milk Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Ingestion of Poultry Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

 

Ingestion of Other 
Meat Crops 

Type 9 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

person-Sv 

Total Economic 
Costs 

Type 10 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

$ 
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VarLab Comments Qualifiers Units 

Pop Dependent 
Costs 

Type 10 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

$ 

Farm Dependent 
Costs 

Type 10 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

$ 

Pop Dependent 
Decontamination 
Costs 

Type 10 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

$ 

Farm Dependent 
Decontamination 
Costs 

Type 10 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

$ 

Pop Dependent 
Interdiction Costs 

Type 10 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

$ 

Farm Dependent 
Interdiction Costs 

Type 10 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

$ 

Pop Dependent 
Condemnation 
Costs 

Type 10 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

$ 

Farm Dependent 
Condemnation 
Costs 

Type 10 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

$ 

Emergency Phase 
Costs 

Type 10 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

$ 
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VarLab Comments Qualifiers Units 

Intermediate Phase 
Costs 

Type 10 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

$ 

Milk Disposal Costs Type 10 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

$ 

Crop Disposal 
Costs 

Type 10 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

$ 

Farm Dependent 
Decontamination 
Distance 

Type 11 results Source Term 

Evacuation 

MACCS_Input 

km 

Pop Dependent 
Decontamination 
Distance 

Type 11 results Source Term 

Evacuation 

MACCS_Input 

km 

Farm Dependent 
Interdiction 
Distance 

Type 11 results Source Term 

Evacuation 

MACCS_Input 

km 

Pop Dependent 
Interdiction 
Distance 

Type 11 results Source Term 

Evacuation 

MACCS_Input 

km 

Farm Dependent 
Condemnation 
Distance 

Type 11 results Source Term 

Evacuation 

MACCS_Input 

km 

Pop Dependent 
Condemnation 
Distance 

Type 11 results Source Term 

Evacuation 

MACCS_Input 

km 

Milk Disposal 
Distance 

Type 11 results Source Term 

Evacuation 

MACCS_Input 

km 

Crop Disposal 
Distance 

Type 11 results Source Term 

Evacuation 

MACCS_Input 

km 
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VarLab Comments Qualifiers Units 

Farm 
Decontamination 

Type 12 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

ha 

Pop 
Decontamination 

Type 12 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

individuals 

Pop 
Decontamination 
Area 

Type 12 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

ha 

Farm Interdiction Type 12 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

ha 

Pop Interdiction Type 12 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

individuals 

Pop Interdiction 
Area 

Type 12 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

ha 

Farm 
Condemnation 

Type 12 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

ha 

Pop Condemnation Type 12 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

individuals 

Pop Condemnation 
Area 

Type 12 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

ha 
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VarLab Comments Qualifiers Units 

Milk Disposal Area Type 12 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

ha 

Crop Disposal Area Type 12 results Source Term 

Evacuation 

Ldistance 

Rdistance 

MACCS_Input 

ha 

Maximum Annual 
Food Dose 

Type 13 results Source Term 

Evacuation 

Organ 

Ldistance 

Rdistance 

MACCS_Input 

Sv 
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